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Module 3

Deployment of Cisco ASA
Adaptive Security Appliance
AnyConnect Remote Access
VPN Solutions

Overview

The Cisco AnyConnect VPN Client and Cisco ASA adaptive security appliance gcting a6 a
Secure Sockets Layer (SSL) virtual private network ( VPN) gateway provide full tunnel 881
VPN services to remote workers. This module describes how to deploy full tunnel SSL YPNs
using basic and certilicate-based authentication. The module alse describes advanced
deployments of Cisco AnyConnect VPN Client software.

Module Objectives

Upon completing thizs module, you will be able to implement and maintain remote-access VPNs

based on Ciseo AnyConnect technology on the Cisco ASA adaptive security appliance VPN

gateway according to policies and environmental requirements. This ability includes being able

to meet these objectives:

s Deploy and manage basic features of a Cisco AnyConnect full tinnel 851 VPN

m  Deploy and manage the advanced centrally configured features of the Cisco AnyConnect
client

m  Deploy and manage the advanced authentication features of a Cisco AnyConnect full
tunnel S5L VPN
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Lesson 1

Deploying a Basic Cisco
AnyConnect Full Tunnel SSL
VPN Solution

Overview

A basic Cisco AnyConnect full tunnel Secure Sockets Layer (SSL) virtual private network
(VPN) provides users with flexible client-based access to sensilive resources over  remote
access VPN gateway, implemented on the Cisco ASA adaptive security appliance. A basic
Cisco AnyConnect full tunnel SSL VPN uses basic user authentication by using usernames and
passwords. [t also provides [P address assignment to the full tunnel clieat from the Cisco ASA
adaptive secunity appliance, and uses a basie access control policy. This lesson enables you to
eonligure, verily, and troubleshoot a basie Cisco AnyConnect full tunnel 881 VPN solution.

Objectives

Upon completing this lesson, you will be able to deploy and manage basic features of Cisco
AnyConnect full tunnel 881 VPNs, This ability includes being able 1o meet these objectives:

Plan the configuration of a Cisco AnyConnect full tunnel 5L VPN solution
Configure and verily basic Cisco ASA adaptive security appliance gateway leatures 1in
Cisco AnyConnect full tunnel 8SL VPNs

Configure and verily password-based local user authentication in a Cisco AnyConnect full
tunnel SSL VPN

Configure and verify local [P address management, basic access control, and split tunneling
in & Ciseo AnyConnect full tunnel S8L VPN
[nstall, eonfigure, and verify the predeploy version of the Ciseo AnyConnect client

Troubleshoot VPN session establishment between a Cisco AnyConnect client and a Cisca
ASA adaptive security appliance VPN gateway



Configuration Choices, Basic Procedures, and
Required Input Parameters

This topic provides an overview of how to plan the configuration of a Cisco AnyConnect full
tunnel SSL VPN solution.

Basic Cisco AnyConnect SSL VPN

Solution Components
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In a basic Cisco ASA adaptive security appliance full tunneling remote acecss Secure Sockets
Layer (SSL) virtual private network | VEN) solution, remote users use the Cisco AnyConneet
VPN Client w establish an SSL/Transport Layer Security (TLS) wunnel with the Cisco ASA
adaptive security appliance. The basic solution uses bidirectional authentication, where the
client authenticates the Cisco ASA adaptive security appliance with a certificate-based
authentication method, and the Ciseo ASA adaptive security appliance authenticates the user
based on a username and password against its local user database. After authentication, the
security appliance applies a set of authorization and accounting rules to the user session. After
the Cisco ASA adaptive security appliance establishes an aceceptable VPN enviconment with
the remote user, the remote user can forward raw [P trafTic inta the SSLTLS tunnel, This
action cecurs as the Cisco AnyConnect client creates a virtual network interface to provide this
functionality. The chient can use any application te-access any resource behind the Cisco ASA
adaptive security appliance VPN gateway, subject to access rules applied to the VPN session.
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Basic Cisco AnyConnect SSL VPN
Deployment Tasks

1. Configure basic Cisco ASA security appliance gateway
features including SSL/TLS server authentication.

=]

Cenfigure local user authentication.

3. Configure IP address assignment.

B

Cenfigure basic access control.

5. Install the Cisco AnyConnect client.

These are the general deployment tasks to create a basic Cisco AnyConneet full tunnel S5L VPN:

[

LF

Configure the Cisco ASA adapuive security appliance with basic SSL VPN gateway
features, including provisioning the identity certificate of the Cisco ASA adaptive security
appliance to enable SSLTLS server authentication.

Configure basic user authentication by configuring the local user database of the Cisco
ASA adaptive security appliance by creating user accounts with static passwords.

Configure an 1P address assignment method by using either 1P address pools or per-user [P
addresses that are configured loeally on the Cisco ASA adaptive security appliance.

Configure basic aceess control, limiting aceess to the enterprise internal network.

Install the Ciseo AnyConnect client on the remote PCs, and configure it te connect to the
S8L VPN gateway.

Before implementing a basic Cisco AnyConneet full tunnel $SL VPN, you will need 1o obtain
and analyze several pieces of information that arerelated to the network and system environment:

m  The [P addressing plan that will dietate the VPN gateway addressing, and the enterprise

naring plan that will dictate the name of the YPN gateway. This data is needed to assign
an IP address to the Cisco ASA adapuive secunty appliance VPN-terminating interlace, and
Lo assign a name inside the VPN gateway SSL/TLS identity certificate.

The enterprise certificate policy and certificate settings. This information 15 needed in order
to enroll the Cisco ASA adapuve security appliance into a public key infrastructure (PKI)
(il so desired) and include all relevant fields inside a PKI-provisioned certificate.

The enterprise policy for the user-naming format and the enterprise password poliey, in
order to create the local user database on the Cisco ASA adaptive security appliance.

The enterprise eryptographic policy, in order to choose the optimal S5L/TLS protocol
versions and algorithm bundies [cipher suites) for S8L/TLS sessions on the Cisco ASA
adaptive security appliance.
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m  The [P addressing plan for remote clients. In a full tunneling $5L VPN, the Cisco ASA
adaptive security appliance must assign [P addresses to remote clients, and these addresses
must be unigue and routed to the Cisco ASA adaptive security appliance in order for VPN
connectivily to work.

m Access policies that dictate which sensitive internal resources the remole users can Access.
This information is needed to configure an access control policy on the Cisco ASA
adaptive security appliance that will be applied to remote access VPN sessions.

m A list of elient platforms of remote users. This information s needed to correetly provision
the Cisco AnyConnect software images 10 the remote users, and to store on the Clsco ASA
adaptive security appliance flash memaory.

Basic Cisco AnyConnect SSL VPN

Deployment Guidelines
Consider the following general deployment
guidelines:

= Use local password-based usser authentication in low-risk
envirenments, whare all users share the same access policy

= Easily extend the basic solution with remaote AAA user
authentication, and multiple access policies when needed

Consider the following deployment guidelines when deploving a basie Cisco AnyConnect full
tunnel 881 VPN solution:

m  Use local password-based user authentication in low-risk environments where all users
share the same access policy

m  Fasily extend the basic solution with remote authentication, authorization, and accounting
(AAA) user authentication and multiple aceess policies when needed
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Configuring Basic Cisco ASA Adaptive Security
Appliance SSL VPN Gateway Features

This topic enables you to configure and verify basic Cisco ASA adaptive security appliance

S5L VPN gateway leatures in Cisea AnyConnect full tunnel 5L VPNs,

T |
Basic Cisco ASA Adaptive Security
Appliance Gateway Features

Overview

= Configure the Cisca ASA
security appliance as a
8SL/TLS server:
- Provision a server identity
certificate
- Enable the SSL/TLS
Server
= Tune SSL/TLS settings
= dentity certificate: Ly
- Temparary self-signed
certificate generated by
default
- Configurable persistent
self-signed certificate
- PKl-provisioned
certificate recommended

The first deployment step when configuring a full tunnel SSL VPN solution is to confizure basic

SSL/TLS server parameters on the Cisco ASA adapuve secunty appliance. This step includes
provisioning a server identity cenificate, which the Cisco ASA adapuive security appliance will
send to remote clients so that they éan authenticate the Cisco ASA adaptive security appliance.

This step also meludes enabling the SSLTLS server functionality on an interlace, and optionally

wning SSL/TLS parameters Lo be compliant with local cryptographic policies.

By default, the security appliance will ereate a sell-signed X 509 certificate on each reboot,

resulting in many client warnings when you atiernpt SSL VPN access, as the certificate cannot

be verified by any means. You can address this issue by using one of two approaches:

m By creating a permanent sell-signed certificate that is persistent across reboots, and that

you can save on the client. This approach is possible if the remote users have the option of

initially accessing the Cisco ASA adaptive security appliance over atrusted network and
saving the identity certificate of the appliance to their local storage. This approach is

usually not supported by most clients and 15 generally not recommended.

® By enrolling the Cisco ASA adaptive security appliance inte an existing PKI, with the

clients authenticating the identity certificate of the appliance on each access by validatung it

using a relevant certificate authority (CA) certificate that was used to1ssue the identity
certificate of the security appliance. This CA certificate needs o be preprovisioned to all

clients n order Tor such authentication to work.

©2010 Cigca Systems, Ins,
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Configuration Tasks

1. Provision an identity server certificate to the Cisco ASA
security appliance:

A Using a persistant self-signed certificate
B. Using a PKI-provisioned certificate using SCEP
C. Using a PKl-provisioned certificate using manual (cut-and-

paste) enroliment

2. lLoad a Cisco AnyConnect image cnto the adaptive security
appliance.

£ad

Enable SEL VPN terminaticn on aninterface.

4. Configure and optionally tune SSLITLS setlings.

To confligure basic Cisco ASA adaptive security appliance SSL VPN gateway features,
complete the following confliguration tasks:

l.  Provision an identity server SSLTLS certificate to the Cisco ASA adaptive security
appliance. The security appliance will use this certificate to identify itself to remote clients,
and, based on this certificate, remote clients will be able to authenticate the Cisco ASA
adaptive security appliance. You have three options to install a certificate on the Cisco
ASA adaptive security appliance:

—  Oprtion A is to create and install 8 permanent self-signed certificate that is persistent
across reboots,

—  Option B is tocreate and install & persistent, PK1-provisioned certificate by enrolling
the Cisco ASA adaptive security appliance into an existing PKI. You can use either
a PKIl internal to your organization, an externally managed PRI, or an external,
global PKIL. In option B, you will use the Simple Certificate Encollment Protocol
(SCEP) to enroll to the PRI and obtain an identity certilicate.

—  Option C 15 essentially the same as option B, but should be used with PKls that do
not support SCEP enroliment. Instead, you will use manual [cut-and-paste)
enrollment by exchanging raw enrollment data with the PK! manually.

2. Load a Cisco AnyConnect elient software image onto the Cisco ASA adaptive security
appliance, placing 1t into the persistent Mash storage of the seeurity appliance.

3. Enable SSL VPN traffic termination on a Cisco ASA adaptive security appliance interface,
and therefore enable the security appliance SSL VPN server function.

4. Configure and optionally tune the SSL/TLS settings. You will need to assign the installed
wentity certificate of the Cisco ASA adaptive security apphiance to the chosen VPN trafTic
wermination interface. Optionally, you will need o choose SSL/TLS versions and algorithm
bundles {cipher suites) that vou desire to use [or traffic encapsulation.

Daplaying Cisco ASA VPN Solubans (VPN) v1.0 & 2010 Cisca Systams, Ins,
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Configuration Choices

Grocs
Use self-signed or Self-signed certificates should be avoided
PKI certificates except for testing or very small deployments.
‘\erification |s 2 manual process.
Use gicbal (external} PKI certificates if not all
clients are managed,
Gonsider local (internal) PKI certificates if
clients are managed and have an authentic

copy of the CA certificate.
Tuning SSLTLS Unfess you have a policy dictating the use of
settings specific cryptographic algorithms, You can use
default SSUTLS settings.

There are several configuration choices that you need to make based on locally significant
criteria.

The first choice is whether you will use self-signed or PKIl-provisioned certificates. Using any
kind of self-signed certificate is generally not recommended, as the clients typically cannot
verify 1t properly 1if they do not already have an authentic copy of it locally preinstalled. Self-
signed certificates should generally only be used lor test purposes, and not for production use
over untrusted networks. Deploving a permanent self-signed certificate 1s simpler compared 1o
using PKl-provisioned certificates, as it réquires no interaction with the PK1. However, usmga
PKl-provisioned certificate is a recommended and a more scalable solution. You can use a local
(internal to the enterprise, or a managed, private PKI service) PRt all of your elients are
managed, and you can be reasonably sure that all clients have an authentic copy of the CA
certificate installed. Alternatively, you should use a certificate from a global PK LIl not all of
vour elients are managed and you have to rely on the operating system default store of global
CA certalicates (trusted roots).

The second choice involves tining the SSLUTLS settings of the Cisco ASA adaptive security
appliance SSL/TLS server function. You may consider tuning these settings if vou have a local
policy dictating the use of particular SSL/TLS protocol types, or particular eryplographic
algorithms. In most cases, the default Cisco ASA adaptive security apphiance SSL/TLS settings
are optimal for most users.

©2010 Cigca Systems, Ins, Daplaymant of Cisco ASA Adaptive Sacurty Appliance AnyConnact Remota Access VPN Solutone . 3-3



Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Configuration Scenario
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The figure presents the configuration scenario that 1s used in upcoming configuration tasks. The
Cisco ASA adaptive security appliance can either issue a self-signed certificate, or receive its
wdentiey certificate from an external or internal CA server, You will also need to configure your
Domain Name System ( DNS) infrastructure to resolve the name of the Cisco ASA adaptive
security appliance (inside its identity certificate) to its VPN-terminating interface 1P address

(the 1P address ol the outside interface in the example).
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features
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In the fiest task, you will generate a permanent self-signed certificate that does not change
across Cisco ASA adaptive security applianee reboots. The use of a permanent self-signed
eertficate is discouraged, as it offers little benefit over the temporary self-signed certificate.

To deploy a new permanent self-signed certificate, perform the following steps:

Step 1 Using Cisco Adapuve Security Device Manager (Cisco ASDM), choose
Configuration > Device Management > Certificate Management > ldentity
Certilieates ( not shown in the lgure).

Step 2 Click Add o create a new PEI rustpoint. Assign a local name to the new trustpoint.

Step 3 Choose Add a New Identity Certificate, and choose the named Rivest, Shamir, and
Adleman (RSA) key pair to be used as the basis for the 851 VPN server cenilicate.

Step 4 Crptionally, create an RSA key pair of appropriate strength by elicking the New
button. 1t is recommended to create a separate key pair for each trustpoint. Make
sure that you generate a key ol appropriate strength (key size).

Step 5 In the Certificate Subject DN field, enter the canonical name of the security
appliance in the form of CN=hostmame. domaimnname (you can click the Seleet button
o construct a more complex subject name, if needed; however, this is not required
for self-signed certilicates).

Step 6 Check the Generate Self-signed Certifieate check box.

Step 7 Click Add Certificate to immediately generate the permanent self-signed X500
cectificate.

©2010 Cigca Systems, Ins, Deployment of Cieco ASA Adaptive Sacurty Appliance AnyConnact Remota Access VPN Solutione 3-11



Configuring Basic Cisco ASA Adaptive
Security Appliance Features
Task 1B: Provision a PKI ldentity Certificate Using SCEP
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Alternauvely, you can deploy a PKl-provisioned certilicate to the security appliance. This
procedure 15 similar to installing a self-signed certificate, except that you have to forward your
certificate request { contaiming the Cisco ASA adapuve security appliance name and public RSA
key) to a PKI enrollment server (a registration authority or a certificate authority ).

Perform the following steps:

Step 1 Ensure that the Cisco ASA adaptive security appliance hostname and domain name
are setcorrectly.

Step 2 Optionally, if you have not already done so, ereate an RSA kev pair of appropriate
strength. Or you ean reuse existung keys, il they are of appropriate strength.

Step 3 Using Cisco ASDM, choose Configuration > Device Management > Certilicate
Management > Identity Certilicates (not shown in the ligure).

Step4  Click Add to create a new PKI trustpoint. Assign a loeal name to the new trustpoint.

Step 5 Choose Add a New Identity Certilicate, and select an RSA key pair [or create a
new key pair) to be used as the basis Tor the HTTPS server certiflicate.

Step & In the Certificate Subject DN [ield, enter the canonical name of the security
appliance in the form of CN=hostname.domainname (you can click the Seleet button
to construet a more complex subject name if needed).

Step 7 Click the Advaneed button to display PKI enrollment parameters.

Step 8 I the Certificate Parameters tab, venfy that the fully qualified domain name {FQDN)
is properly set to the appliance hostname and domain name (not shown in the fgure).

Stap 9 Ini the Enrollment Mode tab, chick the Request from a CA radio button. Enter the
enrollment parameters (like the enroliment URL ) depending on the PKI that you
are using.

Use the SCEP Challenge Password tab to optionally enter the SCEP pagsword if
required by the PK1 CA server.
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Step 10
Step 11

]
Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Task 1C: Provision a PKI Identity Certificate Using Cut-
and-Paste Enrollment
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Click Add Certificate to generate the certificate request.

When the PKI approves your certilicate request, choose your request and click
Install to install the identity certificate.
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I the PKI does not suppoct SCEP enrollment, you can also enroll using a manual cut-and-paste
method. n this method, you will generate a certificate request, and then send this request {as a
file, or paste it nte a PRI enroliment user interface) 1o a PKI cenificate or registration
authority. The CA will issue yvou a certificate (in the form ofa file, or as text data) that you can
copy and paste into the Cisco ASA adaptive seeurity appliance.

Perform the following steps in order to complete the cut-and-paste enrollment method:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Step 7

Step 8
Step 9

Using Ciseo ASDM, choose Conliguration > Device Management > Certilicate
Management > ldentity Certilicates (not shown in the ligure).

Click Add to create 4 new PE L rustpoint. Assign a local name w the new trustpoint
(not shown in the lfigure).

Choose Add a New ldentity Certilicate, and choose an RSA key pair (or create a new
key pair) to be used as the basis for the HTTPS senver cedificate (not shown in the figurg),

In the Cenificate Subject DN field, enter the canonical name of the security
appliance in the form of CN=hopsiname. domainname (you can click the Seleet button
to construct a more complex subject name il needed) (not shown in the fgure).

Click the Advaneced button to display PEI enrollment parameters (not shown in figure).

In the Certificate Parameters tab, verily that the FQDN is properly set to the
appliance hostname and domain name (not shown in the fgure).

In the Enrollment Mode tab, choose the Request by Manual Enrollment (cut-
and-paste) method. Enter the enrollment parameters depending on the PRI that you
are using.

Click Add Certificate to generate the certificate request (not shown in the figure).

Save the cerificate sizning request (CSR) data nw a file and use it o enroll into the PR

©2010 Cigca Systems, Ins,
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Task 1C: Provision a PKI Identity Certificate Using Cut-
and-Paste Enroliment (Cont.)
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To finish the manual enrollment procedure, perform these steps:

Step 1 When the PKI approves vour certiflicate request, obtamn the certificate file or text
data, and import it 1o the Cisco ASA adaptive security appliance as a {ile, or paste it
mto the Cisco ASDM GUL

Step 2 Choeose Configuration > Deviee Management > Certificate Management >
Identity Certificates and select the trustpoint that was configured 1n one of the
PEEVICUS SLeps.

Step 3 Choose Install Certificate to mstall the identity certificate that was obtained from
the CA by selecting the certification lile or by manuoally pasting in the Base6d-
encoded cerifieate,
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Task 2: Load a Cisco AnyConnect Image onto the Cisco
ASAAdaptive Security Appliance
* Dowrlpad Cisco AnyConnect PKG packages from Cisco.com

* Load them into the flash memory of the appliance

* Download and copy PKGs for all reguired platforms to the appliance
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In Task 2 of the configuration sequence, downlead the Cisco AnyConnect web deployment
client software packages [rom Cisco.com, and transfer them to the Cisco ASA adaptive security
appliance ash memory. You should transfer the PKG formar of the Cisco AnyConnect
software image to the Cisco ASA adapuve security appliance (as shown in the figure), for all
elient platforms that you intend to use. The Cisco ASA adaptive security appliance will use
these web deployment (or web launch) packages to dynamiecally install the Ciseco AnyConnect
client to all users visiting the SSL VPN portal, if' so configured.

Nota In the configuration scenario example that is used in this lesson, you will also be shown how
to use the predeployment (Microsoft Windows Installer [MSI1}} installer package, and not the
web deployment package. However, installing a web deployment is a mandatory step in the
S5L VPN gateway configuration.

If you are using Cisco ASDM, vou can use the ASDM File Transler user interface from the
Tools > File Management ASDM menu to transfer these files from your local storage location
to the Cisco ASA adapuve security appliance.

Note The Cisco AnyConnect client that is loaded on the Cisco ASA adaptive security applisnce is
8 Microsoft Windows-based client. Other operating system environments are also
supported.

©2010 Cigca Systems, Ins, Deplayment of Cisco ASA Adaptive Sacurty Appliance AnyConnsct Remota Access VPN Solutione 3-15



T |
Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Task 3: Enable S5L VPN Termination on an Interface
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In Task 3, you will globally enable the 881 VPN function on the Cisco ASA adapuive security
appliance, and select the interfaces on which the appliance will accept S8L VPN sessions, You
ean also optionally configure support for Datagram Transport Layer Security (DTLS), which
will be automatically negotiated if the path between the client and the Cisco ASA adapuve
seeurity appliance supports it. Additionally, you will enable user connection profile selection,
which is required if you want 1o assign users into da specifie connection prolile, and not use the
default DefaultWebVPNGroup profile for all users.

Perform the following steps:

Step 1

Step 2

Step 3

Step 4

Stap 5

Step &

In the Ciseo ASDM, choose Configuration > Remotle Access VPN > Network
{Client) Aecess = AnyConneect Connection Profiles.

Choose Enable Ciseo AnyConnect VPN Client or Legacy S5L VPN Client
Access check box Lo globally énable SSL VPN functionality. A window appears,
asking you to continue to designate a Cisco AnyConnect image, click Yes to
continue.

The Add SSL VPN Client lmage window appears, prompting you to select a Cisco
AnyConnect image that the Cisco ASA adaptive secunity appliance will use to
deploy the client to users who use a browser to initially connect to the full tunneling
VPN, Select the .pkz image in the Cisco ASA adaptive security appliance lash that
you have previously uploaded. You can also upload an image at this point.

Check the Allow Access check box, and optionally check the Enable DTLS check
box, on the interface on which you want to terminate 8SL VPN connections. ln this
example, these connections are enabled on the outside imectace. 1tis generally
recommended to enable DTLS aecess to provide low-latency tunneling to support
real-time applications, such as software [P phones.

In the Login Page Setung, check the Allow User to Seleet Connection Profile
check box to allow users to select their connection profile at login.

Click Apply and save your configuration, if necessary.
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Configuring Basic Cisco ASA Adaptive
Security Appliance Features

Task 4: Configure and Tune SSL/TLS Settings

Corigursiion > Fernale Aioyss ¥FN & Adviaced = 5L Betinas a
Corfigure G5L perameters. Thaes parameters affect bt ARON end S5, 4T sooe
Tha S5L vk [0 Mil Bdirdy Spyslande [0 iegodile &8 8 "skrwi™: Ay
That S5 veeruuais lid Hhe Shenrdy appihics (D QOO 35 8 hint”) LAy

Ererppine
| Awerlasbe Mlpir it 7n | | At Ao
s fHAL | - AED U GHAT
HLL-GHAL ‘CoZonaly. anaia or dsania AFEI5E-5HAL
SELTLE opher sunes
Caitfuste

Specdy nibich cartficatin, f ey, shack] e used for 5L suthentioaton on mch it Tie Lilboack corisfaate vl
i |METALES Bod asteriEted Wi 8 CEIDICANS Of Whew Seh

:m:rm.-. Trustpoini knad Balrcng Trustpormt | I l-ll-l -

Confguraton = Remodz Acosas WEN > Aguenced » 351 Bettngs

Sqedty asrofed tasnos b be used for S5L suherboatios end VPN foad bofanding an the oulzide:
arfaca.; Ta enfel & neapair, g o Configurelion > Feahures > Device Adinsirason = Canfcabe

B e i g TS
iderdidy carsione
i e maside [ Er
=z Primasy Envcbed Corificae: SELF-S3HED: hommamesypn Soman.cos, mavpn domen_ ¥

In Task 4, you need to anach the installed wdentity certificate of the Cisco ASA adaptive security
appliance o the appropriate network interfaee that you configured for 5L VPN temmination.

Perform the following steps:

Step 1 Choose Configuration > Remote Access VPN > Advanced > SSL Seltings (or
choose Configuration > Remote Access VPN > Network (Client) Aceess >
AnyConnect Connection Profiles, and click the Click Here to Assign Certificate
to Interface link).

Step 2 At the top of the SSL Settings pane, you can select the $8L and TLS protocol
versions that the appliance will support as the SSL/TLS server. I you need to
change the default values, vou have the following options:

SSL Settings

Value Description

any The adaptive security appliance accepts SSL version 2 {SSLv2) client
hellos, and negotistes either S5L version 3 (§5Lw3) or TLS version 1
[TLSw1). This option is selected by default.

Negotiate SSL w3 The adaptive security appliance accepts SSLvZ client hellos, and
negotiates to SSLv3.

SEL w3 only The security appliance accepts only S5Lv3 client hellos, and uses only
35Lv3.

Negotiate TLS v1 The adaptive security appliance accepts SSLvZ client hellos, and
negotiates to TLSW1.

TLS w1 only The security appliance accepts only TLSv1 client hellos, and uses only
TLSw1.

Step 3
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Step 4 In the Encryption section of the SSL Settings pane, you can select or deselect the
cryptographic algorithm bundles (cipher suites) that the Cisco ASA adaptive
security apphance will accept in the intial SSL/TLS negotiation. If vou need to
change these settings based on a local cryptographic policy, you can enable or
disable specific bundles in this pane.

Step 5 In the 8SL Settings pane, where the interfaces are listed, elick Edit to edit the
interface (or interfaces) on which the security appliance will accept S8L VPN
connections,

Stap & In the Primary Enrolled Certificate drop-down menu, choose the installed identity
certificate of the Cisco ASA adaptive security appliance.

Step 7 Click OK, and click Apply.

Stap B Save your configuration, if necessary.

Configuring Basic Cisco ASA Adaptive
Security Appliance Features
CLI Configuration with a Self-Signed Certificate

orypto key generate raa lahel BELF-SIGNED-EEYE modulnas 2048

1
grypte ca trustpoint EELF-SIGKED
enrollmant gelfl 3 - s REM ey pa

subiect-name CHevepn.domadin.oom
keypalr SELF-SIGHED-EEYS
|

erypts ca enroll SELF-SIGNED noconfirm T ——
1 eridoata
et

enable cutside WM sz

sve image dfsgkl: /anyecnnect-win-2.4.10123-k9.pkg 1
ave snaklie
tunnel-group-list enabkle

1 Spacy tewarver ey oerricam
gel trugt-point EELF-SIGKED sutside wsed on S outside keiace.

This output shows the command-line interface (CL1) commands that are required o configure
the basic Cisco ASA adaptive security appliance $SL VPN gateway features using a self-signed
identiry cemtificate of the appliance.

ln the CLL use the eryplo key generate command to generate an RSA key pair, if required.
LUse the eryplo ea trustpoint command to create a self-signed trustpoint. lnside the trustpoint
configuration, use the enrollment self command to specify that this trustpomnt will
automatically generate a persistent self-signed cenificate upon enrollment. Use the subjeet-
name command to specify the name that the Cisco ASA adaptive security appliance will use
inside its identity certificate. Optionally, use the Keypair command to.specify the dedicated
RSA key pair (1] generated) that the Cisco ASA adaptive security appliance will use when
generating the self-signed certificate.

MNext, use the eryvpto ea enroll command to actually generate the self-signed certificate based
on the trustpoint setlings.
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Next, enter 881 VPN server configuration submode on the Cisco ASA adaprive security
appliance using the webvpn command, and enable the SSL VPN server on the outside interface
using the enable command. Designate the Cisco AnyConnect image that is present in the loeal
Cisco ASA adaptive security appliance storage using the sve image command, and enable full
tunnel SSL VPN connections using the sve enable command. To finish the configuration,
enable user selection of connection profiles using the tunnel-group-list enable command.

Finally, assign the installed self-signed interface to the SSL-VPN-gnabled interface by using
the ssl trust-point command.
crypto key generate rsa

To generate RSA key pairs for identity certificates, use the erypto key generate rsa command
in global configuration mode.

crypto key generate rsa [usage-Keys | general-keys] [label bey-pair-labe!] [ modulus size]
[noconfirm)

crypto key generate rsa Parameters

Parameter Description

general -keys Generates a single pair of general-purpose keys. This type is the
default key pair.

label key-pair-label Specifies the name to be associated with the key pair (or pairs).
This key pair must be uniguely labeled. If you attempt to create
another key pair with the same label, the adaptive security
appliance displays a warning message. |f no label is provided
when the key i3 generated, the key pair is statically named
<Default-RSA-Key=.

mdulus size Specifies the modulus size of the key pair (or pairs); 512, TEB,
1024, and 2048. The defautt modulus size is 1024,

noconfirm Suppresses all interactive prompting.

usage-keys Generaltes two key pairs, one for signature use and one for

encryption use. The implication is that two certificates for the
corresponding (dentity are reguired.

crypto ca trustpoint

To enter trustpoint configuration mode for the specified trustpoint, use the erypto ca
trustpoint command in global configuration mede. To remove the specified trustpoint, use the
no form of this command.

eryplo ca trustpoint frusipoint-name

no eryplo ea trustpoint sustpoini-name |noconlirm|

crypto ca trustpoint Parameters

Parameter Description

noconfirm Suppresses all interactive prompting.

trustpoint-nams |dentifies the name of the trustpoint to manage. The maximum
name length is 126 characters.
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subject-name (crypto ca trustpoint)

keypair

webvpn

To include the indicated subject distinguished name (DN} in the certificate during enroliment,
use the subject-name command in erypto CA trustpoint configuration mode. The DN
represents the person or system that uses the certificate, To restore the default setting, use the
no form of the command.

subject-name X500 _name

subject-name (crypto ca trustpoint) Parameters

Parameter Description

X.500 name DCefines the X.500 distinguished name. Use commas to separate attribute-value
- pairs. Insert guotation marks around any value that contains commas or spaces.
For examiple: cn=crl,ou=carts,o="cisco systems, inc.",c=US. The maximum
lengthis 500 characters.

To specify the key pair whose public key is to be certified, use the keypair command in
erypto CA trustpoint configuration mode. To restore the default setting, use the ne form of
the command.

keypair name

keypair Parameters

Parameter Description

name Specify the name of the key pair.

To enter webvpn mode, in global configuration mode, enter the webvpn command. To remove
any commands that are entered with this command, use the no webvpn command. These
webvpn commands apply to all WebVPN users.

These webvpn commands let you configure AAA servers, default group policies, default idle
umeout, HTTP and HTTPS proxies, and NetBIOS Name Service (NBNS) servers for
WebVPN, as well as the appearance of WebVPN screens that end users see.

webvpn

enable (webvpn)

To enable WebVPN or email proxy access on a previously configured interface, use the
enable command. For Web%V PN, use this command 1 webvpn mode. For email proxies
(Internet Message Access Protocol version 4 Secure ( IMAP4S), Post OfTice Protocol version
3 Secure [POP3%], and Simple Mail Transfer Protocol Secure [SMTPS]), use this command
in the applicable email proxy mode. To disable WebV PN on an interface, use the no version
of the command.

enable ifname

enable (webvpn) Parameters

Parameter Description

ifname |dentifies the previousiy configured interface. Use the namaif
command to configure interfaces.
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svc image

To specily an S5L VPN client package file that the adaptive security appliance expands in
cache memory for downloading to remote PCs, use the sve image command from webvpn
configuration mode. To remove the command from the configuration, use the no form of the
command.

sve image filename order [regex expression)

svc image Parameters

Parameter Description
filenams Specifies the flename of the package file, up to 255 characters,
crder With multiple client package files, orderspecifies the order of the

package files, from 1 to 65,535, The security appliance downloads
portions of each client, in the order that you specify, to the remote PC
uritil it achieves a match with the operating system.

ragex sxpression Specifies a string that the adaptive security appliance uses tomatch
against the user agent string that is passed by the browser,

svc enable

To enable the adaptive seeurity appliance to download an S5L VPN elient Lo remote computers,
use the sve enable command from webvpn confliguration mode. To remove the command from
the configuration, use the no form of the command.

sve enable

ss| trust-point

To specily the certificate trustpoint that represents the SSL certificate for an interface, use the
ssl trust-peint command with the iterface argument in global configuration moede. I you do
not specify an interface, this command creates the fallback trustpoint for all interfaces that do
not have a trustpoint conligured. To remove an S8L trustpoint from the configuration that does
not specily an interface, use the no version ol this command. To remove an entry that does
specily an interface, use the no sl trust-point { frusipoint [nterface]} version of the command.

ssl trust-point | frustpoint [interface]}

ssl trust-point Parameters

Parameter Dascription

interfacs The name for the interface to which the trustpoint applies. The nameif command
specifies the name of the interface.

trustpoint The name of the CA trustpoint 23 configured in the crypio ca trustpoint {name)
command,
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CLI Configuration with a PKI Certificate and SCEP
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This output shows the CL1 commands that are required to configure the basic Cisco ASA
adapuive security appliance 88L VPN gateway features using a PKI-provisioned identity
certificate of the appliance. The procedure is generally the same as when using a self-signed
certificate, except for the wrustpomt configuration and enroliment procedure.

Inside the trustpoint contiguration, use the enrollment url command to specify the SCEP
enrellment URL provided to vou by the PRI adnmunistrator. Use the subject-name command 1o
specily the FQDN that the security appliance will use inside 1ts identity certificate in the
canonical name certificate feld, and any other components of the name that the PKI1 requires
(provided to you by the PKI admunistrator). Optionally, use the Keypair command 1o specify
the RS A key pair that the security appliance will use when requesting its identity ceniflicate.

Use the eryptlo ea authenticate command to download the identity certificate of the PRI CA 1o
the Cisco ASA adaptive seécurity appliance. A fingerprint of the downlpaded certificate will be
displayed, and you should aceept it after verifying that it is the correct CA certificate
fingemprint. To verify the fingerprint, use a secure communication channel with the PKI1
administrator, or perform this transaction over a trusted nerwork.

Next, use the eryvpto ea enroll command to request the identity certificate of the Ciseo ASA
adaptive security appliance from the PKI, sending the name parameters and the public key of
the configured key pair to the PRI CA. The PKI CA will issue you an identity certificate, which
the Cisco ASA adaptive security appliance will automatically download by periodically polling
the PRI CA server.

Other CLI steps and commands are the same as when enabling the SSL VPN gateway funclions
with a self-signed certificate.
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enrollment url

To specily automatic enroliment (SCEP) w enrell with this trustpoint and to configure the
enroliment URL, use the enrollment url command in erypto CA rustpoint configuration
mode. To restore the default setting of the command, use the neo form of the command.

enrollment url urf

enrollment url Parameters

Parameter Description

url Specifies the name of the URL for automatic enroliment. The maximum lengthis 1000
characters |effectively unbounded),

crypto ca authenticate

To install and authenticate the CA certificates that are associated with a trustpoint, use the
erypto ea authenticate command in global configuration mode, To remove the CA certilicate,
use the no form of this command,

erypto ca authenticate trustpoint [fingerprint fexvalue] [nointeractive]

crypto ca authenticate Parameters

Parameter Description

fingerprint Specifies a hash value consisting of alphanumeric characters that the adaptive
security appliance uses to authenticate the CA certificate. If 3 fingerprint is
provided, the adaptive security appliance compares it to the computed
fingerprint of the CA certificate and accepts the certificate only if the two values
match, If there is no fingerprint, the adaptive security appliance displays the
computed fingerprint and asks whether to accept the certificate.

hexvalue |dentifies the hexadecimal value of the fingerprint.

nointeractive | Obtains the CA certificate for this trustpoint by using no interactive mode. It is
intended for use by the device manager only. In this case, if there is no fingerprint,
the adaptive security applisnce accepts the certificate without question.

trustpoint Specifies the trustpoint from which to obtain the CA cedificate. Maximum name
length is 128 characters.
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ldentity Certificate Verification
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Configurston > Devdos Mansgament > Serificais Menagemant > identty Cartfoates

To verify that the identity certificate of the Ciseo ASA adaptive security appliance has been
successtully mstalled, choose Cenliguration > Deviee Management > Certificate
Management > Identity Certificates by using Cisco ASDM. Select the idenury certificate of
the Cisco ASA adaptive security appliance and click the Show Details button. The cerificate
status should be listed as “Available.™ In the CLI, use the show erypto ca certilicates
command and verify that the certificate status shows as *Available.”

show crypto ca certificates

To display the certificates that are associated with a specific trustpoint or to display all the
certificates that are installed on the system, use the show erypto ca certilicates command in
global configuration or privileged EXEC mode.

show erypto ca certificates [rusipointname

show crypto ca certificates Parameters

Parametar Description

trustpointnams {Optional}) The name of a trustpoint. f you do not specify 8 name, this
commiand displays all certificates that are installed on the system.
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Verifying Basic Cisco ASA Adaptive
Security Appliance Features

Implementation Guidelines

= Avoid self-signed certificates, unless you will manually load
the Cisco ASA adaptive security appliance identity certificate
o all clients before thay log into the VPN (not scalabla)

* Observe proper enrcliment procedures—submit vour public
key to a CA using a secure procedure

= Censider using the Entrust enrollment wizard in the ASDM
GUIto easily enroll into the global PKI

When implementing basic Cisco ASA adaptive security appliance S5L VPN gateway features,
consider the following implementation guidelines:

m  Generally, avoid using self-signed certificates, except in very small deployments where you
can manually load the identity certificate of the Cisco ASA adaptive security appliance to
all the remote clients betore they log 1nto the VPN, The remote users can also install the
seif-gsigned certilicate themselves il they mitially log in over a trusted network, which s
often not the case.

m  When enrolling inte a PK1 over an untrusted network, ohserve proper enrollment
procedures and make sure that the P administrator properly verifies the appliance name
and public key belore issuing a certilicate, in order o avoid issuing the certiticate to a
malicious entity.

®  The Cisco ASDM includes an Entrust enrollment wizard, which simplifies the enrollment
into the global PKI by providing you with step-by-stép instructions for obtaining an
Entrust-provisioned certificate. Consider using this wizard if you are unsure how Lo enroll
into the global PKL The wizard can be started by clicking the Enroll ASA SSL VPN with
Entrust button in the Configuration = Deviee Management > Certificate Management >
Identity Certificates pane.
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Configuring Local Password-Based User

Authentication

This topic enables you to configure and verify password-based local user authentiéation in a

Cisco AnyConnect full tunnel SSL VPN,
I ——

Configuring Local Authentication

Local Password-Based User Authentication Overview

= The simplest user authentication
method uses local passwords:

— Local user database

- Locally configurad static
passwords
= Password-based users:
- May be permitted to select

connection profile based on
selaction menu or greup URL

— DefaultWebVPNGroup uses
local AAA authentication by

default

Local User Databace

usemamei/passwordl
usamamad passwardd

Cimoa ASA Adanive
Seourty Aopinoce

Alter configuring basic Cisco ASA adaptive security appliance SSL VPN gateway parameters,
the next deployment task is to configure a user authentication method, and prepare the Ciseco ASA
adaptive security appliance with all necessary configuration objects to enable later assignment of
WPN policies. In this basic SSL VPN full tunnel solution, you will deploy simple password-based
useér authentication, using the local user dambase on the adaptive security appliance.

When S5L VPN Tull tunnel users conneet to the Cisco ASA adapuive security appliance, the
users may be permitted to select their connection profile by either choosing the desired profile
from a drop-down list or connecting to the group URL. T no speeific connection profile has
been chosen, the security appliance will assign users to the default WebVPN group
(DefaultWebVPNGroup) connection profile. This profile is, by default, configured to use user
authentication by leveraging the local user of the Cisco ASA adaptive security appliance
database. In this topic, you will configure a custom connection profile, and lock users into this
custom connection profile after they authenticate to the security appliance.
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Configuring Local Authentication

Configuration Tasks
1. Cenfigure group policy:

— Create a new group policy for Cisco AnyConnect
connections

— Nodify the default group policy (not recommended)

(o8]

Create a new connection profile for Cisco AnyConnect
connections, and assign to it the new group pelicy.

bl

(Optienal) Define an alias for the connection profile.

£

Configure local users (credentials, access permissions).

(& ]]

{Opticnal) Cenfigure connection profile lock.

To configure basic user authentication in the basic Cisco ASA adaptive security appliance full
tunnel S5L VPN solution, perform the following configuration tasks:

. Configurea group policy. You can use one of two methods:

—  Create a new, custom group policy for your Cisco AnyConnect users. In this topic,
vou will ereate a single custom group policy for all users. Based on your
requirements, you may need Lo create multiple group policies to differentiate users
based on their aceess needs. This method is recommended in favor of tuning the
default group policy.

—  Modify the default group policy to allow S5L VPN connections. The default group
policy is the root policy from which all other connection or user profiles inherit
settings. By default, full tunnel 851 VPN connections are not allowed, This
approach is not recommended,

Fek

Create a new, custom connection profile into which you can assign users, and, based on this
connection profile, assign the custom group policy to the users. As with the group policy,
based on your requirements, you may need to create multiple connection profiles to
differentiate users based on their access needs; and assign each connection profile a
different group policy.

3. Optionally, define an alias for the connection profile. This approach is required to allow
users to select the connection profile using the drop-down menu.

4. Configure users and their eredentials in the Cisco ASA adaptive security appliance local
user database.

5. Optionally, conligure the connection profile lock feature for the created user account.
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Configuring Local Authentication
Configuration Scenario

Uss=iama
= Smoword

Casa ASA Adaplve-
et Sasunty Aopiansa

AmyCamest

This figure presents the configuration scenario that is used in upcoming conliguration tasks.
On the Cisco ASA adaptive security appliance, you will create a custom connection profile
named BASIC-ANYCONNECT-PROFILE, and a related group policy named BASIC-
ANYCONNECT-POLICY. Then, you will create one user named “vprnuser” in the local user

darabase.
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Configuring Local Authentication
Task 1A: Create a Custom Group Policy
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First, you will ereate a custom group policy that you will apply to the full tunnel VPN users via
their connection profile. Perform the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

In Cisco ASDM, choose Configuration > Remote Aecess VPN > Network
(Client) Access = Group Policies. Click Add to add a new policy.

Provide a name for the new group policy ( BASIC-ANYCONNECT-POLICY, in this
example).

Expand the More Options pane; and check the 8SL VPN Client check box in the
Tunneling Protocols section. This protocol is needed to support Cisco AnyConnect
SSL VPNs. You should uncheck all other tunneling protocols, if they are not used in
vour particular environment.

Click OK.

Click Apply to apply the configuration.
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Configuring Local Authentication
Task 1B: Modify the Default Group Policy

* Gl Pubin

SEEE VP STOSp PARCELA Vel GTOUP 15 8 CORION J1 WEET-ONOMa 0 BUTMI AT SITA AV B DRFE TIAL i
sanver. The gravp psbep information is relerencad by Wi menseaon profiles and uer permmis.

Toerforon sufonzeion stintates from e LOEF sewer wo must pse ae LA siinbete mas,

o ooy
i :_"-l Ed grazo paiay DisBrpPalicy: I Tinzeing Pratacal

 pihasiad [T T
Arkdrae: Pach: l_ ki
ol Address Pacls; BEL WEA Sl s magored [Teled
dor mplanmam 85 WP e
i Cipicad
Tusnalag Protodoi: | Ok SR TN O SECVPH Sl | eee | 00 DY)
1ot Fillie: - hra - > [viamgn,;

Configuraton > Remole Aocess WEN > hetwork (Sient) Acness > Broup Foldes

Alternauvely, you may modify the default group policy. This approach is recommended only 1n
two situations:

m  [nsmall enviconments with a single group policy

m  When a certain parameter 18 identical in all custom group policies and can be inherited
from the default policy

Perform the following steps to tune the defanlt group policy:

Step 1 In Cisco ASDM, choose Configuration > Remote Access VPN > Network
(Client) Acecess = Group Policies. Choose DItGrpPolicy, and click Edit 1o edit it

Step 2 Expand the More Options pane, and check the 88L VPN Client check box m the
Tunneling Protocols section to support 881 VPN full tunnel conneetions.

Note If your Cisco ASA adaptive security appliance will support other VPN access options, you
may need to leave some of the other tunneling protocols enabled.
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Configuring Local Authentication
Task 2: Create a Custom Connection Profile
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Next, you will ereate a custom connection profile to whieh you will assign the full tunne! VPN
users. Perform the following steps:

Step 1

Step 2

Step 3

Step 4

In Cisco ASDM, choose Configuration > Remote Aecess VPN > Network
(Client) Access = AnyConnect Connection Profiles. In the Connection Proliles
section, click Add to add a new connection profile.

Provide a name for the new connection profile { BASIC-ANY CONNECT-PROFILE,
in this example).

In the Authentication section, leave the authentication method at its default settings
(LOCAL AAA authentication).

In the Default Group Policy seetion, choose the custom group policy (BASIC-
ANYCONNECT-POLICY that was conligured in the previous set of tasks) from the
drop-dewn list.
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Configuring Local Authentication

Task 3: (Optional) Define Connection Profile Alias
Aliases are displayed to the user upon login.
= Enable users to choose desired connection profile
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MNext, you may define an alias for the connection profile. Onee the alias 1s defined, users may

be permitted to select the desired connection profile when connecting 1o the S5L VPN, Perform

the lollowing steps:

Step 1 In the connection profile edit window, choose Advanced > SSL VPN. Click Add in
the Connection Aliases section,

Step 2 Assign an alias name to this connecuion profile. Use a user-friendly name, as this
alias will be visible to your VPN users in their Cisco AnyConneet client ( Basie-
profile in this example). Check the Enable check box. You can use spaces n alias
text, but if you do, you must provide the alias name inside quotes.

Stap 3 Chick OK in the Add Connection Alias window. Click OK 1n the Connection Prolile
window,

stepd4  Click Apply, and then click Save to save vour configuration.
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Configuring Local Authentication
Task 4: Configure Local Users and Credentials
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Finally, you will ereate user accounts in the Cisco ASA adaptive security appliance local
database. These user accounts must only be able to log into the VPN, and not to the secunty
appliance management user interfaces (the Cisco ASDM and the CL1). Pedorm the following

rasks:

Step 1

Step 2
Step 3

Step 4

In Ciseo ASDM, choose Configuration > Remote Aecess VPN = AAA/Local
Users > Local Users. Click Add to add a new user account.

Provide a name lor the new user account (vpouser, in this example).
Create a password for the new user account.

In the Access Restriction section, select the No ASDM, S5H, Telnet or Console
Access option. This selection will restrict the user to prevent these credentials from
being accepted Tor deviee management functions.
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Configuring Local Authentication

Task &: (Optional) Configure Connection Profile Lock
Lock user to connection profile

= Enforces use of connection profile
= Access denied if user attempts to connect to other profile

i
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To confligure the connection profile lock feature, perform the following tasks:

Stap 1 In the user account edit window, choose VPN Poliey.

Step 2 Uncheck the Inherit check box next to the Connection Profile ( Tunnel Group) Lock
field. Assign this user account to the custom connection profife by using the drop-
down menu to select the custom eonnection profile (BASIC-ANYCONNECT-
PROFILE, in this example).

Stap 3 Click OK in the Edit User Account window.

Step 4 Click Apply, and then click Save to save your configuration.
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Configuring Local Authentication
CLI Configuration
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The output shows the CL| commands that are required to configure basic Cisco ASA adaptive
security appliance S5L VPN user authentication. In the CLL use the vpo-tunnel-protocol sve
command in the group-policy DIMtGrpPolicy auributes mode to enable the SSL VPN full tunnel
functionality in the default group poliey.

Next, create a new, custom group poliey by using the group-poliey command, and specify the
group policy as internal. In the new group-policy attributes mode, enable the SSL VPN Tull
tunnel funetionahity For this group poliey by using the vpn-tunnel-protocol command.

Nexl, create a2 new, custom connection prolile by using the wnnel-group command, and attach
the custom BASIC-ANYCONNECT-POLICY 1o this connection profile by using the default-
group-poliey command. Also, assign a user-lriendly connection profile alias name to this
connection profile by using the group-alias command, and enable it.

Finally, create a user account in the local database by using the username command, and
assign Lo it a password. In the username attributes mode, restrict this user to VPN access
(without the possibility of management access) by using the serviee-type remote-access
command. Also, assign this user into the BASIC-ANYCONNECT-PROFILE connection
profile by using the group-lock value command.

group-policy

To create or edit a group policy, use the group-policy command in global conliguration mode.
To remove a group policy from the configuration, use the no form of this command.

group-policy agme {internal [from group-policy name| | external server-group
server group password server pasyword |
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group-policy Parameters

Parameter Description

extarnal server-group Specifies the group policy as external and identifies the AA44

Server group server group for the adaptive security appliance to query for
attributes.

from group-policy nams Initizlizes the attributes of this internal group policy tothe values
of & pre-existing group policy.

internal | dentifies the group policy as internal.

nama Specifies the name of the group policy. The name can be up to
B4 characters long and cannot contain spaces.

pasaword Provides the password to use when retrieving attributes from the

server password external AAA server group. The password can be up to 128

characters long and cannot contain spaces.

group-policy attributes

To enter group-policy configuration mode, use the group-poliey attributes command in global
configuration mode. To remove all attcibutes from a group policy, use the no version of this
command. In group-policy configuration mode, you can configure attribute-value pairs fora
specified group policy or enter group-policy webvpn configuration mode wo configure

Web VPN attrnibutes Tor the group.

group-policy name attributes

group-policy attributes Parameters

Parameter Description

nama Specifies the name of the group policy

vpn-tunnel-protocol

To configure a VPN tunnel type (1P Security [1Psec], Layer 2 Tunneling Protocol [L2TP] over
[Psec, Cisco VPN Client, or WebVEN), use the vpo-tunnel-protocol command in group-
policy configuration mode or username configuration mode. To remove the atribute from the
running configuration, use the no form of this command.

vpn-tunnel-protocol {ipsec | 2ip-ipsec | sve | webvpn}

vpn-tunnel-protocol Parameters

Parameter Description

ipsec Negotiates an IPsec tunnel between two peers (2 remote access
client-or another secure gateway ). Creates secunty associations
that govern authentication, encryption, encapsulation, and key

management.
12tp-ipsec Negotiates an IPsec tunnel for an LZTP connection.
sve Negotiates an S3L WPN tunnel with an SSL VPN client.
webvpn Provides VPN services to remote users via an HT TP S-enabled

web browser, and does not reguire a client.

3-38 Daplaying Cisco ASA VPN Solubans (VPN) v1.0 & 2010 Cisca Systams, Ins,



tunnel-group general-attributes

To enter general-attributes configuration mode, use the wonel-group general-atiributes
command in global configuration mode, This mode is used (o configure settings that are
common to all supported tunneling protocols. To remove all general attributes, use the no form

of this command.

tunnel-group name general-attributes

tunnel-group general-attributes Parameters

Parameter

Description

general -attributes

Specifies attributes for this tunnel group

ramsa

Specifies the name of the tunnel group

default-group-policy

To specily the set of attributes that the user inherits by default, use the default-group-paolicy
command in tunnel-group general-atiributes configuration mode. To eliminate a default group
policy name, use the no form of this command.

defauli-group-puoliey group-name

default-group-policy Parameters

Paramater

Description

aroup-namna

Specifies the name of the default group

group-alias

To create one or more alternate names by which the user can refer to a tunnel group, use the
group-alias command in tunnel-group webyvpn configuration mede. To remove an alias from
the list, use the no form of this command.

group-alias name [enable | disable]

group-alias Parameters

Parameter Description

disable Cisables the group alias.

enable Enables a previously disabled group alias.

name Specifies the name of & tunnel group &lias. This name can be any

string that you choose, except that the string cannot contain
SPBCES.

username

Toadd a user to the adaptive security appliance database, enter the username command in
global configuration mode. To remove a user, use the no version of this command with the
username you want to remove. To remove all usernames, use the no version of this command

without appending a username.

username agme {nopassword | password password [mschap | encrypled | nl-encrypted]}

|privilege priv_level]
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username Parameters

Parameter

Description

encrypted

Indicates that the pessword is encrypted (if you did not specify
mschap}. When you define a password in the username command,
the adaptive security appliance encrypts it when it saves it to the
configuration for security purposes. \When you enter the show
running-config command, the usernama command does not show
the actual password; it shows the encrypted passwaord, which is
followed by the encrypted keyword, For example, if you enter the
password “test,” the show running-config dispiay would sppear as
something like the following:

USErname [paT password mvIdRhixFCEhelTs

encrypied
The only time that you would actually enter the encrypted keywaord
at the CLI is if you are cutting and pasting & configuration to another
adaptive security appliance ard you are using the same password.

machap

Specifies that the password will be converied to Unicode and
hashed using Message Digest 4 (MD4) after you enter it. Use this
keyword if users are authenticated using Microsoft Challenge
Handshake Authentication Protocol version 1 (MS-CHAPw1) or M3-
CHAP version 2 {MS-CHAPVZ].

name

apecifies the name of the user as a string from 4 to 15 characters in
length.

nopassword

Indicates that this user needs no password.

at-ancrypted

Indicates that the password is encrypted for use with

WE-CHAPVT or MS-CHAPYZ. If you specfied the mschap keyword
‘when you added the user, then this keyword is displayed instead of
the encrypted keyword when you view the configuration using the
show running-config command.

password password

Sets the password as & string from 3 to 16 charecters in length,

privilege priv_Ievel

Sets & privilege level for this use from Oto 15 [lowest to highest).
The default prvilege level is Z. This privilege level is used with
command authorization.

username attributes

Tu enter username attributes mode, use the username attributes command in username
configuration mode. To remove all attributes {or a particular user, use the no form ol this
command and append the username. To remove all attributes for all users, use the no form of
this command without appending a username. The attributes mode lets you configure attribute-

value pairs for a specified user.

username name attributes

username attributes Parameters

Parameater

Description

name

Provides the name of the user

group-lock

Torestrict remote users 1o access through the tunnet group only, issue the group-lock
command n group-policy configuration mode or username configuration mode. To remove the
group-lock attribute from the running configuration, use the no form ol this command. This
option allows inheritance of a value rom another group policy.
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group-loek {value tunnel-grp-name | none}

group-lock Parameters

Parameter Description

nonea Sets group lock to a null value, thus allowing no group-lock

restriction, Prevents inheriting 8 group-lock value from a default
or specified group policy.

value tunnel-grp-nams Specifies the name of an existing tunnel group that the adaptive

security appliance requires for the user to connect.

Configuring Local Authentication

Implementation Guidelines

* Only use static passwords in small, single-device, low-risk
environments.

= Striclly set the service type of local VPN user accounts to
pravent these accounts from having management access.

* You can use the DefaultWebVPNGroup instead of a specific
group; however, this will make it more difficult to differentiate
users later on.

When implementing local password-based user authentication in an SSL VPN full wnnel
solution, consider the following implementation guidelines:

Only use user authentication with static passwords and the local database in small, single
gateway, low-risk environments, as these passwords are reusable and typically easy Lo guess.

Always strietly set the service type of the users to only allow VPN aceess. This setting is
extremely important to prevent unauthorized aceess o Cisco ASA adaptive security
appliance management functions.

In this topie, all examples used a custom connection profile and & custom group policy. 1f
all of your users share the same authentication method and access policies, you could also
implement this by using only the DefaultWebVPNGroup connection profile and the default
group policy. Note, however, that the approach that is taken in this topic makes it very easy
to differentiate users later on, i needed.
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Configuring Client IP Address Management,
Basic Access Control, and Split Tunneling

This topic enables you to configure [P address management, basic access control, and split

tunneling in a Cisco AnyConnect full tunnel 5L VPN,

Client IP Address Assignment

Cverview

* Full tunneling 35L VP Ns
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- Using 8 DHCP server

When clients connect using the {ull tunnel VPN methods, the VPN gateway will assign them an
1P address on their virtual network interface {adapter), and the elients will use this [P address as
their source [P address to aceess resources beyond the VPN gateway. These addresses can be
from the private address space, but they need to be routed 1o the gateway (Cisco ASA adaptive
security appliance) in the internal network.

There are five different |P address assignment options available in the Cisco ASA security
appliance SSL VPN full tunne! solution. They are identical to the Cisco Easy VPN deployment
methods and inelude the following:

Use a pool of |P addresses, which are configured on the Cisco ASA adapuive security
appliance, and assign the poaol to the default group policy. By default these addresses are
leased to all users (1f their more specific policies do not provide other [P assignment
methoeds).

Use a pool of IP addresses, which are configured on the Cisco ASA adaptive security
appliance, and assign the pool to a specific custom group policy, and therefore to specific
connection profiles that use the specific group policy.

Configure the addresses as part of the user account in the local user datahase, enabling per-
user 1P addresses.

Configure the addresses as part of the user account ina remote ( AAA) user database,
enabling per-user [P addresses.

Use-a DHCP server, which the Cisco ASA adapuve security appliance will query to obtain
an [P address for remote clients.
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Address Assignment and Access Control
Cptional Configuration Tasks (ldentical to Cisco Easy VPN)

1. Define IP address assignment methods.

2. Configure an address pool.

3. Assign an address pool to the group policy.

4. Alternatively, assign per-user [P addresses to users.
Cenfigure interface ACL bypass.

Configure interface ACLs.

(3] (%]

Alternatively, configure per-profile and per-user ACLs.

B. Configure split tunneling.

To configure client [P address assignment, basic aceess control, and split tunneling, you may
need to perform some of the optional conliguration tasks that have been explained in the lesson
on Cisco Easy VPN, The procedures surrounding Cisco Easy VPN will not be further discussed
in this lesson. The optional tasks are as follows:

L.

Globally configure the allowed P address assignment methods on the Cisco AS A adaptive
security appliance.

2, Configure [P address pools, if vou decide to use pools from which users can lease client 1P
addresses.

3. A) Assign the configured [P address pool to the default or specilic custom group policy.
B) Optionally, assign |P addresses to individual users, if vou require per-user [P addresses,
where each user “owns” a particular IP address.

4. Configure interface access control list {ACL) bypass.

5. A) Configure interface ACLs.

B) Configure per-profile and per-user ACLs,
6. Configure split tunneling.
Nota You need to configure either per-group-policy, or per-user I[P addresses. If vou configure no

address assignment, SSL VPN full tunnel connections to the Cisco ASA adaptive security
appliance will fail.
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Client IP Address Assignment
Deployment Choices

Use of one local poolfor  When all users share the same policy in
all users (DftGrpPolicy)  this and other parts of the network

Use of per-profile pools in When you need to distinguish users of this

group policies profile in other network devices

se of per-user IP When you need to distinguish this user
addresses (local or profile in other network devices
rernote A4 )

Use of DHCP servers wWhen you are using completely centralized

|F address managemient, or, with multiple
VPN servers, when a group policy (existing
on multiple ABAs) has an associated IF
addrass range

The selection of the IP assignment method should be based on the following criteria:

[Fall of your users will share a common VPN policy on the Cisco ASA adaptive security
appliance, and also in other parts of the protected network, where you may use other 1P-
address-based access controls, you can consider using a local pool ol |P addresses that are
assigned to the default group policy.

I you want o differentiate berween muluple groups of users on the Clsco ASA adaptive
security appliance, and also in other parts of the protected network, you should consider
using a local pool of 1P addresses that are assigned to the specific group policies and, as a
consequence, to specilic connection profiles.

If you want Lo assign specific, per-user policies on the Cisco ASA adaptive security
appliance, and especially in other parts of the protected network, you should consider
using assigned per-user 1P addresses. This approach also simplifies user auditing and
tracking, as ¢ach user is always uniguely identified by a particular IP address when
connected to the VPN,

I your 1P address assignment is completely centralized, using a DHCP server, you can
consider reusing the DHCP server to also assign VPN IP addresses. The DHCP server must
assign addresses ina VPN with multiple VPN servers, when a group policy (existing on
multiple Cisco ASA adaptive security appliances) has an associated [P address range.
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Installing and Configuring the Cisco AnyConnect
Client

This topic enables you to install, configure, and verify the predeploy version of the Cisco
AnyConnect client.

Cisco AnyConnect Client

Installaticn Cptions
= Predeploy installation

package:
— Standalone installer (EXE, |
MS!, CAB, DMG, tar.gz) il

CISCO
— Must be doewnloaded to

Cizon AnpTosnett VPN Chem: Yermon T4 0202

dients
Il i & Cofnrighl 2004 - 2009 {rige Sydems, Ing. AN
= \Web installation: Bighin Bawwrma
’ = R This grodiet woudes seftaunine Seveioped by
- Using PKG files on Cisco ihe Dpesss, Project for use i the ress5,

Toollts b ngene s

ASA security appliance

— Ma an 88L VPN dlientless
session (web launch)

EriEi 4 ubernars ahd passiode

The Cisco AnyConneet VPN Client is the next-generation VPN ¢lient, providing remote users
with secure VPN connections to the Cisco ASA 5500 Series Adaptive Security Appliance
running Cisco ASA Software Release 8.0 and higher. It does not work with a Ciseo PIX device
or with Cisco VPN 3000 Series Concentrator Software.

As the network administrator, you configure the Cisco AnyConnect client features on the Cisco
ASA adaptive security apphiance. Then, you can load the client software on the Cisco ASA
adaptive security appliance and have it automatically download to remote users when they log
in using web launch, or you can manually install the Crisco AnyConneect client software as an
application on the elient PCs. The Cisco AnyConnect elient allows user profiles to be displayed
in the user interface that defines the names and addresses of VPN gateways. The network
administrator can assign particular features to individual users or groups.

Note Initial instaliation of the Cisco AnyConnect client reguires administrator privileges.

The Cisco AnyConneet VPN Client packages can be downloaded from the Cisco website and
uploaded w the Ciseo ASA adaptive security appliance so that elients ean download the
software as needed.
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Web Launch (Via SSL VPN Clientless Session)

Manual

The web launch installation method requires that the elient sysiem connect o the Cisco ASA
adaptive security appliance by using a compliant web browser over an SSL connection. Alter
being connected and authenucated, the user will be redirected by the security appliance to the
Ciseo AnyConnect VPN Client installation through ActiveX or Java. After the remote device
has successfully installed the new software, the Cisco AnyConnect VPN Chient will
automatically log the user onto the network using the credentials that were originally supplied
during the web session.

Installation

In addition to the autodownlead packages that are available from the Cisco ASA adaptive
security appliance, theremote device can also install the Cisco AnyConnect VPN Client
manuvally by using an MS1 installer on Windows-based systems. This installer is not a
downloaded package from the security appliance, and the elient will not be required 1o use a
web browser for initial access to the network. After it is matalied, the VPN elient can be used to
access the desired network resources.

Note In this topic, you will learn to use the manual installation of the predeploy Cisco AnyConnect
client.

Cisco AnyConnect Client
Cisco AnyConnect VPN Client 2.4 Supported Platforms

Supported Supported Varsions
Platform

Microsoft Microgoft WWindows 7 {32-bit and 64-bit)
Windows Microsaft Windows Vista (3 2-bit and B4-bit}—Service
Pack (SP) 2 or Vista SP 1 with KBS52876
Mcroseft Windows XP SP2and 3P3

Microsoft Windows Mobile
Lirvux Red Hat Enterprise Linux 5 Desktop

Ubuntu B.x
Apple Mac Mac OS5 X 105 N
os X Mac OS5 X 10.6 and 10.6.1 (both 32-bit and B4-hit)

The Cisco AnyConneet client supports the following operating systems:

® Microsoft Windows 7, Windows Vista, Windows XP, and Windows Maobile
m Mae O8S X (version 10,5 or later) on either Intel or PowerPC

m  Red Hat Linux (version 9 or later)

m  Ubuntu ¥ or later

See the Release Notes on Cisco.com for the full set of platform requirements and supported
VErsions.
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Cisco AnyConnect Client

Configuration Tasks
1. Install the predeploy Cisco AnyConnect client.

2. Verify the presence of the CA certificate.
3. Configure basic Cisco AnyConneact profile seftings.
4. Eslablish the S5L VPN connection.

In-order to instal! and configure the AnyConnect client in a basie Cisco AnyConnect {ull tunnel
solution, you will perform the following conliguration tasks:

. Manually install the Ciseo AnyConnect client on the remote user PC.

2, Verfy that the chent has the necessary root CA certilicates installed. The client should
have a local, authentic copy of the CA certificate that was used to issue the Cisco ASA
adaptive security appliance identity certificate.

3. Configure basic Cisco AnyConnect profile settings (the fully quafified domain name of the
Cisco ASA adaptive security appliance).

4, Establish the SSL VPN full wnne! connection.
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Cisco AnyConnect Client
Configuration Scenario
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The figure presents the configuration scenario that 1s used in upcoming configuration tasks, The
Cisco AnyConnect client will be installed on a Microsoft Windows XP system, and the Cisco
ASA adapuve security appliance will use an identity certificate that was issued by the global
PKL The name vpn.domain.com will resolve to the security appliance owside interface [P
address. This name will also be the identifier of the appliance in its identity certificate. The
Cisco ASA adaptive security appliance will authenticate the remote users by using the
username and password method.
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Cisco AnyConnect Client
Task 1: Install the Predeploy AnyConnect Client

¥ ‘Wlzares B Cics
& AnyConnuck UM Cliant
| Setup Wizerd
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& AnyComnesk VPN Hient
# Sahp Werard

&
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In the fiest task, you will install the predeploy version of the Cisco AnyConnect client. Perform
the following steps on your client system:

Step 1 Obtain the MS! installation package of the Cisco AnyConnect client from
Cisco.com, and transler it to the elient.

Step 2 Double-elick the MS1imnstallation package to start the installation process.
Step 3 Click Next ta start the installation dialog.

Step ¢ Examine the license agreement, check the 1 Aeeept the Terms of the License
Agreement check box, and elick Next.

Step 5 Click Install to start the instaliation process.

Step 6 Click Finish to close the mstaller.
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The client certificate

Cisco AnyConnect Client
Task 2: Verify Server Certificate

store must include the | ... =
correct CA certificate: it oo A et o B
. Cis;:nAnyCannect uses e e i Lqarati_ Friand Itame
certificate store and EJABTrest Exdem... AodTrest Estamal . 1053800 USFRTrest
: LpCtaes 3 Fubie P Chiss 3PULSG Pri.,  LEZIH  Verddn Ois..
prElnSIH”Eﬂ glﬂhﬂl CAS :muaﬁm:n._ Chyss 3 Pubiic Pra. LA VaniSgn
* Thi et () 19, Coprghtic) 195 120, HiTash Tis.
Thls_cerﬂﬂpate must be -'.JllFRx-:l{.lJ:G‘ OSTROILCAXY JOOJURL DS Anot A
obtained via a seoure [JEntrustingt Seci,.. Ertrurtres Secare. 1553000 Erénet
Ehﬂnne| [FEqwdax Semite .. B Sdooms Ce..  I2E2013  GeaTrus
= FeotalEen foal . climiGgn Bsa £3 J012000  Gotedsgn
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!I’ using an mtema_l CA. <A e e ek g
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certificate.

ieh Browser > Tooks > internet Optons = Comant > Sandcams > Trated Soo CaniSomon Aufiorizes

In Task 2, on the client PC, examine the installed root CA certilicates 1o determine that the CA
that 1ssued the Cisco ASA security appliance identity certificate is present. This verilicauon
will prevent certificate warnings from being displayved at SSLTLS session establishment, and
allow you to authenticate the appliance VPN gateway.

Typically, with global CAs, this verilication will not be an issue as their CA certificates are
embedded in the default operating system install or operating system updates. 17 you are using a
nonglobal PKL, install the CA certificate to all elient PCa.
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Cisco AnyConnect Client

Start the Cisco AnyConnect
client and specify gateway
information:

# ONS name must match the

name of the security appliance
in the certificate canonical

name field

= By clicking Select, the client
will connect to the gateway

faenes

i profile s arosliatie. Plaass enber bt §6 "Connect 5™,

Carmnect IR Clkanl a1 ]

Task 3: Configure Basic Cisco AnyConnect Profile Settings

Sy S1a NS nama
o e 10 5ha VEN.
SN Eng iterace
7 splianon.
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In Task 3, start the Cisco AnyConnect client and configure it with Cisco ASA adaptive security
appliance VPN gateway information. In the Connect To field, enter the fully gualified domamn

name that resolves o the 35L-VPN-terminating interface of the security appliance. In the

example, the vpo.domain.ecom [ully qualified domain name (FQDN) has been used. This name

must match the canonical name in the identity certificate of the Cisco ASA adaptive security
appliance; otherwise, you will receive certificate name mismatch warnings. Click Seleet to

make the Cisco AnyConneect client connect to the Cisco ASA adaprive security appliance using

an SSLTLS session,
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The client will downlead
instructions for its next action
from the gateway:

= Prompt for user authentication
= Entar your VPN username and
password

» Click Connect to establish the
S8L VPN tunnel

Cisco AnyConnect Client
Task 4: Establish the S5L VPN Connection

S Chate AnyCossect WP T e

o Commcon | @ mester | darl

[Fleaum wriag yous | e s pusrrnd

wilivi )i
Ci5co

= sk o

s i

| conrme: |

After the initial connection, the Ciseo ASA adapuve security appliance will push instructions
for the next step of VPN establishment to the Cisco AnyConnect elient. 1n the example, the
AnyConnect client will display the list of configured connection profile aliases (in the example,
Basie profile, referencing the BASIC-ANYCONNECT-PROFILE, 15 the only available alias)
and prompt vou lor user authentication. Enter vour eredentials, and elick Conneet to establish

the VPN connection.
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Cisco AnyConnect Client
Tasks 3 and 4: Alternatively, Using Web Launch
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Altematively, you can use the web launch feature to start the VPN connection by using a browser.
I no web portal has been configured { for example, a clientless 581 VPN was not enabled on the
secunty appliance interface), the security appliance will automatically start the Cisco AnyConnect
client (using an ActiveX or Java applet, automateally selected depending on the user
environment] after the user logs into the main page. The Ciseo AnyConnect client will use the
eredentials that are supplied Cor the web page to attempt 1o log the user into the network.
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Client-Side Verification

The AnyConnect client
will automatically
minimize by default.

* Open the AnyConnect
GUI frem the tray to
axamine session
properties

* Nenzero sent and
received bytes indicate

YWPM addresses

= Details will reveal
additional feature
properties

proper routing to and from

Verifying Cisco AnyConnect Session
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The Cisco AnyConnect VPN Client will automatically minimize afier a successful connection.
You can verily connection properties by clicking the AnyConneet icon in the Windows icon
ray. In its Staristics pane (not shown in the example), vou ean observe the state of the
connection, the P address that is assigned to the client, the bytes that are sent and received
through the tunnel, and the conneetion time. By clicking the Details button, you can observe
more detailed feature properties (shown in the example).

Note

The client interface {Connection Pane * Disconnact) can also be used to log the user out.
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Verifying Cisco AnyConnect Session
Client-Side Verification (Cont.)

3 Chn A et T e Sl ivties Daiail P | | e dayan ret WPH {fimnt; Sial iz Hptain

altat] i alnai]ne

T o Tunals
cisco fhsirlorg CISCO Stk
Hetwass
foitasad Bt Secuwl Avum:
[esirunm Stewt wsl | Bertramn Shabwnt i _\ﬁ...g”l_;_.l_'_' Tatrvddon ]
g it oo maag

| The detsuriroui ponts o
=o 2 DRSS adanier

Tre defeutroaie points
1o ;e VEN Bdanten

I Rouls o apitnetworks |t
point do WEN adao

Tnerxde b iha ascunty vl S ——

appiEnce nierface IF pointa B A .
3 i Fie pryical ‘adazie e 2t el EpaEance inedace IF poine o

To verily the state of split tunneling and routing on the client, you can navigate to the Route
Details tab of the Details window.

(o the left side, you can see a client that is configured with no split tunneling (that is, the
default setiing). In the Secured Routes pane, you can see the default network (L.0.0L0/0
mnstrueting all tralfic to enter the tunnel. You can also verify this setting by using the route
print Windows CMD command, where a default route should point to the VPN adapter
irecognized by its assigned 1P address).

On the right side. you can see a client that is configured for split tunneling. In the Secured
Routes pane, vou can see the default network 10.0.00L0/8 instructing only traffic to this specific
network to enter the tunnel. ¥ ou can also verily this setting by using the route print Windows
CMD command, where a route to this network should point wo the VPN adapter (recognized by
its assigned [P address, 10.2535.0.11), The default route should point o the physical interface of
the client (172.16:1.200, in the example),
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Verifying Cisco AnyConnect Session
Gateway-Side Verification
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To verify the conneetion of the chient on the Cisco ASA adaptive security appliance, use Cisco
ASDM to choose Monitoring > VPN = VPN Statisties > Session. From the drop-down menu,
choose S8SL VPN Client in the Filter By field. The VPN session should be displayed in the

main pane.

In the example, you can see that the SSL VPN user with the vpnuser username has been

assigned the 102350200 |P address. The group policy that 1s being used 1s BASIC-
ANYCONNECT-POLICY, and the connection profile 15 BASIC-ANYCONNECT-PROFILE.
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Verifying Cisco AnyConnect Session
Gateway-Side CLI Verification
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In the CLIL use the show vpo-sessiondb sve command to obtain the same information.

show vpn-sessiondb

To display mformation about VPN sessions, use the show vpn-sessiondb command in
privileged EXEC mode. The command includes options for displaying information in full or in

derail. It also lets you specify the type of sessions to display, and it provides options to {ilter
and sort the information. The syntax table and usage notes organize the choices accordingly.

show vpn-sessiondb [detail] [full] {remote | 121 | index fndexnumber | webvpn | email-proxy |
sve| [filter { name wsername | ipaddress [Poddr | a-ipaddress (Paddr | pripaddress [Paddr |
tunnel-group groupname | protocol protocol-name | eneryption encryption-algo | inactive} )
[sort {name | ipaddress | a-ipaddress | p-ipaddress | unnel-group | protocol | encryption |

inactivity }]

show vpn-sessiondb Parameters

Paramater

Description

detail

[Optional} Displays extended details about 2 session. For
gxsmple, using the detail option for an IPsec session displays
additional details such as the Internet Key Exchange (IKE}
hashing algorithm, authentication mode, and rekey interval

If you choose datail with the full option, the adaptive security
applisnce displays the detailed output in & machine-readable
format.

filtar filrer criceria

[Optional) Filters the output to display only the information you
specify by using one or more of the filter options.

full

(Optional) Displays streamed, untruncated output. Output is
delineated by horizontal bar (7"} characters and a double
horizontal bar (°]") string between records.
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Parameter Description

session typse {Optional}) To show data for 8 specific session type, enter one of
the following keywords:

= email-proxy: Displays email-proxy sessions.

n Index indexnumber. Displays a single session by index
rniumber. Specify the index number for the session, 1=750.

m |21 Displays VPN LAN-to-LAN (LZL) session information.
ratio: Displays VPN session protocol or encryption ratios.
remote: Displays IPsec remote scCess SBs3i0ns

= summary: Displays the VPN session summary,

swve: Displays Cisco VPN Client sessions.
vpn-lb: Cisplays VPN load-balancing management sessions.

n  webvpn: Displays information about clientiess SSL VPN
SESRiONS.

gort sSort_oriteria [Optional) Sorts the output according to the sort option that you
specify
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Troubleshooting Basic Full Tunnel SSL VPN
Operation

This topic explains how to deploy the Diagnostic AnyConnect Reporting Tool (DART) and

troubleshoot full tunnel S8L VPN session establishment between a Cisco AnyConnect client

and a Cisco ASA adaptive security appliance VPN gateway,

_—_——————
Troubleshooting Cisco AnyConnect
SSL VPNs

Diagnostic AnyConnect Reporting Tool (DART)

= Collects data useful for troubleshooting Cisco AnyConnect problems:
- Diagnostics for Cisco TAC

* Operations;
- Runs on computer with Cisco AnyConnect (VWindows 7, Vista, XP}
= Can be started from CiscoAnyConnect client or independently

* |natallation:
= Btandalone launch
- Pushed from Cisco ASA sdaptive security spplisnce
= Does mot reguire edministrator privileges

T sl Fesfott
T P
@mmmm— “- L
S - m— e —
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You ecan use DART to collect data that is useful for troubleshooting Ciseo AnyConnect install
and connection problems. DART supports Microselt Windows XP, Microsoft Windows Vista,

and Microsell Windows 7.

The DART wizard runs on the computer that runs the Cisco AnyConnect client. Without

requiring administrator privileges, DART assembles the log, status, and diagnostic information

for Cisco Technieal Assistance Center (TAC) analysis.

DART does not rely on any component of the Cisco AnyConnect software (o run, though you
can launch DART from AnyConnect, and DART does collect the Cisco AnyConnect log file, if

it s available.

Any version of DART works with any version of Cisco AnyConnect; the version numbers of
each are no longer synchronized. To optimize DART, it is recommend o download the most
recent version that is available on the Cisco AnyConnect VPN Client Software Download site,

regardless of the AnyConnect version you are using.

DART is currently available as a standalone installation, or the adminastrator can push this

application to the chient PC as part of the Cisco AnyConneet dynamic downlead infrastructure.
Cnee installed, the DART wizard can be launched from the Cisco folder available through the

Start button.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Troubleshooting Scenario
1. Install DART.

2. Collect diagnostic information [ TAC).
4. (Opticnal) Examine gathered data.
4

FPerform troubleshooting.

SMRT

AmpCannect GUl Messages ;oW logging
ping. racsrouia. nsiookup. ms L AZTM S Time Log Vinwer
BrsiemEsamiiag

Cimsa ASA Adaptee
Ssouily Apgiancs

When troubleshooting Cisco AnyConnect S8L VPNs, you will typically perform these tasks:
L. Install DART.

=

Collect diagnostic information ( TAC).
3. Optionally, examine the gathered data.

4. Perform troubleshooting on both the client and the Cisco ASA adaptive security appliance.
Sometimes, you may need to also resolve routing issues on adjacent network devices. The
figure shows some of the most useful troubleshooting commands and actions that yvou ean
use pn involved components.

Note The Cisco ABA adaptive security appliance will extensively log all issues into its:sysiog
subsystem. Debug commands are generslly not reqguired, except for in-depth
troubleshooting of complex issues.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Task 1: Install DART (Standalone Example)
= Standalone package: anyconnect-dart-win-2.4, version-k9.pkg

* Altarmnatively: Pushed frem Cisco ASA adaptive security
appliance:

- As part of AnyConnect client install
- anyconnect-all-packages-2 4.version-k3.zip
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DART is avalable as part of the Cisco AnyConnect chent download and mstallation package,
or as a standalone .msi file,

Following are the AnyConneet downloads, containing DART, on Cisco.com. Refer to the
Release Notes for the Cisco AnyConnect VPN Client for the fatest version numbers:

®  anveonnect-all-packages-2.4d.version-kY.zip: Contamns all Cisco AnyConnect packages.
When the user downloads the AnyConnect elient, a new version of DART, il available, is
also automatically downloaded to the PC of the user. When a new version of the Cisco
AnyConneet client 18 downloaded as part of an automatie upgrade, that download ineludes
a new version of DART, if there is one.

a  anveonnect-dart-win-2 d.version-k9 pkg: Contains only the DART mstallation paclage,

not the Cisco AnyConnect or VPNGINA software. Use this download when installing
DART as astandalone application.

Installing DART with Cisco AnyConnect

Perform this procedure to download DART to the machine of the remote user the next time the
USEr connects:

Step 1 Load the Cisco AnyConnect package containing DART to.the security appliance,
just as you would any other Cisco soltware package.

Step 2 After installing the Cisco AnyConnect -pkg file containing DART on the security

appliance, you must specily DART n a group poliey, in order lor it to be installed
with AnyConneet:

m  Choose Configuration > Remote Access VPN > Network (Client) Access >
Group Policies and add a new group policy or edit an existing group policy. ln
the group policy dialog box, expand the Advanced selecuion and elick SSL
VPN Client.
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m o the SSL VPN Client dialog box, uncheck Inherit Tor the Optional Client
Modules to Download check box. Choose the DART module in the option drop-

down list,

m  [Fthe version of Cisco ASDM that you are using does not have the DART option
check box, enter the keyword dartin the field. Click OK, and then click Apply.

Manually Installing DART on the Host

Perform these steps to install DART wsing the standalone package:

Stap 1 Obtain the DART software from Ciseo.com (hitp://www.cisco.com/ pegi-
bin/tablebuild pl/anyeonnect). Store the anyeonnect-dart-win-2.4. version-k%.pkg
file locally.

Step 2 Using a file compression utilivy, extract the contents of the anyeonnect-dart-win-
2 4.version-kY.pkg lile and maintain the directory strueture.

Step 3 Open the binaries directory that 1s ereated from extracting the contents ol the
anyeonnect-dart-win-2 4. version-k9:pkg file.

Step 4 Double-click the anyconneet-dart-win-2.4.version-k9.msi file to launch the DART
Setup Wizard.

Step 5 Follow the wizard prompts. The installation wizard installs DanOffline exe in the
=Systemn Drive=!\Program Files\Ciseo'Cisco DART directory. Click Finish to
complete the installation.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Task 2: Collect Diagnostic Information
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You must launch the DART wizard to collect diagnostie information. Follow these steps to
createa DART bundle ona Windows PC:

Step 1 Start the DART wizard by using one of the two options:

m  From the Cisco AnyConnect client GUIL, click the Statisties tab and then click
the Details button at the bottom of the dialeg box. This action opens the
Statistics Details dialog box. Click Troubleshoot at the bowom of the Statistics
Dretails window.

= From the Start menw, choose and launch the DART wizard.

Click Next at the Welcome sereen. This brings you to the Bundle Creation Option

dialog box.

Step 2 In the Bundle Creation Option area, choose Default or Custom:

m  The Default option includes the typical log files and diagnostic information, such
as the Cisco AnyConnect and Cisco Secure Deskiop log files, general information
aboul the computer, and a summary of what DART did and did not do.

®  When you choose Default and then click Next at the bottom of the dialog box,
DART immediately begins creating the bundle. The default name for the bundle
is DARTBundle zip, and it is saved to the local deskiop.

m  [f youchoose Custom, the DART wizard will present you with more dialog
boxes after you click Next. These boxes will allow vou to specify which [les
you want to include in the bundie and where Lo store the bundle.

Step 3 If you want to enceypt the DART bundle, in the Encryption Option area, check the

Enable Bundle Eneryption check box. Then, enter a password in the Encryption

Password field. Optionally, check the Mask Password check box. This selection

will cause the password that you enter in the Encryption Password and Reenter

Password fields to be masked with asterisks (%),

Step 4 Follow the wizard to create the bundle,
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SSL VPNs

Troubleshooting Cisco AnyConnect

Task 3: (Optional) Examine Gathered Data
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DART generates a bundle that 1s useful when esealating the problem to Ciseo TAC or another
troubleshooting team. The bundle, when unpacked, contains three folders with diagnostic
information: Cisco AnyConnect VPN Client, Cisco Secure Deskiop, and General Information.
You may examine the logs when you are troubleshooting AnyConneet problems.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Troubleshooting Flow

mow logging
AryCarmact GUI, DART

l

=haw logging
AEDM RaalTrme Log viessr

=noe lagging
AEDN Rex'sTiene Log Visser

n-_rﬁ:g-:-\'-ﬁu:;éqrﬁ-:ﬂﬂt::d

show logging AEDM FeaixTime
= ag Viewa

I you are encountering session establishment 1ssues, you may lollow these steps to
troubleshoot the issues:

Step 1 First, check that the SSLTLS session mitially establishes, and that there are no
negouation problems that are related to the use of incompatible protocol versions or
cipher suites. You can observe these 1ssues in the Cisco AnyConnect GUL but vou
will obtain more-detailed and specific information by examining Cisco ASA
adaptive security appliance syslog messages.

Step 2 If the SSL/TLS negotiation completes with no errors, check whether user
authentication works and whether the user is supplying the correct credentials. The
Cisco ASA adaptive security appliance will elearly indicate these issues in its syslog
MESEAZES.

Step 3 MNeat, check whether the connection profile and the associated group policy allow
SS5L WPN tunnels. The Cisco ASA adaptive security appliance will clearly indicate
these issues in its syslog messages.

Step 4 Finally, verify that the Cisco ASA adaptive security appliance is able to assign an [P
address to the client. The 1P Address Assignment (IPAA) subsystermn will extensively
log to the syslog subsystem to indicate any issues,

I1f all these steps do not resolve your issue, you may need to deploy troubleshooting tools that
are beyond the scope of this course.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Troubleshooting Flow (Cont.)
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If your 881 VPN session establishes, but there 1s no connectivity over the tunnel, you may
follow these steps to troubleshoot the issue:

Stap 1

Stap 2

Step 3

First, if yvou are using split tunneling, check that the correct routes (networks) to the
tunneled destination are present in the routing table of the client PC. You can
observe this information in the Cisco AnyConnect GUL, or by examining the routing
table of the chent PC.

Next, verify that the Cisco ASA adaptive security appliance is not denying tralTie
from the VPN tunnel. Examine the Cisco ASA adaptive security appliance syslog 1o
see messapes regarding permitted or denied packets.

Finally, verify that the protected network has a route to the client-assigned addresses
by examining routing tables in internal network routers along the path to the
destination,

If all these steps do not resolve your issue, you may need to deploy troubleshooting tools that
are beyond the scope of this course.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Gateway-Side Issues

* Mo shared 3SLTLS cipher suite between client and gateway

ASA{configld logging enablae
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The outputs in this figure list the Cisco ASA adaptive security appliance syslog messages that
mdicate two common session establishment 1ssues: a failed SSLTLS negotiation due to

incompatible cipher suites, and a session teardown due to the 851 VPN {ull tunnel funetion not
being enabled lor a user, a connection profile, or a group policy.

]
Troubleshooting Cisco AnyConnect
SSL VPNs

Gateway-Side Issues (Cont.)
= Client authentication failure: bad password

ABA{config}# logging scable

ABA{config)¥ loggicg commolae £ _
antication Rejected i

B+ LOoT = vpLUEGE

P rpPolicy> User <vpoupar» IF <i73;1E.L,
sjected, Bapsion Typai WabV¥FHN.

* No IP address pool assigned to a specific or default group
policy

REA{configl # logging emable

ABR{config) # loggicg console. &

RABA-4-T370¢15) IPAAY DOoable to get addrases from grovp-policy or
tuncel -growp local poolm
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IF <173, 16.1.2%84> Invalld address 0.0 0. 8> mnsligred to EWO conpaction.

The outputs in this figure hst the Cisco ASA adaptive security appliance syslog messages that
indicate failed user authentication due to a bad password, and a lailed IP address assignment
due to a lack of 1P address pools configured on the Cisco ASA adaptive seeurity appliance.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Client-Side lssues: Certificates
= A certificate warning can appear because of:
— Unverifiable security appliance Identity certificate

— Aname mismatch between certificate cancnical name and
AnyConnect profile hostname

— An expired security appliance identity certificate
= You should never see this issue in production use:
— This message indicates a man-in-the-middle attack

— If users are conditicned to accapt, they negate all
S3LTLS protection
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On the client, the most commaon issue that you may observe 1s a certilicate warning at VPN
session establishment. There are three main reasons for this message to appear:

m  The Cisco ASA adaptive security appliance identity certificate is not verifiable, due toa
missing CA certificate on the client that should be used to verily the signature of the
appliance identity certificate. To resolve this issue, install an authentic copy of the CA
certiflicate on the client.

® A pame mismatch between the name that is specified mn the Cisco AnyConnect profile (in
the Connect To field), and the canonical name field in the security appliance identity
certilieate, To resolve this 1ssue, fix either of these values to mateh the other.

m  Anexpired Cisco ASA adaptive secunty appliance identity certilicate. To resolve this
issne, renew the security appliance identity certificate.

You should neyver see these issues oceurring during production use of the network. 11 users are
conditioned to proceed with the VPN connection despite these warnings, their VPN connection
will be vulnerable to man-in-the-middle interception attacks, where the attacker poses as the
Cisco ASA security appliance and terminates VPN connections from legitimate users. This
message is the only message that indicates such an attack.
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Troubleshooting Cisco AnyConnect
SSL VPNs

Client-Side Notifications
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During session estabhishment, the client wall display informative messages that you can use to
pinpoint the cause of an issue. The figure shows the five common scenarios and the messages

that they produce inside the Ciseo AnyConneet GUL

Troubleshooting Cisco AnyConnect
SSL VPNs

Client-Side Notifications: Windows Event Viewer
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The Cisco AnyConnect client will also use the Windows Event Log to store all error messages,
as well as informational messages about client operation. Y ou can use the Windows Event
Viewer to examine this log for past and current issues with client operation.
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Summary

This topic summarizes the key points that were discussed in this lesson.
]

Summary

* A basic full tunneling SSL VPN involves basic gateway
configuration, user authentication, address assignment, and
access control configuration.

* |n basic gateway cenfiguration, vou should enable the
S5L/TLS server and provision the identity cerificate of the
Cisco ASA adaptive security appliance.

= Basic user authentication uses the local user database.

= ¥ou have multiple opticns for IP address assignment, and
you can create general, per-user, or per-profile access
controls.

= The Cisco AnyConnect client can be installed manually or by
using the web launch feature through a clientless S5L VPN
session.

= Use the DART tool, Cisco AnyConnect warming messages,
and logging messages on the Cisco ASA adaplive seourity
appliance to troubleshoot SSL VPN session establishment.
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Lesson 2

Deploying Advanced Cisco
AnyConnect VPN Client

Overview

Different deployment objectives require a scalable and flexible solution. This lesson enables you
w deploy and manage advanced deployment functionality of the Ciseo AnyConneet VPN Client.

Objectives

Upan completing this lesson, you will be able to deploy and manage the advanced centrally
configured features of the Cisco AnyConnect VPN Client, This ability includes being able to
meet these objectives:

Configure and verify DTLS encapsulation in Ciseo ASA adaptive security appliance Cisco
AnyConnect full tunnel VPNs

Choose centrally controlled client functions in Cisco AnyConnect full tunnel SSL VPNg
Manage Cisco AnyConnect soltware

Configure and verify Cisco AnyConnect client profiles

Deploy advanced Ciseo AnyConnect operating system integration options

Configure and verify Cisco AnyConnect user interface customization



Configuration Choices, Basic Procedures, and
Required Input Parameters

This topic provides an overview of how to choose centrally controlled client functions in Cisco
AnyConnect full wnnel Secure Sockets Layer (SSL) virtual private networks (VPNs).

T |
Advanced Cisco AnyConnect

Deployment Options

Deployment Tasks

Deploy Datagram Transpert Layer Security (DTLS).
Manage the Cisco AnyConnect software.

Bop -

Configure Cisco AnyConnect gateway-deployed settings.

Deploy advanced Cisco AnyConnect operaling systam
integration options.
Customize the Cisco AnyCennect user interface.

(%]

The deployment tasks for centrally controlled ¢lient functions in the Ciseo AnyConnect VPN
Client include the following:

. Deploy Datagram Transport Laver Security (DTLES).

2. Manage Cisco AnyConnect soltware.

3. Conligure Cisco AnyConnect gateway-deployed settings,

4. Deploy advanced Cisco AnyConnect operaling system integration oplions.

3. Customize the Cisco AnyConnect user interface.

Before you deploy the Cisco AnyConnect VPN Client, several input parameters need to be
examined in order to ensure success:

m  Ensure that the Cisco AnyConnect VPN Client exists for operating systems that are used by
your clients.

m  Determine the experience and environment integration needs of Tuture VPN users in order
to select the customization options that need ta be deployed.

m  Consult client security policy to determine software update requirements.

m  Determine any requirements for Cisco AnyConnect user interface custonization and
localization needs. These needs can be different based on the country where the Cisco
AnyConneet client is used, owing to different laws, different languages, and so on.
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Deploying DTLS

This topic describes how to improve Cisco AnyConnect VPN Client performance by using
DTLS.
[

Datagram Transport Layer Security

Cverview
= Standard protocol (RFC 4347)
* Based on TLS
= Equivalent security to TLS
= LUDF transport
— Avoids latency and bandwidth problems
— No retransmission of lost packets at TLS layer
= Only application retransmission

— Improves the pedormance of real-time applications that
are sensitive to packet delays

Datagram Transport Layer Secunty (DTLS) is an alternative VPN transport protocol to Secure
Sockets Layer (SSL)/Transport Layer Security (TLS). DTLS allows datagram-based
applications Lo communicate in a way that i1s designed Lo prevent eavesdropping, tampering, or
message forgery. The DTLS protocol is based on the streame-oriented TLS protocoel and 15
intended 1o provide similar security guarantees.

DTLS mitgates latency and bandwidth problems that are associated with some SSL-only
connections, and improves the performance of real-time applications that are sensitive to packet
delays. ITLS is a standards-based SSL protoco! that provides a low-latency data path using
UDP. ltis defined in RFC 4347,

DTLS improves the application performanece in two ways:

m  User Datagram Protocol (UDP) transport does not stipulate any retransmissions on the
VBN layer. IT VPN packets are lost in transit, only the TCP stack of the application
endpoints will retransmit the datagrams. In contrast, when VPN packets that are transported
over an 851 session are lost, both the SSL VPN endpoint and the TCP stack of the
application endpoint will retransmit the packet.

m  UDP is simpler than TCP, creates less overhead, and consumes fewer resources.
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Datagram Transport Layer Security
Deployment
= DTLE enabled:;

— TLS is used to negetiate and establish DTLS connection
(eontrol messages and key exchange)

— Twa simultaneous tunnels: TLS and DTLS
— DTLS fallback to TLS in case of DTLS tunnel failure
— Automatie, requires DPD
= DTLS disabled:
— Clients connect with an S5L VPN tunnel only

rm—

= OTiE Turral

Disen AnCannes Chant
e Cissn ASA Adaatis
Saoafity Asplanss

Enabling DTLS allows the Cisco AnyConnect VPN Chient that 1s establishing an 851 VBN
connection to use two simultaneous tunnels—an SSL tunnel and a DTLS tunnel.

The SSL/TLS channel 15 used to negotiate and establish the DTLS tunnel by exchanging &
series of secured control and key exchange messages.

The security appliance supports an automatie fallback from DTLS to TLS if DTLS 18 no longer
working, The DTLS-to-TLS fallback requires that dead peer detection (DPD) is enabled. DPD
is described later in this lesson. [Fthe DTLS wnnel does not work and DPD is not enabled,
connectivity is broken.

If you do not enable DTLS, Cisco AnyConnect elient users who are establishing S5L VPN
connections connect with an SSL VPN tunnel only.
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Configuring DTLS

Enable DTLS Globally
= OTLE takes precedence over S3L.
* OTLS s enabled by default.
* Default DTLE port is 443.

#icoess Interfnces
| o] Enalole Taon dpvpConnect W Chentor kegacy 530 WPH Client scress on e inierfaces seberted in e table helry
Triterface Al ATes Ensbie DTS |
s ¥ 2
e X
Enseie DTLE
. 5 \
| DTS Port {LIOP par interdzos.
ActEss Part #42 D715 Party 443
Chck hwte & Agip) Crrificate i lnterfws.

Confguraton > Remole Aoneas VPN = Network (Csent) Access = AnyConnent Connecton
Profiea

When configuring DTLS, you have to first make sure that DTLS 1s enabled globally. To
configure DTLS globally, complete the lollowing steps:

Step 1 Choose Configuration = Remaote Aceess VPN = Network (Client) Access =
AnyConneet Connection Profiles.

Step 2 Choose an interface that i1s configured for an 851 VPN,

Step 3 Check the check box under the Enable DTLS column for the desired interface.

MNota By default, the 551 VPN wizard will enable DTLS on the interface that is configured far
Gisco AnyConnect 551 VPN service.

Step 4 Enter the DTLS port number (LUDP) in the DTLS port field. The default value 1s
443, the same as for SSLTLS that uses TCP,

Step 5 Click Apply to apply the configuration.

Lo this figure, the outside interface 1s conligured to use DTLS with the Cisco AnyConnect
S5L VPN,
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Configuring DTLS
Configure DTLS in Group Policy

Caonfiguraton > Remole Accesa VBN » Natwory (Siant) Access » Broup Poides

Canfguraton » Remote Ascess VPN = A28 | Loca Lsens > Loca Users

* OTLS can be activated on group or user policy level
— Must be enabled on an interface
. DFItGernhc,ﬂ has DTLS activated by default

______ Tha gefaut sating s
o PR g i e
1 = "m;:':m Comenison [Wibeet - Eriple -8
B Praxy D frferd & Enadle | Deabie
|| PEEEE s it e s
Epvine Rowiong ared Pl Mde: (i el Erde vkl
Cienies e Rihestt (T ] Paasise Frivw
el Bl b Diorwieack: et |~ lpow
Oy Cheri Wik I8 Cnrprisiet: |1, et

Onee enabled, DTLS can be activated in group policy or individual user settings. To conligure
DTLS at the group policy or user level, complete the following steps:

Stap 1

Stap 2

Choose Configuration > Remate Aecess VPN = Network (Client) Aceess >
Group Policies. Choose the policy that you want to edit, and then click the Edit
button. Il vou want to activate DTLS for individual users, choose the Configuration
> Remote Access VPN > AAA / Loeal Users > Loeal Users submenu and perform
the same action.

Inside the group poliey or user conliguration window, choose the Advaneced = S5L
VPN Client submenu, and choose the desired option (Inherit, Enable, or Disable)
that is associated with DTLS,

Nota

DTLS is, by default, that is activated in the default group policy [DftGrpPolicy). By default,
all other group policies and users inherit from the DftGrpPolicy. If you leave the Inherit
check box selected, OTLS will effectively be activated for the group or user,

Step 3
Step 4

Click OK.
Click Apply to apply the configuration.

In this figure, DTLS is enabled in the SSL VPN group policy named SalesGroupPolicy.
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Configuring DTLS
CLI Configuration

webvpn 4 DTL8 iagnanied by defsut whan you anakie 581 on an interase.
enable sutalde

Stie pors 443

1

group-policy BASIC-ANYCONKECT-POLICY attributes
webvpn

ave dtls enable

The figure illustrates the DTLS-related command-line interface (CLI) configuration that 1s
applied to the Cisco Adapuve Security Appliance (ASA) adaptive security appliance in this
procedure. Use the dils port command in webvpn configuration mode to set the DTLS port
number, The default port 1s 443 and will not be shown in the configuration. In the example,
the S5L VPN is enabled on the outside interface, and DTLS is enabled by default. DTLS port
18 et to port 443,

To enable DTLs in a group poliey, enter group-policy confliguration mode, then enter webvpn
mode and use the sve dils enable command. In the example, DTLS 15 enabled in the
SalesGroupPolicy group policy.

webvpn

To enter webvpn mode, enter the wehvpn command in global configuration mode. To remove
any commands that are-entered with this command, use the ne webvpn command. These
WebVEN commands apply 1o all WebVPN users.

These webvpn commands let vou configure authentication, authorization, and accounting
[AAA) servers, default group policies, default idie timeout, HT TP and HTTPS proxies, and
NetBIOS Name Service (NBNS) servers for WebWVPN, as well as the appearance of WebVPN
screens that end users see.

webhvpn

©2010 Cista Systems, Ins,  Deploymant of Cisco ASA Adaptive Sacunty Appliance AnyConnsst Remate Access VPN Solutions 3-T5



dtls port

To specily a port for DTLS connections, use the dils port command [rom webvpn configuration
mode. To remove the command from the configuration, use the no form of this command.

dils port number

dtls port Parameters

Parameter Description

number The UDP port number, which can range from 1 to 85,535

group-policy attributes

To enter group-policy configuration mode, use the group-poliey attributes command in
global configuration mode. To remaove all attributes from a group policy, use the no version
of this command. In group-policy configuration mode, you can configure attribute-value pairs
for a speeified group policy or enter group-policy webvpn configuration mode o configure
Web VPN aurnbutes for the group.

group-policy name attributes

group-policy attributes Parameters

Parameter Description

nama Specifies the name of the group policy

webvpn (group-pelicy and username modes)

To enter this webvpn mode, use the webvpn command in group-policy confliguration mode or
in username configuration mode. To remove all commands that are entered in webvpn mode,
use the no form of this command. These WebVPN commands apply to the username or group
policy from which you configure them.

Web VPN commands for group policies and usernames define access to files, Messaging
Application Programming Interlface (MAP) proxy, URLs, and TCP applications over
Web VPN, They also identify ACLs and types of traffie to {ilter.

webhvpn
svc dtls enable

To enable DTLS connections on an mterface for specific groups or users who are establishing
SSL VPN connections with the Cisco AnyConnect VPN Client, use the dils enable command
from group-policy webvpn or username attributes webvpn configuration mode.

To remove the command from the configuration and cause the value to be inherited, use
the no form of the command.

sve dils enable interfuce
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Verifying DTLS
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Inthe example, DTLS has been enabled on the outside interface, and the group policy (BASIC-
ANYCONNECT-POLICY) that 1s associated with the user who logged in was conligured to
have DTLS enabled.

The remote user can examine the selected transport protocol by choosing Statstics and then
Details in the Ciseo AnyConnect elient GUL The protocol is displays in the Transport

Information section.

The show conn command output that 15 displayed is taken from a secunty appliance that resides

in the VPN path. [t showsa UDP connection that 15 established in addition to the S8L session.
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Verifying DTLS

AEA# show vpn-passiondb mvo
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Asslgned IF 4 1G.288,0.360 Public IP r P73 18130
grotacol 1 Clisntloce BSL-Turnel DTLE-Tunmal

Licarnes 1 BSL VFH

Ezcryption t RCd AEBELZE Eashirg t BEAL
Bytas Tx r 11337 Eytez Fx I ]
droup Folicy 1 BASIC-ANYCONMECT -POLICY

Turmal Group 1 =AMYCOMMECT - 3R OUF

Logic Time 1 87308 UIC Tum Tab 5 2010

Deration 1 Eheliim27e

Inactivicy t Ohelimille

HACD Rmoult 1 Dnknowno

VLAY Mapping 1 Kfa VLAK | mone

To venfy DTLS, vou can use the show vpn-sessiondb sye command on the terminating full
client 881 session of the security appliance. In the example, you can see that the SSL and
DTLS twmnels are used for a connection.

show vpn-sessiondb

To display information about VPN sessions, use the show vpo-sessiondb command in
privileged EXEC mode. The command includes options for displaying information in full or in
detail. It also lets you specify the type of sessions to display, and it provides options to filter
and sort the nformation. The syntax table and usage notes organize the choices secordingly,

show vpo-sessiondb [detail] [full] {remote | 121 | index indexnumber | webvpn | email-proxy
| sve} [filier {name psername | ipaddress (Paddr | a-ipaddress [Paddr | p-ipaddress (Paddr |
tunnel-group growpname | protocol protocol-name | eneryption encrypiion-alge | inactive ]

[sort {name | ipaddress | a-ipaddress | p-ipaddress | tunnel-group | proteeol | encryption

inaetivity}]

show vpn-sessiondb Parameters

Parameter Description

datail |Optional} Displays extended detsils ebout a session. For
example, using the detail option for an IP Securty (IPsec)
session displays additional details such as the Internet Key
Exchange (IKE) hashing algarthm, authentication mode, and
rekey interval.

If you choose detail, and the full option, the Cisco ASA sdaptive

security appliance displays the detailed output ina maching-
readable format,

filtar filter criteria |Optional} Filters the output to display only the information that
you specify by using one or more of the filter options.

full (Optional) Displays streamed, untruncated output. Output is
delineated by horizontal ine (*|"} characters and a double
horizontal line [°|") string between records.
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Parametaer Description

sasgicn typs {Optional} To show data for & specific session type, enter one of
the following keywords:
n  email-proxy: Displays emaik-proxy sessions.

n  index ngexnumber Displsys a single session by index
number. Specify the index number for the session, between
Tand 750,

m  [2I: Displays VPN LAN-to-LAN (LZL ) session information.
n ratio: Displays VPN session protocol or encryption ratios.
= remote: Displsys IPsec remote 20CEsS SE53I0NS.
summary: Displays the VPN session summary.

sve: Displays Cisco AnyConnect WPN Ciient sessions,

vpn=lb: Cisplays YPN load-balancing management sessions.

n webvpn: Displays information about clientless SSL VPN
SESSions.

sort sort criteria [Opticral} Sorts the output according to the sort option that you
speCify.
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Managing Cisco AnyConnect Software
This topie describes how to manage Cisco AnyConneet software.

Managing Cisco AnyConnect Software
Overview

You can install or upgrade
the Cisco AnyConnect client:

dlnn
= Manually, using an offling cisco
installer package

* Using software management S =| |
tools

= \fia the cliantlass portal
You can uninsiall the Cisco
AnyConnect client:

* Manually

= Using scftware management
teols

= Triggered by the Cisco ASA

security appliance after logout T L T

Depending on client experience and security policy, the Cisco AnyConneet VPN Client can be
distributed and upgraded on workstations using several delivery methods:

m  Manually, using an installation package that is downleaded from Cisco.com. This method
15 best suited for clients with a higher level of experience or for those with slower
Internet connections.

m  [nstallation of the Cisco AnyConnect VPN Client over different software management
tools is the preferred method of instatlation in large organizations that have established
mfrastructure for software package deployment, such as Symantee Altiris or Microsofl
Systems Management Server (SMS). Cisco AnyConnect installation 1s available in .msa
format for the Windows platform, .pkg Format for Linux and the Mae 08 X Intel platform,
and .dmg format for the Mae OF platform.

m  Installapon over the SSL VPN clientiess portal can be inigated over the web. If a client has
not been previously installed, a remote user can enter into a browser the [P address or
Domain Name System (DNS) name ol a security appliance mterface that is configured to
accept elientless SSL VPN connections. The users isthen presented with a login screen, and,
if the user satisfies the login and authenteation, the security appliance identifies the user as
mequiring the Cisco AnyConneet ¢lient. It then uploads the AnyConneet client that matches
the pperating system of the remote computer. Alier loading, the Cisco AnyConnect chient
mstalls and configures itself and establishes a secure Tull tunnel SSL connection.
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Uninstallation of the Ciseo AnyConnect VPN Client can be performed using several methods:
®  Manually, using a computer operaling syslem program manager.
m  Using software management tools.

m  Triggered by the security appliance after logout. The Cisco AnyConnect client that is
mnstalled over a web portal can be configured o uninstall automatically after a elient logs
out from a security appliance.

Managing Cisco AnyConnect Software

Configuration Tasks
1. (Opticnal) Canfigure cllent persistence.

2. (Opticnal) Configure adtomatic client software update.

Lsgradse e AnyCadmme Sl an alf gians Umﬁm1
Redpaas 2.4
Clam s Wever uninats
VPN Gl The Avjconnec
Ralsaas 29 citentat ingout.

The following configuration tasks are required to manage the Ciseo AnyConnect client:

. Opuonally, configure elient persistence.
2. Optionally, configure automatic client software update.

If a client has already been installed, the Cisco ASA adaptive security appliance can be
eontigured to examine the revision of the AnyConneet client with the user authenticates. The
elient can then upgrade the Ciseo AnyConnect client on the remote computer il needed.

In the conliguration scenario, the client that is connected te the Cisco ASA adapuive security
appliance 18 using version 2.3 of the Ciseo AnyConnect VPN Chent software, but the Cisco
ASA adaptive secunty appliance configuration requires the client to use version 2.4, Therefore,
the security appliance will load the latest 2.4 version of the AnyConnect client to the PC. After
the 2.4 AnyConnect chent install, the software will establish the 881 wonel to the Ciseo ASA
adaptive security appliance. After a user logs off, the adaptive security appliance will keep the
Cisco AnyConnect client on the client PC.
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Managing Cisco AnyConnect Software
Task 1: (Optional) Configure Client Persistence

graup-palicy BASIC-ANYCONNECT-POLICY aftributas
wabvpn
syc keap-netalar installed

Spocily wnetmar AnyConnedt ghooid be
Suinmatea’ty uninaigied on VEN logout

bk wieep MEaler on Ciert Sysarm: Thert @ Vag e
Fervare
Aidanimd Compre st o interd latie Werabie
Sl Tarnsirg
Crarzer Dkagram Tis: Fidberd  Cozhr
* o
A et CHNC Ignoce Defmgmen ehan{0F) Bt I Infard Enaivs L=
Lpvera Rctiag a5g Fileeng Rekes: [+ et | [ralee [
Sasqiaken bagia g o iibarn ke el
T =TT
Chang Frofle b oamlasd: 2 riers

Ertioal il Modies o Diwrload: | ket

Caonfigurston > Remols Asceas VPN » Network (SVant) Access » Broup Poides

Opuionally, the Cisco AnyConnect client can be configured in such a way that the client
remains installed on a remote computer after client logout.

Using Cisco Adaptive Security Device Manager ( ASDM), perform the following steps:

Step 1 Choeese Configuration > Remaote Aecess VPN >Network (Client) Aceess (not
shown in the figure).

Step 2 Select the group policy that you want to edit, and choose Edit (not shown in the
ligure).
Step 3 Choose Advanced = 5SL VPN Client.

Stap 4 Uncheck the Inherit check box next to the Keep Installer on Client System lield,
and choose Yes to allow permanent Cisco AnyConnect elient mstallation on the
remote computer. By choosing Yes, you disable the automatic uninstalling feature of
the AnyConnect client, which allows the software to remain installed on the remote
computer [or subsequent connections.

Step 5 Click OK, and click Apply to apply the changed policy to the security appliance.

Using the CLI, enter group-policy confllguration mode using the group-poliey atiributes
command. Enter the SSL VPN portion of the group policy confliguration using the webvpn
command, and use the sve keep-installer installed command to instruct the Cisco AnyConnect
client o remain installed on the remote computer.

svc keep-installer

To enable the permanent installation of an SSL VPN client on a remote PC, use the sve keep-
installer command (rom group-policy webvpn or username webvpn confliguration mode.

Use the no form of the command te remove the command from the configuration and cause the
value to be inherited.

sve keep-installer {installed | none}
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svc keep-installer Parameters

Parameter Description

installed

Disables the automatic uninstalling feature of the client. The client
remains installed on the remote PC for future connections.

none

the active connection terminates.

Specifies that the client uninstslls from the remote computer after

| Barpliiet Snagsl

Managing Cisco AnyConnect Software
Task 2: (Optional) Configure Automatic Client Software Update

Asinundels wilite perbrmed g1ihe nax
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‘Une Sats paremeter 0 mdace the Sne taves to ot on arage for Sie user-agent of 8 browser.
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o | [ censm I

Canfigurasan » Ramata Accmss WEN = Network {Qient|dosess » Advaroad » 880 VPN > Qi Exings

The security appliance can be configured to match a regular expression with a user agent string

that is reported by the browser of a remote computer in order to upload the correct Cisco

AnyConnect client version.

If aregular expression parameter is not entered, the security apphiance will try to mateh the
operating system that 1s reported n the user agent of the browser with the operating system

string that is in the Cisco AnyConnect installation filename.

Using Cisco ASDM, perlorm the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Choose Configuration > Remote Access VPN = Network (Client) Access >

Advanced = 85L VPN = Client Settings (not shown 1o the figure).

Choose Add to add the Cisco AnyConnect elient installaton image from the flash

memory of the Cisco ASA adaptive security appliance (not shown in the figure).

Click Browse Flash. Locate the Cisco AnyConneet elient installation image and

select it Click OK. (This step is not shown in the figure.)

IF the file version that is listed here is higher than the one used by the remote
computer, the Ciseo AnyConnect client will be updated on the remote computer.

Optionally, enter a regular expression to match the user agent of a browser in order
to reduce the time that is taken by the security appliance to locate the correct image.

Chick OK, and click Apply to apply the changed policy to the secunity appliance.
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Managing Cisco AnyConnect Software

Implementation Guidelines
Consider the following implementation guidelines:

» UUse web launch to install software for skilled users with
administrative rights.

= [tis generally not recommended to remove the Cisco
AnyConnect client from clients exceptin very specific
environments.

= Selectively enable or disable automatic updates using local
policy files,

= Federal Infermation Processing Standard (FIPS -enabled
clients do not update the client software en login.

— Bypass downloader for FIPS clients

When you are managing Cisco AnyConnect software, consider the following implementation
guidelines:

m Use the web launch feature to install software for skilled users with administrative rights.

m  |tis generally not recommended to remove the Cisco AnyConnect elient from clients
except m very specific environments.

m Selectively enable or disable automatic updates using the Cisco AnyConneet elient XML
profiles ( This topic is addressed later in this lesson).

m  Beaware that FIPS-enabled elients do not update the client software on login.
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Configuring Cisco AnyConnect Client Profiles

This topic describes how to configure and verify Cisco AnyConnect client profiles.

Cisco AnyConnect Client Profiles
Cisco AnyConnect Configuration

The Cisco AnyConnect

client configuration is fully Crenlagsm
controlled by the Cisco BN 2 B
ASA security appliance (= XML
using XML configuration =l [ Profila
profiles.

= You can create XML profiles & .1"
manually, or by using a \%}.
sandalone editor, e ASA Adaptive
« Profiles are deployed after Security Applisnzs
legin, attached to specific
group palicies.
= Y¥ou can allow the user to
control seme settings.

After the Cisco AnyConneet client connects to the Cisco ASA adaptive security appliance and
a user successfully logs in, the AnyConnect client configuration that is defined in the XML
configuration profile is uploaded to the remote computer.

XML profiles can be ereated and edited as regular text files on a computer, or the Cisco
AnyConnect Profile Editor can be used. A Java-based standalone program, the Profile Editor
can be run on any operating system that has Java software installed on it
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Cisco AnyConnect Client Profiles
Example XML Profile

<7xmil version="1.0" encoding="UTF-E"7>
<Configuration=
<Clientinitialization>
<UseStartBefore Logon>false</UsebtartBeforeLogon=>
</Cllentlnitizlization>
<HostEntry=
<HostName>hY-VFN</HostName>
<HostAddress>vpn.domain.com</HostAddress>
</HostEntry>

</Configuration>

The Cisco AnyConnect chient profile 1s XML formatted text that contains all configured
AnyConnect client parameters. Standard XML format 18 a collection of beginning and ending
tags with eonfiguration values between them.

The recommended procedure 15 to imtally create an XML profile by using the Cisco
AnyConnect Profile Editor ta correctly define the file structure. Later, you can edit the profile
by using the text editor or by again using the Profile Editor.

The ligure shows a sample XML profile, which specifies the name and address of'a VPN gateway.

]
Cisco AnyConnect Client Profile
Parameters
ShthraEum)aclMasaaga Configures tha display of 3 preconnact text massags
AuloConnectOnStart Configurss the clent to sutomaticsily connact whan starsd
inimizaOnCGonnact Configurss sulomstic minimzation sfter s sucosssful cannast
LocallAMNADzess Configures socass to the focal LAN
AuloRaconnect Configuras sulomstic reconnect aftar imvidluntary disconnection
Autclpdsts Enabies or disshise sulomatic updsles
MobisPoiicy Configuras policiss Bpacific 10 tha Windows Maobis platform
WindowsVPNEstsoishmant Ensblesor digsbizss ugs of AnyConnact in terminal ssssions:
‘Semverbst Configurss iist of ssvers that AnyConnect can use (VPN getsways, sic |
BackupSenverlst Configuras list of beckupsarvers
‘Cerfficstehstch Configuras rufes 1o chooss the local carfficels
LCerficats5ions Configurss rules {o chooss ths focal canficats stars
‘CerficatsEnmiimant Configuras oartficsts snmlimant psrametsns
AutomaticVPNPolicy Configuras & Trusied Netwaork Detection [TND) policy
UsaBianbstorsLogon Enabiss or dissblss ihe Start Befors Logan (SBL) festurs

The table describes the various XML profile settings.
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[
Configuring Cisco AnyConnect Client
Profiles

Configuration Tasks
1. Create an XML profile.

2. Uplead and verify the XML profile.
3. Aftach the XML profile (o a group policy.

Lag 1o B BASIC-ANY CONNECT-
PROFLE eamastian arofse.

Cebsa ASA adapiive sacufily aaniants
mavsaas e W-..:"u =

y—ﬂ-

Cissn ASA Adraiive
Sesely AopEancs

To ereate and use Cisco AnyConnect client profiles, perform the following configuration tasks:

I. Create an XML profile either by using the Cisco AnyConnect Profile Editor or the text
editor on a computer.

()

Upload the XML profile to the security appliance. XML profile verification can be done
orline using Ciseo ASDM or standalone XML verification tools.

3. Auach the uploaded XML profile to a group policy so that it can be uploaded and applied
on the remote computers.

In the configuration scenario, after successful SSL VPN connection and user authentication, the
group policy named BASIC-ANYCONNECT-POLICY is applied. During the Cisco
AnyConnect client deployment, the XML AnyConnect elient profile is also deploved. This
XML profile will allow terminal services to establish the 851 VPN connection. The XML
AnyConnect client profile is provisioned to the rémote computer, and the Ciseo AnyConnect
client 15 configured accordingly,
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Configuring Cisco AnyConnect Client
Profiles

Task 1: Create an XML Profile

ey

© _ux o

Brecty an 3983
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Backiis Sarvei Lisl

Cicx Add 1 5dd Tne secumy
A SD0CEN0E B4 3 deresr latentry

To create the XML profile using the Ciseo AnyConnect Profile Editor, follow these steps:

Step 1
Step 2
Stap 3

Step 4

Stap 5
Step &
Stap 7

Run the Cisco AnyConnect Profile Editor on a PC.
Chooese File > New (not shown in the {igure).
Choose the Server List b,

Click Add to add the security appliance as a server list entry. The client will be
connecting to this appliance as a server.

Specify the security appliance name 1n the Hostname (Required) field.
Click OK.

Repeat the previous steps Por all the secarity appliances thar will be used tor
erminating the S§L VPNs,
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Configuring Cisco AnyConnect Client
Profiles

Task 1: Create an XML Profile (Cont.)

S gl M| i Bbiin Dveel | Feyed Ul | Wit el

Changs 88 requined
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eI
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M Coveust Fl e Cimiioiite
Citscarlm Scomn  imarCenotsts fie ey
. ra Farpm | e Enaaiais s A
fute Ko | E e Ry T T }
(e e Faes o e, i fien e
e U ] Vs Eiv it =
] | Uawr Cemirodiie o | R
—T ==
ey =
Fbast i Eelivirees

S

L ]

Toallow terminal services to start a YPN connection, complete the following steps:
Step 1 Click the Preferences tab.

Step 2 Select AllowRemoteUsers from the Windows VPN Establishment drop-down
men.

Step 3 Opuionally, change all other required profile parameters.
Step 4 Choose File = Save As,

Step 5 Save the newly ereated XML profile locally on the PC.
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Y
Configuring Cisco AnyConnect Client
Profiles

Task 2: Upload and Verify the XML Profile

Caniigrittors » Batrese Acory ¥PTEs hebpek (Corel) Actess » Adancad o SELWH sclenl O
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the Caco ASA saanive secunty aonianoe. The apoiance
SBCUSY appkance, Wi ety e XML BgEnat e
Ciaco AnyConnea XML aohema

Upload and verify the newly created XML profile using Cisco ASDM by following these steps:

Stap 1 Choose Configuration > Remate Aecess VPN = Network (Client) Aceess >
Advanced = SSL VPN = Client Settings.

Step 2 In the SSL VPN Client Profiles section, click Add to add the XML profile. The Add
S5L VPN Client Profile window displays.

Stap 3 Assign a name to the profile (MY-XML-PROFILE, in the example).

Step 4 Click the Browse Flash button to add an XML file that is already available on the
{lash memory of the Cisco ASA adaptive security appliance.

Step 5 If" the XML file 13 not resident in the Ciseo ASA adaptive security appliance {lash,
click Upload, and then click Browse Local Files to locate the XML lile on the PC
that is running Cisco ASDM. Onee the locally stored XML file is located, elick
Upload File to upload the file to the flash memory of the Cisco ASA adaptive
security appliance {not shown in the example).

Step & Click OK. The security appliance will verily the XML profile against the Cisco

AnyConnect XML schema.
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[
Configuring Cisco AnyConnect Client
Profiles

Task 3: Attach the XML Profile to a Group Policy

Weovpn
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Attach the XML profile to a group policy using Cisco ASDM by following these steps:

Step 1 Choose Configuration > Remote Access VPN = Network (Client) Access >
Group Policies (not shown in the figure).

Step 2 Select a group policy in which you want to attach the XML profile, and click Edit.
The Edit Internal Group Policy window displays.

Step 3 Choose SSL VPN Client and uncheck the Inherit box next to the Client Profiie to
Download field. From the drop-down list, choose the uploaded XML profile 1o use
for this group policy.

Step 4 Click OK, and chick Apply to save the configuration changes to the security
appliance.

Using the CLL the security appliance can be conligured to use the custom XML profile.

Enter the SSL VPN portion of the group poliey configuration by using the webvpn command.

Use the sve profiles command to define the name of the XML profile and the location of the
XML profile file.

Use the group-poliey attributes command to edit the group-policy properties and use the sve
profiles value command to associate the XML profile with the group policy.

svc profiles (webvpn)

To speeify a file as a profiles package that the Cisco ASA adaptive security appliance loads in
eache memory and makes available to group policies and vsername attributes of Cisco
AnyConnect VPN Client users, use the sve profile command from webvpn configuration mode.

svec profiles (group-policy and username modes)

To specily a Cisco AnyConnect client profiles package that is downloaded 1o AnyConnect
VPN Client users, use the sve profile command from group-policy webvpn or username
attributes webvpn conliguration mede.
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Verify Cisco AnyConnect Client Profiles

Client File Verification
Windows XP: C:\Documerts and Settings\all Users\Application
Data'CiscoCisco AnyConrect VPN ClientiProfile

Winocows Vista'Windows 7: CiProgramDataiCiscovCisco Any Connect
VPN Client\Profile

File: Eon Format View: B

<?xm] warsfon="1,0" encoding="UTF-8"7= -

<inyConnectProfy Te

s | s ="hreg e hemas el soap . org fencading/"

san | ng cxsi="hetp: /v, wi. orgs/ 2 SENL Schena-4ns tance " ¥z

wsizschemalocation="http: //achomas . xelseap. orglencodingd

anytonnacterafile, ssd’>

“«TientInitialization=

<usestartieforeLogon

userControl lable="trua">false< Usesrartlaforel ogon>
<AdConaticCartSe | ection

Usestentral lable="true" =tries Sautomat feCertSe lect lons

Fnd e XML profie
o the ciant {etier
e next VBN gt

<ShowP reConnectMessage=Falsas (Show? reConner thessages
“Certificatestore=All«/Certificatestores

Aart i icatestoretverridest alsec/Cort 1 lcateStoreiverr ide
>

After successful connection and authentication to the 88L VPN, the security appliance uploads
the XML profile file to the remote computer.

Correct configuration and successful upload of the XML profile file can be checked by
examining the location in which the XML profile file is stored based on the operating system of
the client.
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Verify Cisco AnyConnect Client Profiles

Event Viewer Verification
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Sucecessful deployment of the XML profile file can also be ehecked using the Windows Event

Viewer application:

Step 1

Step 2

In the Event Viewer window, choose Applications and Services Logs = Cisco
AnyConneet VPN Client (the path may vary depending on the operating system
and version).

Verify the XML profile usage by examining event details.
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Verify Cisco AnyConnect Client Profiles

Implementation Guidelines
Consider the following implementation guidelines:

= Use XML profiles only when you need to change default
client settings.

= Use the XML profile editor to simplify prefile configuration.

The use of XML profiles is not mandatory. You can wse them only when you need o change
default Cisco AnyConnect chient settings or add advanced features.

In order to-avoid syntax errors and to simphify profile ereation and configuration usage, it 1s
recommended that you use the Cisco AnyConnect Profile Editor,
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Deploying Advanced Cisco AnyConnect
Operating System Integration Options

This topic deseribes how to deploy advanced Ciseo AnyConnect operating syslem inlegration
opLions.

Cisco AnyConnect Operating System
Integration Options

Trusted Network Detection (TND)

= TND allows the Cisco s
AnyConnect client to start
automatically when the user is

Initiate VPN

outside or inside a specific [ ]
network. a {
; ! |

» The trusted network is identified “-\_jf

based on:

- Configured domain name e R —

— Configured DNE server (or Dﬂ’;‘e:"-:g&mmm

OKE Saryars’
SErvers) 55 iy

* The available actions are connect TaiTass

and disconnect

Trusted Network Detection (TND) gives you the ability 1o have the Cisco AnyConneet client
automatically diseonnect a VPN connection when the user is mside the corporate netwaork
(the trusted network), and start the VPN connection when the user is outside corporate
network (the uatrusted network). TND does not interfere with the ability of the user 1o
manually establish a VPN connection.

The Ciseo AnyConnect client supports TND on Microsolt Windows XP and later, and on
Mae 08 X,

TND is configured in the Cisco AnyConnect profile. No changes are required (o the security
appliance configuration.

©2010 Cista Systems, Ins,  Deploymant of Cisco ASA Adaptive Sacunty Appliance AnyConnsst Remate Access VPN Solutions 3-35



Y
Cisco AnyConnect Operating System
Integration Options

Start Before Login (SBL)

SBL is a Windows-only
Cisco AnyConnect feature dialh
that allows the client to start FigE
before user login to
Windows.

* Useful to log in to domains or
Microsoft Active Directory over

a VPN connection i)
* Integrates with Windows login AR R "
interface =T

= Required o establish VPN if
Group Policy Object (GPO)
does not allow caching

Start Before Logon (SBL) forees the user to connect to the enterprise infrastructure over a VBN
connection before logging inte Windows. It accomplishes this forced connection by starting the
Cisco AnyConnect elient before the Windows login dialog box appears. After authenticaning 1o
the security appliance, the user logs in as usual through the Windows login dialog.

SBL 1s only available for Windows and lets vou control the use of login seripts, password
caching, network-drive-to-local-drive mapping, and more.

Note The Cisco AnyConnect client does not support SBL for Windows XP x84 (84-bit) Edition.
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Cisco AnyConnect Operating System
Integration Options

Clignt Scripting

» Ciseo AnyConnect runs up o ene script at legin and up to
one script at logout.

* The twe scripts are defined glebally and toggled per group
policy in the XML profile.

= Lsaful to:
— Refrash Active Directory GPOs
- Map and unmap network drives
- Automatically start user applications

The Cisco AnyConnect client does not require the script to be written in & specific language,
but it does require an application that can run the seript to be mstalled on the client computer.
Thus, for the Cisco AnyConnect client to launch the seript, the seript must be capable of
runmng from the command line.

Write and test the script using the operating system type on which it will run when the
AnyConnect client launches it.

Note You should write and test the script on the targeted operating system. If a script cannot run
properly from the command line on the native operating system, the Cisco AnyConnect
client cannot run it properly either.

The Ciseo AnyConnect client supports seript launching on all Microsoft Windows, Mac 08 X,
and Linux platforms that accommuodate the AnyConnect software.

On Microsoft Windows, Cisco AnyConnect can only launch seripts after the user logs into
Windows and establishes 8 VPN session. Thus, the restrictions that are imposed by the sécurity
environment of the user apply to these seripts. Scripts can only execute functions that the user
hasrights to inveke. Cisco AnyConnect hides the command window during the execution of a
seript on Windows, so executing a script to display a message in a .bat file for testing purposes
does not work,

On Linux-based operating systems, assign execule permissions to the seript files for vser,
group, and other.
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Cisco AnyConnect Operating System
Integration Options

Configuration Tasks
1. (Optienal) Configure TND.
2. (Optional) Cenfigure SBL.

— When using SBL. ensure that transport netwerk
connectivity does not depend on user login (IEEE
802.1X).

4. (Optional) Cenfigure scripting.

To confligure Cisco AnyConnect advanced operating system integration options, perform the
following tasks:

. Configure the TND feature if you need automatic SSL VPN connection for remote
computers when they are connected to an untrusted network.

2. Conligure the SBL leature when SSL VPN connectivity is needed before the Microsoft
login procedure,

Note When using SBL, ensure that the transport network connectivity does not depend on USEer
login (IEEE B02.1X).

3. Conligure scripting if you need o execute commands after the SSL VPN is suceessfully
connected or when the SSL VPN tunnel connection 15 terminated.
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Cisco AnyConnect Operating System
Integration Options

Configuration Scenario

Confguea AnyConnesi i
Bulomatcaty connest AR
oulEde e rustsd networi ANYODNHECT
XML POLICY

Engnie SAL domain .com

A

Trusted MNetwork

Configuration of all three Ciseo AnyConnect client features 1s included in the XML profile. In
the example, yvou will configure Trusted Network Detection (TND) and Siart Belore Login
(SBL), and you will enable seripting to run the CONNECT .emd seripr

After successiul user authentication, the XML profile is parsed for those conligurations. If the
security appliance has a newer version of scripts than those stored on remote computers, then
those seripts are replaced and a new version of scripts 1s executed.

Also, TND and SBL configuration are refreshed on remate computers.
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Cisco AnyConnect Operating System
Integration Options

Task 1: (Optional) Configure TND
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TND s configured in the Cisco AnyConnect XML profile. No changes are required to the

security appliance configuration except uploading of the changed XML profile.

To configure the XML profile using the Cisco AnyConnect Profile Editor to enable TND,

follow these steps:
Stap 1 Choose the Preferences tab.

Stap 2 Enable TND by checking the Automatic VPN Paoliey check box.

Step 3

Stap 4

In the Trusted DNS Domains field, enter a list of DNS sufTixes (a string that is
separated by commas) that a network inteclace may have when the client is in the
trusted network. In the example, domain.com s the trusted domain.

In the Trusted DNS Servers {ield, enter a list of DNS server addresses (a string that
is separated by commas) that a nevwork interface may have when the elient is in the
trusted network.

Note

If you configure bath the Trusted DNS Domain and Trusted DNS Servers fields, users must
match both settings in order to be included in the trusted neteork.

Step 5

Step &

Step 7

Select a network policy in the trusted network. In the éxample, when the client is
connected to the trusted network, the network poliey is configured to disconnect the
Ciseo AnyConneet client.

Select a network policy outside the trusted network. In the example, when the client
is connected to the untrusted network, the network policy 18 configured to conneet
the Cisco AnyConneet client.

Choose File > Save (Save As) to save changes in policy.
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The following example shows the (Jientfnitialization section of the profile file with TND
eonfigured. The output reflects the configuration for automatic connection to the VPN when the
client 1% in the untrusted network, and automatic disconnection when it is in trusted network:

zAutomati oVENFPolicystrue
<TrustediNSDomains=~* cicco. come /TrustediNSDomaines

«TruetedlNSServers»161.44.124.%, 64
s>

L102,.6.247«/ TructedONEServer

<TriusredietworkPolicy>Di sconnect</Trusredietworkbolioy s
dintrustedietworkPolicysConnacte/UntrustedietworkPol icys
</AutonacicVENPolicys
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Cisco AnyConnect Operating System
Integration Options

Task 2: (Optional) Configure SBL
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SBL is conligured in the Cisco AnyConnect XML profile. To enable SBL, you must first
specily the SBL module name in a group policy on the Cisco ASA security apphiance.

To specify SBL module name, follow these steps using Cisco ASDM:

Step 1 Choeese Configuration > Remaote Aecess VPN > Network (Client) Aceess >
Group Policies (not shown in the lgure).

Stap 2 Seleet a group policy and elick Edit. The Edit Internal Group Policy window
displays (not shown in the {igure).

Step 3 Choose Advanced = 5SL VPN Client in the navigation pane on the lelt. The SSL
VPN settngs window displays (not shown i the lgure).

Step 4 Uncheek the Inherit check box for the Optional Client Modules for Download
setting (not shown in the ligure).

Step 5 Enable the Start Before Logon (SBL) feature by checking the vpngina check box.
This selection enables the security apphliance to dewnload a Graphical ldentification
and Authentication (GINA) for the Cisco AnyConnect elient VPN connection (not
shown in the figure).

Step 6 Click OK, and click Apply to save the confliguration changes to the Cisco ASA

adaptive security appliance.

The XML profile configuration has o be changed and uploaded to the security appliance.

To configure the XML profile using the Ciseo AnyConnect Profile Editor to enable SBL,
follow these steps:

Step 1
Step 2
Step 3

Choose the Preferences tab.
Enable SBL by checking the Use Start Before Logon check box.

Choose File > Save (Save As) to save the changes in policy.

Note

The user must reboot the remote computer before SBL can take effect.
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Cisco AnyConnect Operating System
Integration Options

Task 3: (Opticnal) Configure Scripting
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To enable scripting, {ollow these steps using Cisco ASDM:

Step 1 Choose Configuration > Remote Access VPN = Network (Client) Access >

AnyConnect Customization/Localization > Seript.

Step 2 Click Impaort.

Step 3 Specily the seript name and script type. Then, select the remote computer operating

pladorm for which the seript is written.

Step ¢ Select the seript file by filling 1n the path information.

Step 5 Select Import Now to upload the seript to the security appliance.
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Integration Options
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Cisco AnyConnect Operating System

Task 3: (Optional) Configure Scripting (Cont.)

<Cheniinitalization=

<EnablaSaripting
UsarCantrolable="falsa >trua
<TerminataSenplOnNadEvant=falss
= TerminalSaiptOnlNaxtEvents
<EnablePastSBLOn CannastSanpt>t
<EnablePoet SBLOnCannactSeripte
<EnablaSaripting>

=i Cligntinttigization>

rua

After the script 1s uploaded to the secunity appliance, the XML profile has to be changed in

order to execute the scripts.

To configure the XML profile by using the Ciseo AnyConnect Profile Editor to enable

seripting, Tollow these steps:
Stap 1
Step 2
Step 3
Stap 4

Cheose the Preferences (Cont) tab.

Choose File > Save {Save As) to save the changes in policy.

Enable seripting by checking the Enable Seripting check box.

Upload the XML profile file to the Cisco ASA adaptive security appliance as
deseribed in the previous topic.
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Verifying Cisco AnyConnect Operating
System Integration

Trusted Metwork Detection
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To verily TND on Windows operating systems, use the Event Viewer.

Step 1 In the Event Viewer window, choose Applications and Services Logs > Cisco
AnyConnect VPN Client (the path may vary based on the operating system and
version).

Step 2 Verily that the Cizsco AnyConnect client will automatieally initiate when a remote
computer is in an untrusted nerwock. 5 TND action is also configured for a wusted
network, @ separate event in Event Viewer verification should be recorded.
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Scripting
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Verifying Cisco AnyConnect Operating
System Integration
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You can also use the Event Viewer to verily scripting on Windows operating systems.

Step 1 In the Event Viewer window, choose Applications and Services Logs > Cisco
AnyConneet VPN Client (the path may vary based on the operating system and

version).

Step 2 Verify that the Cisco AnyConneet elient will automateally execute seripting after
VPN connection. I seripting is also enabled upon VPN disconnection, a separate
event in the Event Viewer should be created upon VPN disconnection.
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Customizing the Cisco AnyConnect User
Interface

This topic deseribes how to configure and verify Cisco AnyConnect user interface
customization.

Customizing Cisco AnyConnect User
Interface

Overview

= ¥ou can fully customize the
Cisco AnyCannect client GUI.

3 Dl AmyCannect VAN RS .
W, Cosnactin | () Satabon | B Abodl

— Graphical elements
(bitmaps, icons) i

— Language strings

* Most customnization tasks are PR ey o 1
easily performed using the =5
Cisce ASDM. G [Beme -

« For more extensive st T
customization, replace the T
VPN GUIl entirely and deploy
g custorm GUI application e
integrated with Cisco
AnyConnact AP L e gl il

You ean customize the Cisco AnyConnect client GUIL elements and language strings; for
example, you can confligure it to display your own COrporate image Lo rémote Users,

Customization can be performed on the Cisco AnyConnect client that runs on Windows, Linux,
and Mac 018 X computers, Customization is not supported for the Cisco AnyConnect client that
runs on a Windows Mobile device.

You can use one of three methods wo customize the chent:

m  |mport individual elient GUI and string components, such as the corporate logo, (o the
security appliance that deploys them to remote computers with the installer

®  |mport your own programs ( Windows and Linux platforms only) that provide their own
GUL or CLI and use the Cisco AnyConnect application programming interface ( APL)

m  |mport a transform ( Windows only) that you create, and enable the security appliance to
deploy it with an installer
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Customizing Cisco AnyConnect User
Interface

Configuration Tasks
1. (Optienal) Customize Cisco AnyCennect GUI objects.

2. (Optienal) Customize Cisco AnyCennect GUI lecalization.

Lig=a new

Extand ine ‘comnecton
15'2d" messsge win B
cortec] emas eddress.

Baoth the GUI and string components of the Ciseo AnyConnect client can be replaced by
custeimized versions, Most of customization tasks are easily performed using Cisco ASDM.

In this configuration scenario, you will change the Cisco AnyConnect GUI client logo and
madify one of status messages,

(UL customization can be performed on all graphical elements and 1cons that the Cisco
AnyConnect client GUI contams. If you ereate your own custom images 1o replace the Cisco
AnyConnect client icons, your images must be the same size as the original Cisco images. In
addition, Nlenarmes must be the same to those used by Ciseo. The Ciseo AnyConnect client uses
different filenames lor different operating systems.

Default AnyConneet chent English messages ean also be customized and, if needed, translated
into other languages.
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Customizing Cisco AnyConnect User
Interface
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To customize the elient GUI by importing & new company logo, follow these steps using Cisco

ASDM:
Step 1

Step 2
Step 3

Step 4

Step 5

Step &

Step 7

Choose Configuration > Remote Access VPN = Network (Client) Access >
AnyConneet Customization/Localization > Resources.

Click Import.
Enter the name of the file to import.

Selectan operating system platform and speeify the file o import. Your custom
obiects have ta be the same size and use the same names as those objects that are
used by default by the Ciseo AnyConnect VPN client. You can [ind object names
and sizes for all operating systems in the tables that Tollow.

Click Import Now. The file appears in the table.

Repeat Steps 2 through 5 for all the files that you want to import to the Ciseo ASA
adaptive security appliance.

Click Apply to apply the configuration changes Lo the security appliance.

The following tables list the (iles that you ean replace for éach operating system that supports
the Ciseo AnyConnect client.

Note

If vou create your own custom images to replace the client icons, your images must be the
same size as the original Cisco images.
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Microsoft Windows

All Iiles for Windows are located in the "9 PROGRAMFILESY\Cisco'\Cisco AnyConnect VPN

Chent'res) folder.

Note

most Windows installations, this is the C:\Program Files environment.

The %FPROGRAMFILES % name refers to the environment variable by the same name. In

Microsoft Windows Files

Filename in Microsoft |Client GUI Area Affected Image Size
Windows Installation [Pixels, L x H)
AboutTabico lcon that appears on the About tab 1TEx 16
company_logo.bmp Corporate logo that appears on each tab of the user interface | 142 x 982
connected.ico Tray icon that displays when the client is connected 16x 16
ConnectionTab.ico lcon that appears on the Connection tab 16x 16
disconnecting.ico Tray icon that displays when the client is in the process of 168x 16
dsconnecting

GUlico |con that appears on the Windows Vista SBL screen 48 x 48

32x 32

245 24

16x% 16
reconnecting.ico Tray lcon that displays when the client is in the process of tEx 16

reconnecting
StatsTab.ico |con that appears on the Stetistics tab T6x 16
unconnected.ico Tray icon that displays when the client is not connected TEx 16
Linux
All files for Linux are loeated in the /opteisco/vpr/pixmaps’ folder.
Linux Files
Filenama in Linux Client GUI Area Affected Image Size
Installation |Pixels, L xH)
company-logo.png Corporate logo that appears on each tab of the user interface | 142 x52
cvc-gbout.png lcon that appears on the About tab 16x 16
cvc-connect.prg lcon that appears next to the Connect button, and on the 1Ex 18
Connection tab
cvc-disconnect.png lcon that appears next to the Disconnect button 16 x 16
cvc-info.png lcon that appears on the Statistics tab 16 x 16
systray_connected.png Tray icon that displays when the client 15 connected 18x 16
systray_notconnected.png |Tray icon that displays when the client is not connected 1Ex 16
systray_disconnecting.prg | Tray icon that displays when the client is disconnecting 1Ex 16
systray_reconnecting.png | Tray icon that displays when the client is reconnecting 16 x 16
vonuids.png Main program icon 48 x 4B
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Mac OS X

All files Tor Mac OS X are located in the /Applications/Ciseo AnyConnect VEN

Chent/Contents/Resources folder.

Mac OS X Files

Filename in Mac O8 X Client GUI Area Affected Image Size
Installation (Pixels, L x H)
bubble.png MNotification bubble that appears when the chent 142 %02
connects or disconnects
connected. png lcon that displays under the disconnect button when the | 32x 32
client is connected
logo.png Logo icon that appears on main screen in the top right 50x 33
COFMEr
menu_connected.png Connected state menu bar icon fEx 16
MENU_&rror.png Error state menu bar icon 1Bx 16
ment_idle.prg Cisconnected idle menu bar icon tEx 16
menu_reconnecting.png Reconnection in process menu bar jcon tEx 168
warning.png lcon that replaces login fields on various authentication | 40x 40
and certificate warnings
VpNgUi.icns Mac OB X icon file format that is used for all icon 126 x 128

services, such as Dock, Sheets, and Finder

Interface
Task 2:
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Customizing Cisco AnyConnect User

(Optional) Customize GUI Localization
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Canfiguration » Remoie Acoess VPN > Language Locsizaton

You can make changes o the English messages displayed on the Ciseo AnyConnect client GUI
by adding an English translation table and by changing message text within an editing window

of Cisco ASDM.
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The following procedure describes how to change the default English messages using Clsco

ASDM:

Step 1 Choose Coofiguration > Remote Aecess VPN > Language Localization.

Stap 2 Click Add,

Step 3 The Add Language Localization Entry window appears. Choose AnyConnect
as the translation domain from the Translation Domain drop-down menu.

Step 4 Click the Language drop-down menu, choose En-US for English.

Step 5 To customize messages, edit each message separately. Text between the quotes in a
line beginning with the string magid 15, by default, English text and must not be
changed. A customized siring must be entered between the quotes in a ling
beginning with the string magstr. Enter all custom string in corresponding lines.

Stap & Click OK, and click Apply to save the configuration changes to the security

appliance.

For Windows, Linux, or Mac computers, you can deploy your own client that uses the Cisco
AnyConnect client APL. You can replace the Cisco AnyConnect GUIL or the Cisco AnyConnect
CL1 by replacing the ¢lient binary file.

Your executable can call any resource files, such as logo images, that you import to the
security appliance. When you deploy your own executable, any filename can beused for your

resource lles.

Executable filenames must be exact for each operating system.

Executable Filenames

Client Operating System

Client GUI Filename

Client CLI Filename

Microsoft Windows VPRUL EXE vpncli exe
Linux vpnui vpnR
Mac Mot supported for security vpn

appliance deployment

In order to import your executable to customize the client GUI, follow these steps using Cisco
ASDM (not shown in the figure):

Step 1 Choose Conlfiguration > Remote Access VPN = Network (Client) Access >

AnyConneet Customization/Loealization = Binary.

Step 2 Choose Import.

Step 3 Enter the name of the file to import.

Stap 4 Choose an operating system platform and speeify the file o import.

Step 5 Click Import Now. The [ile appears in the table.

Step & Repeat the previous Tour steps Cor all files that you want w import to the Cisco ASA
adaptive security appliance.

Stap 7 Click OK, and click Apply 1o apply the configuration changes to the security

appliance.
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Summary

This topic summarizes the key points that were discussed in this lesson.
-

Summary

= DTLE consumes less bandwidth than TLS because it does
not cause retransmission on the TLS layer. DTLS is enabled
by default.

= Cisco AnyConnect VPN Client configuration ean be centrally
contrelled using XML profiles.

= There are multiple options to install, uninstall, and upgrade
the Cisco AnyConnect VPN Client.

* Clignt XML profiles allow you to centrel all client sattings frem
the WPN gateway.

= The Cisco AnyConnect client can integrate with the client
operating system to provide autermatic initiation (TND), SBL,
and seripting.

= You can extensively customize the Cisco AnyConnect client
Gul.

References
For additional information, refer Lo these resources:

m  Cisco AS4 3500 Sertes Command Reference, 8.2 at
http:/fwww cisco.com/en/US/does/security/asa’asa82 ‘command reference/cmdrefhiml

8 Cisco AnvConnect VEN Client Administrator Guide, Release 2.4 at
http:/fwww cisco.com/en/US/docs/security/vpn_client’anyconneet/anyconnect24/administr
ation/guide/anyconnectadmin24 himi
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Lesson 3|

Deploying Advanced
Authentication in Cisco
AnyConnect Full Tunnel SSL
VPNs

Overview

When deploying virtual private networks (VPNS) in general, it 18 very important Lo use strong
authentication options. This lesson describes several advanced authentication options that you
have when implementing Cisco AnyConnect full tunnel Secure Sockets Layer (SSL) VPNs on
the Ciseo ASA adaptive security appliance. These authenucation options offer adequate
security and scalability, as opposed to the basie local authentication that was described in the
previous lesson. This lesson deseribes advanced password-based authentication using external
authentication, authonzation, and accounting (AAA) servers, certificate-based authentication
using the loeal certilicate authority (CA) of the secunity appliance, and options that are
available to verify user certificates for revoeation.

Objectives

Upon completing this lesson, you will be able to deploy and manage the advanced
guthentication features of a Cisco AnyConneet Tull tunnel SSL VPN, This ability mneludes
being able to meet these objectives:

m  Plan the deployment of advanced client authentication

m  Configure and verify the advanced password-based client authentication

m  Configure and verify the local CA on the Cisco ASA adaptive security appliance and on the
Cisco AnyConnect chient with client certificates that are provisioned by the sscurity
apphiance

m  Configure and verify integration with supporting PKI entities

m  Configure and verify multiple client authentications



Configuration Choices, Basic Procedures, and
Required Input Parameters

This topic provides an overview of how to plan the deployment of advanced client
authentication.

Deploying Advanced Authentication

Cverview of Advanced Authenfication

= Authenticaticn methods other than local password-based
authentication:

— Centralized AAA authentication (possibily integrated with
existing back-end databases)

— Client certificate authentication
— Double or triple authentication

= Usually deploved to enhance manageability, integrate with
existing databases, orincrease the strength of credentials

Authentication ol Secure Sockets Layer (SSL) virtual private networl ( VPN) clients using the
local database 15 the most basic authentication option. More-advanced authentication options
for 8SL WPN users include the following:

Centralized AAA authentication: You can authenticate clients with an existing external
AAA database, such as a RADIUS or TACACS= user database. Such an external database
can also be integrated with other back-end databases, such as Rivest, Shamir, and Adleman
(RSA)Y SecurlD or Microsoft Active Directory.

Authentieation with digital eertificates: You can configure the Cisco ASA adaptive
security applianece to require digital certificates on clients. Before establishing a conneetion,
the security appliance validates the certificate of a client and allows connection
establishment only if the certificate can be validated using a public key that is stored on the
certificate of & trusted certificate authority (CA).

Double and triple authentieation: Starting with Cisco ASA Soltware Yersion 8.2, the
SSL VPN remote access (clientless and Ciseo AnyConnect VPN Client) soltware supports
double and triple authentication. You can combine certificate authentication with up to two
AAA authentication methods thatare performed in a row. The following examples are
possible combinations that can be used:

—  RSA/Security Dynamics International (5D1) — Lightweight Directory Access
Protocol (LDAP) authentication

— Certificates = RADIUS
— Certificates = Radius - RSA/SDI
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Such types of client authentication are deployed o enhance the manageability of users, Lo

integrate VPN deployments with an existing user database infrastructure, or 1o inerease strength
of chent authentication,

Deploying Advanced Authentication

Client Password and Server Certificate Authentication
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The figure illustrates an example where the clients authenticate the security appliance by using

its digital eertificate, and the appliance authenticates the clients by using usernames and

passwords. The Cisco ASA adapuve security appliance can validate usernames and passwords
on external authentication servers such as the following:

m RADIUS authentication server

m  TACACS+=authentication server

m  Kerberos authentication server

m  Windows authentication server

m  LDAP authentication server

® RSA SecurlDd authentication server

A RADIUS or TACACS- authentication server can be configured to cheek the credentals of
a user mn back-end authentication servers, Back-end authéntication servers can include the
following:

. Win

dows authentication server

LDAP authentication server

a
a  External Open DataBase Connectivity (ODBC) database
u

RSA SecurlD) authentication server
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Deploying Advanced Authentication
Client Certificate and Server Certificate Authentication
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The figure illusirates an example where the clients authenticate the security appliance using
its digital certificate, and the appliance authenticates the clients using their certificates. When
each entity suceessfully validates the certificate of the other, the 5L VPN connection can be

established.
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Deploying Advanced Authentication

Server Certificate Authentication, Client Certificate, and AAA

Authentication
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In the third example, the Cisco ASA adaptive security applianee again authenticates itsell to the
client using a digital certificate. In this scenario, the client first authenticates itself o the
security appliance using a digital cemtificate. If’ the Cisco ASA adaptive security appliance
successfully validates the client certificate, it prompts the user for a username and password.
The security appliance then validates the eredentials of a user by using external AAA servers.
Thistype of advanced authentication is the most secure, but also requires the most
configuration effort.
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Deploying Advanced Authentication

Server Certificate-Based Authentication Opticns
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When you authenuicate by using digital certificates, you have different deployment options. For
server guthentication, you can deploy the Cisco ASA adapuive security appliance identaty

certificate in two ways:

m  Self-signed certificate: This option is not recommended, but 1t is the only approact if you
do not use external public key infrastructure { PK1).

m  PKl-obtained certificate: Y ou can configure the Cisco ASA adapuve security appliance
to obtain an identity certilicate from the external PKL

I you are using a PKl-obtained certificate, clients should have a CA certificate that is installed
locally to verily the identity certiflicate of a server.
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Deploying Advanced Authentication
Client Certificate-Based Authentication Options

Cliani Identity
Cartificata Optians

S it
e

For client-side authentication, clients can obtain their identity certilicates by using two

different

options:

®  You can enable alocal CA on the Cisco ASA adaptive security appliance. In this case, the
certificates of clients are issued and managed by the security appliance. The appliance still
needs a self-signed or PRl-provided cemificate to authenticate itself 1o clients.

®  You can use an external PK1to issue identty eertificates to the Ciseo ASA adaptive security

appliance and clients. In this case, ceruficates are managed by an external PKI system.

If yvou are using a PKl-obtained certificate, the server should have a CA certficate that is

instatled locally to verify the identity certilicates of elients. If youare using a local CA on the

security appliance, the appliance will create a self-signed certificate, which is used te sign

certificates that are ssued to clients.

Note

The local CA on the Cisco ASA sdaptive security appliance can be used for 35L VPNs only,
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Deploying Advanced Authentication
Deployment Options

* Deploy advanced password-based client authentication

* Deploy certificate-based client authentication using the Cisco
ASA adaptive security appliance local CA

= Configure cerificate-to-connection-profile mapping

= Deploy certificate-based client authentication using external
ChAs

= Deploy advanced PKI integraticn
= Deploy double client authentication

You have these options when deploying advanced authentication for 851 VPNs:

Deploy advanced password-based client authentication

Deploy certificate-based client authentication using the Cisco ASA adaptive security
appliance local CA

Configure certificate-to-connection-profile mappings
Deploy certificate-based client authentication by using an external CA
Deploy advanced PKI integration

Deploy double client authentication

When deploying advanced authentication for SSL VPN connections on the Cisco ASA adapuive
security applianee, you need specific input parameters:

Existing user databases and their location: This parameter is needed to integrate the
Cisco ASA adapuve security appliance with the external user databases,

Strength of existing user credentials: This parameter 18 needed to determine whether an
existing database is suitable {or remote aceess connections.

Existing authentication protocols: This parameter 15 needed to determine authentication
protocol compatibility.

PKIinformation: This parameter is needed to enroll the Cisco ASA adaptive security
apphance and chents into a PKL

Time-synchronization options: This parameter is needed when vou are using digital
certilieates. Time synchronization is very important to synchronize time on all entities that
are involved in authentication.
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Deploying External AAA Authentication

This topic describes how to configure and verify the external AAA clientauthentication.

Configure External AAA Authentication
Cverview

Native RADIUS or TACACS+

authentication:

* Reguires no special configuration

LOAP authentication:
= Reguires loginto LOAP
* Requires LDAP search parameters

RSA SecurlD authentication: 2

3 : . Cis=a ASA e "':.'.,_. ———
MNative ang RADIUS protocol support Aeingliva Samrily k.{' :';‘,‘f,,_";_j""
Supports the required features (next  Aoesence
PIN mode, PIN change, etc.)

Reguires key file to be Imported to
Cisco ASA adaptive security appliance

Must be firstin the AAL authentication
chain

-

When confliguring password-based client authentication, the following options are
recommended:

® RADIUS or TACACS+ authentication: In this case, no special conliguration is needed
on the Cisco ASA adaptive security appliance. You only need to provide the IP address and
shared key of the authentication server.

®  LDAP authentication: When using authentication with LDAP server, you have to provide
the IP address of the LDAP server on the Cisco ASA adaptive security appliance. The
security appliance has to log into the LDAP secver. Therefore, you also have to add the
Cisco ASA adapuve security appliance as a user that has enough privileges in order to
search for users n the LDAP server. Additionally, you must provide LDAP search
parameters, which include base distinguished name (IN) and scope of the search.

®  RSA SecurlD authentieation: The Cisco ASA adapuve secunity appliance supports the
native 3D or RADIUS protocol between the security appliance and the RSA SeewrlD
server. [P multiple AAA servers are consulted in a row, the RSA Seeurl D host must be the
frstin the list.
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Configure External AAA Authentication

Configuration Tasks
1. Configure a remaote authentication server.

2. Enable remete AAA authentication for a connection profile.
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These are the configuration tasks when configuring advanced password-based client
authentication:

I. Configure a remote authentication server on the Cisco ASA adaptive security appliance.
2. Enable remote AAA authentication in a connection profile.

The figure shows an example that will serve as the configuration scenario for ongoing
configuration tasks. First, vou will configure RADIUS, LDAP, and RS A SecurlD
anthentication servers. Then, you will enable remote AAA authentication wsing configured
serviers in a connection profile.
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Configure External AAA Authentication
Task 1: Configure a RADIUS Authentication Server
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In the first configuration task in this sequence, you will configure a AAA group to include the
RADIUS authentication server and the authentication protocols of the group. You may also
reuse an existing A AA group that is defined on the Cisco ASA adaptive security appliance.

To configure a RADIUS authentication server usng the Cisco Adaptive Securty Device Manager
[ASDM), first create a RADIUS server group and then configure an individual server in the AAA
server group. To create 8 AAA server group by using Ciseo ASDM, complete the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Inside the Cisco ASDM, choose Confliguration > Remote Access VPN =
AAA/Local Users = AAA Server Groups. The AAA Server Groups panel 18
displayed (not shown in the lgure).

Click Add m the AAA Server Groups area (not shown in the figure). The Add AAA

Server Group window opens.

Enter a name {or the server group in the Server Group field. This example uses the

name MY-RADIUS-SVRS to name the AAA server group.

From the Protocol drop-down list, choose the AAA protocol thart the servers in the

group support. You can choose RADIUS, TACACS-, Microsolt Windows NT

Domain, SDI, Kerberos, LDAP, or HTTP form. In the figure, RADIUS is chosen.

Click OK.

To configure an individual authentication server in the RADIUS server group, complete the
following steps:

Step 1

Step 2

Step 3

Step 4

Choose a configured server group from the AAA Server Groups table in the AAA

Server Groups panel (not shown in the [igure).

Click Add in the Servers in Selected Group area of the AAA Server Groups panel

(not shown in the figure), The Add AAA Server window opens.

From the Interface Name drop-down list, choose the interface where the AAA server

resides. In the figure, the inside interface is chosen.

Enter the name or [P address of the AAA server in the Server Name or 1P Address

field. In the figure, 10.10.10.21 is entered.
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Step 5

Step &

Stap 7

Optionally, specify the server authentication and accounting ports, RADIUS packets
use UDP port 1812 for RADIUS authentication messages and UDP port 1813 for
RADIUS accounting messages. Some earlier RADIUS implementations use UDP
port 1643 for RADIUS authentication messages and UDP port 1646 for RADIUS
gceounting messages. [nthe figure, the default ports 1645 and 1646 are used.

Enter an alphanumeric value up to 64 characters in the Server Secret Key field. The
server secret key is used for eryptographic protection of the session between the
security appliance and the RADIUS {access control server [ACS]) server. The key
must be the same on both the security appliance and the RADIUS (ACS) server. The
key value 15 a case-sensitive. The Server Secret Key field displays only asterisks.

Click OK.

Configure External AAA Authentication
Task 1: Configure an LDAP Authentication Server (Cont.)
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To configure an LDAP authentication server by using Cisco ASDM, first create an LDAP
server group, and then configure individual servers in the AAA server group. To create 8 AAA
server group by using Cisco ASDM, complete the following steps:

Step 1

Step 2

Step 3

Stap 4

Step 5

Inside the Cisco ASDM, choose Configuration > Remote Aceess VPN >
AAA/Local Users > AAA Server Groups. The AAA Server Groups panel 15
displayed (not shown in the figure).

Click Add inthe AAA Server Groups area (not shown in the figure). The Add AAA
Server Group window opens.

Enter a name for the server group in the Server Group field. This example uses the
name MY-LDAP-SVRS to name the AAA server group.

From the Protoco! drop-down list, choose the A AA protocol that the servers in the
group support. You ean choose RADIUS, TACACS—, Windows NT Domain, SDI,
Kerberos, LDAP, or HTTP form. In the figure, LDAP is chosen.

Click OK.
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To configure an individual authentication server in the LDAP server group, complete the
following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Step 7

Step 8

Step 9

Step 10

Choose a configured secver group from the AAA Server Groups table in the AAA
Server Groups panel (not shown in the figure).

Click Add in the Servers in Selected Group area of the AAA Server Groups panel
(not shown in the figure). The Add AAA Server window opens.

From the Intecface Name drop-down list, choose the interface where the AAA server
resides. In the figure, the ingide interface 15 chosen.

Enter the name or [P address of the AAA server in the Server Name or [P Address
field. In the figure, 10.10.10.22 15 entered.

Optionally, check the Enable LDAP over SSL check box to enable secure
communication between the Cisco ASA adaptive security appliance and the LDAP
server. Itis recommended o enable this option.

Crptionally, specify a nondefault port for communication between the Cisco ASA
adaptive security appliance and the LDAP server by entering a number into the
Server Port input field. By default, LDAP uses 389 and LDAP over 551 (LDAPS)
uses H36.

Choose an LDAP server type ftom the Server Type drop-down menu. You have the
following options:

m Deect Automatically/Use Generie Type

® Microsolt

m Novell
m  OpenlDAP
B Sun

In the example, the Mierosoft server type is selected.

In the Base DN input field, enter a base distinguished name (DN) or a location in the
LDAR hierarchy where the server should begin searching when it receives an LDAP
request. In the example, en=users,de=domain,de=com is entered as the base DN,

Choose an option [rom the Scope drop-down menu wo specily the extent to which the

server should search the LDAP hierarchy when it receives an authonzation request.

The available options include the following:

m  One Level: Searches only one level beneath the base DN, This option 15
quicker.

m Al Levels: Searches all levels beneath the base DN, This option tells the server
to search the entire subtree hiecarchy. This option takes more bme,

In the example, the All Levels option is selected.

Enter a login DN into the Login DN input field. This name should be the DN of a
user who has enough privileges 1o search for users in the LDAP server. In the
example, co=vpngateway, co=users,de=domain,de=com is entered.
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Step 11 Enter a password for the login DN user account inte the Login Password input field.

Note The Cisco ABA adaptive secunty appliance uses the login DM and login password to
establish trust (bind) with an LDAP server. The login DN represents s user record in the
LDAP server that the administrator uses for binding.

Step 12 Opuonally, enable Simple Authentication and Securty Layer (SASL) authentication
by checking the SASL MD3 Authentication or SASL Kerberos Authentication
check box.

Step 13 Click OK.
Step 14 Click Apply 1o apply the configuration.
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Configure External AAA Authentication
Task 1: Configure an RSA Authentication Server {Caont.)
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To configure an RSA authentication server by using Cisco ASDM, first create an RSA server
group, and then configure an individual server in the AAA server group. To create a AAA
server group by using Cisco ASDM, complete the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Inside the Cisco ASDM, choose Configuration > Remote Access VPN =
AAALocal Users = AAA Server Groups. The AAA Server Groups panel is
displayed ( not shown in the fgure).

Click Add in the AAA Server Groups area (not shown in the figure). The Add AAA
Server Group window opens.

Enter a name lor the server group in the Server Group field. This example uses the
pame MY-RSA-SVRS to name the AAA server group.

From the Protocol drop-down list, choose the AAA protocol that the servers in the
group support. You can choose RADIUS, TACACS—, Windows NT Domain, SDI,
Kerberos, LDAP, or HTTP form. In the figure, 311 is chosen.

Click OK.

To configure an individual authentication server in the SD1 server group, complete the
following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Choose a configured secver group from the AAA Server Groups table in the AAA
Server Groups panel (not shown in the figure).

Click Add in the Servers in Selected Group area of the AAA Server Groups panel
(not shown in the figure). The Add AAA Server window opens.

From the Interface Name drop-down hist, choose the intecface where the AAA server
resides. In the figure, the inside interface 15 chosen.

Enter the name or [P address of the AAA server inthe Server Name or 1P Address
field. In the figure, 10.10.10.23 is entered.

Click OK.
Click Apply to apply the configuration.
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Configure External AAA Authentication
Task 2: Enable Remote AAA Authentication
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You can enable remote AA A authentication for the default connection profile to ensure that a
strong authentication method is used by default. To enable remote AAA authentication from
the default connection profile by using Cisco ASDM, complete the following steps:

Step 1 Inside the Cisco ASDM, choose Configuration > Remote Access VPN = Network
(Client) Aceess = AnyConnect Connection Profiles. The AnyConneet Connection
Profiles window is displayed (not shown in the figure).

Stap 2 Choose the DefaultWebYPNGroup connection profile Itom the Connection
Profiles table. Click Edit (not shown in the ligure).

Step 3 The Edit 8SL VPN Connection Profile window is displayed, as shown in the figure.
Step 4 Check the AAA radio button.

Stap 5 Choose the conligured AAA server group from the AAA Server Group drop-down
menil. 1o the example, the MY-RADIUS-SVRS server group 15 selected.

Step 6 Optionally, check the Use Local If Server Group Fails check box to enable
lallback to the local database il'a server group Tails. This selection is generally not
recommended.

Stap 7 Click OK.
Step B Click Apply 1o apply the configuration.
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Configure External AAA Authentication
Task 2: Enable Remote AAA Authentication (Cont.)
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Repeat the steps that are described in the previous [igure to enable remote AAA authentication
for any other connection profiles. In the example, the BASIC-ANYCONNECT-PRUOFILE s

also configured for authentication with the authentication server in the MY-RADIUS-SRY
SErver group.

Configure External AAA Authentication
CLI Configuration
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To configure advanced password-based authentication using the command-line interface (CLI),
use the following commands,
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daa-server

Tocreate an AAA server group, use the sas-server command, Tollowed by a server group
name and authentication protocol. To add a server o the server group, use the aaa-server
command, tollowed by a server group name, the interface through which the server is
reachable, and the [P address of the server. To configure a shared key that is used for
communication between the Cisco ASA adaptive security appliance and the RADIUS server,
use the key command in AAA server configuration mode.

In the example, three server groups are configured. The MY -RADIUS-SVRS server group is
configured as a RADIUS server group, and the server at the 10,100 10.21 address is configured
as a member of the MY-RADIUS-SVRS server group. The MY-LDAP-SVRS server group is
configured as an L DAP server group, and the server at the 10, 10,1022 address 1s configured as
amember of the MY-LDAP-SVRS server group. The MY -RSA-SV RS server group s
configured as an RS A server group, and the server at the [0.10.10.23 address is configured asa
member of the MY-RSA-SVRS server group.

To configure parameters inside the LDAP server group, use the following commands in server
group configuration mode. Use the server-port command to specify the port that is used
between the Cisco ASA adaptive security appliance and the LDAP server. Use the Idap-base-
dn command to specify where the server should begin searching when it receives an
authentication request. Use the ldap-scope command to specily the extent of the search i the
LDAP hierarchy. Use the Idap-naming-attribute command to specily the relative
distinguished name atribute. Use the Map-login-dn and ldap-login-password commands to
specily the name and password that the Cisco ASA adaptive security appliance will use to
search the LDAP directory. Use the sasl-mechanism command to enable SASL
authentications, and use the Idap-over-ssl enable command o enable LDAPS. Use the server-
type command o specify the LDAP authentication server type.

To enable AAA authentication for a connection profile (tunnel group) by using the CL1 use the
authentication-server-group command, followed by the AAA server group name, in tunnel
group configuration mode,

In the example, the connection profile BASIC-ANYCONNECT-PROFILE 15 configured for
authentication using the MY-RADIUS-SVRS server group.

Tocreate a AAA server group and configure AAA server parameters that are group-specific
and common Lo all group hosts, use the aaa-server command in global configuration mode. Ta
remove the designated group, use the no form of this command.

aaa-server sener-tag protocol server-protocol

aaa-server Parameters

Parameter Description

server-tag Specifies the server group name, which is matched by the name
that is specified by the aaa-server host commands. Other AA4
commands make reference to the AAA server group name.

protocol server- Specifies the AAA protocol that the servers in the group support:
protocol = http-form

n  kerberos

= |dap

s nt

n radius

= SBdi

m tacacs+
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aaa-server host

To configure a AAA server as part of a AAA server group, and to configure AAA server
parameters that are host-specific, use the aaa-server host command 1n global configuration
mode. When you use the aaa-server host command, you enter aaa-server host conliguration
mode, from which you can specify and manage host-speeific AAA server connection data. To
remove 4 host configuration, use the no form of this command.

aaa-server server-tag [(interface-name) | host {server-ip | name} [fey] [meoul seconds)

aaa-server host Parameters

Parameter Description

(interface-nams) (O ptional) Specifies the network Interface where the authentication server
resides. The parentheses are reguired in this parameter. if you do not
specify an interface, the cefault is the inside interface, if available.

fey (Optional } Specifies a case-sensitive, alphanumeric keyword of up to 127
characters that is the same value as the key on the RADIUS or TACACS+
server. Any characters that are entered past the 127-character maximum
are ignored, The key is used between the adaptive security appliance and
the server for encrypting dats between them. The key must be the same on
both the adaptive security appliance and the server systems. Spaces are
rot permitted in the key, but other special characters are allowed. You can
add or modify the key using the key command in host mode.

name Specifies the name of the server using either & name that is assigned
locally using the name command or a Domain Name System (DNS) name.
The maximum number of characters is 128 for DNS names and 63
characters for names that are assigned using the name command.

server-ip Specifies the IP address of the AAS server.

Zarver-trag Specifies a symbolic name of the server group, which is matched by the
name that is-specified by the aaa-server command.

timeout sscoonds [Optional) The timeowt interval for the request. This value is the time after
which the adaptive security appliance gives up on the reguest to the
primary AAA server. |f there is & standby AAA server, the adaptive security
appliance sends the request to the backup server, You can modify the
imeout interval by using the timeout command in host mode.

ldap-base-dn

To specify the location in the LDAP hierarchy where the server should begin searching when it
receives an authorization request, use the ldap-base-dn command in asa-server host
configuration mode. The aaa-server host configuration mode is accessible from the aaa-server
protocel configuration mode. To remove this specification, thus resetting the search Lo start at
the top of the list, use the no lbrm of this command.

Idap-base-dn string

Idap-base-dn Parameters

Parameter Description

srring A case-sensitive string of up to 128 characters that specifies the
location in the LOAP hierarchy where the server should begin
searching when it receives an authorization request; for example,
OU=Cisco, Spaces are not permitted in the string, but other
special characters are allowed.
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ldap-scope
To specify the extent to which the server should séarch the LDAP hierarchy when it receives an
authorization request, use the Idap-seope command in aaa-secver host configuration mode. The
gaa-server host configuration mode is aceessible from the aaa-server protocol configuration
mode. To remove this specification, use the no form of this command.

ldap-scope scope

Idap-scope Parameters

Parameter Descripiion

The number of levels in the LDAP hierarchy inwhich the server should search when it
receives an authorization request. Valid values include the foliowing:

n  onelevel: Search only one level beneath the base DM.
= subtree: Search sll levels beneath the base DN.

soope

ldap-naming-attribute

To specify the relative distinguished name attribute, use the ldap-naming-attribute command
in aaa-server host configuration mode. The aaa-server host configuration mode is accessible
from the aaa-server protocol configuration mode. To remove this specification, use the no form

of this command:

Idap-naming-attribute sirxing

Idap-naming-attribute Parameters

Parameter Description

string The case-sensitive, alphanumeric relstive distinguished name attribute, consisting of up
to 128 characters, that uniguely identifies an entry on the LDAP server. Spaces 2re not
permitted in the string, but other special characters are allowed.

ldap-login-dn
Tospecify the name of the directory abject with which the system should bind, use the Idap-
login-dn command in aaa-server host configuration mode. The aaa-server host configuration
mode is accessible from the aaa-server protocol configuration mode. To remove this

specification, use the no form of this command.

Idap-login-dn string

Idap-login-dn Parameters

Parameter Descripiion

string M case-sensitive string of up to 126 characters that specifies the name of the directory
object in the LOWMP hierarchy. Spaces are not permitted in the string, but other special

characters are allowed.

ldap-login-password
Tospecily the login password lor the LDAP server, use the ldap-login-password command in
aaa-server host configuration mode. The aga-server host conliguration mode 18 accessible from
the ag-server protocol configuration mode. To remove this password specification, use
the no form of this command:

Idap-login-password seving
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Idap-login-password Parameters

Parameter Description

string A case-sensitive, alphanumeric password, up to B4 characters long. The password
cannot contain space characters.

Idap-over-ssl

To establish a secure SSL connection between the adaptive security apphiance and the LDAP
server, use the Idap-over-ssl command in aaa-server host configuration mode. To disable SSL
for the connection, use the no form of this command.

Idap-over-ssl enable

Idap-over-ssl Parameters

Paramatar Desecription

enable Specifies that 351 secures a connection toan LDAP server

sasl-mechanism

To specify a SASL mechanism for authenticating an LDAP client to an L DAP server, use
the sasl-mechanism command in aas-server host configuration mode. The SASL authentication
mechanism options are digest-md3 and kerberos,

To disable an authentcation mechanism, use the no form of this command.

sasl-mechanism | digest-md5 | Kerberos server=group-name |

Note Because the adaptive security appliance serves as a client proxy to the LDAP server for
VPN users, the LDAP client that is referred to here is the adaptive security appliance.

sasl-mechanism Parameters

Paramater Description

dlgast-md5s Thie adaptive security appliance responds with a Message Digests
[ME5) value that is computed from the username and password

karbaros The adaptive security appliance responds by sending the username and
reaim using the Generic Security Services Application Programming
Interface (GSSAP|} Kerberos mechanism

SHrVer-group-nams Specifies the Kerberos aaa-server group, up to 64 characters

server-type

To manually configure the LDAP server model, use the server-type command in gaa-server
host configuration mode. The adaptive security appliance supports the following server models:

®  Microsoft Active Directory

®  Sun Microsystems Java System Directory Server, formerly named the Sun ONE Directory
Server

s (eneric LDAP directory servers that comply with LDAP version 3 (LDAPv3) (no
password management)

To disable this command, use the no form of this command.
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server-type {auto-detect | microsoft |sun | generie | openldap | novell}

server-type Parameters

Parameter Description

auto-detect Specifies that the adaptive security appliance determines the LDAP server
type through austodetection.

genaric Specifies LDAPv3-compliart directory servers other than Sun and Microsoft
LCAF directory servers. Fassword management is not supported with
generic LODAP servers.

microgoft Specifies that the LDAP server is a Microsoft Active Directory server.
cpenldap Specifies that the LOAP server 15 an OpenLlDAP server,

novell Specifies that the LDAP server is a Novell server.

sun Specifies that the LDAP server |s 2 Sun Microsystems Java System

Directory Server.

authentication-server-group (tunnel-group general-attributes)

To specifly the AAA server group o use for user authentication for a tunnel group, use
the authentication-server-group command 1n tunnel-group general-attributes conliguration
made. To return this attribute to the default, use the ne form of this command.

authentication-server-group |(interface name)] server_group [LOCAL | NONE]

authentication-server-group (tunnel-group general-attributes) Parameters

Parametar Description

inrerface name (Cptional ) Specifies the interface where the IP Security [|Psec) tunnel
terminates.

LOCAL [Optional ) Reguires authentication ageinst the local user database if &l of

the servers in the server group have been deactivated due to communication
failures. If the server group name is either LOCAL or NONE, do not use the
LOCAL keyword here.

NONE {Optional}) Specifies the server group name 28 NONE, indicating that
authentication iz not reguired.

servear group Identifies the previously configured authentication server or group of servers.
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Verify External AAA Authentication

Implementation Guidelines
Consider the following implementation guidelines:

* Implement a redundant AAA infrastructure for critical remote-
access services

= When using static passwords, ensure that user credentials
are strong enough; censider using account lockout on remote
AALA BarErS

* Deploy one-time passwords if existing credentials are not
adequately strong; also consider migrating to client
certificates

When implementing advanced password-based client authentication, consider the following
implementation guidelines:

m  Create redundant AAA infrastructire for coitical remote aceess services

®  When using static passwords, ensure that user credentials are strong enough; also consider
using account lockout on remote AAA servers

m  Deploy one-time passwords (OTPs) if existing credentials are not adequately strong: also
consider migrating to client certificates
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Deploying Certificate-Based Client
Authentication Using the Cisco ASA Adaptive
Security Appliance Local CA

This topic deseribes how to configure and verify the local CA on the Cisco ASA adaptive
security appliance and the Ciseo AnyConnect client by using client certificates that are
provisioned by the security appliance.

Configure Certificate-Based Client Authentication
Using the Cisco ASA Security Appliance Local CA

Configuration Scenario P —
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When you configure certificate-based elient authentication, you can configure the local
certificate authority (CA) feature on the Cisco ASA adapuive security appliance. This local CA
is capable of provisioning and managing identity cectificates lor clients. However, the local CA
cannot issue an identty certificate to the Ciseo ASA adaptive security appliance. That 18 why
the seeurity appliance has to obtain an dentty certilicate from an external PKI system. This
identity cerificate is signed by the external CA.

When you configure the loeal CA on the Cisco ASA adaptive security appliance, the appliance
generates an additional sell-signed cectilicate that is used to sign the identity certilicates that
are 1ssued to the clients. When a client requests an identty certificate from the appliance, the
appliance creates an identity certificate and signs it with its local CA root certificate. The
identity certificate of the elient can then be downloaded by the client. However, before a user
can download its identity certificate from the Cisco ASA adaptive security appliance, you have
Lo create user accounts on the appliance for users who will be eligible 1o obtain an identity
certificate from the loeal CA of the security appliance.
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When the client and the Cisco ASA adaptive security appliance want to establish an S5L VPN
connection, they have to first exchange identity certificates. The security appliance sends a
PKl-abtained identity certificate to the elient, The client verifies the certificate of the Cisco
ASA adaptive security appliance by using the cectificate of the CA, which has Lo be installed on
the client. The client also sends its identity certificate (which has been obtained from the Cisco
ASA adaptive security appliance) to the secunity appliance. The appliance verifies the client
identity certificate using its self-signed certificate, which was used Lo sign the identty
certificate of the client in the first place. If both certificates ¢an be verified, the client and the
Cisco ASA adapuive security appliance estabhish the 881 VPN connection.

The figure shows an example that will serve asa configuration scenario for ongoing
configuration tasks. First, you will configure a local CA on the Cisco ASA adaptive security
appliance and ereate a user account for a user to download a certificate. Then, you will enable
eertificate-based authentication lor the BASIC-ANYCONNECT-PROFILE. Lastly, you will
eonfigure mapping berween the certificate and the connection profile to map users to the
BASIC-ANYCONNECT-PROFILE conneetion profile.

Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Configuration Tasks

1. Configure the local CA of the Cisco ASA adaptive security
appliance.

Create CA user accounts.

Provision client identity certificates.

oM

install a client certificate on the Cisco AnyConnect client.

[#]]

Map certificates te connection profiles.

£. Enable client certificate authentication for a connacticn
profile.

Perform these configuration tasks to configure certificate-based client authentication by using
the local CA of the Cisco ASA adaptive security appliance:

. Configure the Cisco ASA adapuive security appliance local CA.
2. Create CA user accounts.

3. Provision elient identity certificates.

4. Install a client certificate on the Cisco AnyConnect VPN Client.
5. Map certilicates to connection profiles.

6. Enable elient certificate authentication For a connection profile.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 1: Configure the Local CA of the Cisco ASA Adaptive
Security Appliance
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To conligure the Cisco ASA adaptive security appliance local CA by using Cisco ASDM,
complete the following steps:

Stap 1

Stap 2

Step 3

Step 4

Step 5

Step &

Stap 7

Inside the ASDM, choose Configuration > Remote Aecess VPN = Certificate
Management > Loeal Certificate Authority > CA Server (not shown in the
figure). The CA Server panel is displayed.

Check the Create Certificate Authority Server check box.

Click the Enable radio button to activate the loeal CA server. The default is
dizabled. After vou enable the local CA server, the security appliance generates the
local CA server certificate, key pair, and necessary database files. It then archives
the local CA server certilicate and key pair ina Public Key Cryptography Standard
#]2 (PKCS12) file,

When you enable the local CA for the lirst tme, you must provide an alphanumenie
enable passphrase, which must have a minimum of seven alphanumeric characters.
The passphrase protects the local CA certificate and the local CA certificate key pair
that 1s archived in storage. 1t also secures the local CA server from unauthorized or
accidental shutdown. The passphrase is required to unlock the PKCS12 archive if
the local CA certificate or key pair is lost and must be restored.

Enter the issuer subject name into the 1ssuer Name input feld in CN=FQDN format.
By detault, this field is pepulated with CN=hostname.domain_name.

From the CA Server Key Size drop-down list, choose the CA server Key size of the
key pair to be generated tor the CA certificate. Key sizes can be 512, 768, 1024, or
2048 bits per key. The default is 1024 bits per key.

From the Client Key Size drop-down list, choose the client key size ol the key pair
to be generated lor each user certificate that is issued by the local CA server. Key
sizes can be 312, 768, 1024, or 2048 bats per key, The default is 1024 bits per key.
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Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Enter the CA certificate lifetime value into the CA Certificate Lifetime input field.
This value specifies the number of days that the CA server certificate 1s valid. The
default is 3650 days (10 years).

Enter the client certificate lifetime value into the Client Cenificate Lifetime input
field. This value specifies the number of days that a user cectificate that is issued by
the CA server is valid, The default is 365 days (1 year).

In the Simple Mail Transler Protocol (SMTP) Server & Email Settings area, you set
up email aceess for the local CA server by specifying the settings that {ollow. Local
CA needs email access il you want to send email notifications with instructions on
how Lo obtain an identity certificate to users. Complete the following substeps to set
up email access:

m  Enter the SMTP mail server name or [P address. Alternatively, click the ellipsis
[« t0 display the Browse Server Name/IP Address dialog box, where you can
choose the server name or [P address. Click OK when you are finished to close
the Browse Server Name/|P Address dialog box.

m  Ener the address {rom which 1o send email messages to local CA users, in
adminnamefghost com lormat. Automatic email messages carry OTPs to newly
enrolled users and issue email messages when certificates need to be renewed or

updated.

s Enter the subject, which specilies the subject line in all messages that are sent o
users by the loeal CA server. I'vou do not specily a subject, the default is
Certificate Enrollment Invitation.

Optionally, configure additional options by clicking the More Options drop-down
bar (not shown in the figure).

Optionally, enter the certilicate revocation list (CRL) distribution point location into
the CRL Distribution Point URL input field. The default location is
http://hostname. domain/—CSCOCA~/asa_ca.crl (not shown in the figure).

Optionally, specify CA database storage by entering a database storage location inta
the Database Storage Location input feld. The security appliance accesses and
implements user information, issued certificates, and revocation lists by using a local
CA database. Alternatively, to specify an external file, enter the pathname to the
external file or click Browse o display the Database Storage Location dialog box
(not shown in the figure.)

Click Apply to apply the configuration.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 2: Create CA User Accounis
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When you are inished creating the local CA, you have to create user accounts on the Cisco
ASA adaptive security appliance for all users who are eligible to obtain a certificate from the
Cisco ASA adaptive security appliance. To create a user account on the local CA using Cisco
ASDM, complete the following steps:

Step 1 Inside the ASDM, choose Configuration > Remote Aecess VPN = Certificate
Management > Local Certifieate Authority > Manage User Database (not shown
in the figure). The Manage User Database panel 1s displayed.

Stap 2 Click Add in the Manage User Database panel. The Add User window opens.

Step 3 Enter a valid username into the Username mput feld.

Step 4 Enter the email address ol a user into the Email [ input Geld.

Stap 5 Enter the subject name into the Subjeet (DN String) input feld. This name will be
used in a cetificate as a subject name.

Step & Click Add User.
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Configure Certificate-Based Client Authentication Using

the Cisco ASA Security Appliance Local CA

Task 3A: Provision Client Identity Certificates (Emall)
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When you are [imished with creating user accounts, a user can obtain a certiflicate using a web
browser or the Cisco AnyConnect client. When a user wants to connect to the Cisco ASA
adaptive security appliance by using the Cisco AnyConneet elient, and a certificate is needed,
the user will get an option to download the eertificate. Before downleading the certificate, the
user has o authenticate to the Cisco ASA adaptive security appliance by using a usernarme
(defined in the previous task when ereating user accounts on the local CA)and an OTP, which
are generated by the security appliance. A user can be notified about the username and OTP in
two different ways. The first way 18 to allow the Cisco ASA adaptive security appliance to send
an email notification to the user. Click the Email OTP button in the Manage User Database
panel o send an émail notfication wo the user. An example of the email notification that is
composed and sent to the user is shown in the figure.

Nota You have to configure email settings in the SMTP Server & Email Seltings: area of the TA
Server panel in order: for the Cisco ASA soaptive security appliance to send email
notifications.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 3B: Provision Client Identity Certificates
(Out-of-Band)
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Another way to notily the user about the username and OTP 1s to relay the username and (TP
to the user manually (for example, using a phone). Choose g user from the username table and
click the Verily/Re-generate OTP button to display the OTP for that specific user. You can
then cut and paste the OTP and relay it to the user by using other communication channels.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 4A: Install Client Certifi

cate (Portal)
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The figure shows a procedure for how a user can obtain a certificate. I you decided to notily a
user by using an email notification, the user can click the link in the email. A web page will

open where the user has to enter a username and OTP. When the user enters the correct
username and password, the ceruficate will be downloaded. After the user installs the
eertificate into the appropriate certificate store, the user ean authenticate to the Cisco ASA

adaptive seeurity appliance by using the certifieate.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 4B: Install Client Certificate (Cisco AnyConnect)
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A user can also download a cectilicate by using the Cisco AnyConnect client. I a certificate 15
required [or a connection profile and a user does not have one, the Cisco AnyConnect client
will display a Ger Centificate button. When the user elicks the button, the Cisco AnyConnect
window content changes. A user can then retrieve a certilicate by entering a username and OTP
and by elicking the Conneet button. After the user elicks the Connect button, the eertificate will
be downloaded and nstalled automaucally into the appropriate certificate store. At that point,

an SSL connection will establish automatically.

Note

Before a user can download a certificate using the Cisco AnyConnect client, you have to
enable certificate-based authentication for a specific connection profile. This process is

shown in the next, fourth task.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 5: Map Certificates to Connection Profiles
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In this task, you will enable certificate-based authentication for a connection profile. You will
first configure mapping between certificates and a connection profile to enable the Cisco ASA
adaptive security appliance to use the proper connection profile for users who are
authenticating with a ceruficate. When the Cisco AnyConneet client is establishing a
connection with the Cisco ASA adaptive security appliance, the Cisco AnyConneet client
immediately tries o authenticate to the security appliance with the elient identity certificate that
15 found in a certificate store (if there is one). The Cisco ASA adaptive security applignce can
use the proper connection profile for that user based on the subject attributes in the received
client identity certificate.

To configure cenificate-to-connection-profile mapping by using Cisco ASDM, complete the
following steps:

Step 1 Inside the ASDM, choose Configuration > Remote Access VPN > Advanced >
Certificate to S5L VPN Connection Profile Maps and click Add under the
Certificate to Connection Profile Maps area.

Step 2 Choose an existing map from the map drop-down menu.

Step 3 Alternatively, click the New radio button in the Map area and provide a name for the
connection profile map.

Step 4 Configure the rule priority by entering a value into the Prority input field. A rule
with a lower prority number will be consulted before a rule with a higher priority
number.

Step 5 Choose the desired connection profile from the Mapped to. Connection Profile drop-
down menu. In the example, BASIC-ANYCONNECT-PROFILE is chosen.

Step 6 Click OK 1o accept the profile map.
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Task 5: Map Certificates to Connection Profiles (Cont.)
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After the profile map has been configured, configure the rule eriterion 1o identify to the Cisco
ASA adaptive security appliance what will be used to map the connecting users 10 the desired
connection profile.

Step 1 At the same Configuration > Remote Access VPN > Advanced > Ceruficate to SSL
VPN Connection Profile Maps submenu, click the Add button under the Mapping
Criteria area.

Stap 2 Configure the Field, Component, Operator, and Value fields lor the mapping
criteria. Click OK to aceept the changes.

The following items can be selected under the Mapping Criteria:

m  Field: From the drop-down list, choose the part of the certificate that you want
to evaluate.

—  Subject: The person or system that uses the certificate. For a CA root
certilicate, the subject and issuer are the same.

— Alternative Subject: The alternative subject names extension allows
additional identities 1o be bound to the subject of the certilicate.

—  lIssuer: The CA or other entity (jurisdiction) that issued the certificate.

m  Component: (Applies only il Subject or lssuer is selected.) Choose the
distinguished name component that is used in the rule:

— Country (C): The two-letter country abbreviation. These codes conform
to IS0 3166 country abbreviations.

—  Common Name (CN): The name of a person, system, or other entity.
This component is the lowest (most specific) level in the identification
hierarchy.

— DN Qualifier (DNQ): A specilic DN atribute.

—  E-mail Address (EA): The email address of the person, system, or entity
that owns the certificate.
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Step 3

—  Generational Qualifier (GENQ): A generational qualifier such as Jr.,
S, or L1L

— Given Name (GN): The first name of the certificate owner.

— Initials (1): The first letters of each part of the name of the certificate
W ner.

—  Laeeality (L) The city or town where the organization is located.
— Name (N): The name of the certificate owner.

—  Organization (0): The name of the company, institution, agency,
association, or other entity.

—  Organizational Unit (OU): The subgroup within the organization.
— Serial Number (SER): The serial number of the certificate.
— Surname (SN): The family name or last name of the certificate owner.

— State/Provinee (8/P): The state or provinee where the organization is
located.

—  Title (T): The title of the certificate owner, such as Dr.
— User 1D {UID): The identification number of the certificate owner.

— Unstructured Name (UNAME): The name or names of a subject as an
unstructured ASCI! string,

— P Address (1P): 1P address field.
s Operator: Choose the operator that is used in the rule:
—  Equals: The disunguished name field must exactly match the value.
—  Contains: The distinguished name field must include the value wathin i
—  Duoes Not Equal: The distinguished name field must not mateh the value.

—  Does Not Contain? The distinguished name field must not include the
value within 1t

—  Value: Enter up to 255 charaeters to specily the object of the operator.

In the example, if the subject orzanizational unit field of a certificate contains the
“Engineering” string, a user with that certificate will be mapped to the BASIC-
ANYCONNECT-PROFILE connection profile.

Click Apply to apply the configuration.
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Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA

Task 6: Enable Certificate Authentication in
Connection Profile
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Finally, you have to enable certificate-based authentication for a specific connection profile. To

enable chent-based authentication for a specific connection profile by using Cisco ASDM,

complete the following steps:

Step 1 Inside the ASDM, choose Configuration > Remote Aecess VPN = Network
(Client) Aceess = AnyConnect Connection Profiles. The AnyConneet Connection
Profiles window is displayed (not shown in the figure).

Step 2 Choose a connection profile from the Connection Profiles table and elick Edit. In
the example, the BASIC-ANYCONNECT-PROFILE has been selected (not shown
in the figure). The Edit SSL VPN Connection Profile window is displayed.

Stap 3 Click the Certifieate radio button 1 the Authentication section of the window.
Step 4 Click OK.
Step 5 Click Apply 1o apply the configuration.

Note The Cisco ASA sdaptive security appliance has suppaorted certificate authentication per
connection profie since the Cisco ASA Software Release B.2(1}.
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CLI Configuration
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To use the CL1to configure certificate-based authentication using the local CA, use the
following commands. To configure the SMTP server that 18 used to send email notification, use
the SMTP-server command. To enable the local CA server, first use the ervpto ea server 1o
enter CA server configuration mode: Inside CA server configuration mode, configure the CA
name by using the issuer-name command. Specily the lifetime of issued certificates by using
the lifetime certifieate command. Use the smip (rom-address command to specify the email
address that the Cisco ASA adaptive security appliance will use as a from address to send email
notifications with certificate download instructions. Specify the size of the key that is used for
the CA certifieate and the size of the key that s used Tor the certificates of clients by using the
keysize server and keysize commands, respectively. Specily the CRL distribution point that
will be included in certificates using the cdp-url command. Finally, enable the local CA server
by using the no shutdow ncommand, followed by a passphrase keyword and a password Lo
protect the CA certificate and key pair archive.

To create user accounts for users who are eligible to obtain a certificate, use the erypto ca
server user-db add command, lollowed by the DN and email address of the vser. To allow a
user to oblain a certificate, use the erypto ea sever user-db allow command.

To create a certificate-to-connection-prolile mapping using the CL1, use the following
commands. First, create a certificate-lo-connection-prolile map by using the ervpto ea
certificate map command, followed by a name and rule priority number. Then use the subjeet-
name atrr command to specily which attribute 1n a subject name should contain which value.
Finally, configure mapping between a connection profile and connection profile map using the
certificate-group-map command in webvpn configuration mode. In the example, if the Cisco
ASA adapuve security appliance receives a certificate where the organizational unit field of' a
subject name contains “Engineering,” the Cisco ASA adaptive security appliance will use the
BASIC-CONNECTION-PROFILE connection profile lor that user.

Finally, enable certificate-based authentication for a specific connection profile (tunnel group)
using the authentication certilicate command in tunnel group configuration mode.
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smtp-server

To conligure an SMTP server, use the smip-server command in global configuration mode. To
remove the attribute from the configuration, use the no form of this command,

smip-server {primany_server} [backup server]

smtp-server Parameters

Parameter Description
backup server |dertifies & backup SMTF server to relay event messages if the
primary SMTP server is unavailable. Use either an |P address or
NS name.
primary server |dentifies the primary SMTP server. Use either an IF address or
DNS nama.
issuer-name

Tospectfy the issuer name DN of all issued certificates, use the issuer-name command in focal
CA server configuration mode. To remove the subject DN from the cenilicate authority
certilicate, use the no form of this command.

issuer-name ON-siring

issuer-name Parameters

Parametor Description

DN-string Specifies the distinguished name of the certificate, which is also the subject name
DM of the self-zigned CA certificate. Use commas to separate attribute-value
pairs. Insert guotation marks around any value that contains 2 comma. An issuer
name must be less than 500 alphanumernic characters.

lifetime (ca server mode)

To specify the length of time that the local CA cenilicate, each issued user certificate, or the
certificate revocation list (CRL) is valid, use the lifetime command in CA server configuration
mode. To reset the lifetime to the default setting, use the no form of this command.

lifetime {ca-certificate | certificate | erl} iime

lifetime (ca server mode) Parameters

Parameter Description

ca-certificate Specifies the lifetime of the local CA server certificate.

cartificate Specifies the lifetime of all user cerlificates that are issued by the CA server,
exrl Specifies the lifetime of the CRL,
time For the CA certificate and all issued certificates, time specifies the number of

days that the certificate is valid. The valid range is from 1 to 3650 days.

For the CRL, fme specifies the number of hours that the CRL |s valid, The
valid range for the CRL is from 1 to 720 hr.

smtp from-address

To specily the email address w use in the E-mail From field for all emails that are generated by the
lpeal CA server (such as distobution of OTPs), use the smip lrom-address command in CA server
configuration mode. To reset the email address to the default, use the no form of this command.
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smip from-address e-mail address

smtp from-address Parameters

Parameter

Description

e-mail address

that are generated by the CA server.

Specifies the email address that sppears inthe Email From field of all emails

keysize

To specily the size of the public and private keys that are generated by the local CA server at

user certificate enrollment, use the keysize command in CA server configuration mode. To

reset the key size to the default length of 1024 bits, use the no form of this command.

keysize {512 768 | 1024 | 2048

keysize Parameters

Parameter

Description

512

Specifies a size of 512 bits for the public and private keys that are generated at
certificate enrofiment

758

Specifies a size of 768 bits for the public and private keys that are generated at
certificate enroliment

1024

Specifies a size of 1024 bits for the public and private keys that are generated at
certificate enroliment

2048

Specifies a size of 2048 bits for the public and private keys that are generated at
certificate enrollment

keysize server

To specify the size of the public and private keys that are génerated by the local CA server to

configure the size of the key pair of the CA, use the keysize server command in CA server

configuration mode. To reset the key size to the default length of 1024 bits, use the no form of
this command.

Keysize server{512 | 768 | 1024 | 2048}

keysize server Parameters

Paramater

Description

E12

Specifies a size of 512 bits for the public and private keys that are generated at
certificate enrollment

758

Specifies a size of 768 bits for the public and private keys that are generated at
certificate enrollment

1024

Specifies & size of 1024 bits for the public and private keys that are generated at
certificate enrollment

2048

Specifies a size of 2048 bits for the public and private keys that are generated at
certificate enrollment
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cdp-url

Tospecify the CRL distribution point (CDP) to be included in certilicates that are issued by the
loeal CA, use the edp-url command in CA server configuration mode. To revert to the default
CDP, use the no form of this command,

|no| edp-url wr

cdp-url Parameters

Parameter | Description

url Specifies the URL where a validating party obtains revocation status for certificates that
are issued by the local CA. The URL must be fewer than 500 alphanumeric characters.

shutdown (ca-server mode)

To disable the local CA server and render the enrollment interface inaceessible to users, use
the shutdown command in CA server configuration mode. To enable the CA secver, lock down
the configuration from changes, and render the enrollment interface aceessible, use the no form
of this command.

[no] shutdown

crypto ca server user-db add

Toinsert a new user into the CA server user database, use the erypto ca server user-db
add command in privileged EXEC mode.

eryplo ca server user-db add wser [dn dn] [email e-mail-address]

crypto ca server user-db add Parameters

Parameter Description

dn dn Specifies a subject name distinguished name for certificates that
are issued to the added user. If a DM string contains a comma,
enclose the value string with double guotes (for example,
O="Company. Inc.”}.

email e-mail-address Specifies the email address for the new user.

user Specifies a single user to whom enroliment privileges mav be
granted. The username can be a simple Username or an email
address.

crypto ca server user-db allow

To permit a user or a group of users to enroll in the local CA server database, use the erypto ea
server user-db allow command in privileged EXEC mode. This command also includes
options Lo generate and display OTPs or to email them to the users.

cryplo ca server user-db allow {username | all-unenrolled | all-certholders | [display-otp]
[email-otp] [replace-otp |
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crypto ca server user-db allow Parameters

Parameter Description

all-cartholders Specifies that enroliment privileges be granted to all users in the database
who have been issued a certificate, whether the certificate is currently valid
or not, This specification is equivalent to granting renewal privileges.

all-unenrolled Specifies that enroliment privileges be granted to all users in the database
who have not been issued a certificate:

emall-otp [Cptional) Sends the specified users OTPs by email to their configured email
addreszes.

replace-otp (Orptional ) Specifies that OTPs be regenerated for all specified users who
originally had valid OTPs.

display-otp [Cptional) Displays the OTPs for all specified users to the console.

uEernams Specifies s single user to whom enroliment privileges may be granted. The

username can be a simple username or an email address.

crypto ca certificate map

Toenter CA certificale map mode, use the erypto ca certificate map command n global
conliguration mede. Executing this command places you in CA certificate map mode. Use this
group of commands to maintain a pnortized list of certificate mapping rules. The sequence
number orders the mapping rules. To remove a erypto CA certilicate map rule, use the no form
of the command.

crypto ea certificate map |seguence-number | map-name sequence-number |

crypto ca certificate map Parameters

Parametar Description

map-nams Specifies a name for & certificate-to-group map.

ssguanca-number Specifies = number for the certificate map rule that you are creating. The
range is 1 through 65,535, You can use this number when creating a tunnel
group map, which maps a tunnel group to a certificate map rule.

subject-name (crypto ca certificate map)

To indieate that a rule entry is applied to the subject DN of the 1Psec peer certificate, use
the subject-name command in erypto CA certificate map configuration mode. To remove a
subject name, use the no form of the command.

subject-name [attr fag eq | ne | ¢o | ne string)
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subject-name (crypto ca certificate map) Parameters

Parameter Description

attr tag | Indicates that only the specified attribute value from the certificate N will be comipared
to the rule entry strimg, The tag values are as follows:

m C=Country

m N = Commaon name
= DNQO = DN gualifier
= BA = Email acdress

» GENQ = Generational gualifier
m -GN = Given name

m | =Initials

s [P =P address

m L= Locality

= N=Name

m = Crganization name

n  OU = Organizational unit

= SER = Serial number

m 3N = 3urname
m 5P = State/Province

m  T=Title
UMNAME = Unstructured name

ca Specifies that the rule entry string must be a substring in the DN string or indicated
attribute.

ag Specifies that the DM string or indicated attribute muest match the entire rule string.

ne Specifies that the rule entry string must not be a substring in the DN string or indicated
attribute.

ne Specifies that the DM string or indicated attribute must not match the entire rule string.

string Specifies the value to be matched.

certificate-group-map

To associate a rule entry from a certificate map with a tunnel group, use the certificate-group-
map command in webvpn configuration mode. To clear current tunnel group map associations,
use the no form of this command.

certificate-group-map certificate_map _name index tunne!_group_name

certificate-group-map Parameters

Parameter Description

certificate _map nama The name of a certificate map.

index The numeric identifier for a map entry in the certificate map. The
index value can be range from 1 1o 65535

tunnel group name The name of the tunrel group that is chosen if the map entry
matches the certificate. The tunnel group name must already
exist.
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authentication-certificate

To request a certificate from a WebVPN client that is establishing a connection, use
the authentication-certificate command in webvpn confliguration mode. To cancel the
requirement for a client certificate, use the no form of this command.

authentication-certificate inferfoce-name

authentication-certificate Parameters

Parameter Description

interface-namea The name of the interface that is used to establish the connection. Available
interfaces names include the fallowing:

»  Inside: Name of interface GigabitEthernet 0/ 1
m  Outside: Name of interface GigabitEthe rnet 00

e 7
Configure Certificate-Based Client Authentication Using
the Cisco ASA Security Appliance Local CA
Implementation Guidelines
Consider the following implementation guidelines:
« Do not distribute OTPs over untrusted networks

» Securely provision a CA certificate (the issuer of the identity
certificate of the Cisco ASA adaptive security appliance) lo
the client

When implementing centificate-based authentication, consider the following implementation
guidelines:

®  Ensure that you do not distribute OT Ps that are needed to obtain the client identity
certificates, over untrusted networks.

®  The local CA is capable of provisioning and managing identity certificates lor clients,
However, the local CA cannot 1ssue an identity certificate to the Cisco ASA adaptive secunty
appliance. That is why the security appliance has to obtam an identity eertificate from an
external PKI system. This identity cernficate is signed by the external CA. For the client to
authenticate the Cisco ASA adaptive secunty appliance, you must sull securely provision a
CA certificate (the issuer of the identity certificate of the security appliance) to the elient.
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L1
Verify Certificate-Based Client Authentication Using the

Cisco ASA Security Appliance Local CA

Verify Client Certificates
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You can verify obtained client certilicates by choosing Tools > Internet Options = Content =
Certificates in Internet Explorer. A Certificates window 1s displayed where vou can review
your centificates, In the example, you ean see in the certilicate store that there is a certificate
that is 1ssued to vpouser, You can verify the detaiis of the ceruficate, such as certificate
validity, DN, and key length, by double-clicking the certificare.
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Verify Certificate-Based Client Authentication Using the
Cisco ASA Security Appliance Local CA

WVerify Authentication Policy
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To verily established 5851 Cisco AnyConnect sessions using the Cisco ASDM, choose
Monitoring > VPN = VPN Statistics > Sessions (not shown in the figure). Choose the 351
VPN Client option frem the Filter By drop-down menu to show S5L Cisco AnyConnect
eonnections (not shown in the figure). Select a specific connection from the table and elick the
Details button (not shown in the figure). The Session Details window 15 displayed. In the
Session Details section of the window, verify which conneetion profile is used lor the
connection. In the example, the BASIC-ANYCONNECT-PROFILE is used for the connection.
Click the Details tab o verily that certificates are used for authentication.
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Verify Certificate-Based Client Authentication Using the
Cisco ASA Security Appliance Local CA

Manage Certificates
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When using the Cisco ASA adaptive security appliance as alocal CA, you can use Cisco
ASDM to manage certilicates that are 1ssued to a client. The management of certificates
includes revoking and unrevoking of the cenificates of users. To revoke or unrevoke a
certificate using Cisco ASDM, complete the following steps:

Step 1 Inside the ASDM, choose Configuration > Remote Aecess VPN = Certificate
Management > Local Certifieate Authority > Manage User Certilicates.

Step 2 Select a certificate from the table.
Stap 3 Click the Revoke button to revoke the certilicate.
Step 4 Click the Unrevoke button to unrevoke a revoked certilicate.

Torevoke a certificate using the CLI, use the erypto ea server revoke command, lollowed by
the certificate serial number.

To unrevoke a certificate, use the erypto ea server unrevoked command, followed by the
certificate serial number.

crypto ca server revoke

To mark a certificate that 15 issued by the local CA server as revoked in the certilicate database
and the CRL, use the eryplo ca server revoke command in privileged EXEC mode.

crypto ca server revoke cert-serial-no

crypto ca server revoke Parameters

Parametar Description

cert-geriai-no Specifies the serial number of the certificate to be revoked. Enter
the serial number in hexadecimal farmat.
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crypto ca server unrevoke

To unrevoke a previously revoked cerlificate that is issued by the local CA server, use
the erypto ea server unrevoke command in privileged EXEC mode.

eryplo ca server unrevoke cert-serial-ngo

crypto ca server unrevoke Parameters

Parameter Description

ert-gerial-no Specifies the serial number of the certificate to be unrevoked,
Enter the serial number in hexadecimal format.
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Deploying Advanced PKI Integration

This topic describes how to configure and verify integration with supporting PKI entities.

Configure Advanced PKI Integration

Overview

The Cisco ASA adaptive
security appliance must

provide revocation R'
methods o reduce a P
risk of compromised J
credentials: i - e ﬁ'
* CRLs ,
= OCSP a ,l'l Citca ASAAdagive -

ocse
Y
g ;@' Sty Aodianse I
= AAS gutherization : -
BAA

The appliance may
need {o provide a AAA
per-user settings server
for certificate users

In some cases of certificate-based client authentication, advanced integration with existing PK1
is needed. Advanced PRI itegration includeés configuring a revocaton method to reduce a risk
of compromised certificates, Certificates are considered compromised when a cenificate was
issued improperly by a CA or a private key matching a public key on the cerfificate is thought
1o be compromised. For example, 1f the laptop of & user that stores a cenificate and a matching
private key 1s lost, the centificate should be revoked. Another example would be revocation of

certificates belonging to users who are no longer employed at an organization.
A cectificate revocation method can be implemented in the following ways:

m  Conliguring certificate revocation lists (CRLs): A CRL 1sa hstof senal numbers of

certilicates that have been revoked and are no longer valid. A CRL 18 generated and
published by the CA that issues corresponding certilicates and 1s updated periodieally or
immediarely after a certificate has been revoked. You can configure the Cisco ASA
adaptive security appliance to make CRL checks mandatory when authenticating a
certilicate. The Cisco ASA adaptive security appliance needs a CRL location to verify the
certilieates of clients. A CRL location can be found in a CRL distribution point (CDP) that
is specilied in an identity certilicate. The security appliance can download a CRL using
HTTP, LDAP, or Simple Cenificate Enrollment Protocol (SCEP).

Conliguring Online Certilicate Status Protocol (OCSP): OCSP is a protocol Tor
obtaining the revocation status of digital certificates. OCSP messages are usually
communicated over HTTP. You can configure the Cisco ASA adaptive secunity appliance
to make QTSP checks mandatory when authenticating a certificate. The location of the
CICSP server on the Cisco ASA adaptive seeurity appliance can be configured as an OCSP
LRL that is defined in a match cenificate rule. The location can be statically conligured as
an QTSP URL, or it can be specified in the Authonty Information Access (ALA) lield of
the authentieating certificate.

3182

Daplaying Cisco ASA VPN Solubans (VPN) v1.0 & 2010 Cisca Systams, Ins,



Nota The OCSP server is being termed as the OCSP responder.

s  Configuring AAA authorization of the certificate of a user: You can also revoke user
authorizaton by deploving an external RADILS server. When the Cisco ASA adaptive
security appliance receives the certificate of a user, it sends a predefined field from the
certificate as a username and a predefined (eommon to all users) password to the RADIUS
server, which authorizes the user. On the RADIUS server, users with proper usernames
(which match predefined fields in the user certificates) and passwords, have 1o be
conligured. I you want to revoke user authorization; you have to delete or disable a user
account that corresponds to the centificate that you want to revoke.

Configure Advanced PKI Integration

Configuration Tasks
1. (Optional) Configure a certificate revocation checking policy.

2. (Optional) Configure AAA authorization revocation.

CRL Use thie mathod as the laet rason, if there arano
tettar methods availabla.

0csp Usa thie method if you have an OCSP sarvar
avallable and cannatl uss AAL

AAA Ues this methed f you have 2 ASA sanvar
availabla.

s it if you naed to aleo aesign AAS par-usar of
pargmoup altributes (IP-addresses, accese contml
lists [ACL=]; and & an)

These are the configuration tasks that are involved in configuring advanced PK1 integration:
1. Optionally, configure a certificate revocation checlkdng policy.
2. Opuonally, or alternatively, configure AAA user authonization based on certificate identity.

These tasks are identical 1o those that are used in Cisco Easy VPN deployment, and are
therefore not discussed here.,
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Deploying Multiple Client Authentication

This topic deseribes how to configure and verify multiple client authentications.

Configure Multiple Client Authentication

Cverview
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Cisco AnyConnect VPN solutions offer multiple client authenticanon. With multiple
authentications, clients can be first authenticated by using a certificate. After the Cisco ASA
adaptive security appliance validates a certificate, an S5L tunnel is established. Inside the
SSL tunnel, users may have Lo authenticate again by using & username and a password or a
one-time password (OTP). This AAA authentication can be performed against one or two
separate databases.
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Configure Multiple Client Authentication
Deployment Options

= Client-side authentication opflicns:
- Certificate-based and cne AAA authentication

— Certificate-based and ocne AAA authentication with
usermame prefill
— Certificate-based with one AAA authentication with hidden
prefilled hide
* Double A&A authentication (no certificate)

— With cptional username reusa

You can deploy one of these muluple authentication combinations:

®  Certificate-based and one AAA authentication

®  Certificate-based and one AAA authentication, where a username for AAA authentication

can be extracted from a certificate subject field (username prefill)

®  Certificate-based and one AAA authentication where a username for AAA authentication

can be extracted from a certificate subject field and hidden from users

®  Double AAA authentication (no certificate) with optional username reuse

All of these options are used to perform client-side authentication. The security appliance

authenticates the clients by using any of these methods.
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Configure Multiple Client Authentication
Certificate and One AAA Authentication
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To confligure certificate-based and one AAA client authentication; complete the following
configuration steps in the Cisco ASDM:

Stap 1

Stap 2

Step 1

Step 2

Stap 3

Inside the ASDM, choose Configuration > Remote Aecess VPN = Network
(Client) Aceess = AnyConnect Connection Profiles.

Choose a connection profile and elick Edit (not shown in the example). The Edit
SSL VPN Connection Profile window is displayed.

Malke sure that the Basic option is selected {tom the menu on the left.

In the Authenteation section ol the Edit 851 VPN Connection Profile window,

choose the Both radio button te enable anthentication by using certificates and
AAAL

From the AAA Server Group drop-down menu, choose either Loeal or a AAA
server group to perform the AAA authentication.

The figure shows the Cisco AnyConnect interface in which the user must enter the username
and password that is required lor the AAA authentication. The AAA authentication is
performed after the cenificate authentication.
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Configure Multiple Client Authentication
Certifica
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The figure illustrates the configuration of the Pre-fill Username from Certificate feature. The
security appliance can extract the username from the user identity certilicate and use 1t for
AAA authentication.

Complete these steps to enable the username prefill feature:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Choose Configuration > Remote Aeeess VPN > Network (Client) Access >
AnyConneect Connection Profiles o edit the desired connection profile.

Choose the Anthentication submenu.

Check the Pre-fill Username from Certificate check box to specily that the
username field should be populated automatically from a specific field in a
certificate.

Click the Speeily the Certilicate Fields to Be Used as the Username radio button
to select that a username will be derived (rom a specified certificate field. Multiple
options exist:

®  Choose a value from the Primary Field list. This method is set by default to CN
{ Common Name). You can augment this selection by defining the secondary
field that will be extracted if the primary field does not exist.

m  Custom methods.
Click OK in the Edit $5L VPN Connection Profile.
Click Apply to apply the configuration.

When the Cisco AnyConnect client connects to the 851 VPN and seleets (or is assigned o) the
connection profile that 1s configured for certificate-based and AAA authentication with the
username prefill feature, the Username field in the Authentication tab is filled in and srayed
out. The user cannot modify it and is only prompted for the corresponding password. This
password may be checked against either the local or an external AAA database, depending on
the configuration of the connection profile,
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Configure Multiple Client Authentication
Certificate and One AAA Authentication with Prefill and Hide
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Codfigraion > Ramma fooess VAN > Network (e} Aooess > Arplionnecs Gonnecson Srolies

In addition to using the username prefill feature, you may enhance security by hiding the
username from the authenticating users, This option improves security in situations when an
unauthorized person tries to break into the VPN by using a stolen computer.

To enable the username hide feature, eheck the Hide Username from End User check box in
the Authentication menu of the connection profile.

When the username is extracted [rom the certilficate and hidden from the end user, users are
only prompted for a password when they connect by using the respective connection profile.
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Configure Multiple Client Authentication

Double AAA Authentication
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You ean also enable double AAA authentication. In this case, you should choose AAA instead
of Both as the authentication methed in the Basic menu of the connection profile conliguration.

Configure Multiple Client Authentication
Double AAA Authentication (Cont.)
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The ligure shows the Cisco AnyConnect elient connecting to a connection profile that is
configured for double authentication. The user is prompted to enter a primary username and
password and a secondary username and password.
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Configure Multiple Client Authentication

CLI Configuration

* Cerfificate and one AAA authentication with pre-fill and hide
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To confligure certificate and AAA chent authentieation using the CLIL, use the following
commands. First, enter tunne! group configuration mode by wsing the tunnel-group command,
followed by the wnne! group name and the general-attributes keyword. Then, use the
authentication-server-group command to configure a AAA server group that will be used for
primary authentication.

MNext, enter tunnel group configuration mode for Web VPN attributes using the unnel-group
command, lollowed by the winnel group name and webvpn-attributes keyword. Use the pre-
fill-username ssl-client hide command to specily that the username will be extracted {rom a
certilicate. Finally, enable AAA and certificate authentication by using the authentication
certificate aaa command.

To configure double AAA chent authentication using the CLIL use the following commands.
First, enter tunnel group conliguration mode by using the wnnel-group command, followed by
the tunnel group name and the general-attributes keyword. Then, configure AAA secver
eroups that will be used for primary and secondary authentication by using the authentication-
server-group and secondary-authentication-server-group commands, respectively.

Next, enter tunnel group configuration mode for WebVEN attributes by using the tunnel-group
command, followed by the tunnel group name and the webvpo-atiributes keyword. Enable
AAA authentication by using the authentication aaa command.

tunnel-group general-attributes

To enter the general-attributes configuration mode, use the tunnel-group general-
attributes command in global configuration mode. This mode is used to configure settings that
are common Lo all supported tunneling protocols.

To remove all general attributes, use the no form of this command.

tunnel-group name general-atiributes
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tunnel-group general-attributes Parameters

Parameter

Description

ganeral -attributes

Specifies attributes for the tunnel group

rame

Specifies the name of the tunnel group

authentication-server-group (tunnel-group general-attributes)

To specify the AAA server group to use for user authentication for a tunnel group, use
the authentication-server-group command in tunnel-group general-attributes conliguration
mode. Tao return this attribute to the default, use the no form of this command.

authentication-server-group [(interface_name)| server group [LOCAL]

authentication-server-group {tunnel-group general-attributes) Parameters

Paramaeter

Description

(Optional} Specifies the interface where the IPsec tunnel
terminates

(Optional} Requires authentication against the iocal user
database if all of the servers in the server group have been
deactivated due to communication failures

s8rvVer group

ldentifies the previously configured suthentication server or group
of servers

secondary-authentication-server-group

To specily a secondary authentication server group Lo assoeiate with the session when double
authentication is enabled, use the secondary-authentication-server-group command in
tunnel-group general-attributes mode. To remove the attribute from the configuration, use

the no form of this command.

secondary-authentication-server-group [interface name] {none | LOCAL
| groupname [LOCAL]} [use-primary-username]}

secondary-authentication-server-group Parameters

Parameter Description

interface name {Optional) Specifies the interface where the IPsec tunnel
terminates.

LOCAL [Optional) Reguires authentication against the local user
database if all of the servers in the server group have been
deactivated due to communication failures. If the server group
name is either LOCAL or NONE, do not use the LOCAL keyword
hara.

nona [Optional} Specifies the server group name a3 NONE, indicating
that authentication is not required

aroupname [LOCAL] lgentifies the previously configured authentication server or group

of servers. Optionally, this group can be the LOCAL group.

use-primary-usernams

Use the primary username &8 the username for the secondary
authentication,
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tunnel-group webvpn-attributes

To enter webvpn-attribute s configuration mode, use the tunnel-group webypn-
attributes command in global configuration mode. This mode conligures settings that are

common to Web VPN tunneling,
To remove all WebVEN attributes, use the ne form of this command.

tunnel-group mame webvpn-attributes

tunnel-group webvpn-attributes Parameters

Parametar Description
webvpn-attributes Specifies WebWPM attributes for the tunnel group
namea Specifies the name of the tunnel graup

pre-fill-username

Toenable extraction of & username from a client certificate for use in authentication and
authorization, use the pre-fill-username command in tunnel-group webvpn-attributes mode. To
remove the attribute from the configuration, use the no form of this command.

pre-fill-username |ssl-client | dientless)

pre-fill-username Parameters

Parametar Description
ggl=client Enables this feature for Cisco AnyConnect VPN Client
connections
clientless Enables this feature for clientiess connections
hide Coes not display the extracted username to the end user
authentication

To configure the authentication method for Web% PN, use the authentication command in
various modes. To restore the default method, use the no form of this command. The adaptive
security appliance authenticates users Lo verifly their identity.

authentication ||aaa) [certificate]]

authentication Parameters

Paramatar Description

aaa Frovides & username and & password that the adaptive security
appliance checks against a previocusly configured AAA server

cartificats Provides a certificate during SSL negotiation
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Configure Multiple Client Authentication
Implementation Guidelines

Consider the following implementation guidelines

» Deploy cerlificate with AAA authentication to provide separate
machine and user authentication

= When deploying double AAA authentication, consider
mplementing twe-factor authentication:

— Based on “somsthing you know” (password) and
“something you have™[OTF token)

— R3A SecurlD must be configured as primary AAR server
— Implement prefill feature to improve user experience

Consider the following configuration guidelines when implementing muluple client

authentication:

m  Deploy “certificate — AAA"™ authentication to provide separate maching and user

authentication

®  When deploying double AAA authenueation (with or without certificates), consider

implementing two-factor authentication:

—  Based on “something you know" | password) and “something you have” (OTP

token).

—  RSA SecurlD must be configured as the primary AAA server.

—  Consider implementing the prefill or “use primary username” leature to improve

LSEr experience.
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Summary

This topic summarizes the key points that were discussed in this lesson.
]

Summary

= To increase scalability and manageability, you can deploy
centralized AAA password-based authentication.

= You can configure SSL VPN to support password
authentication against external password databases.

= Afull tunneling Cisco AnyConnect 8L VPN supports
S3L/TLS authentication using client identity certificates. The
Cisco ASA adaptive security appliance includes a local CA
that can deploy and manage client identity certificates.

= Consider an appropriate revecation checking method.

= Consider using multiple user authentication in specific
envirenments te further reduce risk of identity theft.

References

For additional information, refer to these resources:

m AS4 8.x AnyConnect SCEF Envollment Configuration Example at
htep://eiscosystems. com/en/US products/psa 1 20/products configuration_example09186a00
80b25del shiml

w454 8. AnyConnect S5L VPN CAC-SmariCards Configuration for Windows at
http:/fwww cisco.com/en/US/ products/psb | 20/products_configuration_example09 [ 86a(08
(19a2b93 shuml
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Module Summary

This topic summarizes the key points that were discussed in this module.

Module Summary

* Abasic Cisco AnyConnect full tunnel SSL VPN allows users
fiexible client-based access to sensilive resources over a
remete-aceass VPN gateway, implemented on the Cisco ASA
adaptive security appliance.

= OTLS is an alternative VPN transport protocol to SSLUTLS.

= When you are deploying VPNs, it is very impertant to use
streng authentication options,
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Module 4

Deployment of Cisco ASA
Adaptive Security Appliance
Clientless Remote Access
VPN Solutions

Overview

Clientless Secure Sockets Layer (SSL) virtual private network (VEN) solutions provide
browser-based access 1o resources behind the Cisco ASA adaptive security appliance. In
clientless SSL VPNs, users can access resources without any special client software. Using
clientless SSL VPNs, users can access web-based applicatons, Common Internet File System
(CIFS) file shares, and FTP servers. Using application plug-ins, port forwarding, and smart
tuanels; you ean access almost any application that uses static TCP ports. The module describes
deployment of the basic elientless SSL VPN, as well as advanced application access, and
advanced authentication. This module also deseribes how to customize the chientless SSL VPN
portal to the needs of the organization.

Module Objectives

Upan completing this module, you will be able to implement and maintain a Cisco clientless

remote access SSL VPNg on the Cisco ASA adaptive security appliance VPN gateway

according 1o policies and environmental requirements. This ability includes being able to meet

these obiectives:

m  Deploy and manage basie clientless VPN features of a Cisco ASA adaptive security
apphiance clientless SSL VEN

m  Deploy and manage advanced clientless VPN application access features of a clientless
S8SL VEN

s Deploy and manage advanced authenuication features of a clientless S5L VEN

®  Deploy and manage advanced clientless VPN application access features of a clientless
SSL VEN
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Lesson 1

Deploying a Basic Clientless
VPN Solution

Overview

A basic elientiess Cisco SS5L VPN solution allows users browser-based access to sensitive
resoUrces Over a remote aceess Seeure Sockets Layver (S8L) virtual private network {VPN)
gateway that is implemented on the Cisco ASA adaptive security appliance. A basic Cisco ASA
clientless SSL VPN uses basic user authentication with usernames and passwords, basic S85L
VPN portal features, and a single access control policy. This lesson enables you 1o configure,
verify, and troubleshoot a basic clientless SSL VPN solution.

Objectives
Upon completing this lesson, you will be able to deploy and manage basic clientless VPN
features of a Cisco ASA adaptive security appliance clientless S8L VPN, This ability includes
being able to meet these objectives:

Plan the eonliguration of aclientless S5L VPN solution

Configure and verily basic Cisco ASA adapuive security applianee gateway leatures for a
clientless SSL VEN solution

Configure and verily password-based local user authentication in a clientless S5L VPN
solution

Configure and verily basic portal features and access control ina clientless 881 VPN
solution

Troubleshoot VPN session establishment between a browser client and a Cisco ASA
adaptive security appliance gateway



Configuration Choices, Basic Procedure, and
Required Input Parameters

This topic describes how to plan the configuration of a clientless 5L VPN solution.

Basic Cisco Clientless SSL VPN

Solution Components

SELTLS sasxan

Uedrustad Nataars

Campuar
with Erowdr

In a basie Cisco ASA adaptive security appliance chentless SSL VPN solution, remote users
use a standard web browser to establish a Secure Sockets Layer or Transport Layer Security
(SSL/TLS) session with the Cisco ASA adapuive security appliance. The basic solution uses
bidirectional authentication, where the ¢lient authenticates the Cisco ASA adaptive security
appliance with a certificate-based authentication method, and the appliance authenticates the
user based on a username and password against its local user database. Alter authentication, the
Cisco ASA adaptive security appliance applies a set of authorization rules to the user session,
and presents the user with a web portal over which the user can access internal resources only
using a browser. In the basic clientless solution, the client can only use some services, such as
web application access and browser-based file-share access Lo internal resources.

-
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Basic Cisco Clientless SSL VPN
Deployment Tasks

1

R T~

Canfigure basic Cisco ASA gateway features including
SSL/TLS server authentication.

Configure loeal user authentication:
Caonfigure basic portal features and access confrol.
(Oplienal) Tune basie 35L VPN proxy operaticn.

Use the following general deployment tasks o create a basic Cisco ASA clientless SSL VEN:

8

()

Configure the Cisco ASA adaptive security appliance with basic 851 VPN gateway
features, including provisioning the identity certificate of the appliance to enable SSL/TLS
server authentication.

Configure basic user authentication by conlipuring the local user database on the Ciseo

ASA adaptive security appliance to create user accounts with static passwords.

Configure basic S8L VPN portal features and basic aceess control, limiting access to the

enterprise network.

Tune the configuration of the Cisco ASA adaptive security appliance 851 VPN proxy

operations Lo support potentially prablematic applications.
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Basic Cisco Clientless SSL VPN

Input Parameters

Paramater

VPN gateway addressingand  Required to canfigure Cisso ASA P inedaces
naming. and DNS resolutian for tha VPN gateway

Canfficata policy and settinge  Raguired to enroll tha Cieco ASA inta 3 PHI
Lesr naming and cradantiale  Required 1o craate the localusar databass

Cryptographic palicy Reguired to enable or disabla cryptographic
algarithme within SSLTLS
Accass polisies Ragqurred o create sapamats profiles and access

contral policias for amote users

Before implementing a basie Cisco ASA clientless 5L VPN, you will need to obtain and
analyze several pieces of information that are related to the network and system enviconment.
These input parameters include the following:

The 1P addressing plan that will dictate the SSL VPN gateway [P addressing, and the
enterprise naming plan that will dictate the name of the SSL VPN gateway. This data is
needed 1o assign an 1P address to the Cisco ASA adapuve security appliance VPN-
terminating interface, and to assign a name mnsde the SSL VPN gateway SSLTLS
identity certificare.

The enterprise certilicate policy and certificate settings to inelude all relevant fields inside a
PKl-provisioned certilicate, to enroll the Cisco ASA adaptive security appliance into a PK1
(1f so desired).

The enterprise policy of user naming and the enterprise password policy, to create the local
user database on the Cisco ASA adaptive security appliance.

The enterprise cryptographic poliey, to choose the optimal S8L/TLS protocol versions and
algorithm bundles (cipher suites) for SSL/TLS sessions on the Cisco ASA adaptive security
appliance.

Access policies that dictate which sensitive resources remote users can access. These
policies are needed to configure an access control poliey on the Cisco ASA adaptive
security appliance that will be applied to clientless SSL VPN sessions,
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Configuring Basic Cisco ASA Adaptive Security
Appliance SSL VPN Gateway Features

This topic deseribes how to configure and verify basic Cisco ASA adaptive security appliance
gateway leatures for clientless SSL VPN,

. 1
Configuring Basic Clientless SSL VPN
Features

Configuration Tasks

Provision an idenlity server certificate to the ASA”
Enable 85L VPN termination on an interface.
Cenfigure and optienally tune SSL/TLS settings.
(Optional) Create a DMS server group.

[S IS

* Confguraton of 1nis 188k '3 e game 83 = Ciaco AnyConnect VNS

To configure basic Cisco ASA adaptive security appliance SSL VPN gateway Teatures for
clientless aceess, complete the following conliguration tasks:

L. Provision an identity server SSLTLS certificate to the Cisco ASA adaptive security
appliance. This task is performed in the same manner as the related task in 881 YPNs that
are based on the Cisco AnyConnect VPN,

bk

Enable SSL VPN termination on a Cisco ASA adaptive security appliance interlace and
therefore enable the Cisco ASA adaptive security appliance SSL VPN server function.

3. Configure and optionally tune SSLTLS settings of the 881 VPN server.

4, Upuonally, create a DNS server group if vou want 1o use hostnames instead of 1P addresses
to access internal resources, The DNS settings enable the security appliance to resolve the
hostmames that are specified in the user reguests.
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Features
Configuration Scenario
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This figure presents the configuration seenano that is used in upcoming configuration tasks. The
Cisco ASA adapuve security appliance can either use a sel{-signed certificate or receive is
wenuty certificate from an external or mternal CA server. You will need to conligure the external
Domain Name System [ DNS) infrastructure to resolve the name of the Cisco ASA adapuive
security appliance (inside 1ts identity cemtilicate) to s VPN-terminating interface P address (the
1P address of the outside interface in this exampie). Additionally, you may need the 1P addresses
of internal DNS servers lor the S8L VPN portal to be able to resolve internal URLs.
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Configuring Basic Clientless SSL VPN
Features

Task 2: Enable SSL VPN Termination en an Interface
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For detailed configuration guidance on the first configuration task (provisioning the identity

certificate), refer to the “Deploying a Basie Cisco AnyConnect Full Tunne! 5L VPN Solution™
lesson of this course.

In Task 2, you will globally enable the SSL VPN server function on the Cisco ASA adaptive
security appliance, and select the interface or interlaces on which the appliance will accept
S5L VPN sessions.

Perform the following steps:

Step 1 In the Cisco Adapuive Security Device Manager (Cisco ASDM), choose
Conliguration > Remote Access VPN = Clientless SSL VPN Aecess>
Connection Profiles.

Step 1 Ir the Enable Interfaces for Clientless SSL VPN Access eld, check the Allow Access
check box for the interface on which you want to termunate 5L VPN connections. In
this example, these connections are enabled on the “outside™ inerface,

Step 2 Chick Apply, and elick Save to save vour configuration, if necessary.
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Configuring Basic Clientless SSL VPN
Features

Task 3: Configure and Tune SSL/TLS Setlmgs
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In Task 3

. you need to attach the installed identity certificate to an appropriate Cisco ASA

adaptive security appliance network interface on which you will conligure clientless SSL
VPN termination.

Perform the following steps:

Step 1
Stap 2

Step 3

Step 4

Step 5

Step &

Choose Configuration > Remaote Aecess VPN > Advanced > SSL Settings.

At the top of the SSL Settings window, you can select the S5L and TLS protocol
versions that the appliance will support as the SSL/TLS server. For configuration
guidance on these settings, refer to this same topic in the “Deploying a Basic Cisco
ApnyConneet Full Tunnel 881 VPN Solution™ lesson of this course.

From the 881 Settings window, in the Eneryptien area, you can choose the
eryptographic algorithm bundles (cipher suites) that the Cisco ASA adaptive
security appliance will aceept in the initzal SSL/TLS negotiation. I you need to
change these settings based on a local eryptographic policy, you can enable or
disable specilic bundles here.

In the S5L Settings window, where the interfaces are listed, click the Edit button to
edit the interface or interfaces on which the Cisco ASA adapuive security appliance
will accept 5L YWPN connections.

Lo the Select 851 Certilicate dialog box, choose the Primary Enrolled Certificate

drop-down list, and choose the installed identity certificate. The example in the
ligure 15 using a self-signed identity certificate.

Click OK and Apply, and then elick Save to save your configuration, if necessary.

e
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Configuring Basic Clientless SSL VPN
Features

Task 4: (Opticnal) Create a DNS Server Group
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In the optional Task 4, you will ereate a DNS server group that the Cisco ASA adaptive secunty
appliance will use to resolve internal URLs that are requested by clientless SSL VPN users.

The significance of DNS in clientless SSL VPN is higher than in full tunnel YPNs (Cisco
AnyConnect VPN Clients or Easy VPN Clients), because the VPN server resolves hostnames
separately from the client. The elient specifies the desired resources and the internal
hostnames in the URLs that are sent to the gatewsy. The gateway rewrites the content and
resolves the hostnames to reach the mternal servers. In full tunnel VPNs, only the VPN
clients perform DNS lookup:

You can create multiple DNS server groups, and assign a different DNS server group to each
user group. To create a DNS server group, perform the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Step 7

Choose Configuration = Device Management = DNS > DNS Client.

o the DNS Setup area, click the Configure Multiple DNS Server Groups radio
button.

Chick Add to add a new DNS server group.

In the Add DNS Server Group window, name the new DNS server group by entering
the name in the Name field. ( This example uses CLIENTLESS-DNS-SERVERS lor
the name.)

Enter the addresses of all required DNS servers in the Server [P Address to Add
field, and click Add to add a server to the group.

Specify the local domain suffix in the Domain Name field.

Click OK and Apply, and then click Save to save your configuration, il necessary.
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Configuring Basic Clientless SSL VPN
Features

CLI Configuration

webvpn

e
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1
o TINE smrisr o
dns server-group CLIENTLESS-DNS-SERVERS

domain-name domain.aom
name-gervar 172.15.1.53

The output in the figure shows the CLIcommands that are required to.configure the basic Ciseo
ASA adapuve security appliance 851 VPN gateway leatures using a preprovisioned certificate
in the “MYTRUSTPOINT” trustpoint.

In the CL1, enter the SSL VPN server confliguration submode on the Cisco ASA adaptive

security appliance using the webvpn command, and enable the SSL VPN server on the outside
mterface using the enable command.

Mext, assign the installed idenuty certificate of the Ciseo ASA adaptive security appliance o
the interface using the ssl trust-point command.

Finally, ereate the optional DNS server group using the dns server-group command, and
mside its configuration submode, use the domain-name command to specify the default local

domain suffix and the name-server command or commands o specify all DNS servers that
belong w this group.

dns server-group

To enter the dns server-group mode, in which you can specify the domain name, name server,
number of retries, and umeout values for a DNS server to use for a tunne! groap, use the dns
server-group command in global configuration mode. To remove a particular DNS server
group, use the no form of this command.

dns server -group nome

dns server-group Parameters

Parameter Description

namsa Specifies the name of the CNS server group configuration that should be used for the
tunnel group
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domain-name (dns server-group)

To set the default domain name, use the domain-name command in dns server-group
configuration mode. To remove the domain name, use the no form of this command. The Cisco
ASA adaptive security appliance appends the domain name as a sulTix to unqualified names,
For example, if vou set the domain name to “example.com,” and specify a syslog server by the
unqualified name “jupiter,” then the security appliance qualifies the name to

Jupiter example, com.

domain-name name

domain-name (dns server-group) Parameters

Parameter Description

name Sets the domain name, up to 83 characters

name-server

To identify one or more DNS servers; use the name-server command in dns server-group
configuration mode. To remove a server or servers, use the no form of this command. The
adaptive security appliance uses DNS to resolve server names in your S5L VPN configuration
or certilicate configuration. Other features that deline server names (such as authentication,
authorization, and accounting [AAA]) do not support DNS resolution. You must enter the [P
address or manually resolve the name t an [P address by using the npame command.

name-server ip_address [ip_address?][..] [ip_addressé]

name-server Parameters

Parametar Dascription

ip address Specifies the DNG server IP address. You can specify up to 6 addresses as separate
commands, or for convenience, up to & addresses in one command separated by
spaces. If you enter multiple servers in one command, the Cisco ASA adaptive
security appliance saves each server in a separate command in the configuration. The
appliance then tries each DMNS server in order until it receives a response,
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L.
Configuring Basic Clientless SSL VPN
Features
Implementation Guidelines
Most deployments need to support unmanaged clients.
= Reqguire web server certificate from a global PKI provider.

When you implement basic Cisco ASA clientless S5L VPN gateway features, consider this
implementation guideline:

m  With clientless VWPNs, yvou are likely to support unmanaged VPN clients. 1l vou deploy a
self-signed or private public key mfrastructure (PR 1) certifieate, these clients have no built-
in mechanism to be able to verify the identity certificate of the Cisco ASA adapuve
seeurity appliance, efTectuvely negating all SSL/TLS protection and possibly exposing you
to signilicant risk. If vour Cisco ASA adaptive security appliance SSL VPN gateway is
aceessed by such users, you should install an identity certificate from a global PKI provider
on the Cisco ASA adaptive security appliance.
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Configuring Local Password-Based User
Authentication

This topic deseribes how to configure and verify password-based local user authentication in a
clientless SSL VPN,

Configuring Local Authentication
Password-Based User Authentication Overview
All clientless password-based

users will initially default to the Local Usar Databaes
DefauliWeb'VPNGroup connection ;

2 usamamal/passward |
profile usamamal/paseward2

* DefaultWebVPMNGroup uses local AAA
authentication by default

Alfter configuring basic Cisco ASA adaptive security appliance S5L VPN gateway parameters,
the next deployment task is o configure a user authentication method, and prepare the Cisco
ASA adaptive security appliance with all the necessary configuration objeets to enable later
assignment of VPN policies. In this basic S5L VPN clientless solution, you will deploy simple
password-based user authentication, using the local user database on the Cisco ASA adaptive
security appliance.

When SS5L VPN clientless users connect to the Ciseo ASA adaptive security appliance, the
Cisco ASA adaptive security appliance will initially assign them to the DefaultWebY PNGroup
connection profile. This connection profile is by default configured to use the local user
database for user authentication,
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Configuring Local Authentication

Configuration Tasks
1. Configure group policy.
— Cresate a custom group policy for clientless SSL VPN.
of
- Medify the default group pelicy (not recemmended)

2. {Optional) Create a connection profile for clientless S3L
VPN, and assign a group policy toit.

{Optional) Define alias for a connection profile.
(Optional) Allow connection profile selection.

Configure local users, and optionally, a connection profile
lock.

o Ca

= 1]

To configure local user authentication in a clientless 851 VPN solution, perform the following
configuration 1asks:

l. Configure a group policy using one of two options:
—  Create a custom group policy for clientless 851 VPN,

—  Modify the default group policy. This approach is not recommended, because you
may have problems with grouping users later on.

[

Create a connection profile for clientless SSL VPN, and assign the configured group policy
to it.

3. Optionally, define an alias for the connection profile. An alias makes a profile selectable to
VPN users.

4. Optionally, allow connection profile selection. This option allows the VPN users to connect
using achosen connection profile, il the profile has an alias.

5. Configure local users and, optionally, a connection profile lock. This task is identical to the
Cisco AnyConnect and Easy VPN scenarios and will not be covered here.

418 Daplaying Cisco ASA VPN Solubans (VPN) v1.0 & 2010 Cisca Systams, Ins,



Configuring Local Authentication

Configuration Scenario
» Configuration procedure identical

tz Cisco AnyConnect and Easy BABIC
POLICY

» Clientless-specific parameters
visible throeugh Configuration =

Laoa

Femacte Access WPMN = Clientless de2 Jaznnzs

=3
FROFILE

55L VPN Access menu

SELTLE Sassan

255 A 3A

This figure presents the configuration scenario that is used in upcoming configuration tasks, On
the Cisco ASA adaptive security appliance, you will create a custom connection predile named
BASIC-CLIENTLESS-PROFILE. and a related group policy named BASIC-CLIENTLESS-
POLICY. A user named “vpnuser™ exists in the local user database.

The configuration procedure that 1s shown here 15 identical o Cisco AnyConnect and Easy
WPNs. It is presented to illustrate the reusability of configuration components for the various
VPN types. The group policies and connection profiles can be configured and edited in either
ol the two configuration menus:

m  Conliguration > Remote Access VPN > Clientless SSL VPN Aceess: This menu allows
you to view and conligure parameters that are specific to clientless SSL VPNs. The group
policies and connection profiles that are delined in Configuration > Remote Access VPN
> Network (Client) Aceess also appear here.

®  Configuration > Remote Access VPN > Network (Client) Aceess: This menu allows you
to view and configure parameters specific to full tinnel WVPNs (Cisco AnyConnect VPN
and Psec chients), The group policies and ¢onnection profiles that are defined in
Confliguration > Remuote Access VPN > Clientless S5L VPN Access also appear here.
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Configuring Local Authentication
Task 1A: Create a Custom Group Policy
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In the first configuration task, you will ereate a custom group policy that you will apply to VPN
users. Perform the following steps:

Stap 1

Step 2
Stap 3

Step 4

Step 5

In Cisco ASDM, choose Configuration > Remote Aceess VPN > Clientless SSL1L
VPN Aecess > Group Policies.

Click Add to create a new policy.

Provide a name for the new group policy ( BASIC-CLIENTLESS-POLICY 1n this
example).

Uncheck the Inherit check box, check the Clientless SSL VPN check box in the
Tunneling Protocols option, and uncheek all other unneling protocols.

Click OK and Apply, and then click Save to save your configuration, il necessary.
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Configuring Local Authentication
Task 1B: Modify the Default Group Policy
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Alternatively, you may modifly the default group policy to support clientless S5L VPN
connectons. Perform the following steps:

Step 1

Step 2

In Cisco ASDM, choose Conliguration > Remote Access VPN = Clientless SSL
VPN Aceess > Group Policies, select the DtGrpPoliey, and click the Edit button
to edit it

In the Edit Internal Group Poliey window, check the Clientless S5L VPN check box
mn the Tunneling Protoeols section, and uncheck all other tunneling protecols.

Note

If your Cisco ASA adaptive security appliance will support other VPN access options, you
may need o leave some of other tunneling protocols enabled.

Step 3

Click OK and Apply, and then click Save to save your configuration, if necessary.
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Configuring Local Authentication
Task 2: Create a Custom Connection Profile
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In the second configuration task, you will create a custom connection profile, Pecform the

following sieps:

Stap 1 In Cisco ASDM, choose Configuration > Remote Aceess VPN > Clientless SSL1L
VPN Access > Connection Profiles, and elick Add to add a new connection profile.

Step 2 Provide a name for the new connection profile (BASIC-CLIENTLESS-PROFILE in
this example).

Stap 3 In the Authentication area, leave the authentication method at its default settings
(local AAA authentication).

Step 4 In the DNS section, select the configured DNS server group (CLIENTLESS-DNS-
SERVERS) from the Server Group drop-down list

Stap 5 In the Default Group Policy area, select the eustom group policy (BASIC-
CLIENTLESS-POLICY in this example) from the Group Policy drop-dewn list
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Configuring Local Authentication
Task 3: Define Alias for Connection Profile
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Next, you will create an alias for this new profile, using the following steps:

Step 1

Step 2

Step 3

Step 4
Step 5

In the same connection profile edit window, navigate Lo the Advaneed = Clientless

SSL VPN subpane, and click Add in the Connection Aliases section.

Assign a name to this connection profile. Use a user-friendly name, because this

name will be visible to your VPN users in their browsers. In this example, the name

Basic_portal_profile 1sused.
Chick OK in the Add Connection Alias window.
Click OK in the Connection Profile window,

Click Apply, and elick Save to save your configuration if necessary.
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Configuring Local Authentication
Task 4: Allow Profile Selection
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Finally, vou will allow profile selection, and enable the configured profile for use in clientless
SSL WPNs Continue with the following steps:

Stap 1 In the Connection Profiles pane, in the Login Page Setting area, cheek the Allow
User Lo Seleet Connection Profile check box to allow users to seleet ther

connection profile at login. This setting is required. Later in this lesson, vou will
lock VPN users toa particular profile.

Step 2 In the Connection Profiles area, check the Enabled check box of the newly created
connection profile (BASIC-CLIENTLESS-PROFILE here).

Step 3 Click Apply, and click Save 1o save your conliguration il necessary.

i
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Configuring Local Authentication
CLI Configuration
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To enable local authentication for clientless SSL VPN connections, use the following CLI
commands. First, use the group-policy internal command (o ereate a new internal group
policy. Then use the vpo-tunnel-protocel webvpn command inside group-policy atiributes
eonfiguration mode to specify allowed VEN protocols.

Next, create a new, custom connection profile (BASIC-CLIENTLESS-PROFILE) using the
tunnel-group command, and attach the custom BASIC-CLIENTLESS-POLICY group policy
to this connection profile using the default-group-policy command in its general-attributes
section. Also, in the webvpn-attributes section of the tunnel group, assign a user-friendly
connection profile alias to this connection profile using the group-alias command, and enable
it using the enable parameter. Use the dns-group comimand to specify the DNS group that will
be used by the Cisco ASA adaptive security appliance to resolve domain names inside a
clientless SSL request.

Finally, enter webvpn conliguration mode and enable user connection profile selection using
the unnel-group-list enable command.

group-policy

To create or edit a group policy, use the group-poliey command in global configuration mode.
To remove a group policy from the configuration, use the no form of this command.

group-policy name {internal |Irom growp-policy_name)| |external server-
group server_group password server_password |
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group-policy Parameters

Parameter Description

extarnal server-group Specifies the group policy as external and identifies the AAL server

server group group for the adaptive security appliance to guery for altributes

from group-policy name I nitializes the attributes of this internal group policy to the values
of a preexisting group policy

intarnal |dentifies the group policy as internal

nama Specifies the name of the group policy. The name can be up to 64

characters long and can contain spaces. Group names with spaces
must be enclosed in double quotes, for example, "Sales Group.”

pasaword Provides the password to use when retrieving attributes from the
server password external AAA server group. The password can be up to 128
characters long and cannot contain spaces.

group-policy attributes

To enter group-policy configuration mode, use the group-poliey attributes command in global
configuration mode. To remove all attcibutes from a group policy, use the no version of this
command. In group-policy configuration mode, you can configure attribute-value pairs fora
specified group policy or enter group-policy webvpn configuration mode wo configure

Web VPN attrnibutes Tor the group.

group-policy name attributes

group-policy attributes Parameters

Parameter Description

nama Specifies the name of the group policy

vpn-tunnel-protocol

To configure a VPN tunnel type (1P Security [IPSec], Layer 2 Tunneling Protocol [L2TP] over
[PSec, S8L VPN client [SVT], or WebVPN), use the vpn-tunnel-protocol command in group-
policy configuration mode or usérname configuration mode. To remove the atribute from the
running configuration, use the no form of this command,

vpn-tunnel-protocol {IPSee | Rtp-ipsec | sve |webvpn |

vpn-tunnel-protocol Parameters

Parameter Description

IFSac Megotiates an |Psec tunnel between two peers (& remote access client or anpther
secure gateway). Creates security associstions that gavern authentication,
encryption, encapsulation, and key management.

12tp-ipsac Negotiates an IFsec tunnel for an LZTF connection.
Bve Megatiates an S5L VPN tunnel with an 5L VPN client.
webvpn Frovides VPN services to remote users via an HT TP S-enabled web browser, and

does not require a client.
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tunnel-group
To create and manage the database of connection-specific records for [Psec and WebVEN
tunnels, use the wnnel-group command 1 global configuration mode. To remove a tunnel
group, use the no form ol this command.

tunnel-group name type tipe

tunnel-group Parameters

Parameter Description

nams Specifies the name of the tunnel group. This name can be any string that you choose. I
the nameis an |P address, itis ususlly the |P address of the peer.

type Specifies the type of tunnel group:
= remote-access: Allows a user to connect using either IPsec remote access or
WebVPN (portal or tunnel client)

n ipsec-12]l: Specifies IPsec LAN-to=LAN, which allows two sites or LANS to connect
securely across a public network like the Internet.

Note The following tunnel group types are deprecated in Cisco ASA Software Version
B.D{2)
= ipsec-ra; |Psec remote 2ccess
=webvpn: WebWVPN
The adaptive security applience converts these to the remote sccess type.

tunnel-group general-attributes

To enter general-atiributes configuration mode, use the tunnel-group general-
attributes command in global configuration mode. This mode is used to configure settings that

are common to all supported tunneling protocols,
Toremove all general attributes, use the no form of this command.

tunnel-group name general-attributes

tunnel-group general-attributes Parameters

Parameter Description

general -attributes Specifies attributes for this tunnel group

name Specifies the name of the tunnel group

default-group-policy

To specily the set of attributes that the user inherits by default, use the default-group-
poliey command in tunnel-group general-attributes conliguration mode. To eliminate a default
group policy name, use the no form of this command.

default-group-poliey group-name

default-group-policy Parameters

Parameter Description

Qroup-rams Specifies the name of the defsult group
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tunnel-group webvpn-attributes

To enter webvpn-attribute s configuration mode, use the tunnel-group webypn-
attributes command in global configuration mode. This mode conligures settings that are
common to Web VPN tunneling,

To remove all WebVEN attributes, use the ne form of this command.

tunnel-group mame webvpn-attributes

tunnel-group webvpn-attributes Parameters

Parametar Description

webvpn-attributes | Specifiies WebWPN attributes for this tunnel group

namea Specifigs the name of the tunnel group

group-alias

To create one or moere alternate names by which the user can refer to a tunnel group, use
the group-alias command in tunnel-group webvpn configuration mode. To remove an alias
from the list, use the no orm of this command.

group-alias name [enable | disable|

group-alias Parameters

Parametar Description

digabla DCisables the group alias.

enable Enables a previously disabled group alias.

nama Specifies the name of a tunnel group alias, This can be any string that you choose,
except that the string cannot contain spaces.

dns-group (tunnel-group webvpn configuration mode)

webvpn

To specily the DNS server to use for a WebVPN tunnel group, use the dns-group command in
wnnel-group webvpn configuration mode. To restore the default DNS group, use the no form
of this command.

dns-group name

dns-group (tunnel-group webvpn configuration mode) Parameters

Parameter | Description

nama Specifies the name of the CNS server group configuration to use for the tunnel group.

Toenter webvpn mode, in global configuration mode, enter the webvpn command. To remove
any commands that are entered with this command, use the no webvpn command. These
webvpn commands apply to all Web VPN users.

These webvpn commands let vou configure A AA servers, default group policies, default idle
umeout, HTTP and HTTPS proxies, and NetB10S Name Service (NBNS) servers [or

Web VPN, aswell as the appedrance of WebWVPN screens that end users see.

webvpn
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Configuring Local Authentication

Implementation Guidelines

* Only use slatic passwords in small, single-device low-risk
environments.

= Slrictly set the service type of local VPN user accounts to
prevent these accounts from using management access.
= You can use the DefaultWebVPNGroup instead of a specific

group; however, this choice will make it more difficult to
differentiate users later on.

Similar to full tunneling SSL VPNs, consider the following implementation guidelines when
implementing local AAA authentication in a chientless S5L VPN solution:

®  Unly use user authentication with static passwords and the local database in small, single
gateway, low-risk environments because these passwords are reusable and typically easy
Lo gUess.

m Always strictly set the serviee type of the user to only allow VPN access. This policy 15
extremely important to prevent unauthorized access to Cisco ASA adaptive security
appliance management [unctions.

m  Inthis topic, all examples used a eustom connection prolile and a custom group poliey. IT
all of your users share the same authentication method, and aceess policies, you could alse
implement local AAA authentication by using only the DefaultWebVPNGroup connection
profile and the default group policy.
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Verifying Local Authentication

Verify Access
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At this point, you should be able to access the SSL WPN portal,
without access restrictions to internal resources.

At this point in your configuration flow, you should already be able o access basic features of
the S5L VPN, without any aceess restrictions for authenticated users.

On your client system, open a browser and navigate to the HTTPS URL of the Cisco ASA
adaptive security appliance outside interface. In this configuration example, the outside
mterface of the appliance s reachable at hitps://vpon.domain.com, and vpn.domain.com is also
the canomical name ( that is used inside the Cisco ASA adaptive security appliance idenuty

certificate.

The browser should open the S8L VPN logim page without any certilicate warnings if the Cisco
ASA adaptive security appliance 15 using an identity certiflicate from a global PKI provider. IT
you observe certificate warnings, it 1s imperative that you remedy this problem before
production use.

On the login page, enter the username and password (vpnuserpassword) to log into the SS5L VEN
portal. You can see that the alias of the connection profile is listed in the GROUP drop-down box.
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Verifying Local Authentication
Default Portal User Interface
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This figure shows the default SSL VPN portal interface as 14 seen by the clientless S5L VPN
user. You can fully customize this page, as you will leam in the upeoming lessons in this course.

(i the left side of the defanlt portal, vou can see application tabs that invoke specilic views of
the portal. The Web Applications view will invoke a portal view that only displays the
preconfigured links (bookmarks) to web applications, The Browse Networks view will invoke a
portal view that only displays the preconfigured links (bookmarks) to file shares and the file-
share browsing interface.

By default, the portal will include a URL entry field, which allows users to enter a URL of their
choice. By elicking Browse, the Cisco ASA adaptive security appliance 881 VPN portal will
retrieve the requested resource and display it in the browser window.

Nota The prefix to the URL pathin the browser changes depending on whether you require
authentication. The security appliance uses /+CSCOE+/ for objects that reguire
authentication, and /+CSCOU+/ for objects that do not. The security appliance displays

A+CSCOE+/ objects on the portal page only, while /+CSCOU+/ objects are visible and
usable in either the login or the portal pages.
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Verifying Local Authentication
Portal User Interface
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When you navigate 1o a resource over clientless S5L VPN, the browser will display navigation
icons as a Hoating toolbar at the top of 1ts content window. You can use these icons anytime to
return to the home page, open an URL over the clientless SSL VPN session (if allowed), move
the toolbar 1o the other side of the content window, or close (logout) your 851 VPN session.

Note Never use the home page button of the browser during a dientless session because this
action will cause you to navigste away from the SSL VPN portal.
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Verifying Local Authentication
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To verify the clientless connection for your client on the Cisco ASA adaptive security
appliance, use Cisco ASDM, and navigate to the Monitoring > VPN > VPN Statistics >

Sessions pane. Choose Clientless SSL VPN in the Filter By lield. The VPN session should be

displayed in the main pane.

Verifying Local Authentication
cLI
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o the CLIL use the show vpo-sessiondb webvpn command to obtain information that is similar

to the information from Cisco ASDM.
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show vpn-sessiondb

To display information about VPN sessions, use the show vpn-sessiondb command in
privileged EXEC mode. The command includes options for displaying information in full or in
detail, lets you specify type of sessions to display, and provides options to filter and sort the
mformation, The syntax table and usage notes organize the choices accordingly.

show vpo-sessiondb [detail] [full] {remote | 121 | index indexnumber | webvpn | email-proxy
| sve} [filter {name wsername | ipaddress [Paddr | a-ipaddress [Paddr | p-ipaddress [Paddr |
tunnel-group groupname | protocol protocol-name | eneryplion encrpiion-algo | inactive )]
[sort {name | ipaddress | a-ipaddress | p-ipaddress | tunnel-group | protocol | encryption
inactivity}]

show vpn-sessiondb Parameters

Parametar Description

detail {Cptional} Displays extended details about a session. For
example, using the detail option for an IPsec session displays
additionzal details such as the Internet Key Exchange [IKE)
hashing algorithm, authentication mode, and rekey interval.

I1f you choose detail, and the full option, the adaptive security
appliance displays the detailed output in 2 machine-readable
format.

filter filter crireria [Optional) Filters the output to display only the information: that
you specify by using one or more of the filter options.

full (Optional} Displays streamed, untruncated output. Output is
delineated by | characters and a || string between records.

sassion type [Optional} To show data for s specific session type, enter one of
the following keywords:

= amail-proxy: Displays email-proxy sessions.

n  index indexnumber: Displays a single session by index
number, Specify the index number for the session, 1=750.
12]: Cisplays VPN LAN-to-LAN session information.

ratio: Displays WPN session protocol or encryption ratios.

= remote: Displays IPsec remote 2CCESS SESSI0NS.

summary: Displays the VPN session summary.
sve: Displays BSL VPN Client sessions.

= vpn-lb: Displays WPN Load-Balancing mansgement
SESRIONS.

»  webvpn: Displavs information about clientless 33L VPN
SESSiONS.

sort sort criteria (Optional) Sorts the output according to the sort option that you
specify
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Configuring Basic Portal Features and Access
Control

This topic describes how to configure and verify basic portal features and access control 10 &
clientless S5L VPN,

Configuring Basic Portal Features
URL Entry and Bookmarks
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By default, the Cisco ASA adaptive security appliance 851 VPN portal will not restrict users
and allows authenticated users access to all internal resources. 1t also provides several ease-of-
use mnterface features. You can useé basic portal tuning Lo control basic portal appearance by
enabling or disabling senie of its user interface functions.

This figure shows two main basic features of the Cisco ASA adaptive security appliance SSL
VPN portal. The first feature 18 the URL entry, which allows users to specily the URL of the
resource they want to aceess, and the second is user-defined bookmarks, with which the
administrator can specily a list of often-used resources for users to navigate oo quickly. When
a user logsin to the 8L VPN portal, all bookmarks that are enabled in the group policy of the
user are displayed on the portal home page. In addition to the bookmark list, the URL entry
field is displayed at the top of the interface. By tuning portal functions, vou can enable or
disable either of these two features.

These are the protocols that can be used to access resources using URL entry or bookmarks:
HITP, HTTPS, CIFS, and FTP.
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Configuring Basic Portal Features
Metwork File Server Access
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Another basic 881 VPN portal feature s the ability to allow users to aceess Common Interngt
File System ( CIFS) file shares, and browse a CIFS network using a browser interface. This
ability allows for easy interoperability with Microsoft Windows Server lile servers, by
presenting a Windows Explorer-like user interface within the browser. Using portal tuning
features, you can perrmit or deny access to this [ile browsing interface.

The same user interface is also presented when you aceess an F1TP server using FTP protocol.
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Configuring Basic Access Control

Webtype ACLs
Webtype ACLs control proxy access to resources:

* Webtype ACLs are assigned in user profiles or group policies
= Based on allowed or denied URL patterns
« First match, implicit deny access philosophy
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The Cisco ASA clientless SSL VPN feature does not use the Cisco ASA adapuive security

appliance interface access controf lists (ACLs) and Cisco Modular Poliey Framework (MPF)

access control model, but enforees its own aceess control by using webtype ACLs. Webtype

ACLs are per-user or per-group ACLs that permit or deny access to URLs reachable over the

S8L VPN portal. You can use URL pauerns to specify the allowed or denied URLs, and use

multipie rules inside a webtype ACL. Webtype ACLs use the same evaluation logie as classie
Cisco ASA adapuve security appliance ACLs: the first matehed rule dictates the permit or deny
action, and there is an implicit deny-all statement at the end of the ACL.

Nota

Mote that enabling or disebling portal features such as URL entry and bookmarks does not

prevent the user from accessing internal resources, but only removes the relevant user
interface options. If users know how to properly construct the rewritten internal URL and
enter it in the browser Address field, they can still access the resource behind the Cisco
ASA sdaptive security sppliance, if properly authenticated. Therefore, you must deploy

webtype ACLs if you want to reliably control access to internal resources.
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Configuring Basic Access Control
Direct Access via Rewrite Disable

It is possible to redirect the client cutside the SSL
VPN session for specific protected content links.

» Can be used with problematic applications or to increase
performance

= Does not provide any VPN protection

= [f the redirected resource is behind the Cisco ASA, you must
allow this using classic firewall ACLs or Cisco Medular Policy
Framework

Sarewr &

Just as full tunnel VPNs can be conligured to allow some traffic to bypassthe tunnel, you can
configure clientless SSL VPNs in a similar manner. You can use such direct access for servers
that are hosting problematic content that the Cisco ASA adapuve security appliance has
problems rewriting. You can also use direct access to increase performance by avoiding aceess
via the proxy.

Note MNote that in clientless 3SL VPMs, you can always bypass the 535L VPN session o access
resources in the transport network (that is, not behind the Cisco ASA adaptive security
appliance} by just opening another browser session and navigating directly to the resources.

Direct access via rewrite disable 1s useful for clientless VPNs to directly access resources that
are linked to protected content that is retrieved over the pontal, Normally, any links in
documents that you retrieve over the S8L VPN portal will be rewritten by the Cisco ASA
adaptive security appliance, which will force the browsing session of the user Lo always access
these links aver the SSL VPN portal. You can specify that certain links should not be rewritten,
causing the browser of the client to directly access the destination server, bypassing the SSL
VPN gateway proxy lunction,

Note Note that resources that you access directly are not protected by the SSL VPN
encapsulation.

If the bypassed resource is located in the network outside the Ciseo ASA adaptive security
appliance SSL VPN gateway, access to that resouree requires no further configuration.
However, if the resource that 1s configured for direct access 15 behind the Cisco ASA adaptive
security appliance SSL VPN gateway, you will have to modify Cisco ASA adapuve security
appliance interface ACLs or MPF rules to enable such direct access. This direct aceess is no
different from any other access through the Cisco ASA adaptive security appliance, and it is
subject to the elassic firewall aceess poliey.
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Configuring Basic Portal Features and
Access Control

Configuration Tasks
1. (Optienal) Cenfigure basic portal features.

=

2. (Optienal) Configure portal per-profile and per-user ACLs.
4. (Optienal) Configure direct access via rewrite disable.

To configure basic portal features and access control in a basic clientless solution, you will
perform some of the following conliguration tasks:

. Optonally, you can enable, disable, and wne the basic S5L VPN portal user-interface
features.

()

Optionally, conligure per-user or per-group-policy webtype ACLs to implement per-user or
per-group aceess policies.

3. Opuonally, conligure direct access via rewrite disable feature to enable remote clients o
directly access specific resources.
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Configuring Basic Portal Features and
Access Control

Configuration Scenario
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This figure presents the configuration scenario that is used in upeoming configuration tasks.
Remote users will only be allowed to aceess a single web server (hitp:/intranet. domain.com) in
the protected network, and a single file server (eifs:/W2K38), You should ereate predefined
bookmarks to aceess the web server home page and the file share named * share” on the
WZK3S file server. To browse the W2K35 server and possibly the rest of the Windows
domain, you will configure the Ciseo ASA adaptive security appliance to eonsult the internal
Microsoft Windows name server (( WINS/NetB10S name service) o resolve CIFS hosmames.

You will also configure direct aceess 1o all servers in the Cisco.com domain, disabling the rewrite
il links w Cisco.com are present in the content that 18 retrieved over the SSL VPN portal.
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Configuring Basic Portal Features and
Access Control

Task 1: (Opticnal) Configure Basic Portal Features
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In the first task, you will contrel some basic SS5L YPN portal user interface features, namely,
the presence of predefined bookmarks on the portal home page for a specific user group, the
ability for users to freely enter URLs on the portal, and file share access features.

Complete the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Step 7

Step 8

Step 9

In Ciseo ASDM, choose Conliguration > Remote Access VPN > Clientless SSL
VPN Aceess > Group Policies, and chick Edit to edut the group policy thatapplies
i & user group (in this case, the BASIC-CLIENTLESS-POLICY ).

Inside the Edit Internal Group Poliey window, navigate to the Portal subpage.

I you want 1o ereate a bookmark list for this policy, click Manage in the
Boeokmark List row. The process of bookmark list ereation is explained m the next
pages of this opie.

If you want to enable or disable URL entry Tor this poliey, click the Enable or
Disable radio button in the URL Entry row.

Il you want to enable or disable the possibality for users to enter a path to an mternal
file share in the 881 VPN portal Browse Networks view, click the Enable or
Disable radio button in the File Server Entry row.

If you want to enable or disable the possibility for users to browse the lile server
network 1n the 5L VPN portal Browse Networks view, click the Enable or Disable
radio button in the File Server Browsing row.

If you want to allow or deny aceess to hidden CIFS shares (shares whose name ends
in the § characters), click the Enable or Disable radio button in the Hidden Share
Accessrow,

Click OK in the Edit Internal Group Policy window,

Click Apply, and click Save to save your configuration, if needed.
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Configuring Basic Portal Features and
Access Control

Task 1: (Optional) Configure Basic Porial Features
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A bookmark listis a set of URLSs that is configured to be displayed in the clientless SSL VBN
portal for a group of users sharing the same group policy. By default, there are no conligured
bookmark lists, and the network administrator must configure them.

To ereate a bookmark list inside a group poliey, complete the following steps:

Step 1 Inside the Edit Interngl Group Policy window, click Manage to create anew
bookmark list.

Stap 2 Click Add to add a bookmark list.

Step 3 Configure the bookmark list name (MY -BOOKMARKS in this example) and click
Add to ereate individual bookmarks for this list. The Add Bookmark Entry window
appears. The creation of a bookmark entry 15 eovered next.

To ereate a web application (HTTP or HTTPS) bookmark in the bookmark list, complete the
followimng sieps:

Step 1 Confligure a name lor the bookmark in the Bookmark Title field.
Stap 2 Conligure the URL value lor the bookmark as HTTP or HTTPS.
Stap 3 Configure the server HTTP or HTTPS URL to be used with the bookmark entry.

Step4  Optionally, configure the bookmark subtitle, The subtitle will appear under the
bookmark entry on the web portal.

Step 5 Optionally, configure the thumbnail picture to be used with this Bookmark entry.
Stap 6 Click OK, OK, and Apply, and click Save to save your configuration, if needed.

Note To use thumbnails with bookmarks, they must first be uplozded to the Cisco ASA adaptive
security appliance.

In this figure, 8 web application bookmark named “Internal server™ has been created. The
bookmark has been given an URL of hitp://intranet.domain.com.
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To create a file share (CIFS) bookmark 1n the bookmark list, complete the following steps:
Step 1 Configure a name for the bookmark in the Bookmark Title field.

Step 2 Configure the URL value for the bookmark as CIFS.

Step 3 Configure the server CIFS URL to be used with the bookmark entry.

Step 4 Optionally, configure the bookmark subtitle. The subtitle will appear under the
bookmark entry on the web portal.

Step 5§ Optionally, configure the thumbnail o be used with this bookmark entry.
Step & Click Ok, Ok, and Apply, and click Save to save your configuration, i needed.

In this figure, a CIFS bookmark named “File server share” has been created. The target CIFS
URL is cifs:/"'W2K35/share.

If you are using CIFS file share access, especially if you are not using bookmarks and want
users o browse the network, you must configure appropriate CIFS name servers that the Cisco
ASA adaptive security appliance will consult to obtain a list of file servers in a domain,
together with their 1P addresses. To configure a list of CIFS name servers, you should edit the
relevant connection profile to which your users belong.

Perform the following steps (not shown in the fgure):
Stap 1 Edit the connection profile to which your users belong,

Step 2 Inside the Edit Clientless SSL VPN Connection Profile window, navigate Lo the
Advanced > NetBIOS Server subpane.

Step 3 Clhick Add 1o add a CIFS name server.

Step 4 o the Add NetBIOS Server window, specily the 1P address of the CIFS name
server,

Note Itis recommended that you add more than one CIFS name server for redundancy,

Step 5 Click OK, OK, and Apply, and elick Save to save your conliguration, if’ needed.
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Configuring Basic Portal Features and
Access Control

Task 2: Configure per-Group and per-User ACLs
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In the second task, youwill configure a webtype ACL to limit access Lo internal resources, and
apply the webtype ACL to a group policy that applies to your user group (connection profile).
To create a new webtype ACL, perform the following steps:

Step 1 In Cisco ASDM, choose Configuration > Remote Access VPN > Clientless S5L1L
VPN Access > Advanced > Web ACLs. An ACL manager window for webtype
ACLs will open.

Stap 2 Choose Add > Add ACL toadd a new webtype ACL.

Step 3

In the Add ACL window, choose a unique name for the new webtype ACL.
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Configuring Basic Portal Features and

Access Control

Task 2: Configure per-Group and per-User ACLs (Cont.)
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Step 4

Step 5

Step &

Choose the newly created ACL in the ACL pane, and choose Add > Add ACE o

add arule (access control entry [ACE]) to the new webtype ACL.

I the Add ACE window, enter the conditions that will control access to internal
FESOUICEs:

m  Click the Permit or Deny radio button in the Action area.

m  [nthe Filter area, click the Filter sn URL radio button, and specily the URL

pattern that you want to filter on. You can use the * character to make a resource

a wildeard. In this example, the first ACE will allow all access o the

intranet. domain.com web server, and the second ACE will allow access to any

share on the W2K35 CIFS server.

m [0 the Logging area, you can enable specific logging for this ACE, similarly to

the process for classic Cisco ASA adaptive security appliance ACLs.

Click OK and Apply, and click Save 1o save your configuration, if necessary.
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Configuring Basic Portal Features and
Access Control

Task 2: Configure per-Group and per-User ACLs (Cont.)
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To apply the newly created webtype ACL to a group policy (and therefore one or more
connection profiles), or toa user account, perform the following steps:

Step 1

Step 2

Step 3

Chooese Conliguration > Remote Access > Clientless SSL VPN Aceess > Group
Policies and edit a group policy that you want 1o assign the webtype ACL to (in this
example, this is the BASIC-CLIENTLESS-POLICY group policy).

Expand the More Options area, uncheck the Inherit check box, and seleet the
newly created webtype ACL in the Web ACL field.

Click OK and Apply, and click Save to save your configuration if needed.

Alternatively, ifyou need to apply this ACL only to a specific user, edit the profile of the user
by choosing Configuration > Remote Access > AAALocal Users > Local Users > Edit, and
navigating to the VPN Policy > Clientless 881 VPN > More Options section of the profile of
the user. Uncheck the Inherit check box, and select the newly created webtype ACL in the
Web ACL lield.
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Configuring Basic Portal Features and
Access Control
Task 3: Configure Direct Access via Rewrite Disable
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In the optional Task 3, you can configure direct access and specilly that the Ciseo ASA adaptive
security appliance SSL VPN proxy-rewriting engine should not rewrite specilic URL patterns
that are found inside protected content. In this example. any content referencing Cisco.com
sites should not have these links rewritten. This configuration allows elientless users to elick
these links inside their SSL VPN session. and open direct connections to these sites.

To configure such direct access by disabling specific content rewnting functions, perform the
lollowing steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Choose Configuration > Remote Aceess > Clientless SSL VPN Access >
Advanced > Content Rewrite,

Click Add to add a rewriting exception rule.

In the Add Content Rewrite Rule window, uncheck the Enable Content Rewrite
check box, specily arule number (i you have multiple rules, they are evaluated m
order according to their sequence number), and assign the rule a user-friendly name.

In the Resource Mask feld, specify the URL patterns that the Cisco ASA adaptive
security appliance should not rewrite. 1o this example, the URL pattern is

s /leisco.com ™", meaning that any link using any protocol to the Cisco.com
domain inside protected content should be left unmodified.

Click OK and Apply, and click Save to save your configuration if needed.
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Configuring Basic Portal Features and
Access Control

CLI Configuration
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This output shows the CLI comumands that are required to configure the basic portal features
and aceess control in clientless SSL VPNs.

Enter group-policy attributes confizuration mode, and enter its webvpn submode. In this
submode, use the url-list command to assign a bookmark lst to the group policy. Use the
hidden-shares command to allow or deny access to hidden CIFS shares and the file-entry
command to allow or deny users to freely enter CIFS URLs in the Browse Networks view. Use
the file-browsing command to allow free browsing of file servers and shares and the url-entry
command to allow or deny free entry of URLs on the portal home page.

Note The bookmark lists cannot be configured using the GLI, because they are saved as XML
files In the Cisco ASA adaptive security appliance flash fie system (FF3).

To configure webtype ACLs and apply them to a group policy, first conligure a webtype ACL
using the aceess-list name webtype command. You can apply this webtype ACL 1o a group
poliey by using the filter value command in the webvpn submode of the group-policy
attributes configuration mode.

To configure direct acceess by making content rewritng exceptions, enter the S8L VPN secver
configuration submode on the Cisco ASA adaptive security appliance using the webvpn
command. Use the rewrite command to specify & new content rewriting exception rule, with a
particular sequence number, specilying 4 resource mask, and using a user-friend!y rule name.

url-list (group-policy webvpn)

Toapply a list of WebVPN servers and URLS o a particular user or group policy, use the url-
list command in group-policy webvpno configuration mode or in username webvpn
configuration mode. To remove a list, including a null value that is created by using the url-list
none eommand, use the no form of this command. The no option allows inheritance of a value
from another group poliey. To prevent mmheriting a URL list, use the url-list none command.
Using the command a second time overrides the previpus setting.

url-list {value name | none} [index)
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url-list (group-policy webvpn) Parameters

Parameter Description

index Indicates the display priority on the home page.

nonea Sets a null vaiue for URL lists. Prevents inheriting a list from a default or specified
group policy.

value nams Specifies the name of a previcusly configured list of URLs. To configure such a list,
use the wrl-list command in global configuration mode.

hidden-shares

To control the visibility of hidden shares for CIFS files, use the hidden-shares command in
group=policy webvpn configuration mode. To remove the hidden shares option from the
conliguration, use the no form of this command.

hidden-shares {none | visible}

hidden-shares Parameters

Parameter Dascription
nona Specifies that no configured hidden shares are visible or accessible to users
vigible Reveals hidden shares, making them accessible to users
file-entry
To enable or disable the ability of a user 1o enter [ile server names to access, use the file-entry
command in group-policy webvpn conliguration mode.
file-entry {enable | disable}
file-entry Parameters
Parameter Description
enable disable | Enables or disables the ability to enter file server names to access
file-browsing
To enable or disable CIFS or FTP file browsing for [ile servers or shares, use the file-browsing
command in group-policy webvpn configuration mode.
file-browsing [enable | disable]
file-browsing Parameters
Paramatar Description
enable disable Enables or disables the ability to browse for file servers or shares
url-antry

To enable or disable the ability to enter any HTTP or HTTPS URL on the portal page, use the
url-entry command in group-policy webvpn conliguration mode.

url-entry {enable | disable}
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filter

url-entry Parameters

Parameter Description

enable digsable Enables or disables the ability to browse for file servers orshares

To specify the name of the aceess list to use for WebVPN connections for this group policy or
username, use the filter command in group-policy webvpn configuration mode, To remove the
access list, including a null value that is created by 1ssuing the filter none command, use the no
form of this command.

filter {value ACLuname | none}

filter Parameters

Parametar Dascription

nona Indicates that there is no webltype access list. Sets.a null value, which disallows
an access |ist. Prevents inhenting an access list from another group policy.

valuea A0Tname | Provides the neme of the previously configured access list.

access-list webtype

T add an aceess list to the configuration that supports filtering for clientless SSL VPN, use the
access-list webtype command in global configuration mode. To remove the aceess list, use the
no form of this command.

access-list id webtype {deny | permit} url [wel sting | any| [log |[disable | default] | level]
[interval secs] [ime range name])

access-list webtype Parameters

Parameter Description

any [Optional} Specifies all URLs.

deny Denies access if the conditions are matched,

id Name or number of an access fist.

intarval secs [Optional} 5 pecifies the time interval at which to generate system log
message 106100, Valid values are from 1 to 600 sec.

log [[disable [Optional) Specifies that system log message 106100 is generated for the

dafault] Ievell | ACE. See the logcommand for information.

oper Compares ip_sddress ports. Possible operands include It (1ess than), gt
{greater than), eq (equal), neg (ot equal), and range (inclusive range).

parmit Permits access if the conditions are matched.

Eime range name [Optional} Specifies a keyword for attaching the time-ranoe option to this

BCCess list element.

url Specifies the use ofa URL for filtering

url string {Optional) Specifies the URL that is to be filtlered.

&-4H
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rewrite

To disable content rewriting of a particular application or type of traffic over a WebVEN
connection, use the rewrite command in webvpn mode. To eliminate a rewrite rule, use the no

form of this command with the rule number, which uniguely identifies the rule. To eliminate all
rewriting rules, use the no form of the command without the rule number.

By default, the adaptive security appliance rewrites, or transtorms; all WebVPN trafTic.

rewrite order integer {enable | disable} resource-mask simng [name resouwrce name|

rewrite Parameters

Parameter Description

disable Defines this rewrite rule as a rule that disables content rewriting for the specified
traffic. When you disable content rewriting, traffic does mot go through the
security appliance.

enable Crefines this rewrite rule as a rule that enables content rewriting for the specified
traffic.

integer Sets the order of the rule among all the configured rules. The range is 1—
B5,534.

nAmME [Optional) |dentfies the name of the application or resource to which the rule
applies.

erdar Cefines the order in which the'adaptive security appliance applies the rule.

reasource-mask |dentifies the application or resource for the rule.

Irgourca nama

(Optional} Specifies the application or resource to which the rule applies.
Maximum, 128 bytes,

string

Specifies the name of the application or resource to match that can contain a
regular expression. You can use the following wildcards!

n *=—Maiches everything, You cannot use this wildcard by itself. It must
accompany an alphanumeric string.

m P=—Matches smy single character.

n [!seg]—Maiches any character not in sequence.
= [segl—DMatches any character in sequence.
Maximum, 300 bytes.
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Verifying Basic Portal Features and
Access Control

User Portal Verification
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To verily portal feature configuration and access control, you can start a clientless SSL VPN
session and log in to the portal.

The top portion of the [igure shows the default, Home view of the portal, displaying the two
preconfigured web application and C1FS bookmarks. The URL entry function is also engbled.
The bottom portion of the figure shows the Web Applications view of the portal, displaying
only the preconfigured HITP and HTTPS bookmarks.
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Verifying Basic Portal Features and
Access Control

User Portal Verification (Cont.)
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The Browse Networks view shows the preconfigured CIFS bookmark, as well as allowing
CIFS URL entry and the browsing functionality through the Browse Entire Network link.

If you access a share by clicking its CIFS bookmark, entering a CIFS path in the CIFS URL
entry field, or navigating to a share through the network share browser, the Cisco ASA adapuive
security appliance will open a file share interface as seen on the right side of the S8L VPN
window in the lower portion of the figure. This interface allows users to flexibly manipulate
files, offering the following menu buttons:

= LUp One Level
= Favorites

m  Delete File

m  Copy File

= CutFile

m  Paste File

= New Folder
m  Upload File
= Network

= Web Folder
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Verifying Basic Portal Features and
Access Control

fccess Control Verification
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Wendoning > Logging > Reak-Tima Lag Viewer

You can verily the correctness of your webtype ACLs by attempting Lo access LURLs that
should be allowed or denied. The Cisco ASA adaptive security appliance will, by default, log
all resource accesses through the S5L VPN poral. In this example, the Cisco ASDM Real-
Time Low Viewer shows accounting records that show a successful {GRANTED) and
unsuecessiul (DENIED) atempt to access the webtype-ACL-protected internal network.

‘{:ﬂ
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Verifying Basic Portal Features and
Access Control

Implementation Guidelines
* Tuming off portal featuras does not deny access to
resources; use ACLs instead.
« Bookmark eontents are not saved in the Ciseo ASA main
canfiguratien file but as XML files in a special folder.
* The Cisco ASA doses not validate cerlificates in HTTPS portal

links. You should aveid creating proxy HTTPS links to sites
reachable over untrusted networks.

When you implement basie Cisco ASA adaptive security applianee clientless portal functions
and access control, consider the following implementation guidelines:

m  Disabling portal wser interface functions does not prevent access to internal resources if the
user has bookmarked a link, or knows how to construct a rewritten URL. Webtype ACLs
are the only reliable method wo restrict access to internal resources.

m  Bookmark list contents are not saved in the Ciseo ASA adapuve security appliance main
configuration file; but inside separate XML files. If you need o back up the Cisco ASA
adaptive security appliance configuration or migrate the econliguration to a difTerent
apphiance, you will need to migrate these XML liles aswell.

m  [fyouaceess HITPS resources over the SSL VPN porial, the Cisco ASA adaptive seeurity
appliance SSL VPN proxy does not validate the certificate of the HI'TPS server against a root
certificate. Although this lack of validation is usually not an issue if' the connection between
the Cisco ASA secunty appliance and the target server 18 over a trusted network, accessing
HTTPS servers over untrusted networks éan expose the HTTPS session o significant risk.
The nsk is significant because man-in-the-middle attacks cannot be detected by the user.
Therefore, avoid allowing chientless SSL VPN users o access HTTPS sites over the 881
WPN portal, it these sites are reachable over untrusted transport networks.
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Troubleshooting Clientless SSL VPNs

This topic deseribes how to troubleshoot VPN session establishment between a browser client
and a Ciseco ASA adaptive security appliance chientless SSL VPN gateway.

Troubleshooting Clientless SSL VPNs
Visual Troubleshooting Aid

ViAo oT MSSIagE show logging
ping. iracerouis, nslookup, dig U AZTN Soars Wiewsr

)

-

Clle

Cazn ASA

When troubleshooting elientless SSL VPN session establishment, you should perform
troubleshooting tasks on both the client and the Cisco ASA adaptive security appliance, if
possible. This figure shows some maost useful troubleshooting commands and actions that you

can use on invoelved components.

On the client, you can use operating system utilities to determine the reason for conneclivity or

name resolution issues. Here are some examples of these utilities:

m  The ping utility to determine Layer 3 reachability of the Cisco ASA adaptive security

appliance from the client

m  The traceroute utility to troubleshoot Layer 3 path problems between the client and the

Cisco ASA adapuive security appliance

m  The nslookup and dig uuliues to troubleshoot name resolution, 16 the browser cannot

resalve the URL for the SSL VPN portal

MNote that the Cisco ASA adaptive security appliance will extensively log all 1ssues into its
syslog subsystem. Debug commands are generally not required, except for n-depth

troubleshooting ol complex 1ssues.
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Troubleshooting Clientless SSL VPNs

Troubleshooting Flow
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I you are encountering clientless session establishment issues, you may follow these steps to
troubleshoot the issue:

Step 1

Step 2

Step 3

First, check that the SSLTLS session mitially establishes, and that there are no
negotiation problems that are related to the use of incompatible protocol versions or
cipher suites. You can observe these issues in the browser GUL but you will obtain
more detailed and specific mformation by examining Cisco ASA adaptive security
apphance syslog messages.

If the SSL/TLS negotiation completes with no errors, check il user authentication
works and the user is supplying the correct eredentials: The Cisco ASA adaptive
security apphiance will ¢learly indicate these issues in 11s syslog messages.

Next, check whether the connection profile and the associated group policy allow
clientless SS5L VPN connections. The Cisco ASA adaptive security appliance will
clearly indicate these issues in its syslog messages.

IT these steps do not resolye your issue, you may need to deploy troubléshooting tools that are
beyond the scope of this course.
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Troubleshooting Clientless SSL VPNs
Troubleshooting Flow (Cont.)

Canarxs requsix
anfacisn:

If you your 881 VPN session establishes, but there is no connectivity over the SSL VPN portal,
you may follow these steps to troubleshoot the issue:

Stap 1 Werily that the Cisco ASA adaptive security appliance 18 not denying trafTic from the
SSL VPN tunnel. Examine the Cisco ASA adaptive security appliance syslog to see
messages about permitted or denied packets.

Step 2 Next, if you are using direet access through content rewriting, check that your
content rewriting rules are not oo general, which would foree access to internal
resources outside the S5L VPN session. You can observe this in the browser, which
will attempt te contact internal hoests directly, instead of over the SSL VPN session.

Stap 3 Finally, vou ¢an verify the HTML content that is returned to the browser by the SSL
VPN portal.

II these steps do not resolve yvour issue, vou may need to deploy troubleshooting tools that are
bevond the scope of this course.
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Troubleshooting Clientless SSL VPNs

Client-Side Issues: Certificates

= A certificate warning can
appear because of:
— Unverifiable Cisco
ASA identity cerificate
— A name mismatch
between cerificate
CM and YPN URL
in the browser
— An expired Cisco ASA I P e e
identity certificate ot s
= You should never see this
issue in production use

As with Ciseo AnyConnect full tunneling VPN, the most common client 1s5ue that you may

encounter in & clientless 5L VPN 15 a certilicate warning at VPN session establishment. You

should never see these issues appearing during production use of the network. Refer to the

“Deploying a Basic Cisco AnyConnect Full Tunnel 8L VPN Soluton™ lesson n this course to

obtain guidelines for resolving these issues:
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Troubleshooting Clientless SSL VPNs

Gateway-Side Issues: Access Control
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If you have misconfigured your webtype ACLs to.deny traffie that should not be denied, you
can observe denied access in the Cisco ASA adaptive security appliance logging output.,
Another, even simpler method of ACL verification is to observe the predelined bookmarks in
the S8L VPN portal. If you havemisconfigured your ACLs, the bookmarks that are not
reachable because access o these resources 1s not permitted are dimmed in the portal.

&5

d
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Summary

Thistopic summarizes the key points that were discussed in this lesson.

e
Summary

= A hasic clientless 35L VPN Involves basic gateway configuration,
user authentication, address assignment, and access control
configuration.

* In basic gateway configuration, you should enable the SSLTLS
server and provision the Cisco ASA adaptive security appliance
identity certificate.

« Basic user authentication uses the local user database.

* You can implement general er per-user or per-profile accass
control.

* Use various show and debug commands to troubleshoot the
operation of clientless S5L VPNs.
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Lesson 2

Deploying Advanced
Application Access for
Clientless SSL VPN

Overview

Many enterprise applications are not web-based. and use other standard or proprietary protocols
to communicate over P networks. Clientless Secure Sockets Layer (S5L) virtual private
network (VPN gateways must therefore provide some aliernative possibilities for users to
access these application resources. This lesson discusses application plug-ins, Cisco smart
tunnels, port forwarding, and the Secure Sockets Layer and Transport Layer Security
(SSL/TLS) email proxy features of the Ciseo ASA adaptive security appliance SSL VPN
gateway, which provide clientless access to a wide range of thin- and thick-client applications.
In the lesson, youwill learn how to conligure, verify, and troubleshoot these access features.

Objectives

Upon completing this lesson, you will be able to deploy and manage advanced clientless VPN
application access features of a clientless Cisco 351 VPN, This ability includes being able 1o
meet these objectives:

m  Plan the deployment of clientless SSL VPN application access [eatures
s Configure application plug-ins

m  Configure and verify smart tunnels in clientless SSL VPN

m  Configure and verify port forwarding in clientless SSL VPN

®  Troubleshoot advanced application aceess in clientless SSL YPN



Configuration Choices, Basic Procedures, and
Required Input Parameters

This topic describes how to plan the deployment of clientless 851 VPN application access
features.

Advanced Application Access
Solution Componenis

EI. SE_TLE smssan EI ::;: l'.'_*:

Unrusted Nabanri
Lar Comaolér wih
Srddar

The SSL VPN rewriting proxy in the Cisco ASA adaptive security appliance provides
clientless, transparent aceess to web and Common Internet File System (CIFS) resources
behind the Cisco ASA adaptive security appliance to clients enly using a web browser. To
provide access to other enterprise applications, including terminal aceess, database clients, or
instant messaging applications, the Cisco ASA adaptive security appliance provides several
methods of relaying data over the 8SL VPN gateway without the requirement for an SSL VPN
client installation,

To enable such advanced application access methods, the Cisco ASA adaptive security
appliance loads some additional software in the web-browsing session of the client. This
software acts as a lightweight client or a helper relay agent that enables additional
communications over an SSL VPN session. The Cisco ASA adaptive security appliance does
not require any other components 1o enable advanced application access,
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Advanced Application Access

Deployment Options
= Application plug-ins:
— Access from the browser
— Recommended approach
- Limited range of applications
= Smart tunnels:
- Support for native application clients
— Recommended for all applications without plug-in
= Port forwarding:
— Older technology
— Use for Linux and earlier Cisco ASA software versions

You ean choose several options when deploying advanced application aceess:

®  Application plug-ins provide users with thin application client access to enlerprise
resources. This 1s the recommended approach but it supports only a himited set of
applications,

m  Cisco Smart Tunnels provide users with native application client aceess 1o enterprise
resources. This approach is the recommended approach for all applications that do not have
a plug-in.

m  Port forwarding provides users with native application client aceess 1o Snlerprise resources.
This method should only be used i smart tunnels cannot be deployved, such as on Linux
workstations or when running older Cisco ASA adaptive security appliance software
VErsions,
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Advanced Application Access
Input Parameters

Description

Type af remola application Ragured 1o determing compatigility with ramaote
and application protocal accase mathods

Local priviages of the ramota
uear

Oparating system of the
ramale usar

Ragurementfor nativa client  Regquirad to chaose batween native applicatans
applizations wid applate

Before you deploy advanced application access, you will need to gather some input parameters
aboul remote systems that are being used by the remote user. Gather the following information:

m  Thevype of applications and application protocols that are used by remote users, that you
will need o support over a clientless S5L VPN session.

m  The local privileges of the remote user, who may use a hmited account without
administrative rights on the remote system.

®m  The operating system that is used by remote users.

Thesea three picces of information will allow you to determine the application and operating
gystem compatibility with advanced access methods. They will allow you to choose the
most optimal method for a particular environment.

®  The requirement lor the use of native applications, versus thin applications with redueed
functionality, which can be provisioned by the SSL VPN gateway. Some users may réguire
advanced application features {such as a specific terminal emulation) that thin application
chients do not provide.

a-gid
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Configuring Application Plug-Ins

This topic describes how to configure application plug-ins on the Cisco ASA adapuve security
appliance SSL VPN gateway.

Configuring Application Plug-lns
Owverview of Application Plug-Ins

Application plug-ins are lightweight client applications
that run inside the browser.

= Java or ActiveX applets downloaded from the SSL VPN
gateway on demand

* Executed inside the browser SSL VPN sassion
* Provided by Cisco and downleadable frem Cisco.com

TER ooy Forward
mncansudzed TEP 50 hostpoe

Application plug-ins are light-client applications that provide basic application functionality
ingide the browser ol a user. These plug-ins are downloaded on demand from the SSL VPN
gatewsy, and all their communications with internal protected resources is transparently
encapsulated within the 851 VPN session. The user does not have to use any local applications,
but mnstead uses the thin applicanon plug-ins only.

This figure illustrates plug-in-based application access:

I. A user connects and authenticates to the 551 VPN portal and then runs an application plug-
in that allows access toa server that is running on the internal network.

()

The application plug-in runs inside the browser, and reuses the 851 session of the browser
with the SSL VPN gateway to forward a TCP connection inside it.

3. The SSL VPN gateway extracts the TCP session from the 881 VPN session, establishes a
TCP connection with the destination server, and aets as a data relay between the two TCP
SEE810Ns,

The application plug-ins are distributed by Cisco through the Cisco ASA adaptive security
appliance (remote access plug-ins) software download page, and need to be imported into the
appliance. Each plug-in contains multiple files that are packed into a JAR (Java Archive) file.
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Configuring Application Plug-Ins

Benefits and Limitations

Do not require client instaliation on Only & limited number of

remote system applications supported

Easy to use for the remote sser May motinclude all native client
functionality

Do not reguire administrator Mot sup ported on Windows Mobile

privileges on remote system platfarm

The benefits of application plug-ins are as follows:

m  They do not require any installation on the remaote system, because they run as Java or
ActiveX applets inside the browser.

m  They are easy to use for the remote user, because they start virtually automatically and are
precon{igured for use.

m  They do not require administrator privile ges on the remote system. (Microsolt AetiveX
applets may require additional privileges, but a Java alternative ean be used instead. )

The limitations of application plug-ins are as follows:

= There isonly a limited number of plug-ing available, mostly 1o support interactive terminal
ACC LSS,

m  The plug-ins do not contain all the functionahty that their thick-client equivalents elude,
and may not support some leatures that are required by your users.

= Application plug-ins are not supported on the Windows Mobile platform, and generally not
supported on platforms that do not support Java.

Nota Per the GNU General Public License [GPL), Gisco redistributes the plug-ins without having
made any changes to them: Per the GMNU GPL, Cisco cannct directly enhance these plug-
ing. Cisco does not provide direct support for or recommend any particular plug-ins that are
riot redistributed by Cisco:
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Configuring Application Plug-Ins

Avallable Plug-ins
Plugin | Supported Application Servers |

S5H Telnet, S5H servers

ROP Microsoft Terminal Services servers

ROPZ Mewer Microsoft Terminal Services (Windows 2003
R2, Windows Vista, Windows 7} servers

104 Citrix ICA servers

VNG VNG servers

Cisco provides the following application plug-ins for download on Cisco.com:

®  The SSH plug-in provides a standard terminal emulator with support for the Telnet and
Secure Shell (SSH) (version | and 2) protocols. You can control the SSH version by
providing command-line parameters to the application plug-in mits URL.

m  The RDP plug-m provides a Microsoli Remote Deskiop Protocol (RDP) client to connect
o older versions of Microsoft Terminal Services servers.

®  The RDP2 plug-in provides a Microsolt Remote Deskiop Protocol (RDP) client to conneet
to newer versions of Microsolt Terminal Services ( Windows 2003 Server B2, Windows
Vista, and Windows 7) servers. The ActiveX version of the plug-in also supports advanced
functionality, such as sharing of remote drives or printers on the terminal server. You can
control this functionality by providing command-line parameters to the application plug-in
mnits URL.

Note Youcan import RDP-and RDPZ2 plug-ins to make both of them available to clientless users.

®  The ICA plug-in provides an Independent Computing Architecture (1CA) client o conneet
Lo Citrix WinFrame, XenApp, and XenDeskiop terminal services.

m  The VNC plug-in provides a Virtual Network Computing ( VNC) client to conneet to ¥ NC
display servers. The WNC plug-in does not support encryption over the internal network.
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Configuring Application Plug-Ins

Configuration Tasks

1. Downlead and impert application plug-ins from Cisco.Com
ta the Cisco ASA FFE

2. Enable application plug-in aceess on S5L VPN portal.
3. {Optional) Control access Lo intemal resources.

To conligure application plug-in-based aceess through a Cisco ASA adaptive security appliance
SSL VBN gateway, vou will perform the [ollowing conliguration tasks:

. Download and import application plug-in files from Cisco.com to the Cisco ASA adaptive
security appliance lash file system (FFS).

2. Enable application plug-in access on the 8L VPN portal, using optional application plug-
in hookmarks,

3. Opuonally, deploy access control features on the Cisco ASA adaptive security appliance
SSL VPN gateway to control aceess from application plug-ins to internal resources,
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Configuring Application Plug-Ins

Configuration Scenario

o
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This figure presents the conliguration scenario that is used in upcoming configuration tasks.

Y ou will import all required application plug-ins on the Cisco ASA adaptive security appliance
and configure an RDP2 bookmark, which the elient will select after login. The client will then
load the RDP2 plug-in, and access a terminal server ( 10.10.1.1) in the internal network. You
will also configure the Cisco ASA adaptive security appliance to limit aceess to the protected
network using a webtype access control list (ACL), which will only allow the specific RDP
connection Lo the internal network.

The confliguration scenario assumes that the Cisco ASA adaptive security appliance s already
configured with a basic clientless 851 VPN gateway [unctionality as was discussed in the
previous lesson, “Deploying a Basic elientless VPN Solution.”
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Configuring Application Plug-Ins
Task 1: Download and Import Application Plug-Ins
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The first conliguration step in the application plug-ins configuration sequence 1s to download
the needed application plug-ins from Cisco.com, and install them on the Cisco ASA adaptive
security appliance. You can find the application plug-ins i the Cisco.com Cisco ASA adapuve
security appliance software download section, or downlead them as part of the Cisco ASA
adaptive security appliance client bundle, which includes the Ciseo AnyConnect elient, Ciseo
Secure Desktop, and all application plug-ins.

The Ciseo ASA adaptive seeurity appliance chent bundle can be found at
hitp:/fw wow.cisco.com/cgi-bin/tablebuild.plasa-manufacturing.

You can either unpack the client bundle yourself, and install the relevant [iles manually, or
have the Cisco ASA adapuve security appliance automatically install them. The Cisco ASA
adaptive security appliance client bundle 15 a #ip file and i’ vou transfer 1o the Cisco ASA
adaptive security appliance {lash, the appliance will automatically decompress it and install all
included software upon reboot. The file that is downloaded from Cisco.com must be renamed
“client_bundie zip” for the auto install w work.

T
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Configuring Application Plug-Ins
Task 1: Download and Import Application Plug-ins
{Cont.)
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Tomanually import plug-ins mto the security appliance, complete the following steps:

Step 1

Step 2
Step 3

Step 4

Step 5

Choose Configuration > Remote Access VPN = Clientless SSL VPN Access >
Portal = Client-Server Plug-Ins.

Click the Import button.

Choose the type of plug-in that is to be imporied from the Plug-in Name (Frotocol)
drop-down menu.

Click the Browse Local Files button to choose any plug-ins that are downloaded
from Cisco.com on your local machine.

After the plug-in has been chosen, elick Import Now o import the plug-in for use
by the security appliance.

In this figure, the RDP2 plug-in is being imported to the security appliance for use with the
SS5L WPN. The Cisco ASA adaptive security appliance will unpack the JTAR plug-ins file and
wrile the unpacked [iles o the appropriate Ciseo ASA adapuve security appliance [ile system.
Aflter you have imported all the desired plug-ing, they will be listed in the main Chient-Server
Plug-ins window,

To remove a plug-in that has been imported to the Cisco ASA adaptive security appliance,
select the plug-in. and then click the Delete button.
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Configuring Application Plug-Ins

Task 2: Enable Application Plug-In Access
* Create bookmarks with plug-in-related URL protocols.
* Enter plug-in-related URLs with free URL entry.
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After the plug-ins have been imported to the Cisco ASA adaptive security appliance, you do
not need to authorize their use in group policies. [ you are using 5L VPN portal bookmarks,
you now have the option of choosing additional protocols—as supported by plug-ins—in the
bookmark URL specification. If you allow free URL entry on the SSL VPN portal, users ean
now enter URLswith protocols that are supported by imported plug-ins. In this second taslk,
you will ereate bookmarks that use application plug-ins and allow users to start these plug-ins
from the SSL VPN portal.

To configure SSL VPN portal bookmarks to use imported plug-ins, complete the following
steps:

Step 1 Choose Configuration > Remote Acecess VPN = Clientless SSL VPN Access >
Portal > Bookmarks and click Add to add a new bookmark list.
Configure the bookmark list name and elick Add to create individual bookmarks for
this list. The Add Bookmark window appears as shown in the figure.

Step 2 To configure a bookmark title named *Internal server™ in this example, choose the
desired plug-in protocol, and then configure the target server address. In this
example, the RDPZ plug-in using the RDPZ protocol is used, connecting to the
intranet. domain.com internal server. An optional subtitle of “Terminal access to
internal server™ is alse defined Tor this bookmark.

Stap 3 Click OK to add the bookmark to the security appliance configuration and then click
Apply to send the configuration to the security appliance. Save your configuration if
TECESEArY,

After the bookmark st with the RDP2 bookmark 18 configured, apply the bookmark
list to the desired group policy as shown in the previous lesson.
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Specifying Applet Settings

Some of the plug-mns allow you to specily additional settings in the URL, which the plug-in will
interpret as a set of parameters for the current plug-in session. For example, vou can specifly the
S8H plug-in to use a specific S8H version in the following manner:

m  Specifying the bookmark or free entry URL as sshe//<targer= will default to SSH version 2
(SSHv2).

m  Specifying the bookmark or free entry URL as sshe//<targer=?version=1 will use S§H
version | (SSHv).

Other plug-ins that are not discussed in this lesson support single sign-on (5503 to internal
resources. They are covered in a later lesson of this madule.

Configuring Application Plug-Ins

Task 3: Contrel Access to Internal Resources
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In the third task, you can optionally control aceess o mternal resources by creating or
modifying your webtype ACLs to permit or deny plug-in-based URLs. To control access; you
should ereate access control entries (ACEs) in vour webtype ACLs and apply the webtype
ACLs to the desired group policies, as shown in the previous lesson, to allow the appropriate
URLs based on the plug-ins protecol. In this example, you will add an ACE to an existing
webtype ACL to allow RDP2 aceess to the intranet domain.com internal server.
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Configuring Application Plug-Ins
CLI Configuration

igport wabvpr plug-inm protocol Tdpl flaphi/Tdpl-plugin.GS$02ll.jar
|
access=list BASIC-CLIENTLESE-ACL webtype peralc url

Tdpdyf fincranat.doaeiniocom log dafeult

This output shows the CL1 commands that are required to configure application plug-in access.

In the CL1 enter the privileged mode of the Cisco ASA adaptive security appliance and use the
import webvpn plug-in protoeol command to manually import application plug-ins that are
located in the flash {ile system or from a remote URL. This configuration will automatically
enable all access o URL s that are managed by the plug-in protocol,

Mext, optionally ereate or modify the webtype ACL by creating an ACE thatallows access Lo
plug-in-based resources, using the access-list name webtype command.
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import webvpn plug-in protocol

To install a plug-in to the adapuive security appliance, enter the import webvpn plug-in
protecol command 1n privileged EXEC mode.

import webvpn plug-in protocol protocol URL

import webvpn plug-in protocol Parameters

Parameter Description

protocel | m  rdp: The Remote Desktop Protocol (RDP) plug-in lets the remote userconnect toa
computer running Microsoft Terminal Services. Cisco redistributes this plug-in
withrout &ny changes. The website containing the original is
hitp:i/proper|avardp.sourceforge. net!,

n  s8h, telnet: The Secure Shell [(SSH) plug-in lets the remaote user establish a secure
channel to 2 remote computer or lets the remote user use Telnet to connectto a
remote computer. Cisco redistributes this plug-in without any changes. The website
containing the original is httpjavassh.orgl.

Caution The import webvpn plug-in protocol sshtelnet URL command installs
both the SEH and Telnet plug-ins. Do not enter this command once for
S55H and once for Telnet. When you type the ssh,telnet string, do nat
insert & space. Use the revert webvpn plug-in protocol command to
remove any import webvpn plug-in protecol commands that deviate
from these reguirements.

®  vnec: The Virtual Metwork Computing (WNC] plug-in lets the remote user use a
monitor, keyboard, and mouse to view and control a computer with remote desktop
sharing turned on. Cisco redistributes this plug-in without any changes. The
‘website containing the original is hitp:dwww tightvnc.comy,

(23] Remaote path to the source of the plug-in.
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Configuring Application Plug-Ins

Implementation Guidelines

* Use plug-in access as the preferred methed for nen-HTTP
and non-CIFS resolrce access:

- Unless native application functionality is required
= Enforce strict access control:
— Plug-ins can allow interactive terminal access

When you are implementing application plug-in access in clientless 851 VPNs, consider the
following guidelines:
m  Use application plug-ins as the preferred method of access to non=-HT TP and non-C1FS

resources, unless your business process requires the use of features not available 1n the
lighrweight clients inside application plug-ins.

m Most plug-ins provide interactive terminal access Lo resources in the protected network.
Because such powerlul resource aceess can lead 1o sericus seeurity ineidents, limit the
required aecess 1o & minimum using weblype ACLs, especially from unmanaged, and less
trustworthy, remote ¢lients.
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Verifying Application Plug-Ins
Verify Access
The S5L VPN portal will automatically change:

» Plug-in-related views
* URL &ntry for plug-in access
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To verily the availability of application plug-ins and their proper operation, log in to the SSL
VPN portal. You should see additional plug-in-related views on the lelt side of the 881 VPN
portal home page. These views—il selected—will display all plug-in-related bookmarks on the
right side of the portal page: By detault, all bookmarks are listed. In this example, the newly
ereated RDP2 bookmark is available in the right pane of the portal windew.

Users can also use the URL entry control (i allowed) to select URLs for protocels that are
enabled by imported plug-ins.

This example is alse showing other imported plug-ins like Telnet/SSH, Citrix MetaFrame,
WNC, and so on.
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Verifying Application Plug-Ins
\erify Access (Cont.)
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Click the plug-in bookmark, or enter a plug-in-refated URL 1o start an application plug-in. The
portal will start a plug-in in a new window. In this example, selecting the RDP2 plug-in
resulted in starting the RDP2 application plug-in, which opened a Java RDP2 elient in a new
window, showing the login page of an internal server.
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Configuring Smart Tunnels

This topic describes how to configure and verifly smart tunnels in clientless SSL VPN,
-

Configuring Smart Tunnels
Smart Tunnels Overview
Smart tunnels allow for relaying of arbitrary TCP
applications over the clientless SSL VPN session.
= Mative applications on the client unaware of the VPN session

= Alightweight connection broker applet, downloaded from the
S5L VPN gateway, intercepts sessions from designatad
applications and forwards them across the 35L VPN session

= No recenfiguration an the client
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Smart tunnels enable users to use native client applications without the need for administrative
rights or application recontiguration. They work by downloading a smart tunnel agent
(connection broker) applet to the client system. This applet intercepts all local socket calls (that
18, connection requests of the application to the operating system kemel) from Window Seckets
2 (Winsock2) TCP applications, and automatically redirects them into the SSL VPN session.

This figure illustrates smart-lunnel-based application access:

. A user connects and authenticates to the SSL VPN portal. A smart tunnel configuration is
in place lor that user and automatically downloads and executes the smart tunnel agent on
the client system. For example, the user starts the Lotus Sametime instant messaging client.

()

The smart tunnel applet intercepts the TCP connection of the 1BM Lotus Sametime client o
the real server and forwards it over the existing S5L VPN session.

3. The SSL VPN gateway extracts the TCP session from the SSL VPN session, establishes a
TCP connection with the real target server, and acts as a data relay bevween the two TCP
SEES10NS.

As long as the clientless SSL VPN session of the user is established, specific local applications
can access protected resources, with the agent relaying their communications through the
session of the browser.
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Configuring Smart Tunnels
Benefits and Limitations

Support native cient applications:  Only simple static<port TGP
over S3L VPN applications are supported

Easy to use for the remote tser Bypass advanced CiscoOASA
application controls and SSMs

Do not reguire administrator Supported or Windows and Mac
privileges on remote system 05X

The benefits of smart tunnels are as (ollows:

m  They support the use of fully featured, native applications that are already installed on the
remote system of the user.

m  They are easy to use for the remote user because users use their local network applications
just as they doin the protected network or any other non-YPN loeation.

m  They do not require administrator privileges on the remote system.

The limitations of smart tunnels are as {ollows:
®  Only Winsock2, TCP-based applications are eligible for smart wnne! access.

= Smart tunnels only suppoct simple, statie-port TCP applications. Most chient-server
applications operate in this manner and are therefore supported by smart tunnels,

m  Access to the internal network bypasses the advanced Ciseo ASA adapuive security
appliance application layer controls and security services modules. However, you can
control the resourees that are available to smart tunnel users by destination server and
application {port).

m Smart tunnels are supported only on the Microselt Windows and Apple Mac OS X
platforms.
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Configuring Smart Tunnels

Configuration Options
= For applicaticns with native clients:
— Create smart tunnel list
— Assign smart tunnel list to a greup policy or user profile
» For web-based applications:
— Add bookmark to bookmark list
- Enable bookmark for smart tunnel access
— Bind bookmark list to group policy or user profile
= Contrel access to internal resources

You have several options when deploying smart tunne! access through a Cisco ASA adaptive
security appliance SSL VPN gateway:

®  For applications with native clients:

—  Create a smart tunnel list.

—  Assign the smart tunne| list to a group policy or user profile.
®  For web-based applications:

—  Add a bookmark to the bookmark list.

—  Enable a bookmark for smart tunnel aceess.

—  Bind a bookmark list to a group policy or user profile.

®  Control access to mternal resources,
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Configuring Smart Tunnels
Configuration Scenario
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This figure presents the configuration scenario that is used in upeoming confliguration tasks.
You will configure the Cisco ASA adaptive security appliance to download and enable the
smart tunnel applet to the elient, and relay all trafTic of the native Microsolt Windows RDP
client to the mternal network. The remote user will use the native Microsoft Windows RDP
client to conneet 1o the internal terminal server at 10.10.1.1. Youwill also conligure the Cisco
ASA adaptive security appliance to limit aceess to the protected network using a webtype ACL,
which will only allow the specilic RDP connection to the internal network.

As with the previous conliguration seenario, this configuration seenario assumes that the Cisco
ASA adaptive security apphiance 18 already configured with a basic clientless SSL VPN
eateway functionality. It alse 18 assumed that the configuration is using local authentication,
authorization, and accounting (AAA) authentication and a verifiable identity certificate and that
all local users are assigned the BASIC-CLIENTLESS-POLICY group policy.
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Configuring Smart Tunnels
Create Smart Tunnel List (Native Application Access)
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If you want to enable smart tunnel access for applications with a nauve client, you createa list
of applications that are subjeet to smart tunnels relaying on the remote client.

To configure a smart tunnel list, complete the following steps:

Step 1 Choose Configuration > Remote Access VPN > Clientless S5L VPN Access >
Portal > Smart Tunnels, and click Add 1o add a new smart tunnel list.

Step 2 Configure a list name (MY -SMART-TUNNELS in this example), and then elick
Add to add a smart wunne! list entry (that 18, application).

Step 3 In the Add Smart Tunnel Entey window, specily the properties of the application on
the remote system of the user:

= Application 1D: This is a user-friendly name that will be displayed on the
portal, informing users which applications are relayed to the central site.

m 085: Specily the operaung system on which this entry will be active ( Windows
or 08 X, In this example, Windows 1s used.

m  Process Name: Specily the name of the application executable that performs
network connections. You can only specily the executable name, or the entire
pathname, if vou require uniqueness, In this example, the MSTSC EXE
executable name of the Microsoft Windows native RDP client is used.

m  Hash: Optionally, specily the cryptographic Secure Hash Algorithm 1 (SHA-1)
hash of the executable to unigquely identify it. Use this option if there are many
executables with the same name, il you want to allow only a specific build or
version of the executable o be included in smart tunnels, or to lower the nsk of
rogue executables being included in smart tunnels. Hashes are only supported on
the Windows platform.

Step 4 Click OK rwice to accept the new smart tunnel list entry and smart tunnel list,
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Application Image Hashing

To obtain the hash value for an application, enter the checksum of the application (that is, the
cheeksum of the executable file) nto a ueility that calculates a hash vsing the SHA-1 algorithm,
One example of such a utility is the Microsoft File Checksum Integrity Verifier (FCIV), which
15 available at hitp://support.microsoli.com/kb/84 1290/, After installing FCIV, place &
wemporary copy of the application to be hashed on a path that contains no spaces (for example,
citempimstseexe), then enter feiv.exe -shal application at the command line (for example,
feiv.exe -shal e/\temp \mstsc.exe) to display the SHA-1 hash,

Configuring Smart Tunnels
Bind Smart Tunnel List to Group Policy or User Profile
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To enable smart tunnel access for applications with a native client, you will apply a smart
tunnel policy to a group policy or user profile.

To modify an existing chientless SSL VPN group policy, complete the following steps:

Step 1 Choose Configuration > Remote Aecess VPN = Clientless SSL VPN Access >
Group Policies and choose the previeusly configured clientless SSL VPN group
policy (not shown),

Step 2 Click Edit to edit the clientless SSL VPN group policy.

Step 3 Choose the Portal option rom the menu in the lefi pane and uncheck the Inherit
check box next to the Smart Tunnel List {ield in the Smart Tunnel area. From the
drop-down box, select the configured smart tunne! list—in this example, the MY'-
SMART-TUNNELS list.

Stap 4 Optionally, check the Auto Start check box to configure the smart tunnel Lo start
automatically for this group policy.

Stap 5 Click OK and Apply to apply the changes to the Cisco ASA adaptive security

appliance. Click Save to save the configuration; if needed.
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Configuring Smart Tunnels

Enable Bookmarks for Smart Tunnel Access
* Bookmarked application will display in a separate web browser
« Al traffic from that browser will pass over smart tunnel
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To deploy smart tunnels for web-based application access, enable a bookmark for smart tunnel
by completing these sieps:

Step 1 Choose Configuration = Remaote Access VPN = Clientless S5L VPN Access >
Portal = Bookmarks, and create a bookmark list or edit an exasting one.

Step 2 Add a bookmark or edit an existing bookmark. In the example, a bookmark for a
custom web-based application running on port 3333 is configured.

Step 3 Check the Enable Smart Tunnel check box. Only HTTP and HTTPS bookmarks
can be configured for smart tunnel access.

Step 4 Click OK and Apply te apply the configuration.

The bookmarked applicatien will appear in a separate web browser, not in the S8L VPN portal.
All rafTie from that browser will pass over the smart tunnel.
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Configuring Smart Tunnels

Control Access to Internal Resources
VWebtype ACEs support address and service syntax.
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You can optionally control access to internal resources by creatung or modifying your weblype
ACLs to permit or deny smart tunne! access to specilic resources. To control access, you should
create ACEs in your webtype ACLs that are applied to the desired group policies, and click the
Filter on Address and Service radio button in the webtype ACE. In this example, the webtype
ACE only allows aceess to the 10.10.1.1 server on TCP port 3389 (RDP).
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Configuring Smart Tunnels
CLI Configuration
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This output shows the CL1 commands that are required to configure smart tunnel aceess on the
Cisco ASA adapuive security appliance.

Inthe CLI, enter SSL VPN server configuration submode on the Ciseo ASA adaptive security
appliance using the webvpn command, and conligure smart tunnel application lists using the
smari-tunnel list command. In the example, a smart tunnel hst named MY-SMART-
TUNMELS, which specifies the RDP Windows applications, is deflined.

Next, assign the configured smart tunnel application list 1o a group policy by entering group-
peliey atributes mode and then switching to s webvpn submode. Use the smart-tunnel
command to assign the smart tunnels list. Use the optional mite-start argument (o automatically
download and start the smart tunnel agent. In the example, the MY-SMART-TUNNELS smart
wnnel list s applied to the BASIC-CLIENTLESS-POLICY group policy.

Finally, you may create a webtype ACL and ACES that govern smart tunnel access using the
access-list name webiype command. In the example, the webtype ACL will only permit access
to the 10.10.1. 1 sérver over port 3389 (RDP),

smart-tunnel list

To poputate a list of applications that can use a clientless (browser-based) 5L VPN session o
connect to private sites, use the smart-tunnel list command in webvpn configuration mode.

To remove an application from a list, use the no form of the command, specilying the entry. To
remove an entire list of applications from the adaptive security appliance configuration, use the
no form of the command, specifying only the List.

[no] smart-tunnel list list application path [platform O8] [hash)
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smart-tunnel list Parameters

Parameter

Description

Mame of = list of applications or programs. Use quotation marks around the name
if it includes a space. The CL| creates the list if it is not present inthe
configuration. Otherwise, the CLI adds the entry to the list.

application Name of the application to be granted smart tunnel access. Thie string can be up

to 64 characters.

path

For Mac OS, the full path to the application. For Windows, the filename of the
application; or a complete or partial path to the application, including its filename.
The string can be up to 128 characters.

platform OS5 (Optional if the operating system is Microsoft Windows) Enter windows or mac to

specify the host of the application,

hash

{Optional and applicable only for Windows ) Enter the hash of the application, The
SHA-1 hash is always 40 hexadecimal characters.

smart-tunnel auto-start

T start smart tunnel access automatically upon user login in a clientless (browser-based) SSL
VPN session, use the smart-tunnel auto-start command in group-policy webvpn configuration
mode or username webvpn conliguration mode.

To remove the smart-tunnel command from the group policy or username and inherit the [no)
smart-tunnel command from the default group policy, use the no form of the command.

smart-tunnel auto-start fist

smart-tunnel auto-start Parameters

Parameter

Description

Iist

The name of a smart tunnel list that is already present in the adaptive security appliance
webvpn configuration.

To view any smart tunnel list entries already present inthe S3L VPN configuration,
enter the show running-config webvpn command in privileged EXEC mode.
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Verifying Smart Tunnels
Manual Start (Smart Tunnel List)
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Toverily the availability of smart tunnels and their proper operation, log inte the SSL VPN
portal, You should see an Application Access view on the left side of the SSL VPN portal

home page.

If yvou have configured smart tunne |s to start automatically, the browser will automatically

download and execute the smart tunnel relay agent. You will be prompred to inspect and aceept
digitally signed smart tunnel relay applets from the 881 VPN gateway.

I you have not configured smart tunnels to start automatically, select the Application Aceess
view, and click the Start Smart Tunnel button. The browser will download and execute the
smart tunnel relay agent on demand.
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Verifying Smart Tunnels
Manual Start with RDP Example (Smart Tunnel List)

Remote Desktop

W =
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After the smart tunnel relay agent is running, you can now start the native applications that are
present in the smart tunnel list of your group policy and aceess internal resources directly (from
an end-user perspective). In this example, the native Microsolt Windows RDP client is used as
it were started 1n a non-VPN environment (or a full tunneling Ciseo AnyConnect session),
displaying the login page of an internal server.

Verifying Smart Tunnels
Statistics (Smart Tunnel List)
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In the Apphication Access view, you can also observe basie smart tunne! statistics and settings,
such as the list of applications that are enabled [or smart tunneling and the amount of data that
is exchanged through the smart tunnel session sinee its start.
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Verifying Smart Tunnels

Bookmark
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This figure illustrates smart tunne! access using a bookmark. When you seleet the bookmark,
the application will display in a separate browser window. Y ou must accept the smart tunne!
applet that is signed by Cisco before using the application.
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Verifying Smart Tunnels

Implementation Guidelines
* Use smart tunnels when application plug-ins do net provide
the required application functionality.
* Use bookmarks enabled for smart tunnel access to relay data

to problematic sites that do not werk using SSL VPN proxy
rewriting.

When youimplement smart tunnel aceess in clientless S8L VP Ns, consider the following
guidelines:

m Use smart tunnel aceess as the preferred method o support native remote user applications,
especially when you cannot support a business process with application plug-ins,

®  Youcan also use smart tunnels as a remedy for applications that have issues with the S5L
VPN proxy rewriting engine. Use bookmarks enabled for smart tunnel access o relay data
to problematie sites.
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Configuring Port Forwarding

This topic describes how to configure and vealy port forwarding in elientless 881 VPN,

Configuring Port Forwarding
Port-Forwarding Overview
Port forwarding allows for relaying of arbitrary static TCP
applications over the clientless S5L VPN session.

* fApplications on the clientconnect to a local port.

= An in-browser Java relay listening on this socket forwards all
data to the SSL VPN gateway.

* The SSL VPN gateway forwards all data to a preconfigured host
ar port.

= Requires client application and operating system name
esolution reconfiguration.

Pt Farwadng Asol el
Lo Par 3000

TIR prewy Serwans acodond ated

Port forwarding 15 a legacy technology for supporting TCP-based applications over a clientless
SSL VPN connection. Port forwarding is an alternative to smart tunnels, and makes use of a
local Java helper applet to provide access o certain applications that are not supported by
clientless SSL VPN by default. The Java helper application requires local applications to make
& connection to the local host to provide port-lforwarding functionality, and heénce require some
modificauon of application settings or user actions,

This figure illustrates the port forwarding process to aceess an internal Telnet server:

Alfter 851 VPN portal login, a port-forwarding Java applet that was downloaded from the
SSL VPN portal is started inside the browser. The applet dynamically modifies the local
hosts file; and listens on the loopback address of the remote host at port 3001 to forward
any incoming connections over the S5L VPN session.

A user opens a Telnet client and attempts to connect to an internal server, on port 3001,

The local hosts file; which is dynamically modified by the Java applet, 1s analyzed. It has
an entry for the internal server, which points to 127.0.0.1. The Telnet client connects to the
local host on port 3001, The Java applet forwards this connection over the S8L VPN
session Lo the S8L VPN gateway.

The VPN gateway extracts the TCP session from the SSL VPN session, establishes a TCP
eonnection with the destination on the standard Telnet port (23), and acts as a data relay
berween the two TCP sessions,
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Configuring Port Forwarding
Benefits and Limitations

Supports native dient applications - Only simple static<port TGP

over S3L VPN applications are supported
Bypasses advanced Cisco ABA
application controls and SSMs
Requires presence of native client
applications on the remote system
Reguires users to change their
application settings
Requires acmimistrator rights to
change host files

The benefits of port forwarding are as follows:

They support the use of fully featured, native applications that are already installed on the
system of the remote user.

The limitations of port forwarding are as follows:

Port forwarding only supports simple, static-port TCP applications.

Aceess o the internal network bypasses the advanced Cisco ASA adaptive security
appliance application layer controls and security services modules. However, you can
controf the resources that are available to port forwarding users by destination server and
application {port).

It requires premstalled native applications on the remote system.

It requires users to change their application settings (for example, the destination port of the
server), and even their application usage (ifa different application profile 1s needed for
non-YVPN and VPN use).

Port forwarding requires administrative rights because it changes the local hosts file.
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Configuring Port Forwarding

Configuration Tasks
1. Specify client protocols (ports) subject to port ferwarding.
2. Enable pert forwarding in a group policy.
3. (Opticnal) Centrol access to internal resources.

To configure port forwarding aceess through a Cisco ASA adapuve security apphiance SSL
VPN gateway, you will perform the following configuration tasks:

I. Specify the client application protocols (ports) that are subject to port forwarding after S5L
VPN login.

[

Enable port forwarding in a group policy, and optionally specily that the port-forwarding
applet should start automatically alier S5L VPN login.

3. Opuonally, deploy aceess control features on the Cisco ASA adaptive security appliance
SSL VPN gateway to control aceess [rom applications using port forwarding to internal
FESOUMCEs.
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Configuring Port Forwarding

Configuration Scenario

SELITLS Sassan

This figure presents the conliguration scenario that 1s used in upcoming configuration tasks. You
will configure the Cisco ASA adaptive secunity appliance to download and enable the Java port-
forwarding applet to the elient. The Java port-forwarding client hstens for incoming TCP
conneetions from the local host, on the local TCP pont of 3001, and relays these connections o
the internal terminal serverat 10.10.1.1. The remote user uses the native Microsolt RDP elient to
conneet to the local port, which relays the RDP session to the internal terminal server. You will
also conligure the Ciseo ASA adaptive security appliance to linit aceess Lo the protected network
using a webtype ACL, which only allows the specific RDP connection Lo the internal network.

Asg with the previous eonliguration seenario, this configuration seenario assumes that the Cisco
ASA adaptive security appliance 18 already configured with a basic clientless 851 VPN
gateway functionality. 1tis alse assumed that the configuration is using local AAA
authentication and a verifiable identity certificate, and that all local users are assigned the
BASIC-CLIENTLESS-POLICY group policy.
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Configuring Port Forwarding
Task 1: Specify Client Protocols for Port Forwarding
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In the first configuration task of this configuration sequence, you will create a list of remote
application ports and mternal respurces that are subject to port forwarding on the remote client.
¥ou ean specily a single list of ports and internal resources for each group policy, which you
ean apply to one or more connection profiles.

To configure a port-lforwarding list, complete the following steps:

Step 1 Choeose Configuration > Remote Access VPN > Clientless S5L VPN Access >
Portal = Port Forwarding, and click Add to add a new port-forwarding list.

Step 2 Configure a list name (MY-PORT-FORWARDING in this example) and then click
Add to add a port-forwarding entry.

Step 3 Configure the port-forwarding list entry with the Tellowing information:

s Loeal TCP Port: The port that the Java applet will listen on Tor port forwarding
of this entry. In this example, TCP port 3001 15 used. To avoid confliets with
existing services on the loeal host, use a port number greater than 1024,

®  Remole Server: The address of the target server in the protected network, You
can also provide the name of a remote secver, I you provide the name, the Java
applet will modify the local host file, Recall that adminisrator privileges are
needed wo change the local host file.

m  Remote TCP Port: The port that the target server in the protected network will
listen on for network connections.

m  Description: User-friendly description of the port-forwarding entry.

Step 4 Click OK rwice to accept the new port-lorwarding entry and port-forwarding lise

Nota Remember that the connection is only cryptographically protected between the remote user
and the Cisco ABA adaptive security appliance. If a protocol such as Telnet is used with port
forwarding, the traffic leaving the security appliance will not be encrypted.

©2010 Cieco Systems, Ino.  Deploymeant of Cisca ASA Adaptive Securty Appliance Clisntiess Ramaote-Accsss VPN Solutions 487



Configuring Port Forwarding
Task 2: Enable Port Forwarding in a Group Policy
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In the second configuration task, you will apply a port-forwarding policy to & group policy,
which will in turn enable port forwarding on one or more connection profiles.

To madify the esasting Clientless SSL VPN group policy, complete the following steps:

Step 1 Choeese Configuration > Remote Aecess VPN > Clientless S5L VPN Access >
Group Policies, and choose the previously configured Clientless S5L VPN group
policy.

Stap 2 Click Edit to edit the Clientless S5L VPN group policy.

Step 3 Choose the Portal option lrom the menu in the left pane and uncheck the Inherit
cheek box from the Port-Forwarding List and Applet Name [elds.

Stap 4 Choose the conligured port-forwarding list (MY-PORT-FORWARDING) from the
drop-down menu, and check the Aute Applet Download check box. The Auto
Applet Download option will automatically start the configured port-forwarding
conliguration after the user logs into the S8L VPN portal.

Step 5 Optionally, configure an applet name Tor the application to be used with the Port-
Forwarding SSL VPN,

Step 6 Click OK and Apply to apply the changes to the Cisco ASA adaptive security

appliance. Click Save to save the configuration, if necessary.
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Configuring Port Forwarding

Task 3: (Opticnal) Control Access to Internal Resources
Webtype ACEs support address and service syntax.
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Confguraton = Remole Acceas WEN > Dientess 881 VPN Access > Aduenced > Wao A%1S

In the third task, you can optionally control aceess to mternal resources by creating or
modifying your webtype ACLSs to permit or deny port-forwarding aceess to specific resources.
The configuration of these rules is the same as with the smart tunnel feature.
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Configuring Port Forwarding
CLI Configuration
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This output shows the CLI1 commands that are required to configure port forwarding on the
Cisco ASA adaptive security appliance.

In the CL1, enter SSL VPN server configuration submade on the Cisco ASA adaptive security
appliance using the webvpn command, and create a port-forwarding list and 115 entries using
one or more port-lorward commands. Next, assign the port-lforwarding hist to & group policy,
n its group-policy attributes mode and webvpn submode, using the port-ferward name
command. Optionally, configure the Cisco ASA adaptive security appliance to automatically
start the port-forwarding applet using the port-lforward auto-start command. Finally, you may
create a webtype ACL and ACEs that govern port forwarding aceess using the access-list name
webtype command.

In the example, a pont forwarding list named MY-PORT-FORWARDING, which speciflies a
local port of 300, with the remote server 1P address of 100.10.1.1 and a remote port of 3389 15
defined. A description about this port-forwarding list is also configured.

The MY-PORT-FORWARDING port-forwarding hst 15 applied to the BASIC-CLIENTLESS-
POLICY group policy. Autostart 15 enabled and a name that identifies the port forwarding to
the users is also configured.

The webtype ACL will only permit access to the 100 10.1.1 server over port 3389 (RDP).

port-forward

To configure the set of applications that users of a clientless SSL VPN sgssion can access over
forwarded TCP ports, use the port-forward command in webvpn configuration mode.

port-lorward [lisi_name local_port remote_server remote_port description |

To confligure access to multiple applications, use this command with the same list_name
multiple umes, once for each application.

To remove aconligured application from a list, use the no port-lorward fist_name local_port
command (you do not need to include the remote_server and remote_port parameters).

ne port-forward lisiname localpor:
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To remove an entire configured list, use the no port-forward [ist_name command.

no port-forward list_name

port-forward Parameters

Parametar

Daescription

description

Provides the application name or short description that displays on the end-user
Port Forwarding Java applet screen. Maximum €4 characters.

Iist name

Groups the set of applications (forwarded TCP ports) that users of clientless
33L VPN sessions can access. Maximum, 64 characters.

Jocal port

Specifies the local port that listens for TCP traffic for an application. You can
use alocal port number only once for a fsi_name. Enter & port number in the
range 1=-65,535. To avoid conflicts with existing services, use a port number
greater than 1024,

remote port

Specifies the port to connect to for this application on the remote server. This is
the actual port that the application uses. Enter a port number in the range 1=
65,535 or port name.

mEmote Server

Provides the DNS name or I[P address of the remote server for an application.
you enter the IP address, vou may enter it in either 1P version 4 (1P} or IP
version & (IPv6) format. Cisco recommends using a hostname so that you do not
have to configure the client applications for a specific 1P eddress. The dns sarvar-
group nama-sarvar command must resolve the hostname to an IP address.

port-forward-name

To configure the display name that identifies TCP port forwarding to end vwsers for a particular
user or group policy, use the port-forward-name command in webvpn mode, which you enter
from group-policy or username mode. To delete the display name, including a null value that is
created by using the pert-lforward-name none command: wse the no form of the command.
The no option restores the default name, Application Aceess. To prevent a display name, use
the port-forward none command.

port-forward-name |[value name | none}

port-forward-name Parameters

Parameter Description

none Indicates that there is no display name. Sets a null value, which disallows a display

name. Prevents inheriting a value.

value name | Describes port forwarding to end users. Maximum of 255 characters.
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Verifying Port Forwarding
Autostart
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To verilty the availability of port forwarding and its proper operation, log o the S5L VPN
portal. You should see an Application Access view on the lell side of the SSL VPN portal
home page.

I you have configured the port-forwarding applet to start automatically, the browser will
automatically download and execute the Java applet, which will use a separate popup window.
In most browsers, you have to authorize this popup window separately.
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Verifying Port Forwarding

Manual Start
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If you have not configured port forwarding to start automatically, select the Application Access
view, and click the Start Applications button. The browser will download and execute the

Java port-lorwarding applet on demand.

Verifying Port Forwarding
RDP Example
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After the port forwarding lava applet is unning, you can start a native application and access
internal resourees by either connecting to a local host port (as shown in this figure) or by
connecting Lo the real hostname of the internal server. You connect over the local port (3041 in
this example) of the Java applet because the Java applet will also modify the hosts file. In this
example, the native Microsoft Windows RDP client conneets to the local host port, where it 18
forwarded 1o an internal RDP internal server.
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Verifying Port Forwarding

Implementation Guidelines

* Use port forwarding when you cannot use application plug-
Ins ar smart tunnels.

- Linux
— Older Cisco ASA code

When you implement port lorwarding in clientless SSL VPNs, consider the following
guideline:
m  Useport forwarding to support native remote-user applications when smart tunnels are not

available or cannot be deployed. Examples include Linux workstations or deployments of
older Cisco ASA adapuive security appliance code.
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Troubleshooting Advanced Application Access

This topic describes how to troubleshoot advanced application access in clientless S5 VPN,

Troubleshooting Application Access
Visual Troubleshooting Aid
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When you troubleshoot advanced application access in clientless SSL VPN, you should

perform troubleshooting tasks on both the client and the Ciseo ASA adaptive security

appliance, if' possible. This figure shows some most useful troubleshooting commands and

actions that vou can use on the involved components,

On the client, you can use operating systern utilities to determine the reason for connectivity or

name resolution issues. Here are some examples of these utilities:

m  The pingutility to determine Layer 3 reachability of the Cisco ASA adaptive security
appliance from the client

®  The traceroute utility to troubleshoot Laver 3 path problems between the client and the
Cisco ASA adapuve secunity appliance

8 The nslookup and dig unlities to troubleshoot name resolution; 1if the browser or
application cannot resolve the URL for the SSL VPN portal or an internal resource

Note that the Cisco ASA adapuve security appliance will extensively log all 1ssues into its
sysiog subsystem. The debug commands are generally not required, except for in-depth
troubleshooting of complex 1ssues.
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Troubleshooting Application Access
Application Plug-Ins
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I you are encountering aceess issues with application plug-ins, you may follow these steps 1o
troubleshoot the issue:

Stap 1 First, check that the URL type you are trying to access 15 available on the Cisco
ASA adaptive security appliance (for example, in the free URL entry field). If they
are.not, you may have forgotten to import a specific apphication plug-in into the
Cisco ASA adaptive security appliance.

Stap 2 II' URL s are available, but the application plug-ins do not start, you may have a
client configuration or compatibility 1ssue. Verily that the 851 VPN gateway is
added to the list of trusted sites, that the client system has a supported release of the
Java Runtime Environment, or that it supports ActiveX control execution.

Step 3 Finally, if the application plug-ins start but cannot connect 1o the target server, verily
webtype ACLs on the Cisco ASA adapuive security appliance to se¢ if they permit or
deny the connection. Additionally, verify that the SSL VPN gateway has a route to
the target server, the target server has a route to the SSL VPN gateway, and there is
no access control between them that could impair communications.

I these steps do not resolve your issue, you may need to deploy troubleshooting tools that are
bevond the scope of this course.
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Troubleshooting Application Access
Smart Tunnels
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If you are encounteéring access 1ssues with smart tunnels, you may follow these sieps to
troubleshoot the issue:

Step 1 First, check that the smart tunnel agent starts. 11 it does not, verily that the client
systern has a supported release of the Java Runtime Environment, or that it supports
ActiveX control execulion.

Step 2 I the agent starts, but your apphication does not connect, verify that you have
specilied the correct application name ( for example, using the Windows Task
Manager or Explorer on a remote Windows system) or hash. Also, verify webnvpe
ACLs on the Cisco ASA adaptive security appliance o see if they permit or deny the
connection. Additonally, verify that the S5L VPN gateway has a route to the target
server, the target server Has a route to the SSL YPN gateway, and there is no access
control between them that could impair communications,

Step 3 Finally, if other applications that are not included in the Smart Tunnels policy on
VOUE 8ysLem are experiencing connectivity problems, ensure that you have not
specilied additonal, unwanted applications in the smart tunne! list using
wildearding. Additionally, if you have problems accessing only specific
destinations, verify that the Cisco ASA adaptive security appliance is not blocking
them, for example, by preventing same-security-level communication.

T these steps da not resolve your issue, you may need to deploy troubleshooting tools that are
beyond the scope of this course.
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Troubleshooting Application Access
Port Forwarding
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I you are encountering access issues with port forwarding, you may follow these steps to
troubleshoot the issue:

Stap 1 First, check that the port-forwarding Java applet starts. 111t does not, verify that the
client system has a supported release of the Java Runtime Environment.

Step 2 Verily that the lava applet has correctly configured the elient system:

m  Onthe client PC, open a command prompt window and use the netstat —an
command to verify that loeal listening ports have been opened by the Port
Forwarding applet.

m Verily that the hosts file on the client computer has been updated to support
TCP port forwarding. Examine the hosts file in the Windows
system32\driversiete sublolder to see if entries with a local host address have
been added afier the applet starts.

Stap 3 If' the agent starts, but vour application does not connect, verily that you have
specified the correct ports in the application, that names are correctly resolved to
loeal host, and that the user has administrative rights. Next, verify webtype ACLs an
the Cisco ASA adaptive security appliance to see if they permit or deny the
connection. Additionally, verify that the $5L VPN gateway has a route to the target
server, the target server has a route to the SS5L VPN gateway, and there is no access
control between them that could impair communications.

If these steps do not resolve vour issue, you may need to deploy roubleshooting tools that are
bevond the scope of this course.
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This topic summarizes the key points that were discussed in this lesson.

Summary

= You can choose several options when deploying advanced
application access: application plug-ins, Cisco Smart
Tunnels, or port forwarding.

= Use application plug-ins as the simplest method te deploy
access to nonweb and non-CIFS resources.

* Use smarttunnels to provide access using native application
dients.

* Deploy port farwarding when application plug-ins or smart
tunnels are not available.

Treubleshooting involves tools that are available on the
security appliance and the remote computer.
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Lesson 3

Deploying Advanced
Authentication and SSO in a
Clientless SSL VPN

Overview

Most enterprises need scalable authentication schemes, in which the network devices offload
the authentication process to back-end user databases, such as Lighvweight Directory Access
Protocol (LDAP), TACACS—, or RADIUS. In clientless 5L VPNs, public key infrastructure
(PK1) offers a scalable and secure authentication method. This lesson discusses the various
authentication approaches that should be evaluated when designing a chientless SSL VPN
solution, including the option of combining muluple authentications in & single process. Lo the
lesson, you will learn how to provide user-Itiendly authentication strategy, by requiring only &
single sign-on (550) when accessing various resources.

Objectives

Upon completing this lesson, you will be able to deploy and manage advanced authentication
features of a clientless Cisco SSL VPN, This ability includes being able to meet these
objectives:

m  Plan the deployment of advanced client authentication in clientless SSL WPNs

s Configure and verify the local CA or integrate with an external CA and provision client
certiticates

m  Configure and verify integration with supporting PKI entities and verify external certificate
authorization

®  Troubleshoot advanced client authentication in clientless SSL VPNg

m  Configure and verify clientless VPN S50 methods



Configuration Choices, Basic Procedures, and

Required Input Parameters

This topic describes how to design clientless S5L VPN authentication.

Authentication
Solution Components
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Advanced Clientless SSL VPN

A key aspect of a 851 VPN 1s secure user authentication. You should consider these features as

you design the authentication system:

m  Seeurity: This aspect is related o the security of the authentication protocol and the
trustworthiness of the user credentials. S8L is considered a wrusted protocol, but the
security depends on the strength of user credentials. 1o general, static passwords are
considered a weaker authentication means than certificates or one-time passwords (OTF).
Highest security 15 obtained by combining various authentication methods together.

m Sealability: This design consideration is related to how easy iU is Lo provision new users
and maintain the authentication system. Maintenance involves such tasks as eredential

revocation, high availability, and accountability.

®  Integration: This design consideration involves integration with existing user databases.

Authentication in an $5L VPN occurs in two stages:

= Server-side authentication, in which the client verifies the authenticity of the server

m  Client-side authentication, in which the secver verifies the authenticity of the clients
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Advanced Clientless SSL VPN
Authentication

Server-Side Authentication Options
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Server-side authentication of a clientless SSL VPN session can be based on these two things:

m  Self-signed Cisco ASA adaptive seeurity appliance certificate: This certilicate is
generated automatically by the security appliance and 15 not verifiable by any external
entity. The issuer and subject of the self-signed certificate are set to the 1P address of the
security apphiance. t should be used only in testing or very small deployments. You can
mstall the self-signed certificate into the certificate store of the client compuater using the
manual import procedure. In this process, the client should compare the fingerprint of the
obtained Cisco ASA adaptive security appliance certificate with the onginal lingerprint
received out-of-band (QOB) from the security appliance administrator. The self-signed
Cisco ASA security appliance certificates should be avoided in production environments.

m  Identity cértificate that is issued by an external CA: In this scenario, the Cisco ASA
adaptive security appliance enrolls with an extemal certificate authority (CA) to obtain an
identity certificate that can be verified by the clients. The clients can verify the server
identity certificate, because they have a list of trusted CA rool certificates in their browsers.
If the security appliance enrolls with a CA from that preinstalled eertificate list, the client
uses the appropriate root certificate to authenticate the 5L VPN server. This solution is
recommended for unmanaged elients, including Internet kiosks.
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Advanced Clientless SSL VPN
Authentication

Client-Side Authentication Options
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Client-side authentication of a clientless SSL VPN session can be based on authentication
methods:

m  Certificates that are issued by internal CA of Cisco ASA adaptive security appliance:
These certificates are installed on the elient computer at the first client connection to the
SSL VPN server. This appreach is recommended for managed elients only.

m  Certificates that are issued by external CA: In this deployment mode, the VPN users
enroll with the same external CA as the 851 VPN server. The SSL VPN server has an
identity certificate that is issued by the same external CA. The SSL VPN server
authenticates client certificates using the root cemificate. The SSL VPN server must be in
possession of the root certificate before its own enrollment. This approach is typically
deployed in enterprise-wide environments, where the enterprise maintains its own CA.
Otherwise, the cost of user certificates may be an issue.

m  Passwords: Passwords can be stored either in the local user database or on an external
AAA server. They can be static in nature, or dynamic, as in the case of OTPs. Password-
based authentication is recommended for users accessing the S8L VPN from unmanaged
computers, such ag public kiosks. The level of trust that is placed on the password-based
authentication can be increased by implementing two-factor authentication, which relies on
something you know (password) and something you have (OTP wken).

m  Multiple sequential authentications: In this method, the authentication strength is
enhanced by combining two or more independent authentications, which must jointly
succeed before a user can aceess the VPN, The authentications can either be performed
against separate databases or be a combination of cectificate and authentication,
authorization, and aceounting (AAA) authentications. Double authentication using different
user databases with static passwords 18 not very common, as it can be argued that statie
password authentication is not significantly strengthened by another static password.
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Advanced Clientless SSL VPN
Authentication

Deployment Guidelines

= Combine independent authenticaticn methods to provide
strong, multifactor authentication:

— Certificates with static passwords.
— OTP tokens with stalic passwords.

— Slalic passwords on two AAA servers do not significantly
anhance authentication strength.

= Balance authentication strength with ease of use

— Using certificates with QTP and static passwards s
cumbersome for most users.

The security appliance offers a wide set of authentication options, but only some combinations
of the authentication methods significantly increase the level of trust that 1s put in the
authentication process. These combinations are the most recommended combinations:

m  Certificates with static passwords for managed client computers: This option is not
feasible for Internet kiosks.

® (TP tokens with statie passwords for managed or unmanaged endpoints: This method
can be implemented either as a single authentication using an A AA server that ofTloads
authentication toa back-end OTP server, or as two daisv-chained authentications, one
against a statie database, and one against an OTP server.

In general, you should make the system as user-friendly as possible, il the security policy &
obeyed. Combining too many authentications and requiring the users to enter too many
passwords may place a heavy burden on their shoulders.
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Deploying Client Certificate-Based
Authentication

This topic describes how to deploy client-side certificate-based authentication.

Client Authentication Using Local CA

Configuration Tasks

Cenfigure the Cisco ASA local CAC

Create CA useraccounts.”

Enable client certificate authentication for a connection prefile.

{Optional) Configure mapping of certificates to connection
prafiles.

Provision client identity certificates to clientless users.
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To configure client authentication using the local CA, you will perform the following
configuration 1asks:

l. Configure the Cisco ASA adaptive security appliance local CA (discussed in previous
lessons and not discussed here again).

2. Create CA user accounts (discussed in previous lessons and not discussed here again).
3. Enable client certificate authentication for a connection profile.

4. Optonally, configure mapping of certificates to connection profiles,

3. Provision client identity certificates to chentless users.

These tasks are described in the next pages,
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Client Authentication Using Local CA
Configuration Scenario

Create soost
carifoaie ey

This figure presents the conliguration scenario that is used in upcoming configuration tasks.
You will enable the local CA function on the security appliance and create C A user accounts.
The fully qualified domain names ( FODNs) of the users will include the organizational unit to
which they belong. When the users connect to the SSL VPN, the Cisco ASA adaptive security
appliance will check the organizational unit informatien to apply the correct connection profile
to the user session, BASIC-CLIENTLESS-PROFILE in the example.
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Client Authentication Using Local CA

Input Parameters

Parameter _____|Description |

Connection profilss that use  Authentication type is canfigured in the

‘martificate-bazed connection profile saltings. Amixad =et of lypes
authanticatian & supporad on a sngle Cieco ASA
Local CA saltings |sguarnama, CAand clant kay sizes and CA

=nd chent carificala ifetimes. Secrat
pasephrasa ragquired to activals lbeal CA,

Local cadificate usars and Prapar naming, using tha FODN slamants ON,

thair FQDN names OU, O, C, allows 4 granular binding paiicy of
ueargroups to connactian profiles.

COTP enralimant credentials Usars must provide tha OTP credantials whan
dhiaining kays and idenity carificates. OTP
cradentials distnbutad via email or D0B.

Wapping to cannaction Dafinition of subjact FODNS that ars mapped o

profiles given cannactian prafies.

You have to gather these input parameters prior implementing certificate-based client
authentication using the local CA:

m  Connection profiles that use eertificate-based authentication: The authentication type 15
configured in the connection profile settings. Te authenticate users using local CA
certificates, the appropriate connection profiles must be configured for eertificate-based
authentication.

m  Loeal CA settings: These parameters include the issuer name, key sizes of the CA and the
chients, and CA and client eertificate lifetimes. The key size of the client defines the length
of the private- and public-key pair that the appliance generates for each chient. All these
parameters have default values that can be used Tor most environments. Only the secret
passphrase must be explicitly entered to activate the local CA feature.

m  Local certificate users and their FQDN names: The FODN ¢lements, such as common
pame { CN), erganizational unit (OU), organization name (), and country (), allow a
eranular policy of binding user groups to connection profiles. An example of such a policy
could match the country of the SSL VPN user ( C attribute) and assign a connection profile
that uses a localized customization,

m  OTP enrollment eredentials: OTP enrollment credentials must be generated by the security
appliance local CA and distnbuted to the users before they can connect to the SSL VPN,
These credentials must be distributed QOB, for example by emmailing them to the users.

®  Mapping to connection profiles: 1f you want o assign users to connection profiles based
on their FQDN attributes, you must gather the mapping criteria that will define the binding.
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Client Authentication Using Local CA

Task 3: Enable Client Certificate Authentication for a Conneclion
Profile
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The configuration procedure starts with the enabling of the local CA and creating CA user
accounts, but these tasks are omitted here because they have been explained sufficiently in an
earlier lesson. The first two tasks are identical to Cisco AnyConnect elient authentication

SCENArios.

In the third configuration task, vou will enable certificate-based authentication in the required
connection profiles. To enable certificate-based authentication, complete the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Choose Configuration > Remote Aceess > Clientless SSL VPN Access >
Connection Profiles,

Choose a desired connection profile and elick the Edit button.

I the Authentication area of the window, click the Certilicate radio button as the
authentication method.

Click OK.
Click Apply to apply the configuration,
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Client Authentication Using Local CA

Task 4: (Opticnal) Configure Mapping of Certificates to
nnection Profiles
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In the optional fourth task, you can define the mapping of elient certificates to the appropriate
connection profiles by completing these steps:

Stap 1

Stap 2
Step 3

Step 4

Step 5

Step &
Step 7

Choose Configuration > Remaote Access VPN > Advanced > Certificate to SSL
VPN Connection Profile Maps,

Click Add to create a new map. A new window opens (not shown in the figure).

In the Certificate 1o Conneetion Profile Map configuration window, enter the map
name and the rule priority and select the connection profile that is used lor the
binding. The rule priority defines the order in which muluple maps are evaluated
when searching for a conneetion profile that will be used for a user session. This
step 1s not shown i the example.

Select a map from the list of entries 1n the Certificate to Connection Profile Maps
area and click Add in the Mapping Criteria area. The Add Certalicate Matching Rule
Criterion window opens.

Define your matching eriteria by choosing appropriate parameters from the Field,
Component, and Operator drop-down lists and entering the required value in the
Walue field. If the map consists of multiple matehing rules, all conditions must be
met to bind the user certificate to the connection profile (the rules are combined
using the logical AND operator).

Click OK.
Click Apply to apply the configuration.

You may have multiple Certificate to Connection Profile Maps, each containing several
matching rules. In this scenario, one map 1s defined: Salesmap. The salesmap consists of one
rule that matches certificates where the organizational unit (OL) attribute in the subject field is
set to "Sales” and maps them to connection profile BASIC-CLIENTLESS-PROFILE.
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Client Authentication Using Local CA

Task 5: Provision Client [dentity Certificates to Clientless Users
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In the fifth task, the users have to obtain the private- and public-key pair, and their identity
certificate from the security appliance. The enrollment oeeurs in several sieps:

. The Cisco ASA adaptive security appliance points the users to a conneetion profile or the
users select a connection profile that is configured tor cetificate-based authentication.

[

The users receive an authentication failure notification and a link for obtaining a new
certilicate and the keys.

3. Afier choosing the link, the security appliance prompts users to submit their username and
OTP, which they should have already obtained using an (GOB method.

4. When the username and (3TP combination is correct, the security appliance sends the user a
Personal Information Exchange (or Public Key Cryplography Standard #12 [PKCS #12])
file that the user can open or save. The file has the username a8 its name and extension pl2
and contains the private- and public-key pair and user identity certificate.
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Client Authentication Using Local CA

Task 5: Provision Client [dentity Certificates to Clientless Users
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In the fifth task, the users have to obtain the private- and public-key pair, and their identity
certificate from the security appliance. The enrollment oeeurs in several sieps:

. The Cisco ASA adaptive security appliance points the users to a conneetion profile or the
users select a connection profile that is configured tor cetificate-based authentication.

[

The users receive an authentication failure notification and a link for obtaining a new
certilicate and the keys.

3. Afier choosing the link, the security appliance prompts users to submit their username and
OTP, which they should have already obtained using an (GOB method.

4. When the username and (3TP combination is correct, the security appliance sends the user a
Personal Information Exchange (or Public Key Cryplography Standard #12 [PKCS #12])
file that the user can open or save. The file has the username a8 its name and extension pl2
and contains the private- and public-key pair and user identity certificate.
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Client Authentication Using Local CA
CLI Configuration
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The figure shows the CL1 command that is used to enable client authentication using the local
CA. Local CA configuration and local €A user creation are not shown in the figure, because it
has been already discussed in the “Deploving Advanced Authentication in AnyConnect Full
Tunnel 881 VPNs" lesson.

To create a certficate-to-connection profile mapping using the CL1, use the following
commands. First, ereate a certificate-to-connection profile map using the erypto ca certificate
map command, followed by a name and rule prnority number. Then use the subjeet-name atrr
command to speeily which attribute in a subject name should contain which value. Finally,
configure mapping between a connection profile and connection profile map using the
certifieate-group-map command in webvpn conliguration mode. In the example, il the Ciseo
ASA adapuive security appliance receives a certificate where the organization unit (OU) field of
a subject name contains “Sales,” the security appliance will use the BASIC-CONNECTI1ON-
PROFILE connection profile for that user.

Finally, enable certificates-based authentication for a specific connection profile (tunnel group)
using the authentieation certificate command in tunnel-group configuration mode.

crypto ca certificate map

To enter CA certificate map mode, use the erypto ea certificate map command in global
configuration mode. Executing this command places you in CA certificate map mode. Use this
group of commands 1o maintain a paoritized list of certificate mapping rules. The sequence
number orders the mapping rules, To remove a crvpte CA certilicate map rule, use the no form
of the command.

erypto ea certificate map {seguence-number | map-name seguence-number|
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crypto ca certificate map Parameters

Parameter

Description

map-ramse

Specifies a name for a certificate-to-group map.

SEqL[E!‘]CE-ﬂL.Iﬂ".bEI’

Specifies a number for the certificate map rule you are creating. The range is

1 through 65535. You can use this number when cresting a tunnel-group-
miap, which maps & tunnel group to a certificate map rule.

subject-name (crypto ca certificate map)

To indicate that rule entry 1s applied to the subject distinguished name (DN) of the [Psec peer
certificate, use the subjeet-name command in erypto CA certificate map configuration maode.
To remove a subject-name, use the no form of the command.

subject-name [altr tog eq | ne | co | ne string)

subject-name (crypto ca certificate map) Parameters

Paramatar | Description
attr tag |Indicates that only the specified sttribute value from the certificate DN will be compared to
the rule entry string, The tag values are as follows:
= DNQ = DN gualifier
r GENQ = Generational quslifier
n | = Initigls
n  GN = Givenname
n  N= Name
s 3N = Surmame
n |P =P address
m  S5ER = Serial number
n  UNAME = Unstructured name
= EA = Email address
n T=Tille
» O =0Organization name
n L = locality
s SP = State and province
n  C=Country
= OU = Organizational unit
n  CN=Common name
co Specifies that the rule entry string must be a substring in the DM string or indicated attribute.
ag Specifies that the DN string or indicated attribute must match the entire rule-string.
ne Specifies that the rule entry string must not be a substring in the DN string or indicated
attribute.
ne Specifies that the DN string or indicated attribute must not match the entire rule string.
srring Specifies the value to be matched.

certificate-group-map

To agsociate arule entry from a certificate map with a tunnel group, use the certificate-group-
map command in webvpn configuration mode. To cléar current tunnel-group map associations,
use the no form of this command.

certificate-group-map certificate_map _name index tunnel _group_name
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certificate-group-map Parameters

Parameter

Description

certificate map nams

The name of a certificate map.

Index

The numerc identifier for 3 map entry in the certificate map. The
index value can be in a range of 1=65,535.

tunnel group name

The name of the tunnel group that is chosen if the map entry
maiches the certificate. The tunnel-group name must already exist.

authentication-certificate

To request a certificate from a Web VPN client that is establishing a connection, use
the authentication-certilicate command in webvpn configuration mode. To cancel the

requirement for a client certificate, use the no form of this command,

authentication-certificate interface-name

authentication-certificate Parameters

Parameter Dascription

interfarce-nama
Availableinterfaces names are:

s inside: Name of interface GigabitEthe rmet /1
= outside: Mame of interface GigabitEthernet 0/0

The name of the interface that Is used to establish the connection.

Client Authentication Using Local CA

Werify Connection Profile Assignment

= When certificate-to-profile mapping does not exist, user sees
Login page and selects appropriate profile.

= When mapping exists, userimmediataly enters the portal .
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To verily the certificate-based chient authentication, you will conneet to the SSL VPN, II the

security appliance has a Certificate to Connection Profile Map that binds the user eeruficate o
a connection profile; the specilied connecuon profile will be chosen auromatically. If the maps
do not mateh, the users may have the option to select 8 connection prolile, as shown in the left
halfl of the figure. This ligure depicts a successful certificate-based authentication in which the

user is not prompted for any credentials, as shown in the right half of the figure.
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Client Authentication Using Local CA

Verify Connection Profile Assignment (Cont.)
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To view the user sessions parameters, including the selected connection profile, you may
choose Monitoring = VPN = VPN Statistics = Sessions, and select Clientless SSL VPN from
the Filter By drop-down menu to view the session parameters. This verification will show if the
correct profile has been activated by the Certificate to Connection Profile Map.
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Client Authentication Using External CA

Configuration Tasks

1. Impertthe external CA certificate (file-based, manual, SCEP)
to the Cisco ASA*

2. Enroll clients into the PKEL”
4. Enable client cerificate authentication for a connection profile”

" Discussad (0 e Doewous 28s0ns

To configure client authentication using an external CA, you will pedform the following tasks:

l. Import the external CA root certificate to the security appliance. The CA root certificate
can be installed using file import, manual (cut-and-paste), or Simple Cenificate Encollment
Protocol (SCEP).

F

2. Enroll elients into the PKL

3. Enable client certificate authentication for a connection profile.
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Client Authentication Using External CA
Configuration Scenario
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This figure illustrates the configuration scenario for deploying browser {client) certificates
using an external CA.

The security appliance receives the coot certificate of the external CA and enrolls with it to
obtain its identity certificate.

The users may have the root centificate premstalled in their browsers, depending on which CA
provider is selected in a partientar enterprse environment. Alternatively, the enterprise may
manage its own CA. In either case, the users must enroll with the CA to obtain their identity
certificates.

Both server authentication and client authentication are certificate-based. The entities use the
self-signed root certificate to verify the authenticity of the peer certificate. Onee the peer
certilicate is validated, the entities extract the embedded public key to verify the peer signature.

You have to gather some input data before deploying browser (client) certificates using an
external CA. The parameters belong to three areas:

m  Data for external CA enrollment procedure: Enrollment procedure varies based on the
CA provider. The enterprise may choose 1o install and manage its own CA. CA root
certificate can be imported to the Cisco ASA adaptive security appliance using a file
import, a cut-and-paste process, or SCEP.

= Client authentication policy: Optionally, you may combine certiflicate-based client
authentication with AAA that uses passwords to authenticate the users.

m  Mapping to connection profiles: Optionally, use the definition of FQDNs mapped to
mven connection profiles. This method is required only if elient-side authentication is
certificate-based and users should be directed to various connection profiles based on their
X500 subject names.
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Deploying Advanced Gateway PKI Integration,
External Certificate Authorization, and Double
Authentication

This topic describes how to intégrate the SSL VPN server in a PK1 environment, deploy
external certilicate authorization, and implément double authentication.
-
Advanced Gateway PKI Integration and
External Certificate Authorization
Configuration Tasks
1. (Optienal) Cenfigure a certificate revocation checking policy.”

=

2. [Opflicnal or as an alternative) Cenfigure A8A certificate
authorization.”

* Diacugsad in B8 awious Eaanng

To configure client authentication using an external CA, you will perform the following tasks:
. Optonally, configure a certificate revocation checking policy.
2. Optionally, or as an alternative, configure AAA certificate authorization.

These stepsare the same as for full tunneling 8L VPNs and are not repeated here.
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Multiple Client Authentication
Deployment Options
Client-side authentication options:

= Certificate-based and one AAA authentication

= Certificate-based and one AAA authentication with usermame
prefill and optionally hide

= Deuble AAA authentication (ne certificate)
— With eplicnal usermname reuse

You can deploy one of several multiple authentication combinations. The multiple client-side
authentication options in chentless SSL VPN are identical to the ones mn Ciseo AnyConneet
VPN Clients and inelude these:

m Certilicate-based and one AAA authentication

m  Certificate-based and one AAA authentication where username for AAA authentication can
be extracted from certificate subject field and hidden from users

m  Double AAA authentication (no certificate) with optional username reuse

This topie presents how to conligure multiple client authentications for clientless S8L VPN
connections,
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Configuring Multiple Client
Authentication

Overview
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This figure presents the configuration scenario that 15 used in upeoming configuration tasks.
First, you will configure certificate-based authentication with a single AAA password-based
authentication using the RADIUS server. Then you will configure double authentication,

where primary authentieation will be performed on the LDAP server and secondary on the
RADIUS server.
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Certificate-Based and AAA
Authentication

Certificate and One Afd Authentication
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Confguraton > Remoie Access VPN > Cilentess S5 VPN Access » Connecton Frofies

You will configure the respective connection profiles for both authentication types. Complete

the following steps:

Stap 1 Choose Configuration > Remaote Access VPN > Clientless SSL VPN Access >

Connection Profiles,
Step 2 Select the desired connection profile and click Edit.

Stap 3 Click the Both radio button in the Authentication section of the window.

Step 4 Select the appropriate primary AAA server group from the AAA Server Group drop-
down menu. In this example, MY-RADIUS-SVRS server group will be used.

Step 5 Click OK.

Step & Click Apply woapply the configuration.
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Confgureton > Remots Azoesd VPN > Cientess 881 WFN Aoceas > Conneotion Profies

Certificate-Based and AAA
Authentication

Certificate and One AAA Authentication with Prefill
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Next, you may conligure the username prefill feature. Complete the following steps:

Step 1

Step 2
Step 3

Step 4
Step 5

Step &

Step 7

Step 8

Choose Configuration > Remote Access VPN = Clientless S5L VPN Access >

Connection Profiles.
Select the desired connection profile and click Edit.

Expand the Advanced option in the menu and choose Authentieation in the
subment.

Check the Pre-fill Username from Certificate check box.

Opuonally, you may hide the username rom the end user by checking the Hide the

Username from End User eheck box. This feature increases the security by not
showing the username to users logging into S5L VPN,

Oprionally, modify the default method of extracting the username from the
certificate. You may define the primary and secondary lelds, choose o use the
entire distinguished name (DN) embedded in the certilicate, or defing a custom
seript for selecting the username.

Chick OK.
Click Apply to apply the configuration.
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Certificate-Based and AAA
Authentication

Verification
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To verify double authentication that uses certiflicates and a primary AAA method, you use a
browser to connect to the 581 VPN, I you have a correct certilicate installed in the certilicate
store, the browser submits it for certificate-based authentication. In the second step, the 881
VPN server requests user credentals. I the username prefill feature is enabled, the username
field is filled in and grayed out. 1T the feld 1s grayed out, the elient eannot alter the username.
After the user submits the correct static password, access to the SSL VPN portal 1s granted.
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Double AAA Authentication

E- Flarwr AL TS Sl & =]
SRR
Aeses Samorafie AAAfor Frimany
e Authenticaton
Mt ® AL 7 Cortherm ) Soit

Sonfgureton = Remaots Access VRN > Sientess 851 VPN Access » Spnnecion Frofies

e i, T =

10 b | T i oy Py

7] i ML F e G il

" | b preaary wserrurms (rhde msmestey e on bgnpegn]

Ammelng A =

T — Ayt Server & Py Semeday

Chowiei 5 JET Sesson Usemane Serer @ STy L

To implement the double AAA scenario, you configure the respective connection profile for
AAA authenticaton and configure the primary AAA server group. Complete the following steps:

Step 1

Step 2

Step 3

Step 4

Step 5

Step &

Step 7

Step 8

Step 9

Step 10

Choose Configuration > Remote Access VPN = Clientless SSL VPN Access >
Connection Profiles.

Select the desired connection profile and Click Edit

To configure primary authentication, elick the AAA mdio button in the
Aunthentication area of the window.

Select the appropriate primary server group from the AAA Server Group drop-down
ment. In this example, the primary authentcation will be offloaded to an external
LDAP database.

To configure secondary authentication, expand the Advaneed option from the menu
on the left and choose the Secondary Authentication submenu.

Choose the appropriate secondary AAA group from the Server Group drop-down
mend. In the example, the MY-RADIUS-SVRS server group is selected.

Orptionally, enable Tallback to local database by checking the Use LOCAL if Server
Group Fails check box.

Oiptionally, reuse the username from the primary authentication by checking the Use
Primary Username (Hide Secondary Username on Logon Page) check box.

Click OK.
Click Apply o apply the configuration.
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Double AAA Authentication

Verification
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To verify double AAA suthentication, you use a browser to connect to the 851 VPN,
Depending on the username reuse option for the secondary authentication, the login prompt that
is associated with the appropriate connection profile may contain one or two username {ields.

I you have a correct certificate installed i the certificate store, the browser will submut it for
certilicate-based authentication. In the second step, the SSL VPN server requests user
credentials. If the username prefill feature 1s enabled, the username field will be lilled in and
grayed out. IT the field 15 grayed out, the client cannot alter the username. Afller the user

submits the correct statc password, access to the portal is granted,
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Troubleshooting PKI Integration

This topic describes how to troubleshoot the integration of a elientless SSL VPN with PRL

Troubleshooting PKI Integration
Visual Troubleshooting Aid

Vi ideraty carificats narameres.
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PE1 offers strong authentication capabilities but requires that you understand the principles of
certificate operations. To integrate the SSL VPN system successfully with the PRI, vou should
know how to identify and resolve potential problems.

This ligure presents a typical SSL VPN integration with PR The CA may issue certificates to
the VPN server and optionally to users. The users obtain their identity certificates either from
the local CA that 15 based on the Cisco ASA adaptive security appliance or from the external
CA server. A number of verification and troubleshooting tools exist on the user computer, on
the security apphiance, and on the external servers (AAA, CA). This section focuses on the
troubleshooting methods that are available on the security appliance.
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Troubleshooting PKI Integration
PKIl Troubleshooting Flow

dareeanad

Il the certificate-based clientless SSL VPN authentication fails, perform these troubleshooting

sleps:

Stap 1

Stap 2

Step 3

Step 4

Step 5

First, check the cetificates that are installed on the client and on the security
appliance. 1f the certificates are missing, ensure that the enrollment 1s completed.

Check the current ime on the user computers and the security appliance. Although
the time does not need to be synchronized, it must fall withm the certificate validity
range of the peer certificate. For example, if Cisco ASA adaptive security appliance
identity certificate validity range 18 January 1, 2011 to January 1, 2012, and the
current date on user computer is in 2010, the client will consider the Cisco ASA
adaptive security appliance certificate invalid. The security appliance performs the
same validity check for user certificates.

Checle if certificates have been revoked. Revocation is supported for certificates that
are 1ssued by the Cisco ASA adaptive security appliance internal CA and éxternal
CA. The revoked Cisco ASA adaptive security appliance internal certificates can be
viewed and unrevoked in the menu Configuration > Remote Access VPN >
Certificate Management > Local Certificate Authority > Manage User
Certificates.

Check certificate-to-profile mapping in the menu Configuration > Remote A ccess
VPN = Advanced > Certificate to SSL VPN Connection Profile Maps. If the
mateh eriteria are missing or configured incorrectly, the binding feature will either
fail or point to 4 wrong connection profile.

Verily AAA operations. This step should be pecformed if AAA-based authentication
is attached to the certificate-based authentication or 18 configured as the stand-alone
client authentication mechanism, Basic AAA connectivity should be verilied on the
security applianee. For advanced examination of activity logs, you should use
gppropriate tools on the AAA server.
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Troubleshooting PKI Integration

Time Synchronization lssues
* Current time ocutside of certificate validity period
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BASA-3-T17027: Certifipate chain Failed walidatien., Certificate
chain dare ig sut-of-range.

This figure illustrates the security appliance console output when the current time on the
security appliance lies outside of the user certilicate validity range. You must enable logging on
the security appliance to view these messages. Instead of monitoring the operations via the
eonsole, you may use the real-time log viewer that is available in the Cisco Adaptive Security
Device Manager (Cisco ASDM) menu Monitoring > Logging > Real-Time Log Viewer.

The relevant message in this output reports that the certificate validation failed due to an out-of-
range condition.
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Troubleshooting PKI Integration
AAA Authentication Problems

= Authentication requires that user is present in database
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This figure illustrates the logging output that is generated as a result of an authonzation falure,
In this example, the security appliance 15 configured for a very rudimentary authorization—to
authorize users who exist in the AAA dabase. The user authenticates using certificates. Even
i the users exist in the local CA user database (Configuration > Remote Aceess VPN =
Certificate Management > Local Certificate Authority > Manage User Database), they do
not need to exist in the AAA user database. [T they are not configured as AAA users, the
authorization setting “Users must exist in the authorization database to connect™ will cause the
session o fail. You will see the message “AAA user authorization Rejected : reason = User was
not found” as seen in the figure,
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Deploying Clientless SSL VPN SSO

This topic describes the single sign-on (3303 feature of clientless 851 VPNs.

Clientless SSL VPN SS0O

Overview

« 850 enables users to access internal services without
entering username or password twice

= Five independent features:
— 8380 with HTTP Basic, NTLM, and FTP authentication

— Dedicated S50 servers (CA SiteMinder, SANL Browser
Post Profile)

— Macro subsiitution

— 580 for plug-ins

— 880 foremart tunnels (Microsoft Internet Explorer on
Microsoft Windows only)

S80 is a clientless SSL VPN feature that enables users to aceess different services on internal
servers without entering a username and password more than once. The S50 functionality can
be implemented using four independent features:

SS0 with HT'TP Basie, NTLM, and FTP authentication: This feature configures the
adaptive security applignee to automatically pass clientless 851 VPN user login credentials
(username and password) on to internal servers that are using HTTP Basie, NT LAN
Manager (NTLM), and FTP authentication.

Dedieated S50 servers: In this method, one of two dedicated S50 servers is deployed in
the internal netwaork:

—  Computer Associates SiteMinder SS0 server
—  Security Assertion Markup Language (SAML), Version 1.1, Browser Post Profile
S80) server

Macero substitution: This feature can be used for web-based applications in combination
with bookmarks and allows dynamie parameters, such as username and password, 1o be
mserted mto an HT TP request.

880 for application plug-ins: This method enables 850 for users who use application
plug-ins to access internal resources.

S50 for smart tunnels: This s a simplified S50 method that you can use for web-based
applications that use smart tunngls. This Teature 18 supported only on Microsofl Internet
Explorer running on Microsoflt Windows operating systems.

This topic brielly describes all live 880 methods.
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Note Another 330 festure available onthe Cisco ASA adaptive security appliance is 350
authentication using HT TP Form, but it s not described in the course.

Clientless SSL VPN SSO

HTTP Basic, NTLM, and FTP 850 Authentication

= HTTF Basic 330 can be used to access web pages that require
authentication using HTTP Basic authentication.

NTLM S50 can be used to access CIFS file shares that require
authentication.

= FTP 850 can be used to access FTP servers thal require FTP
authentication.

* You can corfigure either ene of mentioned methods er all of them.

You can usethe HI'TP Basic authentication feature to access web pages that require
authentication using the HTTP Basic authenueation method. NTLM S80 can be used to
access web pages and Common Internet File System (CIFS) file shares that require NTLM
authentication. FTP authentication can be used to access FTP servers, which require
authentication. When configuring 880, vou can enable either one of the mentioned methods
or all of them.
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Clientless SSL VPN SSO

Configure HTTP Basic, NTLM, and FTP 330 Authentication
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Sonfgureton = Remats Access VRN > Sientess 881 VPN Access » Groan Poices

Toenable S50 using HTTP Basie, NTLM, and FTP authentication using Cisco ASDNM,
complete the following steps:

Step 1 Inside Ciseo ASDM, choose Configuration = Remaote Aecess VPN > Clientless
SSL VPN Aceess > Group Policies (not shown in the figure). The Group Policies
pane appears,

Step 2 Selecta group poliey for which you would like to enable 880 and click Edit. The
Edit Internal Group Policy window appears.

Step 3 Expand the More Options menu and select the Single Signon submenu.

Step 4 Click Add in the Aute Signon Servers acea of the window. The Add Auto Signon
Entry window appears.

Step 5 Enter the IP address of the server that requires authentication into the 1P Address
field. 1n the example, the server at 10.0.0. 11 15 specified.

Step & Alternatively, click the URI radio button and enter the server that requires
authentication in the URI form.

Step 7 Select the authentication type by checking appropriate check box. 1o the example,
HTTP Basic, NTLM, and FTP authentication is selected.

Step 8 Make sure that the Use Username/Password that User Logins the Portal check box is
checked.

Step 9 Click OK vrwice.
Step 10 Click Apply to apply the configuration.
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Clientless SSL VPN SSO

Dedicated S50 Servers
= CA SiteMinder and SAML Browser Post Profile server supported
= Cisco ASA acts as a proxy

— At user logon, Cisco ASBA sends an S50 authentication request
[usermame and password)

— Receives an 550 authentication cookie

— Keeps cookie on behalf of the user and uses cookie to
authenticate the user to secure websites within the domain
protectad by the S80 server

The security appliance supports two dedicated 880 platforms:
m  Computer Associates Trust SiteMinder ( formerly Netegrity SiteMinder)

m SAML, Version 1.1 Browser Post Profile.

The S50 mechanism invokes after successful user authentication to either an AAA server
(SiteMinder) or a SAML Browser Post Profile server. In these cases, the clientless SSLVEN
server running on the adaptive security appliance acts as a proxy for the user to the authenticating
server. When a user logs in, the elientless 851 VPN server sends an 880 authentication request,
ncluding username and password, 1o the authenticating server using HTTPS,

Il the authenticating server approves the authentication request, it returns an S50 authentication
cookie to the elientless 851 VPN server. This cookie 1s kept on the adaptive security appliance
on behall of the user and used to authenticate the user o secure websites within the domain that
15 protected by the 880 server.

The S8 process oceurs in these steps:

Step 1 User logs into the clientless 851 VPN portal.

Step 2 Security appliance authenticates the user on the external AAA database.

Step 3 After successful authentication, the secunty appliance submits user profile to the
SiteMinder server.

Step 4 S50 server returns an authentication cookie. The appliance associates the cookie
with the client sessions and stores it for the duration of the session.

Step 5 When the user requests access Lo an internal server that would normally require
repeated authentication, the security appliance delivers the authentication cookie on
behalf of the user.
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Clientless SSL VPN SSO

Dedicated S50 Servers Configuration
* You have te assign configured S50 server to group policy or

user profile.
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Toset up SiteMinder 550 for a user or group, you must first conligure an AAA server
(RADIUS, LDAP, or others). Alter the AAA server authenticates the user, the clientless S5L
VPN server uses HTTPS 1o send an authentication reguest to the SiteMinder S80) server.

Toadd an S50 server, choose Configuration > Remote Aceess VPN = Clientless SSL VPN
Access > Advanced > Single Signon Servers, choose Add, and enter these parameters for a
SiteMinder server:

= Server Name: |I adding a server, enter the name ol the new S50 server. If editing a server,
this field is display enly: 1t displays the name of the selected S50 server.

®  Authentication Type: Displays the type of S50 server. The types that are currently
supported by the Cisco ASA adaptive security appliance are SiteMinder and SAML
Browser Post Profile,

m  LURL: Enter the S50 server URL to which the adaptive security apphance makes S50
authentication requests.

m  Secret Kev: Enter the secret key that is used to encrypl authentication requests 1o the S50
server. 1t is configured on the sécurity appliance, the S50 server, and the SiteMinder Policy
Server using the Cisco Java plug-in authentication scheme,

s Maximum Retries: The number of times the security appliance retries a failed S5O
authentication attempt before the authentication times-out. The range 18 from | to 3 retries
inclusive, and the default 15 three retries.

®  Request Timeout: The number of seconds before a failed SSO authentication attempt
times out. The range is from 1 to 30 seconds, the default is 3 seconds.

In addition to configuring the Cisco ASA adapuve security appliance, the SiteMinder Policy
Server must be configured for Ciseo authentication scheme. This confliguration is not covered
in this lesson.

The SAML Browser Post Profile server requires a different set of parameters, which is not
shown in the figure.
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Clientless SSL VPN SSO

Macro Substitution

= Used for 880 authentication to web-based applications
(HTTP, HTTPS)
= Allows certain variables to be injected in bookmarks

— Username, password, domain, domain password, or other input
paramelars

— Internal password can be also used as a variable. Internal
password is provided separately by a user when authenticating
to 5L VPN

Macro subsutution allows for certain variables w be injected in bookmarks lor substimting
dynamic values, such as the username, password, domain, domain password, or other input
parameters.

This funetionality provides 880 functionality when you access web-based services through the
web interface (such as Microsolt Web Access).

Oine of the most frequently used variables for 880 1s the internal password. The internal
password is entered by the VPN user separately from the user password or passwords. The
security appliance caches the internal password and uses it for-authenticating the user 1o the
internal services, The internal password enables S50 in situations when the VPN users are
authenticated based on certificates or OTP credentials. In these situations, there 18 no user
password (certificates), or the password keeps changing (OTP). The internal password is used
for 880 and not AAA. The primary and optionally secondary password 15 used for AAA and
not for S50,
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Clientless SSL VPN SSO

Macro Substitution (Cont.)

Wariahile Bubathution
C3C0 WESVEN_USERNAME
C3C0_WEBVAN_PASSWORD

CECO_WESVPN_INTERNAL BASSWORD

CE0D WESVPN CONNECTION PROFLE

E5C0. WESVPN. MACRO!
CECO WERVPN MACROZ
CSCO WERPN_FRIMARY. USERNAME

CECO WEBVPN. PRIMARY PAESWORD

SELYON usas lags D

B3 VPN waar lngin ssand

BEL VPN usar iiesnal resducse pasTADrd. Tha s
acached cradenial and ny) sub=dmieaiad by an
e

SSL VPN usar lagin grous drap-down, a grawn
A withic the: sanfesian profis

Saivia RACIUSLDAP vandor-apa e aiouls
Salva RADIUSLOAR vando-spes e alivas
Pricnasy usae hagin 10 e doubie asmenbe o

PEmany ulac iagn paskeant foe Soubse

aulhgnbostan
CS00. WESVRN SECONDARY USERNAME Swemndary mesiagn 1D i douis subemesian
CECO0_WESVAN_SECONTARY. PASEWORD Seeondary das kagin I B dounis authemichian

Variable and macro substitution 1s configured in the bookmark settings.

The following variables can be used for substitution:

® CSCO_WEBVPN_USERNAME: Username from login page

s CSCO_WEBVPN PASSWORD: Password from login page

® CSCO_WEBVPN_INTERNAL PASSWORD: Internal password from login page
s CSCO_WEBVPN_CONNECTION_PROFILE: Connection profile from login page

The following macros can be used for substitution in http, hitps, and cils URL types:
s CSCO_WEBVEPN _MACRO!: Radius and LDAP attribute
. CSCO_WEBVPN MACRO2: Radius and L DXAP attribute

The following variables can be used for substtution when double AAA authentication 18 used:
8 CSCO_WEBVPN_PRIMARY _USERNAME: Paimary username from login page

8 CSCO_WEBVPN_SECONDARY_PASSWORD: Secondary password rom login page
B CSCO_WEBYPN PRIMARY PASSWORD: Primary password from login page

. CSCO_WEBVPN_SECONDARY_PASSWORD: Secondary password from login page
You need toenable the VPN users 1o enter the internal password. The internal password field is
disabled by default. To enable the mnternal password lield, perform these steps:

Step 1 Navigate to the Conliguration > Remote Access VPN > Clientless SSL VPN
Access> Connection Profiles menu (not shown in the Ggure).

Step 2 Check the Allow User to Enter Internal Password on the Login Page check box
(not shown in the figure).

Step 3 Click Apply to apply the configuration.
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Clientless SSL VPN SSO

Macro Substitution Configuration

* Example for
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This figure shows an example of a bookmark that was created to provide 880 lunctionality for
Chatlook Web Access based on username and internal password. Complete the following steps
to configure macro substtution for a bookmark:

Step 1

Stap 2

Step 3
Step 4
Step 5
Step 6

Step 7

Step 8
Step 9

Step 10

Step 11
Step 12
Step 13

Step 14

Inside Cisco ASDM, choose Configuration > Remote Access VPN = Clientless
SSL VPN Access > Portal = Bookmarks (not shown in the figure).

Select a bookmark list where you would like 1o ereate a macro-substtution-
enabled bookmark and elick Edit. The Edit Bookmark List window appears (not
shown in the igure).

Click Add to add new bookmark. The Add Bookmark window opens.
Enter the bookmark title inte the Bookmark Title window.

Enter the bookmark URL into the URL input Hield.

Expand the Advanced Options.

Click the Post radio button to specily that the HITP POST method will be used to
send parameters to a web server.

Click Add. The Add Post Parameter window appears.
Enter a parameter name into the Name input lield.

Select a variable or macro from the Value drop-down menu. You can also manually
enter an arbitecary parameter value.

Click OK.

Repeat the previcus four steps to add all parameters.
Click OK two times.

Click Apply 1o apply the configuration.
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Clientless SSL VPN SSO
S50 for Plug-Ins

= Can be used to enable 320 for application plug-ins

* Mo suppert for macro substitution

= Enabled with parameter esco_sso=1 in the URL field
— For the required plug-in protocel

i
i
Corury, Thr Soman et Sowee
LR st o A e S oo e, pmef] : &
Ot it Add caco_ssowl &8
Frre oEEmeler ints URL
M -t — = |

17 s e ey ik
dcbuseini ipiiess
e—
L

0| [ sl | [ o

Confgoraton > Remote Acceas VBN = Clantess 881 VPN Aocess = Porsd = Bookmarks

When you aceess internal applications using client-server plug-ins, you can deploy 580
functionality by configuring bookmarks using the appropriate URL type. The application plug-
ing are Java applets that do not support the variable and macro. The 880 functionality is
enabled by embedding the esco_sso=1 parameter in the URI field next o the URL protecol.
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Clientless SSL VPN SSO
S50 for Plug-ins (Cont.)

= Efring entared in the text box next to the URL value
— Multiple parameters allowed
* Two string formats:
— server/?Parameter=value&csco_sso=1
— server7osco_sso=1&Parameter=value
O T ——————————
ROP tdpirdp-
sarvar'? DecirmdConr=4&DasradHRas=102¢ &DesiradVRes=T58 &cs0g_ss0=1

I1Ca leaisitri- sarvan? Initia P rogram=#licrosaft Offica Waord
DURTWIMode=anh&esco sen=1

55H &ehi/lesh-sarver7 ceoo_se0=1
Tainat  teinet/fsinet-server?oeco sea=1
VNG wnoite-sanvan ?ceco_sso=1

The string that is entered in the URI field can include, in.addition to the server [P address or
FQDN, an &-delimited list of multiple parameters. Together with the 880 setting csco_sso=1,
two notations are possible:

m server/TParameter=valuedParameter=valuedeesco_sso=1

m  server/ Tesco_sso=|&Parameter=valued: Parameter=value

Examples for various plug-in protocols are shown here:

m  ndp:rdp-server/?DesiredColor=d4& DesiredH Res=1024 & Desired VR es=T768&esco_sso=1

B e/ citrix-server/?Inital Program=aMicrosoft OlTice Word
2003& TWIMode=ondicsco_sso=1

m  asho/ssh-server Tesco_sso=1
m  elnet://telnet-server/?esco_sso=1

m vne:ts-serverlesco_sso=1
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Clientless SSL VPN SSO

880 for Smart Tunnels
* Smart tunnel aute sign-on is suitable for web applications
« Suitable also for bockmarks enabled for smart tunnels
* Smart tunnel aute sign-on supperts enly Internat Explorer

* Lets you access applications such as Microsoft SharePaoint,
Outlock Web Access, Citrix using 380

= Browser requires Java, Microsoft ActiveX, or both

Smart tunne! auto sign-on is a straightforward method that is used to confligure S80 for
particular internal servers. You should use it if you do not have dedicated S50 servers in vour
network. With auto sign-on configured for particular internal servers, the adaptive security
appliance passes the login credentials that the user of elientless SSL VPN entered 1o log into
the adaptive security appliance (username and password) to those particular internal servers.
Aute sign-on is supported only for smart tunnel application aceess from Internet Explorer.

In auto sign=on, you specify a list of mternal servers requiring authentication, to which the
appliance should automatically provide user credentials. More specilically, the Cisco ASA
adaptive secunity appliance content rewriter automatically provides credentials to internal
HTTP resourees that match precontigured URIs.

The auto sign-on feature lets you enable the replacement of login eredentials for Windows
Internet (WinINet) connections. Most Microsolt applications use Win[Net, including Internet
Explorer. Mozilla browsers (such as Firefox and Floek) do not, so they are not supported by
this feature. Auto sign-on supports HTTP-based authentication types: basie and NTLM. Form-
based authentication does not work with this feature.

Credentials are statically associated to destination hosts, not services, so 1l initial eredentials are
wrong, they cannot be dynamically corrected during runtime. ln addition, because of the
association with destinations hosts, providing support for an auto-sign-on-enabled host may not
be desirable if you want to deny access to some of the services on that host.

You should not enable auto sign-on or servers that do not require authentication or that use
credentials different from the adaptive security appliance. When auto sign-on 15 enabled, the
adaptive security appliance passes on the login credentials that the user entered to log into the
SSL VPN,
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Clientless SSL VPN SSO

figure SSO for Smart Tunnels
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You will complete the following steps to configure a list of smart tunnel auto sign-on servers:

Step 1

Step 2

Step 3
Step 4
Stap 5

Stap 6
Stap 7

Step 8

Choose Configuration > Remaote Aecess VPN = Clientless SSL VPN Access >

Portal = Smart Tunnels (not shown in the example).

Click Add in the Smart Tunnel Aute Sign-on Server List area. The Add Smart
Tunnel Auto Sign-on Server List appears (not shown in the example).

Enter the auto sign-on list name into the List Name field (not shown in the example).
Click Add. The Add Smart Tunnel Auto-Sign-on Server window appears.

Click the IP Address radio button and enter the IP address of the server requiring
authentication.

Optionally, select a subnet mask from the Subnet Mask {Optional) drop-down menu.
Click OK twice.
Click Apply woapply the configuration.
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Auto Sign-On with Smart Tunnels for
Internet Explorer

Apply Feature fo Users or Policy Groups
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You have to apply the auto sign-on server list to a user profile or group policy. Configuring the
feature on the group policy level 1s recommended because it offers a more sealable approach.

Toapply the auto sign-on server list to the group policy, complete these steps:

Step 1

Step 2

Step 3

Step 4

Choose Configuration > Remaote Access VPN = Clientless S5L VPN Access >
Group Policies.

Choose Portal and locate the Smart Tunne! section.

Apply the appropriate Smart Tunnel Secver List by either selecting it from the drop-

down menu in the Auto Sign-on Server section or have it inherited from a higher-
level pohicy.

Make sure that a smart tunnel application lor Microsoft Internet Explorer is also
activated [or the speeific user or user group beeause the auto-sign leature works only
in cotmbination with smart tunnels for lnternet Explorer.

In the example, the smart tunnel application list that is named Smart TunnelList, which enables
the Internet Explorer smart tunnel, is selected, and the Auto Sign-on Server List that is named
InternalServer is selected for the poliey-group.

Feature Support

This table shows the availability of the auto sign-on feature on Ciseo ASA adaptive security
appliances, as well as the software release that introduced this feature.

Faature Platform Software Release
Auto sigreon with smart All Cisco ASA adaptive VersionB.1.2
tunnels for IE security applisnce platforms

Variable and macro All Cisco ASA adaptive Version B.2.1
substitution security applisnce platforms
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Summary

This topie summarizes the key points that were discussed in this lesson.

Summary

= The two recommended PKI deployment models include local CA
implementation and external CA enrcliment.

= Inloccal CA deployment, clients obtain identity certificales and
private and public keys that are generated by the 35L VPN server.

= Client-side certificate-based authentication can be augmented by
AAA-based authentication and authorization,

= Common authentication issues include different root CAs, time
synchronization problems. revocation issues, and AAA failures.
= 880 allows access to different services on different servers afler a

single authentication. Several 330 methods exist on the Cisco
ASA adaptive security appliance.

4154 Daplaying Cisco ASA VPN Solubans (VPN) v1.0 & 2010 Cisca Systams, Ins,



Lesson 4|

Customizing the Clientless
SSL VPN User Interface and

Portal

Overview

Many enterprises wish to customize the user interface that is presented to clientless Secure
Sockets Layer (SSL) virtual private network ( VPN) clients. Typical needs include language
localization that ensures that users navigate through pages that are written in their own
language. This lesson discusses basie and advanced customization of portal navigation pages,

help pages, and application integration. It explains how to implement language localization and
deseribes the integration options with the Cisco AnyConnect clieat.

Objectives
Upon completing this lesson, vou will be able wo deploy and manage advanced clientless VPN
application access features of a Cisco chientless S5L VPN, This ability includes being able 1o
meet these objectives:

Configure and verily basic customization of the VPN portal navigation pages
Configure and verify full portal HTML customization

Configure and verify portal localization

Configure and verily portal help customization

Configure and verily integration of the Ciseo AnyConnect elient with the clientless portal



Deploying Basic Navigation Customization

This topic deseribes how to configure and verily the basic customization of the VPN portal
Aavigation panes.

Basic Portal Customization

COverview

= 35L VPN page customization provides faxibility when
designing the portal appearance and design.

* Two customization appreaches: Cisco ASDM and full
{without using Cisco ASDM)

ASDM-Drivan
Customization Full Customization

Principia Bagad on aditing Bagad an importing saif-
pracarfigurad cuslomization  made HTML and XML
ohiscte ontant inta the applianca

Editing S5L VPN Custamization Third-party HTML and XML
Editar (Cisca ASDM ale
mmpanent)

Customization Taxt, images, RSS feads, Texl, imagas, RSS feads,

£COpe HTML HTML

The web portal that is accessed by users who connect via clientiess SSL VPN can be
customized to reflect the requirements that are defined by the enterprise policy or by the local
language. The Cisco ASA adaptive security appliance uses customization objects o define the
appearance of user sereens. The clientless SSL VPN end-user interface consists of a series of
HTML panels. A user logs in wo the clientless SSL VPN by entering the 1P address or Domain
MName System (DNS) name of the Cisco ASA adaptive security appliance. The first panel that
displays is the login window. The user then navigates through the remaining panels. Both the
login window and the subsequent panels can be customized.

There are two general approaches 1o portal customization:

® ASDM-driven eustomization: In this basic approach, the administrator uses Cisco Adaptive
Seewrity Device Manager [ Cisco ASDM) te edit customization objects that correspond to the
elements that are visible in the portal. Cisco ASDM automateally launches the 85L VPN
Customization Editor, which includes the necessary graphical features w complete the task.
Basic customization is simple to configure and allows the customization of most portal
elements, such as text, images, R8S leeds, and HTML content.

m  Full customization: This method allows administrators to create their own HTML or XML
content and import it into the appliance. This approach s useful {or enterprises that want to
use advanced third-party tools Lo create complex portal content.
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Basic Portal Customization

Cn-Screen Keyboard
» Provides protection against key loggers
* Requires that users enter password using Java keyboard

* Can appear for VPN login or any time that authentication is
required

= fvallable for Cieco ASDM and full custemization

[T TR R T

[ T

PR i

The Cisco ASA security appliance supports the use of a Java-based on-screen kevboard 1o
provide an additional layer of security and helps protect users [rom security threats such as key
loggers. The on-sereen keyboard is enabled on the Object Customization page. It can be
eonfigured to show only when someone is logging in to the SSL VPN system, or anytime that

network authentication is required. The on-sereen keyboard feature is available for both basie
and full portal customization.
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Configuring Basic Portal Customization

Configuration Tasks

Crealz a new customizatien cbject.

(Opticnal) Update the default DfitCustomization object.
Edit the custemnization chject.

Associate the customization ebject with a cennection
profile.

o

The adaptive security appliance uses customization objects to deline the appearance of user
screens. A customization object 18 compiled from an XML file, which contains XML tags for
all the customizable screen items that are displaved to remote users.

To perform basic portal customization, you will perform the following conliguration tasks:

2

4.

Create a new customization objeet. The administrator may decide to ereate a new
custemization object without manipulating the preconfigured DftCustomization object.
The new customization object is created with the settings of a default template, which is
identieal to the default configuration of the DNtCustomization object.

Optionally, update the default DfitCustomization object. This is the alternative approach, in
which the administrator updates the default customization object.

Edit eustomization object. Editing the object launches the 851 VPN Customization Editor.

Associale customization object with connection profile.

VPN users view the customized pages afler they access their connection prolile. The elients
may connect o a connection profile using one of two methods:

m By selecting the appropniate connection profile from the drop-down list that s visible in the

logon page

m By connecting to a URL that 1s associated with the speeific connection profile
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Configuring Basic Portal Customization
Configuration Scenario

Customiza logan
paga, partsl pags,
and lagout pagse.
nput Farametary
(hom  [Mams |

Cusinerizaton oojent  WootsWoruer

Connacion profis MomseWorker

SELTLE Saszian

Coa Coton ASA

This figure presents the conliguration scenario that is used in upcoming configuration tasks.

The table lists the input parameters that are required te achieve this goal. Before you perform
basic portal customization, you will need to gather the required portal parameters. Those
parameters include the following:

m  Name of the customization object. n this example, the name 15 MobileWorker.

®  Name of the connection profile that must be associated with the customization object. In
this scenario, its name 1§ identical wo the customization object.

The customization obiect includes three components: logon page, portal, and logout page. All
three elements will be customized in this scenario.

Initially, when a user [irst connects, the default customization object (named
DfltCustomization) that is identified in the connection profile (nnel group) determines how
the logon page appears. If the connection profile list is enabled, and the user selects a different

profile that has its own customization, the screen changes to reflect the customization obyect for
that new profile.

After the remote user is authenticated, the screen appearance is determined by the
customization object that has been assigned to the connection profile.
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Configuring Basic Portal Customization
Task 1: Create a New Customization Object
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Configurston > Remols Aocess VRN = Oigntass 851 VPN Accass » Fodel » Customizeton

The first confliguration task in the basic customization sequence is Lo create a new
custemization object. 1t 1s optional, because you may alternatively edit the existing
DfltCustomization object that is preinstalled within the image bundle. To ereate a
customization object and conligure the on-screen keybeard, complete the following steps:

Step 1 Choose Configuration > Remote Aecess VPN = Clientless S5L VPN Access >
Portal > Conliguration and click the Add butten.

Step 2 Enter the object name and elick (XK.

Step 3 Configure the en-screen keyvboard settings by elicking the appropriate radio button at
the bottom of the main custormization pane. The on-sereen keyboard conliguration

applies to all customization objects, independently of the connection profile that the
user connects to. The available choices are as follows:

® Do Not Show Onsereen Keyboard (defanlt setting)
m  Show Only for the Login Page
m  Show for All Portal Pages Requinng Authentication

Step4  Click Apply to apply the conliguration. The new customization object cannot be
edited until it has not been committed to the appliance.
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Configuring Basic Portal Customization
Task 3: Edit the Customization Object
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Next, make sure that the appropriate object is highlighted and click Edit. This step launches the
S85L VPN Customization Editor in a secondary web-browser window.
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Configuring Basic Portal Customization
Task 3: Edit the Customization Object {Logon Page)
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After you have chosen the newly created customization object and clicked Edit, the main user
interface customization window for the 8851 VPN Customization Editor will appear. The 881
VPN Customization Editor is split into three distinet areas for user interface configuration:

B | ogon page
= Portal page
B | ogout page

This figure displays the conliguration options that are available in the logon page. Those
options include the displayed text, logo URL, and graphic parameters.

MNote If you want to use custom elements (such as images} on the portal, you have to upload them
first to the Cisco ASA adaptive security appliance. You can upload them using Cisco ASDM
by navigating to Configuration > Remate Access VPN > Clientless S5L VPN Access > Portal
= Web Contents and clicking the |mport button,

When you make changes to the template pages using the 35L VPN Customization Editar,
click the Save button to save the changes to the appropriate page.
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Configuring Basic Portal Customization

Task 3: Edit the Customization Object (Portal)
» Page text. graphics, and colors can be modified for each page.
« Title panels can alsoe be modified by using style sheets (CS5).

FRER

The
=quence of
118 menods
canoe
ghanged:

When one of the customization submenus 15 chosen on the lelt side of the editor window, the
corresponding configuration menu for that selection 18 displayed on the right side. From these

eonfiguration menus, the user can change page text, graphics, and eolors. You can modify

eolors by using a color selector that 1s available wherever colors can be modified. Title panels
also have the option of being configured using cascading style sheets (CS5Ss).

This figure presents the configuration options that are available in the Portal section. Those

options mnclude browser window, title panel, toolbar, navigation panel, applications, home

page, custom panes, and columns. Choosing the Applications Ik displays the available types

of applications.

You ean reorder the application types or disable any of them. All types are enabled by default.
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Configuring Basic Portal Customization
Task 3: Edit the Customization Object (Logout Page)
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The customization of the logout page involves a single element. The logout form defines the
text and colors that are to be displayed in the logout page.

Mota Remember to save the changes to the customized user interface so that it will reflect the
desired modifications.
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Configuring Basic Portal Customization
Task 4: Assign Customization Object to Cennecticn Profile
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Confguraton > Remods Acceas WEN > Dientess 881 VPN Access > Sonnection Frofies

In the fourth task, youmust assign the customization object to the respective connection
profile. Perform the following steps:

Step 1 Choose Configuration > Remaote Access VPN = Clientless SSL VPN Access >
Connection Profiles.

Step 2 Choose the desired connection profile and elick the Edit button. A new window
opens.

Step 3 Choose Advaneed > Clientless SSL VPN and select the customization object from
the Portal Page Customization drop-down list.

Step4  Click OK.
Step 5 Click Apply to apply the conliguration.

In this figure, the newly defined customization object MobileWorker 18 being assigned to the
eonnection profile MobileWorker.
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Verifying Basic Portal Customization
Logon Page Verification
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This figure shows a customized portal logon page. The fgure illustrates which conliguration
elements can be found in the logon page.

Specifically, the logon page includes these elements:

Browser Window? Changes the text that is shown in the main browser title bar,

Title Panel: Changes the utle that is shown on the main page of the 851 VPN logon page
as well as available colors,

Languages: Selects the default language that is used for the logon page.

Language Selector: Provides a drop-down selector For other available languages o the
logon page.

Logon Form: Changes the text and colors that are displayed in the Logon box.
Information Panel: The information panel is an optional panel that can be enabled and
placed 1o either side of the logon form. The information panel ean inelude required text and
graphics as needed for the logon page.

Copyright Panel: Adds copyright information to the logon page.

Full Customization: Configures the security appliance 1o use a fully customized web page
that you can choose from previously uploaded media that is found in the Web Contents
submenu.
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Verifying Basic Portal Customization
Portal Page Verification
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This ligure shows a sample customized web portal page. In addition to customized headers, a
custom column has been added to provide room for additienal information on the web portal.

The following items can be modified when configuring a portal page:

Browser Windew! Changes the text that 18 shown in the main browser title bar.

Title Panel: Changes the title that is shown on the main page of the 851 VPN portal page
as well as available colors.

Toolbar: Configures the text that is shown for the address bar and the Moating toolbar that
18 shown when younavigate pages.

Applications: Configures the order and name ol available application buttons. Apphication
buttons can also be disabled from this menu.

Home Page: Configures the use of a custom page lor the web portal.

Custom Panes: Allows the ereation of custom panes o provide additional functionality o
the web portal. The following panes are available:

— Text

— HTML
— Image

— RSS Feed

Columns: Configures the number of columns to be displayed on the web portal.
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Verifying Basic Portal Customization
Logout Page Verification
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This figure shows a custonuized logout page. The figure illustrates the correspondence between
the conliguration options and the logout page elements.
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Deploying Full Portal Customization

This topic describes how to configure and verify full portal HTML customization.
-

Full Portal Customization

Overview

= Full eustomization is based on importing self-made XML
components

= Must follow XML-based customization file structure
* Two approaches:

- Replacing the logon page

- Using a custorm XML portal

Logon Page Replacement Completely Seif-Mades XML Page
Requires special Cisco HTML code Available template contains all currantly
that creates the logon form and the employed tags with corresponding
Language Selector drop-cown list comments that describe how to use them

Uses specific area of cache memory that contains files that are displayed to
remote users before suthentication, referenced as (+CSCOU+!

Full portal customization allows you to ereate the HTML and XML pages using external tools
instead of the S5L VPN Customization Editor, and then import them as portal pages. The self-
made content must follow the XML-based customization file structure that is used by Cisco.
Cptionally, you may choose one of two methods to simplify the full portal customization:

®  You can export an XML file to a local computer or server, make changes to the XML tags,
and reimport the file to the Cisco ASA adaptive security appliance. The security appliance
includes a template that contains all currently employed tags with corresponding comments
that describe how to use them.

®  You can replace only the logon page and leave the remaining panels unchanged. The self-
made logon page must include special Cisco HTML code that ereates the logon form and
the Language Selector drop-down List.

If you do not simplify the customization process using any of these methods, you can create
your own page and import it to the adaptive security appliance lor full eustomization. Either
method ereates a customization object that you apply toa connection prolile or group policy.

In all methods, files that are displaved to remote users before authentieation must reside in a
specific area of the adaptive security appliance eache memaory, which is represented by the path
=CSCOU-/. Therefore, the source for each image in the file must include this path.
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Configuring Logon Page Replacement

Configuration Tasks
1. Create a custem logeon file.

2. Importthe file and images to Cisco ASA adaptive security
appliance.

3. Caonfigure a customization chject to replace the logon page.
4. Atftach the customization object toa connection profile.

Toreplace the logon page, perform the following configuration tasks:

l. Create acustom logon page {ile and name it logon.ine (path to images must be
~CSCOU-. The file must include the function esco_ShowLoginFormi *iform’, which
injects the Logon form, 1t may optionally include the function
esco_ShowlanguageSelector( *selector’) that injects the Language Selector, if language
customization is desired.

2. Impaort the file and images to the Cisco ASA adaptive security appliance as Web Content.
The Web Content corresponds to the space in the appliance flash memory that stores the
files that are related to the S5L VPN portal.

3. Configure the customization object to replace the login page.

4. Asgociate the customization object with connection profile.
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Configuring Logon Page Replacement
Configuration Scenario
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This figure presents the conliguration scenario that is used in upcoming configuration tasks.

The table lists the input parameters that are required to achieve this goal. Before you replace the
logon page, you will need to gather the required portal parameters. Those parameters include
the following:

m  Name of the customization object. n this example, the name 15 MobileWorker.

®  Name of the connection profile that must be associated with the customization object. In
this case, its name is dentical to the customization ohjeet.

m  Name of the self-made logon page lile. The name must be logon.ine.
m  Directory, where the images are placed. The directory is referenced as (~CSCOU=/.
When the elients connect 1o the 851 VPN ponal using the MobileWorker connection profile; they

will see the pages that are defined by the customization object MobileWorker. This customization
objeet will be configured to replace the default logen page by a sell-made logon page.
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Configuring Logon Page Replacement
Task 1: Create a Custom logon.inc File (Example)
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In the first task of this configuration sequence, you create the code for the logon page. This
figure illustrates a sample logon.ine file that contains the key elements that are necessary to
provide the key logon functionality. The path to images is set to /~CSCOU=/, which represents
a special area of the adaptive security appliance cache memory. Files that reside in this special
memory ¢an be displayved to remote users before completed authenneation.

In addition, the logon.ine fle invokes two functions: eseo_ShowLoginForm, and
csco_ShowlanguageSelector, that display the logon form and the language selector, respectively.

This logon.inc example contains this code:

<head=

cmeta http-eguiv="Concent-Type" content="text/html; charset=windows-1252"s
<tizleszlew Page 3« tle=s

<base targec="_sel:l
</heads> <p align="lef
cimg border="0" arc:",r'mh_:ac:_lzgc.glf" width="55" height="36"=

<forr face="8nap ITC" size="g&" color="KFFIO0FF"=a

</fontsx<efont face="8nap ITC" oolor="#FFOOFF" aizez="T7"a&nbsp;</fontacis<ba
#FFO000" gize="3" face="Sylfaen"s 858L VIN Service by the Cisco

<body

onload="caco ShowloginForm|!1lfowm!) jcacc Showlanguagelelsacear|faeleccox! | =
<zables

strz<td colspan=3 height=20 align-rights<div id-"galecter" scvle="width:
300" s fdivs

<ftdse/traetd align=middle valign-middles

ediv id=1fgrm =

«p»inbsp; «/prepsinbep; < fpacpaénbapr</pa

<caloading. . .</p>

cfdivs <ftds <ftrs <ira

rod width="251"xcfrd>

<td width="1"></td=

<cd align=right walign=right widch="800"12

o/ tdec/cra </ cables
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Configuring Logon Page Replacement
Task 2: Import logon.ine and Images to Cisco ASA
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In the second task, you will import the logon.ine file and the images it references into the

special area of cache memory. Complete the following steps for the logon.ine seript and each
file that is referenced in it

Choose Configuration > Remote Access VPN = Clientless S5L VPN Access >

Step 1

Step 2

Step 3

Step 4

Step 5

Portal > Web Contents,
Click the Import bution.

Click the appropriate radio button to point to the source from which to import the

files and either locate the file or enter the required URL in the Path field.

In the Desunation area, chick the No. For Example, Use This Option to Make the

Content Available to Logon or Portal Page radio button. Optionally, you may

specily a subdirectory.
Click Import Now.
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Configuring Logon Page Replacement
Task 3: Configure Replacement of Logon Page
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In the third task, you will configure the customization object to use the custom logon.ine file.
Complete the lollowing steps:

Stap 1 Choose Configuration > Remaote Access VPN > Clientless SSL VPN Access >
Portal = Customization.

Step 2 Select the appropriate customization object and click the Edit button. The 88L VPN
Customization Editor opens.

Stap 3 Within the 851 VPN Customization Editor, navigate to Logon Page > Full
Customization.

Step 4 Choose Enable from the Mode drop-down menu.
Step 5 Choose the =CSCOU+/logon.ine entry from the HTML Content drop-down menu.

Step & Save the customization objeet (not shown in this figure).
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Configuring Logon Page Replacement
Task 4: Attach Customization Object to Connection Profile
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Confguraton > Remods Acceas WEN > Dientess 881 VPN Access > Sonnection Frofies

In the fourth task, you will assign the previously conligured customization object to a
connection profile. Complete the following steps:

Step 1 Choose Configuration > Remaote Access VPN = Clientless SSL VPN Access >
Connection Profiles.

Step 2 Select a desired connection profile and elick Edit

Step 3 Choose Advaneed > Clientless SSL VPN and choose the required customization
obieet from the Portal Page Customization drop-down menu.

Step 4 Click OK.
Step 5 Click Apply o apply the configuration.
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Verifying Logon Page Replacement

Logon Page Verification
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To verify the replaced logon page, conneet to the 581 VPN portal using the connection profile
that has the conligured customization object associated with it You should see a customized
logon page that includes the previously configured elements, sueh as text, images, and the
logon form. The language selector is not displayed, because it must be enabled using a

procedure that is discussed in a later topic.
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Full XML Portal Customization

XML Customization Template

* The template contains all eurrently employed tags with
correspanding comments that describe how to use them.

<iaml vargions™ I7 encoging = LITF-8"F>
ol—
Ooprerignt (o) $008-2008 by Cisoo Sysiema, Inc

Noder @ whil2spEces 0 i2g e Ues e sgnfoantang oresanved
Tag: oesiom
Deasrioton: Root cusiomizaton tag

Teg: cusfomiengusgea

Daggeroton: Containa dat ofianguegea, recognizad by ASA

‘Walpe:aring coniesning comma-ssparaiad Bnguege oodes. Eaon EnguEge code la
2381 0ESN-3S0ETEISI 8 DNENUMEnC cnEracieta Fiatss win
Fona-CnatacieT |fof SNEMIE! &0, 8n-u3, fDuessd-Enguage-us)

Dafaud vaius: en-us

The security appliance allows you to perform a full portal customization using a completely
self~-made XML page. Cisco offers a customization template that will help you create a properly
formatted page. The template eontains all eurrently employed tags with corresponding
eomments that deseribe how to use them. An imual fragment i1s shown here:

«?xml version="'1.0" ercoding="UTF-8"7=>

wfe=

Copyright (c) 2006-2008 by Cisco Systems, Ing.

ALL rights rasexrved.

Note: all whirespaces In tag values are significant and

prezerved.

Tag: custom

Description: Koot customization tag

Tag: custom/languages

Desoription: Centains lisr of Ianguages, recognized by ASA
Value: string containing comma-separated larguage codes. Each
language oode Is a set dash-separated alphsnumeric charapters,
started. with alpha-character (for sxample: en, en-us,
irokesed-language-us)

Default value: en-us
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Full XML Portal Customization

Configuration Tasks
1. (Optional) Expert the customization template.

2. Create an XML file using third-party tocls (optionally based
on the exported template).

3. Importthe XML file as a customization chject.
4. Atftach the customization object with a connection profile.

To perform a full portal customization using a completely seli-made XML page, perform the
following conliguration tasks:

. Optionally, export the customization template.

2. Create an XML file using third-party tocls. This page may be based on the exporied
template.

Lk

mport the XML page as & customization object.

4. Associate the customization object with & connection profile.
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Full XML Portal Customization
Configuration Scenario
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This figure presents the conliguration scenario that is used in upcoming configuration tasks.

The table lists the input parameters that are required to achieve this goal. Before you perform

the full portal customization, you will need 1o gather the required portal parameters. Those

parameters include the following:

m  Name of the customization object. n this example, the name 15 MobileWorker.

®  Name of the connection profile that must be associated with the customization object. In
this scenario, its name 1§ identical wo the customization object.

m  Name of the self-made XML page. ln this example, it is Template_customized, as it has
been created based on the exported template.

When the clients connect to the SSL VPN portal using the MobileWorker conneetion profile,

they will see the pages that are defined by the customization object MobileWorker. This
customization object has been created by importing the self-made XML page

Template_customized and saving it under the name MobileWorker.
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Full XML Portal Customization
Task 1: Export the Customization Template
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In the first task, you will export the customization template by completing these steps:

Step 1 Choose Configuration > Remate Aecess VPN = Clientless 851 VPN Access >
Portal > Customization.

Step 2 Seleet the template and click the Export button. Identify the destination file by
chicking the appropriate radio button and enterig the path in the Path field.

Stap 3 Click the Export Now button.
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Full XML Portal Customization

Tasks 2-3: Edit Template and Import File
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In the second task, you will create the custom XML page using a third-party tool. This task is
not depicted here. This figure illustrates the third task, which imports the custom [ile named
template_customized. lmport the file by completing these steps:

Step 1

Step 2

Step 3

Step 4

Choose Configuration > Remote Access VPN = Clientless S5L VPN Access >
Portal = Customization.

Click the Impert button. The lmport Customization Object window appears.

Provide the intended name of the customization obiect in the Customization Object
Name {ield (MobileWorker in this example).

Select the source lile for import and elick Import Now.
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Full XML Portal Customization

Task 4: Attach Customization Object to Connection Profile

Assign the custymizalon ooject
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In the fourth task, you will associate the imported customization object with the connection
profile by completing these steps:

Stap 1

Stap 2
Step 3

Step 4
Stap 5

Choose Configuration > Remaote Access VPN > Clientless SSL VPN Access >

Connection Profiles,

Select a desired connection profile and click the Edit button. A new window opens.

Choose Advanced > Clientless SSL VPN and select the customization object lrom

the Portal Page Customization drop-down list.
Click OK.
Click Apply wapply the conliguration.

In this figure, the imported customization objeet MobileWorker 18 being assigned to the
connection profile Basic-profile.

FR

Deplaying Cissa ASA VPN Solutians (VEN) v1.0

& 2010 Cisca Systams, Ins,



Deploying Portal Localization

This topic describes how to configure and verify portal language localization.

Language Localization

Overview

Cisco ASA provides language translation for the portal and screens
for:

« Clentless 331 VPN connactions
" SBoreans associated with optional plug-ins
o Usar interface of Clsco AnyConnact VPN client

Based on language translation tables
« Dictionary containers
« Partitioned in 11 transiation domaing based on functional areas
» Can bae adited, imported, and exportad
* Praconfigured for three languages: French, Russian, and Japanese
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et wmin

The Cisco ASA adaptive security appliance provides language translation for the portal and the
screens that are displayed to users. The screens include browser-based, clientless S5L VPN
connections, screens that are associated with optional plug-ing, and the interface that is
displayed to Cisco AnyConnect VPN client users.

To improve the manageability of the language localization, the languase support is based on
multiple translation tables that correspond to functional areas of the 88L VPN portal. A
translation domain covers its functional area and the messages that are visible to remote users.
There are 11 translation domains, and each of them can be edited, imported, and exported. This
modular approach offers users the fexibility to modify the desired subsets of the dictionary.

Several translation domains have three preconfigured languages in addition to English. The
preconfigured languages are French, Russian, and Japanese.
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Language Localization

Language Translation Domaing
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This table lists the available translation domains and provides their description.

Translation Domains

Transglation Domain

Functional Areas Translated

AnyConnect Messages that are displayed on the user interface of the Cisco AnyConnect
VPN client
cCsD Messages for the Cisco Secure Deskiop

customization

Messages on the logon and logout pages, portal page, and all the
messages customizable by the user

keepout Message that is displayed to remote users when VPN access is denied
PortForwarder Messages that are displayed to port-forwarding users

urklist Text that user specifies for URL bookmarks on the portal page

webvpn All the Layer 7, AAA, and portal messages that are not customizable
plugin-ica Messages for the Citrix plug-in

plugin-rdp Messages for the Remote Deskiop Protocol (ROP) plugsin

pluginstelnet,zsh

Messages for the Telnet and SSH plug-in

plugine=vnc

Messages for the VNC plug-in

The software image package for the adaptive security appliance inclodes a language
loealization template for each domain that is part of the standard functionahity. The templates
for plug-ins are included with the plug-ins and define their own transiation domains.
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Configuring Language Localization

Configuration Tasks

View, expert, import, or edit language translation tables.
Enable customizatien language selector.

Configure customization languages.

4. Associate customization cbject with connection prefile.

—

[ R L |

To configure language localization, you will perform the following confliguration tasks:

. Wiew, export, import, or edit language translation tables.
2. Enable a customization language selector.
3. Configure customization languages,

4. Associate a customization object with connection profile.

©2010 Cista Systems, Ins,  Deploymant of Cisco ASA Adaptive Securty Applanca Clientiess Ramala Access VPN Solutions 4-185



Configuring Language Localization
Configuration Scenario
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This figure presents the configuration scenario that is used in upeoming confliguration tasks.

The table lists the input parameters that you will need to gather before deploying language
loealization. Those parameters include the following:

m  Name of the customization object! In this example, the name 15 MobileWorker.

m  Name of the eonnection profile that must be associated with the customization ohject:
In this scenario, its name is identical to the customization object.

m  Required languages: lo this example, the languages include English {available by default)
and French.

You will associate a connection profile with a specific customization object and configure that
object to use & logon page with a language selector. ¥PN users connecting to the
MobileWorker connection profile will see a language selector drop-down box and will be able
to select their own language.

4488  Deplying Cisco ASA VPN Sslutions (VPN v1.0 © 2010 Cista Systems, Ing,



Configuring Language Localization
Task 1A: View, Import, Export Translation Tables

 u]
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In the first configuration task of this configuraton sequence, you will verity the list of
preconfigured translation tables and either import or export them inte or from the security
appliance. These options can be selected if you navigate to the Configuration > Remote Access
VPN > Language Loealization submenu. The language translation tables are identified by their
language code, and the functional area they deseribe. The lower area of the window contains
translation templates that ean be exported o ereate new translation tables on demand.

Y ou can export the template for & ranslation domain, which ereates an XML file of the
template at the URL you provide. The message fields are empty in this file. You can
customize the messages and import the template to create a néw language localization table
that resides in flash memory.

You c¢an also export an existing language localization table. The XML file that is created
displays the messages that you edited previpusly. Reimporting this XML (ile with the same
language name creates a new version of the language localization table, overwriting previous
MEsSages.
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Configuring Language Localization
Task 1B: Edit Predefined Translation Table
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As an optional part of the {irst conliguration task, you can edit one or more of the existing

translation tables.

To madify the exasting translation table, complete the following steps:

Step 1

select the desired ranslation table.
Stap 2 Click Edit to edit the wranslation table.
Step 3

Enghish text, and the translated text.
Stap 4 Click OK.

Choeese Configuration > Remote Aecess VPN > Language Loealization and

Update the required records. The translation records include an entry identifier, the
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Configuring Language Localization
Task 1C: Export Templaie
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As an optional part of the first configuration task, vou can export a language localization
template. In the same menu, select a template from the Templates area and click Export to save
the template as the specilied destination file.

This ligure depicts how the View button is used to display the contents of a language
localization template for the Custormization domain.

After the template is exported, youwwill edit ivand then reimport it into the Cisco ASA adapuve
security appliance. The import procedure is invoked using the Import button and requires that
you specily the language and funetional area that is deseribed by the given transiation table.

Some templates are statie, but some change based on the configuration of the adaptive security
appliance. Because vou can customize the logon and logout pages, portal page, and URL
bookmarks for clientless sessions, the adaptive security appliance generates the customization

and url-list translation domain templates dynamically, and the template automatically reflects
your changes to these functional arcas,
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Configuring Language Localization
Task 2: Enable Customization Language Selector
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> Ed

After you create language localization tables, they are available to customization objects that
vou create and apply to group policies or user attributes. A language localization table has no
affect and messages are not translated on user screens until you ereate the customization object,
wentify a language localization table to use in that object, and speeify the customization for the

group policy or user.

In the second confliguration task, you enable the customization language selector by completing

these steps:

Step 1 Choose Configuration > Remote Access VPN = Clientless S5L VPN Access

Stap 2 Highlight the desired customization object and click Edit to start the SS5L VPN

Customazation Editor.

Step 3 o the SSL VPN Customization Editor, choose Logon Page > Language Selector

and choose Enable from the Mode drop-down menu.

Stap 4 Edit the languages list by deleting unnecessary languages by clicking the Delete

button or adding new ones by clicking the Add button.
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Configuring Language Localization
Task 3: Configure Customization Languages
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In the third configuration task, you configure the languages that are used in the customization

objeet by completing these steps:

Step 1 In the S8L VPN Customization Editor, choose Logon Page > Languages and add a
least one language code in addition to the default English language (code: en). Use a

comma to separate the language codes. This list does not need to include all

languages that you want [ activale.

Step 2 Save the settings of the customization object.

Note The customization object must be associated with & connection profile. This task is omitted

here because it has been shown in earlier configuration procedures
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Verifying Language Localization
Logon Page Verification
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To verify language localization, connect to the SSL VPN portal using the connection profile that
15 associated with the tuned custonuzation object. The language selector appears in the upper right
corner. After a languagze 1s selected, all functional wext fields are transtated using the appropriate

wansiation tables. This Bgure illustrates the logon page that is ranslated 1nto French.
-_—-",—

Verifying Language Localization

Portal Verification
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When the users successiully authenticate, they see the text fields in the portal also translated
into their local language. The content of the HTML pages is presented in the language in which

LIS written.
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Deploying Portal Help Customization

This topic describes how to configure and verily portal help eustomization.

Portal Help Customization
Cverview

Customization areas
* Customization of help files provided by Cisco
* Creating help files for languages not provided by Cisco
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The Cisco ASA adaptive security appliance displays help content on the application panes during
dientless sessions. Each clientless application pane displays its own help file content using a
predetermined filename. For example, the help text that is shown in the ligure comes from the file
rdp-hlpinc because it displays information that is related to the Termmnal Servers plug-in.

You can modify the help files that are preinstalled on the security appliance and create new
help files for languages that are not predefined.
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Portal Help Customization
Areas of Help Customization

o S
yp
Standard Application/Access  app-access-hlp.inc

Browse Networks file-access-hip.inc
AnyConnect Client  net-access-hipinc

WebAccess web-access«hip.inc
Plug-in MeteFramefocess  ica-hipinc
Terminal Servers rdp-hip.inc

Telnet'S5H Servers  sshtelnethip.inc

WVMNC Connections  wnc-hipinc

The help files are organized into functional areas, just as language translation tables are. The
table shows the clientless application panels and predetermined filenames for the help content.

Clientless Application Panels and Predetermined Filenames for the Help Content

Application Type Panel Filename

Standard Application ACcess Bpp-access-hip.inc
Browse MNetworks file=access=hip.inc
AnyConnect Cllent net-access-hip.inc
‘Web Access web-access-hip.inc

Plug-in MetaFrame Access ica-hlp.inc
Terminal Servers rdp-hip.inc
Telnet’'55H Servers s3h telnet-hip.inc
WNC Connections vnc=hip.inc

You can display the help file for an application panel by accessing the 3851 VPN server using
the help file URL in the format hups://=ssl-server>/~CSCOE help/language/<filenames,
where language 1 the language code.
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Configuring Portal Help Customization

Configuration Tasks (Cisco Help Files)

1. Display the help file in a browser by aceessing the help file URL.
— Requires that user is authenticated to S5L VPN

Save the help file on local computer.

Customize the help file.

Import the customized help file into the security appliance.

B W M

To customize Cisco help files, you will perform the following configuration tasks:

I. Display the help file in a browser by aceessing the help file URL. Accessto that URL
requires that user 15 successfully authenticated.

()

Save the help file on the loéal computer.
3. Customize the help file.

4. Import the customized help file into the security appliance.
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Configuring Portal Help Customization
Configuration Scenario
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This figure presents the configuration scenario that is used in upeoming confliguration tasks.

The table lists the input parameters that you will need to gather before pedorming help file
customization. Those parameters include the following:

m  Functional area of help customization. Lo this seenario, you customize the help information
for the RDP plug-in.

m  language of help customization. In this scenario, you customize the help file in English.
You obtain the RDP-related help file by connecting to the SSL VPN and then accessing the

help file URL. You download the help file to the user PC, modify it, reimport it muo the Cisco
ASA adapuve security appliance, and verily the resulis.
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Configuring Portal Help Customization
Tasks 1-2: Display Help File in Browser and Save
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In the fiest task, you display the desired help file in the chient browser by connecting to the
URL: https://server-address —=CSCOE='help/language/<filename>. 1n this example, the URL
was htps://172.31.0.1/=CSCOE=/help/en/rdp-hip.ine

In the second task, vou save the help file on the client computer by completing these tasks:

Step 1 In the browser, choose File = 8ave As. (This menu may differ depending on the
browser you use.)

Step 2 Set the file type to Webpage, HTML anly (*.hitm, *.html) and save.

In the third task (not shown in the figure), vou modify the help file according to the
reqUIrements.
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Configuring Portal Help Customization
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In the fourth task, after the help file has been customized, you will import the file into the
securily appliance:

Stap 1 Choose Configuration > Remaote Access VPN >Clientless SSL VPN Access >
Portal > Help.

Step 2 Choose the appropriate language code from the Language drop-down menu.
Stap 3 Choose the appropriate panel from the File Name drop-down menu.

Step 4 Locate the customized file using a suitable option and elick Import Now.
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Verifying Portal Help Customization
Portal Help Verification
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To verily the help file customization, you will first validate that the import procedure was

successiul by completing these steps:

Step 1

Step 2

To verify the results that are visible to the client, connect to the 851 VPN portal, optionally

Choose Configuration > Remaote Access VPN = Clientless S5L VPN Access >
Portal = Help.

Verily that an entry was ereated in the help fife list. It should specify the conligured
language code and filename.

select the local language, access the appropriate panel, and view the help text. It should reflect
the changes that you applied during the file eustomization.
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Configuring Portal Help Customization

Configuration Tasks (Custom Languages)
= Create the help file.
— Save as Webpage, HTML only (* htm,*.himl).
* Impaort the help file into the security appliance.
— Specify the correct language and filename that is related
to the panel.

Specific configuration guidance is outside the scope
of this course.

The procedure for creating help files in other languages, not provided by Cisco, represents a
subset of the help file customization, because you do not need to obtain the existing help file
belore customizing i

Therefore, it consists of two tasks:
I. Create the help file. The file should be saved as Webpage, HTML only (*him, *.html).

2. Import the customized help file into the security appliance. The import procedure requires
that you select the appropriate language code and panel-related filename.

This configuration procedure is not discussed further here, because it contains tasks that have
been performed when the help [iles provided by Cisco were customized.
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Cisco AnyConnect Portal Integration

This topic describes how to conligure and verify the integration of the clientless SSL VPN
portal with the Ciseo AnyConnect elient.

Cisco AnyConnect Portal Integration

WebLaunch

= Clientless SSL VPN access can be combined with AnyCennect
dient.

» AnyConnect panel appears automatically when beth access types
are enabled.

= Client software can be installed frem the portal.
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SSL VPN portal includes the Cisco AnyConnect panel that allows the clients to start the Cisco
AnyConnect client from the clientless session that is initiated from the browser. The pane
appears in the portal automatically when Cisco AnyConnect actess has been enabled on the
security appliance,

When users click the Cisco AnyConnect button in the Cisco AnyConnect paneg, they trigger ong
of two actions:

®  The Cisco AnyConnect client software is launched if it 15 mstalled on the client computer.
The Cisco AnyConnect tunne! is established while the clientless session remains active.
Only a single S5L VPN license 1s consumed in this approach.

m I the Cisco AnyConnect elient software 18 not installed on the client computer, the installer
15 downloaded from the security appliance and the installation procedure begins. When the
nstallation procedure completes, the Cisco AnyConneet wnnel is set up. Also, in this
situation, the clientless session remains active and only one license unit is consumed.
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Cisco AnyConnect Portal Integration

Configuring WebLaunch
Configurable behavior after user logs into clientless portal
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You can confligure the security appliance to take certain actions after the user successfully
connects to the 581 VPN portal. To configure the postlogin behavior, complete these steps:

Stap 1 Choose Configuration > Remaote Access VPN > Clientless SSL VPN Access >
Group Policies.

Note To assign & postlogin behavior to an individusl user, choose Configuration > Remote

Access VPN > AAAlLocal Usars » Local Usars.

Step 2 Select a desired group poliey and elick Edit.

Stap 3 Choose More Options > Login Setting.

Step 4 Locate the Post Login Setting area and either leave the defanlt option Do Not
Prompt User to Choose or choose the option Prompt User to Choose and
conligure the timeout (in seconds) alter which the postlogin selection will be made
automatically.

Step 5 Locate the Default Post Login Selection area and leave the default option Go Lo
Clientless SSL VPN Portal or click the Download SSL VPN Client radio button.
The latter starts the Cisco AnyConnect tunnel, if the client software is already
installed on the client computer.

Step & Click OK.

Stap 7 Click Apply to apply the configuration.
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You ean verily the Cisco AnyConnect WebLaunch feature by accessing the S5L VPN portal
and clicking the Ciseo AnyConnect button that is available in the Cisco AnyConnect pane. 1T
the Cisco AnyConneet elient 18 already installed on the elient eomputer, the Cisco AnyConnect
tuane! will be established. You can verify the tunnel status by examining the Stabistics tab of
the Ciseo AnyConneet client. The browser, from which the clientless SSL VPN was started,
displays an indication that the tunnel connection is established. For the license count, it is
important that only one session 18 active ata time, You can verily that only one Cisco
AnyConneet session 18 active in the Monitoring > VPN > VPN Stanstics = Sessions submenu.
The clientless session does not appear in the session database. Only one license unit is
consumed when the Cisco AnyConnect WebLaunch leature is used.
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Summary

This topic summarizes the key points that were discussed in this lesson.
]

Summary

Basic VPN portal customization uses the SSL VPN Customization Editor
that is embedded in Cisco ASDM to customize login, portal, and logout
pEges.

Full portal customization is based on selff~made XML pages uploaded to
the security appliance.

Portal |ocalizationinvolves language translation tables that present all
portal compenents in the desired language.

Help customization reguires that either Cisco help files be modified or
self-made language-specific files are loaded.

S5L VPN Cisco AnyConnect WebLaunchfeature consumes only a single
licernse when a CiscoAnyConnect session is started from the clientless
portal.
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Module Summary

This topic summarizes the key points that were discussed in this module.

Module Summary

= Abasic clientless Cisco SSL VPN solution allows users
browser-based access to sensitive resources over a remote
access 35L VPN gateway, implemented on the Cisco ASA
adaptive security appllance.

The S5L VPN rewriting proxy in the Cisco ASA adaptive
security appliance provides clientless, transparent accessto
web and CIFS resources behind the Cisco ASA adaptive
security appliance to clients using only a web browser.

Pkl offers a scalable and secure authentication method for the
netwaork devices to offload the authentication process to back-
end user datsbaszes, such as LDAF, TACACS+, or RADIUSE.

The'web portal accessed by users who connect using a
dientless S5L VPN can be custornized to reflect the
requirements that are defined by the enterprise policy or o use
the local language.
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